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TO THE MAXIMUM EXTENT PERMITTED BY 
APPLICABLE LAW, KEYSIGHT DISCLAIMS 
ALL WARRANTIES, EITHER EXPRESS OR 
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Technology Licenses
The hardware and/or software described in 
this document are furnished under a license 
and may be used or copied only in accor-
dance with the terms of such license.

U.S. Government Rights

The Software is "commercial computer soft-
ware," as defined by Federal Acquisition 
Regulation ("FAR") 2.101. Pursuant to FAR 
12.212 and 27.405-3 and Department of 
Defense FAR Supplement ("DFARS") 
227.7202, the U.S. government acquires 
commercial computer software under the 
same terms by which the software is cus-
tomarily provided to the public. Accordingly, 
Keysight provides the Software to U.S. gov-
ernment customers under its standard com-
mercial license, which is embodied in its 
End User License Agreement (EULA), a copy 
of which can be found at http://www.key-
sight.com/find/sweula. The license set 
forth in the EULA represents the exclusive 
authority by which the U.S. government may 
use, modify, distribute, or disclose the Soft-
ware. The EULA and the license set forth 
therein, does not require or permit, among 
other things, that Keysight: (1) Furnish tech-
nical information related to commercial 
computer software or commercial computer 
software documentation that is not custom-
arily provided to the public; or (2) Relinquish 
to, or otherwise provide, the  government 
rights in excess of these rights customarily 
provided to the public to use, modify, repro-
duce, release, perform, display, or disclose 
commercial computer software or commer-
cial computer software documentation. No 
additional government requirements beyond 
those set forth in the EULA shall apply, 
except to the extent that those terms, rights, 
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pursuant to the FAR and the DFARS and are 
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the EULA. Keysight shall be under no obliga-
tion to update, revise or otherwise modify 
the Software.  With respect to any technical 
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FAR 12.211 and 27.404.2 and DFARS 
227.7102, the U.S. government acquires no 

greater than Limited Rights as defined in 
FAR 27.401 or DFAR 227.7103-5 (c), as 
applicable in any technical data.

Safety Notices

CAUTION
A CAUTION notice denotes a hazard. It 
calls attention to an operating proce-
dure, practice, or the like that, if not 
correctly performed or adhered to, 
could result in damage to the product 
or loss of important data. Do not pro-
ceed beyond a CAUTION notice until 
the indicated conditions are fully 
understood and met. 

WARNING
A WARNING notice denotes a hazard. 
It calls attention to an operating pro-
cedure, practice, or the like that, if not 
correctly performed or adhered to, 
could result in personal injury or 
death. Do not proceed beyond a 
WARNING notice until the indicated 
conditions are fully understood and 
met.

 

http://www.keysight.com/find/sweula
http://www.keysight.com/find/sweula
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Safety Summary
If the instrument is used in a manner not specified by the manufacturer, the protection provided by 
the instrument may be impaired. Use the power cord included with the instrument. See For Your 
Safety booklet publication number 9320-6797.

The following general safety precautions must be observed during all phases of operation of this 
instrument. Failure to comply with these precautions or with specific warnings or operating 
instructions in the product manuals violates safety standards of design, manufacture, and intended 
use of the instrument. Keysight Technologies assumes no liability for the customer's failure to comply 
with these requirements. Some product manuals may be provided on your instrument at C:\Program 
Files\Keysight Technologies\Logic Analyzer\help\pdfs Printed manuals are an option for many 
products. Manuals may also be available on the Web. Go to www.keysight.com and type in your 
product number in the Search field at the top of the page.

WARNING
General
Do not use this product in any manner not specified by the manufacturer. 
The protective features of this product may be impaired if it is used in a 
manner not specified in the operation instructions.

WARNING
Before Applying Power
Verify that all safety precautions are taken. Make all connections to the unit 
before applying power. Note the instrument's external markings described in 
“Safety Symbols”.

WARNING
Ground the Instrument
If your product is provided with a grounding type power plug, the instrument 
chassis and cover must be connected to an electrical ground to minimize 
shock hazard. The ground pin must be firmly connected to an electrical 
ground (safety ground) terminal at the power outlet. Any interruption of the 
protective (grounding) conductor or disconnection of the protective earth 
terminal will cause a potential shock hazard that could result in personal 
injury.

Install the instrument so that the detachable power cord is readily 
identifiable and is easily reached by the operator. The detachable power cord 
is the instrument disconnecting device. It disconnects the mains circuits 
from the mains supply before other parts of the instrument. The front panel 
switch is only a standby switch and is not a LINE switch.

WARNING
The instrument is for use only on circuits that are NOT directly connected to 
mains. It is NOT intended for measurements on CAT II, CAT III, or CAT IV 
circuits. 

http://www.keysight.com
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Safety Symbols

Table 1  Safety Symbol

WARNING
Fuses
See the service manual for information about line-fuse replacement. Some 
instruments contain an internal fuse, which is not user accessible.

WARNING
Do not operate the instrument in an explosive environment or in the presence 
of flammable gases or fumes.

WARNING
Only qualified, service-trained personnel who are aware of the hazards 
involved should remove instrument covers. Always disconnect the power 
cable and any external circuits before removing the instrument cover.

CAUTION
Clean the outside of the instrument with a soft, lint-free cloth dampened 
with water. Do not use too much liquid or any chemicals or detergent.

WARNING
Do not install substitute parts or perform any unauthorized modification to 
the product. Return the product to an Keysight Sales and Service Office for 
service and repair to ensure that safety features are maintained.

WARNING
Instruments that appear damaged or defective should be made inoperative 
and secured against unintended operation until they can be repaired by 
qualified service personnel.

Symbol Description

Direct current

Alternating current

Both direct and alternating current
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Three phase alternating current

Earth ground terminal

Protective earth ground terminal

Frame or chassis ground terminal

Terminal is at earth potential

Equipotentiality

N Neutral conductor on permanently 
installed equipment

L Line conductor on permanently installed 
equipment

On (mains supply)

Off (mains supply)

Standby (mains supply). The instrument is 
not completely disconnected from the 
mains supply when the power switch is in 
the standby position

In position of a bi-stable push switch

Out position of a bi-stable push switch

Equipment protected throughout by 
DOUBLE INSULATION or REINFORCED 
INSULATION

Caution, refer to accompanying 
documentation

Caution, risk of electric shock

Symbol Description
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Do not apply around or remove from 
HAZARDOUS LIVE conductors

Application around and removal from 
HAZARDOUS LIVE conductors is 
permitted

Caution, hot surface

Ionizing radiation

Indicates that antistatic precautions 
should be taken

CAT II Measurement Category II

CAT III Measurement Category III

CAT IV Measurement Category IV

Symbol Description
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Compliance and Environmental Information

Table 2  Compliance Information

Table 3  Environmental Information

Safety Symbol Description

CSA is the Canadian certification mark to demonstrate compliance with the Safety 
requirements.

The C-tick mark is a registered trademark of the Spectrum Management
Agency of Australia. This signifies compliance with the Australia EMC
Framework regulations under the terms of the Radio Communication Act
of 1992.

CE compliance marking to the EU Safety and EMC Directives.
ISM GRP-1A classification according to the international EMC standard.
ICES/NMB-001 compliance marking to the Canadian EMC standard.

KC certification mark to demonstrate compliance with the South Korean EMC 
requirements.
South Korean Class A EMC declaration
This equipment is Class A suitable for professional use and is for use in 
electromagnetic environments outside of the home.

ISM This is the symbol for an industrial, Scientific, and Medical Group 1 Class A product

ICES/NMB-001 indicates that this ISM device complies with the Canadian ICES-001
Cet appareil ISM est conforme a la norme NMB du Canada.

Product With Toxic Substance 40 yr EPUP

This mark denotes compliance with the essential requirements of the following 
applicable UK regulations:
• Electromagnetic Compatibility Regulations 2016 No. 1091 (as amended)
• Electrical Equipment (Safety) Regulations 2016 No. 1101 (as amended)
• The Restriction of the Use of Certain Hazardous Substances in Electrical & 
Electronic Equipment Regulations 2012 No. 3032 (as amended)

Safety Symbol Description

The crossed out wheeled bin symbol indicates that separate collection for waste electric and 
electronic equipment (WEEE) is required, as obligated by DIRECTIVE 2012/19/EU and other 
National legislation.
Please refer to 
about.keysight.com/en/companyinfo/environment/takeback.shtml to 
understand your Trade in options with Keysight in addition to product takeback instructions.

Packaging is recyclable . Please recycle in a responsible way.

about.keysight.com/en/companyinfo/environment/takeback.shtml 
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Using the Keysight Logic and Protocol Analyzer
Instructions for Use:

“This product has been designed and tested in accordance with accepted industry standards, and 
has been supplied in a safe condition. The documentation contains information and warnings that 
must be followed by the user to ensure safe operation and to maintain the product in a safe 
condition.”

The Keysight Logic and Protocol Analyzer application is used with:

• modules in Keysight AXIe chassis (for example the U4154A/B Logic Analyzer module in M9502A 
portable 2-slot chassis)

• modules in Keysight Digital Test Console chassis (for example the U4002A portable 2-slot 
chassis)

• 16850-series logic analyzers.

• It can also be used by itself on a Windows Vista/7/8/8.1 or Windows Server 2008/2012 computer 
for remote access (see page 59) of logic analysis systems on the network, or for offline analysis 
(see page 217) of captured data.

This user guide provides the following information.

• What's New (see page 25)

• Getting Started (see page 39)

• Probing the Device Under Test (see page 57)

• Connecting to a Logic Analysis System (see page 59)

• Setting Up the Logic Analyzer (see page 71)

• Configuring Logic Analyzer Modules (see page 72)

• "Setting Up Probes" (in the online help)

• Setting the Logic Analyzer Threshold Voltage (see page 77)

• Defining Buses and Signals (see page 83)

• Choosing the Sampling Mode (see page 96)

• Setting Up Symbols (see page 132)

• Installing Licensed Hardware Upgrades (see page 139)

• Capturing Data from the Device Under Test (see page 141)

• Setting Up Quick (Draw Box) Triggers (see page 143)

• Specifying Simple Triggers (see page 146)

• Specifying Advanced Triggers (see page 152)

• Triggering From, and Sending Triggers To, Other Modules/Instruments (see page 186)

• Storing and Recalling Triggers (see page 194)

• Running/Stopping Measurements (see page 196)

• Saving Captured Data (and Logic Analyzer Setups) (see page 198)

• Extending Capture Capability with COM/DCOM (see page 206)

• Analyzing the Captured Data (see page 207)

• Offline Analysis (see page 217) (after Loading Saved Data and Setups (see page 208))

• Analyzing Waveform Data (see page 220)

• Analyzing Listing Data (see page 235)

• Displaying Names (Symbols) for Bus/Signal Values (see page 243)

• Marking, and Measuring Between, Data Points (see page 245)

• Searching the Captured Data (see page 264)

• Comparing Captured Data to Reference Data (see page 274)
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• Viewing Source Code Associated with Captured Data (see page 277)

• Analyzing Packet Data (see page 283)

• Analyzing the Same Data in Different Ways (Using the Window) (see page 307)

• Setting the System Trigger and Skew Between Modules (see page 312)

• Using Display Windows (see page 313)

• Printing Captured Data (see page 314)

• "Using Tools" (in the online help)

• "External Oscilloscope Time Correlation and Data Display" (in the online help)

• "Using the PCIe Gen3 Analyzer"

• Managing Software Licenses (see page 321)

• Updating Software (see page 327)

• Solving Problems (see page 331)

• Concepts (see page 353)

• Reference (see page 385)

• Glossary (see page 613)

• "COM Automation" (in the online help)

• "XML Format" (in the online help)

See Also • "AXIe based Logic and Protocol Analysis – Installation Guide”

•  “AXIe based Logic and Protocol Analysis – Quick Start Guide”

•  "16850 Series Portable Logic Analyzers Installation/Quick Start Guide”

•  "16860 Series Portable Logic Analyzers Installation/Quick Start Guide”
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Keysight Logic and Protocol Analyzer 

User Guide

1 What's New

In this release, version 07.00, of the Keysight Logic and Protocol Analyzer application, the following 
changes have been made:

• New DDR5 and LPDDR5 decoders - Two new tools, DDR5 Decoder and LPDDR5 Decoder, have been 
introduced to allow you to decode and view transactions and commands from a DDR5 and 
LPDDR5  SDRAM memory bus respectively. These decoders work with the Keysight Logic and 
Protocol Analyzer software application (in online / offline mode) to decode the acquired 
DDR5/LPDDR5 traces. The decoded data is displayed in a Listing window.

To know more, refer to the online help installed with these decoders. 

• Refresh Rate Overview tab in the Memory Analysis window - This tab has been redesigned to show 
graphs for:

• the number of Refresh commands found in each sampled Refresh Window.

• the exact locations of Refresh commands and Self Refresh entry/exit periods in each sampled 
Refresh Window.

To know more, refer to the help book Analyzing Refresh Performance of an SDRAM.

• DDR/LPDDR Post Process Compliance Tool -  You can now use this tool to configure one or more 
triggers so that Logic Analyzer can acquire relevant traces with event(s) of interest for running 
compliance tests. 

To know more, refer to the topic Configuring Trigger(s) to Acquire Data Relevant for Compliance 
Tests in the tool's online help.

• Markers with transaction names and color-coding in the Memory Analysis and ONFi Analysis viewers - You 
can now place a marker with the name and color-coding of the decoded memory transaction on 
which it is placed.

To know more, refer to the topic Placing Markers on Decoded Transactions.

• ONFi Decode Customization XML file - The following changes/additions have been made to this XML 
file. 

• Ability to customize the address length for the following commands

• Change Read Column Enhanced

• Read 

• Page Program

• Block Erase 

• 6-byte addresses allowed for address length

To know more, refer to the topic ONFi Decode Customization XML File Structure and Elements. 

• Count of pass events in the Real Time Compliance Tool - The tool now displays the following additional 
information in test results for DDR4, DDR5, and LPDDR5 tests.

• With each violation, the tool lists the count of compliance limit pass events found before 
encountering the violation.

• In case the tool does not encounter any compliance limit violation for a test, it reports the total 
number of pass events found for the test. 

To know more, refer to the topic Viewing Results in the online help installed with the tool.

See Also • "Version 06.71 What’s New" on page 27
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Version 06.71 What’s New

In this release, version 06.71, of the Keysight Logic and Protocol Analyzer application, the following 
changes have been made:

• New Filter feature in Memory Analysis window and ONFi Analysis window - You can filter the display of 
transactions in the Memory Analysis and ONFi Analysis windows as per the filter criteria defined 
by you. 

To know more, refer to the topics Filtering Decoded Memory Transactions and Configure Transaction 
Filter Dialog in the Memory Analysis Window User Guide and ONFi Analysis Window User Guide). 

• Support for Infiniium MXR-series and EXR-series oscilloscopes has been added in the ViewScope 
feature. 

To know more, refer to the External Oscilloscope Time Correlation and Data Display Online Help.

See Also • "Version 06.70 What’s New" on page 28

• "Version 06.60 What’s New" on page 29

• "Version 06.50 What’s New" on page 30

• "Version 06.40 What’s New" on page 31

• "Version 06.30 What’s New" on page 32

• "Version 06.20 What’s New" on page 33

• "Version 06.10 What’s New" on page 35

• "Version 06.00 What’s New" on page 38
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Version 06.70 What’s New

In this release, version 06.70, of the Keysight Logic and Protocol Analyzer application, the following 
changes have been made:

• Support for GDDR6 decode in Memory Analysis window - This support is available only for GDDR6 
command/address information capture and analysis. The GDDR6 data (DQ) capture and analysis 
is not supported.

See Also • "Version 06.60 What’s New" on page 29

• "Version 06.50 What’s New" on page 30

• "Version 06.40 What’s New" on page 31

• "Version 06.30 What’s New" on page 32

• "Version 06.20 What’s New" on page 33

• "Version 06.10 What’s New" on page 35

• "Version 06.00 What’s New" on page 38
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Version 06.60 What’s New

In this release, version 06.60, of the Keysight Logic and Protocol Analyzer application, the following 
changes have been made:

• Support for Multiple System Clock Speeds in compliance and decode - This new feature is available only 
for LPDDR5 tests.

The DDR/LPDDR Post Process Compliance Tool and the Memory Analysis window can now 
handle the system clock speed changes of an LPDDR5 bus running at multiple clock speeds. For 
an LPDDR5 bus running at multiple clock speeds, you can specify a set of bus settings for each 
clock speed to allow these tools to perform correct decode and compliance for changing clock 
speeds.

Refer to the topic Configuring the Setup to Handle Multiple System Clock Speeds in the Memory 
Analysis window online help to know more about this feature.

Refer to the topic Customizing the Compliance Setup to Handle Multiple System Clock Speeds in the 
DDR/LPDDR Post Process Compliance Tool Online Help to know more about this feature.

• New features in the ONFi Analysis window - The ONFi Analysis window has been enhanced to:

• support the indexing of the commands in the traffic overview by logical units (LUNs).

• support the decode of new training related commands in ONFi 4.1.

Refer to the topic Customizing ONFi Decode in the ONFi Analysis Window User Guide to know more.

See Also • "Version 06.50 What’s New" on page 30

• "Version 06.40 What’s New" on page 31

• "Version 06.30 What’s New" on page 32

• "Version 06.20 What’s New" on page 33

• "Version 06.10 What’s New" on page 35

• "Version 06.00 What’s New" on page 38
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Version 06.50 What’s New

In this release, version 06.50, of the Keysight Logic and Protocol Analyzer application, the following 
changes have been made:

• Setting compliance tests limits from system parameters - You can now set compliance tests limits 
automatically based on the specific characteristics that you specified for your system in the Real 
Time Compliance Tool and the DDR/LPDDR Post Process Compliance Tool. This new feature is 
available only for DDR4, DDR5, and LPDDR5 tests. 

Refer to the topic Configuring Tests Limits in the DDR/LPDDR Post Process Compliance Tool Online 
Help or the topic To set or edit specification parameters in the Real Time Compliance Tool Online 
Help to know more about this feature.

• Decoded memory transactions export to a .csv file - You can now export the decoded memory 
transactions data displayed in the upper pane of the Memory Analysis window to a specified .csv 
file. Refer to the topic Exporting Decoded Memory Transactions to know more.

• DDR5, LPDDR5, and LPDDR4x support - The DDR5, LPDDR5, and LPDDR4x support has been added 
to the following memory analysis and compliance tools of the Logic and Protocol Analyzer. 

• Memory Analysis Viewer

• DDR/LPDDR Post-Process Compliance Tool

• Real Time Compliance Tool

• DDR Setup Assistant

• DDR Configuration Creator

• DDR Eyescan

• Improvements to the Mode Registers Overview tab in DDR/LPDDR Memory Analysis window - The features 
available in the Mode Registers Overview tab have been improved to make this tab more 
user-friendly and easy to use. Refer to the topic Analyzing Mode Registers Values to know more.

• Updates to the "send e-mail" feature to use SMTP mail server - The "send e-mail" feature available in 
multiple dialogs of the Logic and Protocol Analyzer application has been updated to allow the 
application to communicate directly with the specified SMTP mail server to send the configured 
email message to the specified recipient(s). Refer to the topic Options Dialog > Email Settings options 
to know more. 

• Improvements to the ONFi Analysis window - The features available in the ONFi Analysis window have 
been enhanced to:

• include additional ONFi decode customization choices in the XML customization file.

• support multiple ONFi viewers on a single Logic Analyzer module.

• support the SDR decode mode.

• allow the export of the payload data from an ONFi trace to a separate binary file.

Refer to the topic Analyzing ONFi Data using the ONFi Analysis Window in the ONFi Analysis Window 
User Guide to know more. 

See Also • "Version 06.40 What’s New" on page 31

• "Version 06.30 What’s New" on page 32

• "Version 06.20 What’s New" on page 33

• "Version 06.10 What’s New" on page 35

• "Version 06.00 What’s New" on page 38
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Version 06.40 What’s New

In this release, version 06.40, of the Keysight Logic and Protocol Analyzer application, the following 
changes have been made:

• ONFi decode customization XML file - You can now customize how the ONFi data is decoded for 
display in the ONFi Analysis window by specifying the available customization options in an xml 
data file.

Refer to the topic Customizing ONFi Decode in the ONFi Analysis Window User Guide to know 
more.

• ONFi data export to a .csv file - You can now export either the raw ONFi data or the decoded ONFi 
transactions data displayed in the ONFi Analysis window to a specified .csv file.

Refer to the topic Exporting ONFi Data to a csv File in the ONFi Analysis Window User Guide to 
know more.

• New Timeline view added to the ONFi Analysis window - You can now get a visual understanding of the 
timeline for the ONFi transactions for a NAND target. The Timeline view displays the ONFi 
transactions as linear bars on a timeline.

Refer to the topic Viewing ONFi Data in a Timeline View in the ONFi Analysis Window User Guide 
to know more.

See Also • "Version 06.30 What’s New" on page 32

• "Version 06.20 What’s New" on page 33

• "Version 06.10 What’s New" on page 35

• "Version 06.00 What’s New" on page 38
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Version 06.30 What’s New

In this release, version 06.30, of the Keysight Logic and Protocol Analyzer application, the following 
changes have been made:

• 16860-series Logic Analyzers - The Keysight Logic and Protocol Analyzer application now adds 
support for the new 16860-series standalone benchtop state and timing logic analyzers. This 
series of logic analyzers provide 34 to 136 logic acquisition channels, depending on the model. 
This series can be used as a medium to high performance general purpose logic analyzer as well 
as for debug, validation and analysis of DDR and LPDDR memory systems.

Refer to the topic "16860-Series Logic Analyzer Notes" on page 555 to know more about this 
series.

• New Multiple clocks state sampling option - You can now run your logic analyzer in the Single clock 
or Multiple Clocks state sampling option. The Multiple Clocks sampling option is new and is a low 
speed option more suitable for general-purpose logic analysis. This option is provided only with 
the U4164A and 16860-series logic analyzers.

Refer to the topic "To select the state sampling option" on page 98 to know more about these 
two sampling options.

• Multiple clocks support - You can now set up to four multiple clocks in an Ored combination for your 
logic analyzer. The multiple clocks feature is provided only with the U4164A and 16860-series 
logic analyzers.

Refer to the topic "To set up the state sampling clock" on page 124 to know more about setting 
up multiple clocks.

• Advanced clocking feature - When setting up multiple clocks, you can use the new Advanced 
Clocking feature to define complex clock descriptions. This feature is provided only with the 
U4164A and 16860-series logic analyzers.

• Master/Slave and Demultiplex clock modes - When setting up multiple clocks, you can now use the 
Master/Slave or Demultiplex clock modes for the U4164A and 16860-series logic analyzers.  

Refer to the topics "Master/Slave Sampling Clock Mode" on page 101 and "Demultiplex 
Sampling Clock Mode" on page 103 to know more about these clock modes.

• New ONFi Analysis window - You can now capture and analyze ONFi data from NAND flash memory 
devices using the new ONFi Analysis window available in the Logic and Protocol Analyzer GUI. 
You can add an instance of this window to your logic analyzer module in the GUI and then 
compute decoded ONFi transactions and ONFi traffic statistics from the captured data.

Refer to the ONFi Analysis Window User Guide to know more.

• New Mode Registers Overview tab in the DDR/LPDDR Memory Analysis window - You can now use 
this new tab to obtain an overview of your SDRAM's mode registers values and compare these 
values in various ways (across ranks or with immediate previous settings or with values at another 
time instance).

Refer to the chapter Analyzing Mode Registers Values in the DDR/LPDDR Memory Analysis User Guide to 
know more.

• 3DS DDR4 rank addressing modes in the B4661A Memory Analysis tools- You can now select 
standard, Quad CS, or 3DS rank addressing mode for your DDR4 RDIMM device in the DDR Bus 
Decoder, Memory Analysis window, Real Time Compliance tool, and DDR/LPDDR Post Process 
Compliance tool.

See Also • "Version 06.20 What’s New" on page 33

• "Version 06.10 What’s New" on page 35

• "Version 06.00 What’s New" on page 38
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Version 06.20 What’s New

In this release, version 06.20, of the Keysight Logic and Protocol Analyzer application, the following 
changes have been made:

• U4164A Logic Analyzer module -The Keysight Logic and Protocol Analyzer application now adds 
support for a new AXIe-based logic analyzer module U4164A. You can use this module to capture 
and analyze DDR 2/3/4 and LPDDR 2/3/4 data. U4164A is installed in a Keysight AXIe chassis 
and configured and controlled using the Keysight Logic and Protocol Analyzer application. This 
module supports maximum of three cards in a multi-card set and supports quad samples and 
quarter channel timing mode. This module allows you to perform full DDR4 data capture at 
speeds > 2.5 Gb/s from a single probe point.

Refer to the U4164A Logic Analyzer Notes to know more about this module.

• Quad Sample clock mode - A new State sampling clock mode - Quad Sample is provided for the 
U4164A module that allows four samples per clock edge to support high speed data capture. It 
allows you to capture separate rising and falling edge samples of both read and write 
DDR/LPDDR DQ signals for data rates up to 4 Gb/s from a single probe point. 02G license of 
U4164A is required for this clock mode. Refer to the topic "To set up the quad sample sampling 
clock mode" on page 119 to know more.

• Dual sample clock mode, when used with the U4164A module now supports two thresholds that you 
can assign as separate offsets to capture two samples per clock edge with different thresholds. 
Refer to the topic "To set up the dual sample sampling clock mode" on page 116 to know more 
about how dual sampling functions in the U4164A module.

• Quarter Channel Timing Mode - A new Timing (Asynchronous) sampling option has been provided for 
the U4164A module- Quarter Channel Timing Mode. 01G or 02G license of U4164A is required for 
this timing mode.

• Clock Hysteresis - U4164A provides a new setting called Clock hysteresis for the state sampling 
clock on Pod1 of the U4164A module. Refer to the topic Setting Clock Hysteresis for the U4164A 
State Sampling Clock to know more.

• Signal Deskew Tool - This new tool allows you to set sampling positions for the Timing 
(Asynchronous) sampling modes of a U4164A logic analyzer. Refer to the online help available in 
the tool's GUI to know more.

• New B4661A Memory Analysis Software Tools - Following standard and licensed tools are available in 
B4661A.

• Standard features

• Default configurations

• Setup Assistant

• Configuration Creator tool

• Eye Finder and Eye Scan

• Licensed features

• DDR decoder with physical address trigger tool

• LPDDR decoder

• DDR and LPDDR compliance violation analysis tool

• DDR3/4 and LPDDR2/3/4 performance analysis tool (Memory Analysis window)

• New W4640-series DDR/LPDDR BGA Interposers - Two new interposers W4641A and W4643A have 
been introduced for use with the U4164A module to achieve higher data rates with smaller KOV. 
These interposers effectively utilizes the single touch probing and quad sampling features of the 
U4164A logic analyzer module thereby allowing you to probe DDR4 DQ signals above 2.5Gb/s 
without double probe load.

See Also • "Version 06.10 What’s New" on page 35
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• "Version 06.00 What’s New" on page 38
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Version 06.10 What’s New

In this release, version 06.10, of the Keysight Logic and Protocol Analyzer application, the following 
changes have been made:

• U4431A MIPI M-PHY Analyzer module - The following new features have been added.

• NVMe, AHCI, and SSIC transactions decoding - The Transaction Decode tab in the Protocol Viewer 
now supports computing and viewing NVMe, AHCI, and SSIC transactions from the captured 
data. 

Refer to the help book Viewing Decoded Transactions in the U4431A MIPI M-PHY Analyzer 
module online help to know more.

• SSIC test assertion - A new tab, Test assertion has been added to the Protocol Viewer window to 
allow you to run predefined SSIC test assertions on the captured trace. 

Refer to the help book Computing and Viewing the Test Assertions in the U4431A MIPI M-PHY 
Analyzer module online help to know more.

• LTSSM states and state transitions - You can now view LTSSM states and state transitions as 
detected in the MPCIe or SSIC data captured in a trace using the newly added LTSSM 
Overview tab in the Protocol Viewer. 

Refer to the help book Viewing LTSSM States and State Transitions in the U4431A MIPI M-PHY 
Analyzer module online help to know more.

• Command Line Packet Generator (CLPG) - You can now use the U4431A module for transmitting 
stimulus on an M-PHY link and capturing bidirectional M-PHY data, that is, capturing the data 
that it transmits as stimulus as well as the data that it receives from a DUT. For this usage 
scenario, you need the Keysight Command Line Packet Generator (CLPG), which is available 
as a licensed software option (U4431A-613) of the U4431A module, 

For detailed information on CLPG and how to use it for stimulus transmission and capture, 
refer to the Keysight MIPI M-PHY Command Line Packet Generator User Guide installed with 
the CLPG software at C:\Program Files\Keysight TechnologiesTechnologies\Logic Analyzer\
Help\pdfs.

• U4301 PCIe Gen3 Analyzer module - The following new features have been added.

• Compact tool - You can now compact the display of training sequence packets into sets in 
Protocol Viewer using the new Compact tool available in the Protocol Viewer toolbar. 

Refer to the topic Compacting the Display of Training Sequence Packets in the U4301 PCIe 
Gen3 Analyzer Online Help to know more.

• Auto link width detection - You can now use the new auto link width detection feature to 
configure the U4301 module to automatically detect link width during initial link up as well as 
link width changes during up/down configurations and accordingly sets its link width based 
on these changes as seen in the captured data. This allows data capture as per the changing 
link width. 

Refer to the topic Specifying the Connection Setup in the U4301 PCIe Gen3 Analyzer Online 
Help to know more.

• Auto lane reversal - You can now use the new auto lane reversal feature to configure the U4301 
module to automatically detect lane reversal based on the TS ordered sets that it sees during 
the LTSSM training of the monitored link. Using this feature, the module automatically 
switches its lane reversal to On or Off to match the lane reversal On/Off that it detects on the 
monitored link. 

Refer to the topic Specifying the Connection Setup in the U4301 PCIe Gen3 Analyzer Online 
Help to know more.

• L1 substates support - The U4301 Analyzer module now supports L1 substates, L1.1 and L1.2. 
You can now:
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• capture entry and exit from ASPM and PCI-PM L1 sunstates.

• view L1 substates and their transitions in the LTSSM Overview tab. 

• set the trigger on ‘CLKREQ# Asserted’ and ‘CLKREQ# Deasserted’ events.

• search and set a filter based on CLKREQ# for the packets displayed in the Protocol 
Viewer.

• qualify whether or not the CLKREQ# transitions should be stored in the Analyzer module's 
memory while capturing data. 

• Trigger on physical layer errors - The U4301 Analyzer module now allows you to set up a trigger 
on physical layer errors such as symbol errors, disparity errors, block header errors. 

Refer to the topic Setting up a Trigger on Physical Layer Errors in the U4301 PCIe Gen3 
Analyzer Online Help to know more.

• Trigger on link width change and trigger on link speed change - The U4301 Analyzer module now 
allows you to set up a trigger on link width and link speed changes. 

• Lane alignment - For data capture, two new options have been introduced for lane alignment - 
Strict and Relaxed lane alignment. 

Refer to the topic Setting the Capture Options in the U4301 PCIe Gen3 Analyzer Online Help to 
know more.

• Trimming non-overlapped data - You can now configure the U4301 module to enable or disable 
the trimming of non-overlapped data while capturing data. Refer to the topic Setting the 
Capture Options in the U4301 PCIe Gen3 Analyzer Online Help to know more.

• Tuning enhancements - Two new tuning methods, Long Tune and Long Fine Tune have been 
added to tune the U4301 Analyzer module for a specific DUT. These methods take longer time 
to complete tuning as compared to other tuning methods but can reduce the trace errors 
resulting from inadequate tuning (after you have completed standard tune and fine tune). 

Refer to the topic Creating a Physical Layer Tuning File in the U4301 PCIe Gen3 Analyzer 
Online Help to know more.

• Filtering enhancements - The Filtering feature available in the Protocol Viewer has now been 
enhanced to support filtering of packets based on the error types. 

Refer to the topic Filtering Packets Displayed in Protocol Viewer in the U4301 PCIe Gen3 
Analyzer Online Help to know more.

• Packet search enhancements - The Quick Search feature available in the Protocol Viewer has now 
been enhanced to support searching the packets based on the error types. 

Refer to the topic Searching for Specific Packets in Protocol Viewer in the U4301 PCIe Gen3 
Analyzer Online Help to know more.

• Exporting data capabilities added to Traffic Overview and Performance Overview tabs of the Protocol 
Viewer - You can now export packet times data and charts data from the Traffic Overview and 
Performance Overview tabs respectively to a specified .csv or an Excel file. 

Refer to the topics Exporting Performance Summary Charts Data to a .csv or an Excel File and 
Exporting Packet Times from a Traffic Overview Chart to a .csv or an Excel File in the U4301 
PCIe Gen3 Analyzer Online Help to know more.

• NVMe performance charts - You can now generate performance charts for the NVMe 
transactions computed in the Transaction Decode tab. 

Refer to the topic Viewing a Transaction Performance Chart in the U4301 PCIe Gen3 Analyzer 
Online Help to know more.
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• Scope Power Analysis - While using the external oscilloscope time correlation and data display 
feature, you can now specify the resistance used at the current probe point to allow scope 
power analysis from the scope voltage and supplied resistance. If the current probe is enabled 
for an analog signal, Amperage is now used as the Base unit for the signal’s data in the 
Waveform Viewer and Listing Viewer. Refer to the topic Channels tab in the External 
Oscilloscope Time Correlation and Data Display Online Help to know more. 

• Two new probes, U4328A M.2 (M-key) Interposer and U4330A SFF-8639 Interposer have been added 
to the list of currently available probing options for use with the U4301 Analyzer module. 

Refer to the PCI Express Gen3 Hardware and Probing Guide to get detailed information on 
each of these new probes. 

• U4421 D-PHY Analyzer and Exerciser module - The following new features have been added.

• You can now extract a compressed image from the captured DSI packet formats as well as 
insert a compressed image while generating stimulus from bitmap files. You can also 
customize the PPS values for a compressed image using the new DSI Image Compression 
Settings tool. This tool is integrated with the Image Inserter as well as the Image View tab. 
Refer to the topics Extracting Images from the Packet Data and Using the Image Inserter 
Application in the U4421 D-PHY Analyzer and Exerciser Online Help.

• You can now add background and foreground colors to user-defined symbols while creating or 
editing these symbols for bus/signal values. These colors are then used for symbols to present 
data in the Waveform and Listing viewers. 

See Also • "Version 06.00 What’s New" on page 38
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Version 06.00 What’s New

In this release, version 06.00, of the Keysight Logic and Protocol Analyzer application, the following 
changes have been made:

• The Keysight Logic and Protocol Analyzer application now adds support for a new AXIe-based 
module U4154B to capture and analyze DDR 2/3/4 and LPDDR 2/3/4 data. U4154B is installed in 
a Keysight AXIe chassis and configured and controlled using the Keysight Logic and Protocol 
Analyzer application. This module supports three cards in a multi-card set and has improved clock 
qualifiers to capture traces out of reset. This module enables DDR4 interposer to perform full data 
capture at speeds > 2.5 GB/s. Refer to the U4154B Logic Analyzer Notes to know more.

• The support for legacy logic analysis systems such as 16760/1680XA/1682XA/16962A/168x/9x 
has been removed from the Logic and Protocol Analyzer software. These systems are supported 
only on the software version 5.9 or earlier.

• U4431A MIPI M-PHY Analyzer module - 

• Transaction decoding - You can now compute and view decoded transactions from the 
captured MPCIe data using the newly added Transaction Decode tab in the Protocol Viewer. 
Refer to the help book Viewing Decoded Transactions in the U4431A MIPI M-PHY Analyzer 
module online help to know more.

• Offline performance summary computation - You can now compute and view offline 
performance summary from the captured MPCIe data using the newly added Performance 
Overview tab in the Protocol Viewer. This tab presents statistics for various performance 
parameters in tabular as well as charts form. Refer to the help book Viewing Offline 
Performance Summary in the U4431A MIPI M-PHY Analyzer module online help to know more.

• A new feature, Flow Control is now available in the Performance Overview tab of the Protocol 
Viewer. This feature allows you to compute and track the available flow control credits for the 
data trace that has bidirectional MPCIe traffic. Refer to the topic Viewing Offline Performance 
Summary in the U4431A MIPI M-PHY Analyzer module online help to know more.

• U4301B PCIe Gen3 Analyzer module - The following enhancements have been made.

• Traffic overview chart - The Traffic Overview tab in the Protocol Viewer now provides a traffic 
overview band chart based on the packet types. 

• Filtering improvements - The procedure for filtering packets in the Protocol Viewer has been 
simplified. A new button has been added to the Protocol Viewer to set up the filtering options.

• Simpler packet search - The procedure for searching packets in the Protocol Viewer has been 
simplified. A new text box has been added to the Protocol Viewer's upper pane to allow you to 
search on the basis of packet names. This text box has the AutoComplete feature.

• Eliminate separate view

• Capture InitFC - The Performance Overview tab in the Protocol Viewer now has the feature to 
set the InitFC discovered in the trace as the default InitFC. 

• Flow control for header packets - The Performance Overview tab in the Protocol Viewer now 
provides options for setting Header Flow Control Init values.

• Equalization summary for Gen3 training sequences - The LTSSM Overview tab in the Protocol 
Viewer now provides Equalization Summary section for Gen 3 training sequences exchanged 
between the link partners.

• 1 button computation - A new Compute button has been added to the Protocol Viewer that 
allows you to compute traffic overview statistics, decoded transactions, and offline 
performance summary for the captured packets by a single click of this button.
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Tutorial - Getting to know your logic analyzer

The following tutorial is intended to give you a quick of logic analyzer basics. In addition to learning 
the concepts of logic analysis, you will see some of the logic analyzer's more common features by 
going through a measurement. Finally, you are shown some easy time saving tasks that can quickly 
make you as productive as a more experienced user.

Logic analysis
basics

• When should you use an oscilloscope? (see page 354)

• When should you use a logic analyzer? (see page 355)

• What is a logic analyzer? (see page 356)

Timing analyzer:

• Sampling clock (see page 356)

• Sampling (see page 356)

• Triggering (see page 357)

State analyzer:

• Sampling clock (see page 358)

• Sampling (see page 359)

• Triggering (see page 359)

Measurement The following does not require an active device under test. However, in order to show features that 
work on data, you are asked to load a configuration file between steps 5 and 6 that contains data to 
finish the exercise.

• Turning on the logic analyzer (see page 40)

• Connecting to the device under test (see page 41)

• Setting up bus/signal names (see page 42)

• Setting the acquisition mode (see page 43)

• Setting up a simple trigger (see page 43)

• Open the tutorial configuration file (see page 44)

• Using markers (see page 44)

• Zooming in on the data (see page 45)

Time saving tasks • Loading and saving configuration files (see page 46)

• Saving and recalling trigger setups (see page 46)

• Quick marker measurements (see page 47)

• Searching data (see page 48)

• Toolbars, tool tips, and mouse shortcuts (see page 49)

See Also • Product Overviews (see page 520)

Turning on the logic analyzer

[ Tutorial Home (see page 40) ] [ Next Topic (see page 41) ] [ Previous Topic (see page 359) ]

1 Consider ergonomics when positioning the keyboard and mouse.

2 Plug in the power cable and press the front-panel Standby button.

3 From the Windows Start bar, click Start>Programs>Keysight Logic Analyzer>Keysight Logic 
Analyzer.
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Connecting to the device under test

[ Tutorial Home (see page 40) ] [ Next Topic (see page 42) ] [ Previous Topic (see page 40) ]

The first step in using a logic analyzer is to probe signals in the device under test.

For more information about probing options, see Probing the Device Under Test (see page 57).

NOTE
Optional: If you have a logic analyzer shortcut icon on screen, double-click the icon.

NOTE
In this tutorial, no probe connections are required. Later on in this tutorial, you are asked to load a 
configuration file containing data to simulate the results of a probed device under test.
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Setting up bus/signal names

[ Tutorial Home (see page 40) ] [ Next Topic (see page 43) ] [ Previous Topic (see page 41) ]

By default, the analyzer has one bus (My Bus 1) set up in the interface. The following exercise cleans 
up the display defaults and re-configures the bus/signal setup for a new measurement.

Delete bus/signal
names

1 In the menu bar click Setup>(Logic Analyzer Module)>Bus/Signal....

2 In the Analyzer Setup dialog that appears, right-click on My Bus 1, then select Delete. Repeat 
until all bus signal names are deleted. After the last bus/signal is deleted, "My Bus 1" appears 
again as a default name.

Add new
bus/signal name

1 In the Analyzer Setup dialog, right-click on My Bus 1, then select Rename.

2 From the popup keypad that appears, type in the new name "counter".

3 Select OK.

TIP You can delete all bus/signal configurations at once with the Delete All button.
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Map signals into
the analyzer

The logic analyzer must be told which probed signals from the device under test are to be included in 
the measurement, and how you want them grouped. In this exercise, you assign channels 0 - 7 on 
Pod 1 under the name "counter". Notice that when more than one channel is assigned to "counter" it 
becomes a bus.

1 Check the activity indicators for verification of proper connection to the device under test. You 
should see a transition arrow on all 8 channels.

2 Click each channel assignment box under channels 0 - 7 on Pod 1. Notice that as you assign 
channels, the configuration information is updated for the bus/signal.

3 Click OK.

Setting the acquisition mode

[ Tutorial Home (see page 40) ] [ Next Topic (see page 43) ] [ Previous Topic (see page 42) ]

Under the Sampling tab of the Analyzer Setup dialog is where you set the analyzer to be either a 
timing or state analyzer. You also set either the timing options, such as memory depth or sampling 
period, or the state clocking options.

1 From the menu bar, click Setup>(Logic Analyzer Module)>Timing/State (Sampling)..., or click 
the  icon in the toolbar.

2 Select Timing - Asynchronous Sampling.

3 Click OK.

Setting up a simple trigger

[ Tutorial Home (see page 40) ] [ Next Topic (see page 44) ] [ Previous Topic (see page 43) ]

NOTE
If you have real device under test hardware, you will see activity indicators as shown below. If you 
are loading the demo configuration file (later in this tutorial) you will not see activity.
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The Simple Trigger is a quick way to configure the analyzer to trigger on either a data pattern on a 
bus, or an attribute of a single signal such as a rising edge or a low logic level.

1 In the Simple Trigger column, click on the pattern qualifier  and set it to Equal.

2 Click in the text entry field  and enter the data pattern "E5".

Open the tutorial configuration file

[ Tutorial Home (see page 40) ] [ Next Topic (see page 44) ] [ Previous Topic (see page 43) ]

At this point in a measurement, you would normally run the logic analyzer. However, because you are 
not connected to a device under test, you cannot capture real data. You will have to load a 
configuration file that contains this data.

Load the
configuration file

1 Select File>Open.

2 From the file manager dialog, select the file named DemoConfig.ala from the following directory: 
C:\Documents and Settings\All Users\Documents\Keysight Technologies\Logic Analyzer\
Default Configs\Keysight\Help Demo\

3 Select Open.

View the data Notice how the logic analyzer triggered on data pattern E5 and placed it in the center of the display. 
The red line shows that the trigger point is at the start of the data pattern E5.

Using markers
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[ Tutorial Home (see page 40) ] [ Next Topic (see page 45) ] [ Previous Topic (see page 44) ]

Markers are used for creating reference points in data. Once markers are placed in data, you can use 
them to quickly see what time, sample, or data value the marker is set on.

To create a marker 1 From the menu bar, click Markers>New.

2 From the New Marker dialog that appears, configure the new marker and if desired, specifically a 
position it in data. When you do not position the marker, by default it is placed at the trigger 
point.

3 Select OK.

To place a marker
in data

When you first create a new marker, you have the option to place it in data at a specific point in time 
or a specific sample number. The following exercise shows you other ways to position markers in 
data.

1 In the display, click on marker M3 (your new marker) and while holding the mouse button down, 
drag maker M3 to -100ns before trigger, then release. Notice that the marker position value 
changes as you move it.

2 From the menu bar, click Markers>Place On Screen, then select M1 and click OK. Notice how M1 
is placed at center screen at the red trigger line.

3 Point the mouse cursor at any desired point in data, then right-click and select Place Marker. 
From the Place Marker dialog that appears, choose the M2 marker. Notice that the marker is 
placed where the mouse was pointing.

Go To a marker in
data

Once you have markers set in data, you can quickly find any of them as follows.

1 From the menu bar, click Markers>GoTo.

2 Select the marker you want to find, and click OK.

Zooming in on the data

[ Tutorial Home (see page 40) ] [ Next Topic (see page 46) ] [ Previous Topic (see page 44) ]

Data from a timing analyzer is displayed (as on an oscilloscope) as waveforms on a horizontal time 
axis. To zoom in or out on a waveform, change the Scale (time/division) of the time axis of the 
waveform.

Both state and timing analyzers can have multiple signals grouped together in a bus. To get a view of 
all signals, you can expand a bus into individual signals.

Expand a bus Click the "+" symbol just to the left of the bus named "counter". The collection of signals under 
"counter" breaks out into individual signals named counter[0] - counter[7].



2 Getting Started

46 Keysight Logic and Protocol Analyzer User Guide

Change the scale Click the zoom out icon to expand the signals to where you want them.

Loading and saving configuration files

[ Tutorial Home (see page 40) ] [ Next Topic (see page 46) ] [ Previous Topic (see page 45) ]

Many times it is quicker to open an existing configuration file with a similar setup than to create a 
new configuration from scratch. You simply open a similar file, make the appropriate changes to the 
setup, then save the file as a new filename.

You already have learned how to open a configuration file. In the following exercise, you will save the 
"democonfig" file to a new name.

1 From the menu bar, click File>Save As....

2 From the file manager dialog that appears, type in the new name "myconfig", then click Save.

Saving and recalling trigger setups

[ Tutorial Home (see page 40) ] [ Next Topic (see page 47) ] [ Previous Topic (see page 46) ]

NOTE
When you rename an existing configuration file, you retain the saved trigger setups and "Find" 
search favorites from the first configuration file.
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Each time you set up a new trigger and run the measurement, the trigger setup is saved in the logic 
analyzer. It is quicker to recall a trigger setup rather than re-configure the trigger setup each time.

To recall a trigger
setup

1 From the menu bar, click Setup>(Logic Analyzer Module)>Recall Trigger....

2 From the lower list, select the desired trigger setup, then click OK.

Quick marker measurements

[ Tutorial Home (see page 40) ] [ Next Topic (see page 48) ] [ Previous Topic (see page 46) ]

You can quickly read the time or number of samples between markers.

1 Click Markers>New Time Interval Measurement.

2 Configure the Interval dialog to display the time from Beginning of Data to Trigger as shown 
below.

To show statistics with the time interval measurement (after repetitive runs, click Properties; 
then, in the Interval Properties dialog, check Show statistics.

NOTE
The logic analyzer must be run before the trigger setup is stored. Also, trigger setups are stored as 
part of the configuration file. If you load a new configuration file, the trigger setups will be 
overwritten by trigger setups stored with the new file.

TIP When the list of most recently used triggers get long, you can store the most often used triggers in 
the upper favorites list.
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Click OK to close the Interval Properties dialog, and click OK to close the Time Interval dialog.

After a repetitive run, the result of the time interval measurement is displayed in the marker 
measurements display bar.

3 Click Markers>New Value At Measurement.

4 Configure the Value At dialog to display the Hex value of My Bus 1 at M1 as shown below; then, 
click OK.

The result of the value at measurement  is displayed in the marker measurement 
display bar.

Searching data

[ Tutorial Home (see page 40) ] [ Next Topic (see page 49) ] [ Previous Topic (see page 47) ]

You can search for a data pattern on a bus or a signal. You can also choose when the search begins 
and ends. Finally, you can save the search criterion in a favorites list.

1 From the menu bar, click Edit>Find....

2 In the Find dialog, configure the search criterion as shown below to find "AA".

3 Select Find.
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As you configure the Find dialog, try to think of it as constructing a sentence that reads left-to-right.

"Find the 1st occurrence searching Forward from Display Center, on a bus named My Bus 1, 
including All bits, a pattern that Equals AA".

Toolbars, tool tips, and mouse shortcuts

[ Tutorial Home (see page 40) ] [ Previous Topic (see page 48) ]

Throughout this tutorial, the menu bar has been used to access features. There are two other ways to 
access features as well as other useful tips that can save you time.

Toolbars Below the menu bar are groups of icons that represent shortcuts to many dialogs and features. For 
more information refer to Toolbars (see page 398) in the main help.

Mouse Shortcuts There are many mouse shortcuts available. To access them simply point the mouse over a screen 
element such as a marker, or screen area, then right-click the mouse. Mouse shortcuts are especially 
useful within the waveform and listing data display areas.

Tool Tips Tool tips are small information displays that appear during operations such as moving markers, 
setting a trigger with the mouse, or hovering the mouse over a bus/signal name. Use them as 
comments (see page 94), or to monitor your progress or current positions.
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Measurement Examples

The following measurement examples show you the typical order of steps to set up and run a 
measurement. As you go through the examples, you will encounter steps such as probing or 
triggering where alternative choices are available. In these steps, select the probing or trigger 
example that best fits your measurement.

• Making a timing analyzer measurement (see page 50)

• Making a state analyzer measurement (see page 51)

• To trigger on one of multiple edges (see page 52)

• To trigger on ranges (see page 53)

See Also • Tutorial - Getting to know your logic analyzer (see page 40)

• Timing Mode Trigger Functions (see page 478)

• State Mode Trigger Functions (see page 490)

Making a timing analyzer measurement

The following measurement example shows you the steps necessary to configure and run the logic 
analyzer for a typical timing analyzer measurement. As you go through the example, make the 
appropriate choices from the selection lists that best match the kind of configuration you need.

1 Connect the probing to the device under test (see Probing the Device Under Test (see page 57) 
for more information).

2 Turn on the logic analyzer.

Bus and signal
setup

1 In the menu bar, select Setup>(Logic Analyzer Module)>Bus/Signal....

2 From the Buses/Signals tab, assign bus/signal names to the device under test signals probed. 
You do this by either renaming (see page 85) existing names, or deleting (see page 84) and 
creating (see page 84) new names.

3 From the Buses/Signals tab, define buses and signals (see page 83) under the appropriate pods 
for all probed buses/signals on the device under test.

Acquisition mode
setup

1 In the Analyzer Setup dialog, select the Sampling tab.

2 From the Sampling tab, set the acquisition mode to Timing - Asynchronous Sampling.

3 Set the Sampling Options (see page 97).

4 Set the timing mode Sampling Period (see page 98).

TIP If you are new to logic analysis, refer to "Tutorial - Getting to know your logic analyzer (see 
page 40)" for a quick tutorial on logic analysis concepts and measurements.



Keysight Logic and Protocol Analyzer User Guide 51

Getting Started 2

Trigger setup 1 The trigger required to capture specific data depends on the measurement. However, the trigger 
is generally set in two ways.

• From within the data display, set up a simple trigger (see page 146).

• From the Advanced Trigger dialog (see page 424), set up a timing mode advanced trigger (see 
page 478) function.

Run the
measurement

1 Run (see page 196) the measurement.

See Also • To specify the trigger position (see page 128)

• To set acquisition memory depth (see page 129)

Making a state analyzer measurement

The following measurement example shows you the steps necessary to configure and run the logic 
analyzer for a typical state analyzer measurement. As you go through the example, make the 
appropriate choices from the selection lists that best match the kind of configuration you need.

1 Connect the probing to the device under test (see Probing the Device Under Test (see page 57) 
for more information).

2 Turn on the logic analyzer.

Bus and signal
setup

1 In the menu bar, select Setup>(Logic Analyzer Module)>Bus/Signal... .

2 From the Buses/Signals tab, assign bus/signal names to the device under test signals probed. 
You do this by either renaming (see page 85) existing names, or deleting (see page 84) and 
creating (see page 84) new names.

3 From the Buses/Signals tab, define buses and signals (see page 83) under the appropriate pods 
for all probed buses/signals on the device under test.

Acquisition mode
setup

1 In the Analyzer Setup dialog, click the Sampling tab.

2 From the Sampling tab, set the acquisition mode to State - Synchronous Sampling.

3 Set the state clock mode (see page 99).

4 Set the state sampling clock (see page 124).

TIP If you are new to logic analysis, refer to "Tutorial - Getting to know your logic analyzer (see 
page 40)" for a quick tutorial on logic analysis concepts and measurements.

NOTE
Be sure that the clock signals of your device under test are connected to clock channels on the 
pods. Any unused clock channels can be used for additional data channels and will not feed into 
the state clock setup.
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5 If necessary, set the advanced state clocking (see page 127).

Trigger setup 1 The trigger required to capture specific data depends on the measurement. However, the trigger 
is generally set in two ways.

• From within the data display, set up a simple trigger (see page 146).

• From the Advanced Trigger dialog (see page 424), set up an advanced trigger (see page 490) 
function.

Run the
measurement

1 Run (see page 196) the measurement.

See Also • To specify the trigger position (see page 128)

• To set acquisition memory depth (see page 129)

To trigger on one of multiple edges 

1 In the timing sampling mode, set up an Advanced Trigger.

2 Select the bus on which you're looking for one of multiple edges.

3 Select All bits in the bus.

4 Select Edge.

5 Click Edge Spec....

6 In the Set Edge dialog, specify edges you are looking for; use the Set All button to make a 
selection for all signals in the bus.

7 Click OK to close the Set Edge dialog.

8 Click OK to close the Advanced Trigger dialog.
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To trigger on ranges

When setting up
simple triggers
(see page 146)

1 In the Simple Trigger field for a bus, click the  operator button; then, choose either In Range 
or Not In Range.

2 Specify the range values, either by entering values in the low range and high range text entry 
fields or, when the Symbol number base is selected, by using the Select Symbol dialog (see 
page 458).

3 From the menu bar, choose Run/Stop>Run, or click the  icon from the run/stop toolbar (see 
page 401).

When setting up
advanced triggers

(see page 152)

1 Click  in the analyzer setup toolbar, or choose Setup>(Logic Analyzer Module)>Advanced 
Trigger... from the menu bar.

2 In the Advanced Trigger dialog, select the bus.

Clicking  lets you select from recently used bus/signal names. Clicking elsewhere on a 
bus/signal name button opens a Select dialog for selecting a different name.

3 Select All bits on the bus.

NOTE
In order to trigger on ranges of bus values, the bus:

• Must not have reordered bits.
• Must not contain clock bits that span pod pairs.
• Must span 2 or fewer pod pairs (up to 64 bits wide).

Waveform Display Window Listing/Compare/Source Display Window

Bus Range Trigger
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4 Select either the In Range or Not In Range operator.

5 Select the number base (Binary, Hex, Octal, Decimal, Signed Decimal, also known as two's 
complement, Ascii, or Symbol).

6 Specify the range values, either by entering values in the low range and high range text entry 
fields or, when the Symbol number base is selected, by using the Select Symbol dialog (see 
page 458).

7 From the menu bar, choose Run/Stop>Run, or click the  icon from the run/stop toolbar (see 
page 401).
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Demo Center

Demo Center is an application that demonstrates logic analysis system features. It loads illustrative 
configurations into the Keysight Logic Analyzer application's offline-demo mode and highlights 
feature capabilities.

To launch Demo
Center

• From the Keysight Logic Analyzer application's main menu, choose Help>Show Demo....

• From the Keysight Logic Analyzer application's Demo Center toolbar, click the  Show Demo 
icon.

• From the Windows Start bar, click Start>All Programs>Keysight Logic Analyzer>Run Logic 
Analyzer Demo Center.

The Demo Center application and the Keysight Logic Analyzer application are tiled horizontally on 
the desktop.

The  Float button maximizes the Keysight Logic Analyzer application's window lets the Demo 
Center application window float over it. The  Locate button returns to horizontally tiled windows. 
The  What is Demo Center button displays more information.

To use Demo
Center

1 Use the left pane to navigate to the feature demonstration you want to view.

The  Expand and  Collapse buttons affect the feature hierarchy tree.

2 Select the feature you want to learn about by clicking it.

Information about the feature appears in the right pane.

3 Click Launch Demo.

A configuration file that illustrates the feature is loaded into the Keysight Logic Analyzer 
application, and more information about the feature appears in Demo Center's right pane. The 

 Print button lets you print the information.

4 When you are done exploring the feature, click Press to Select Another Demo.



2 Getting Started

56 Keysight Logic and Protocol Analyzer User Guide



Keysight Logic and Protocol Analyzer 

User Guide

3 Probing the Device Under Test

Before you can make logic analysis measurements on a device under test, you must connect the 
logic analyzer channels to (in other words, probe) the device under test.

There are several options for probing a device under test:

• Connecting to individual IC pins or test points. — This is called general purpose probing and is 
accomplished with flying-lead probe sets. Accessories that help with general purpose probing are 
also available.

• Connecting to all the pins of a specific QFP package. — This is called QFP package probing and is 
accomplished with optional elastomeric probe adapter and 1/4 flex adapter products available for 
several types of QFP packages.

• Designing connectors (or pads and mounting holes for soft-touch connector less probes and 
retention modules) into the device under test. — This is called target connector probing or 
soft-touch connector less probing and is accomplished with optional probes available for various 
signal and connector types.

• Using processor- or bus-specific probes. — These are called analysis probes (formerly called 
preprocessors) and are available for many processors and buses. Analysis probes include 
configuration files for setting up the logic analyzer, and they may include inverse assemblers or 
other post-processing tools for decoding captured data.

See Also For more information on general-purpose probing, QFP package probing, target connector and 
connector less probing, and other probing options, see:

• "Probing Selection Quick Reference Card"

• "Probing Solutions for Logic Analyzers" ( "latest version on web")

• "Logic Analyzer Probing Solutions"

For more information on analysis probes and other processor and bus solutions, see:

• "Processor and Bus Support for Logic Analyzers" ( "latest version on web")

• "Processor, Bus, and FPGA Support for Logic Analyzers"

For more information on probing signals internal to an FPGA or setting up definitions for the probes 
used, see:

• "Setting Up Probes" (in the online help)

For more information on controlling signals in the device under test from a logic analysis system, see:

• To control signals in the device under test (see page 58)

http://cp.literature.agilent.com/litweb/pdf/5968-4632E.pdf
http://cp.literature.agilent.com/litweb/pdf/5966-4365E.pdf
http://www.agilent.com/find/upsolutions
http://www.agilent.com/find/upsolutions
http://www.agilent.com/find/logic_analyzer_probes
http://www.agilent.com/find/logic_analyzer_probes
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To control signals in the device under test

The 16850 series logic analysis system frames (see page 615) have a target control port, an 8-bit, 
3.3V port that can be used to send signals to a device under test. The target control port does not 
function like a pattern generator, but more like a remote control for switches in the device under test.

To use the target control port outputs:

1 Connect the target control port cable to the logic analysis system frame.

The target control cable is keyed, so it can be inserted only one way. Plug it into the target 
control port with the key up and the cable hanging down.

The wires on the target control port cable are color-coded. Bit 0 is brown, bit 1 is red, bit 2 is 
orange, and so on up to bit 7 (gray). The black and white wires are both ground. Pins 0, 2, 4, and 
6 are on the top of the connector and arranged in the same order as the wires.

2 If you plan on using open collector, remember to install pull-up resistors to a maximum 4V. The 
maximum sink current into the Target Control port is 12 mA and includes a 51 ohm series resistor.

Example: Resetting
Your Device Under

Test

This example also applies to other types of signals you may want to send to your device under test. 
The reset line in this case is active low.

1 Attach one of the wires from the target control port cable to the reset line, using proper 
termination.

2 In the Keysight Logic Analyzer application, choose Setup>Target Control Port....

3 In the Target Control Port dialog (see page 475), check Enabled for the target control port signal 
you are using.

4 Click 1 to output an active high.

5 When the device under test needs to be reset, click Pulse.
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4 Connecting to a Logic 
Analysis System

If you opened the Keysight Logic Analyzer application on a logic analyzer or logic analysis system 
frame, you are most likely already connected to the local frame. (The right-most part of the status 
bar shows "Local".)

However, if you are offline (the right-most part of the status bar shows "Offline") and you want to 
connect to the local frame, or if you want to connect to a different, remote logic analysis system 
frame, you can do so from the File menu.

To connect to the
local frame

• Choose the File>Go Online To Local Frame menu command.

To connect to a
remote frame

1 Choose the File>Go Online To... menu command.

2 In the Select System to Use dialog (see page 459), select the system to access; then, click 
Connect.

The logic analysis system can be:

• Local — connected to the same computer or logic analyzer running the Keysight Logic 
Analyzer application.

• Remote — somewhere else on the local area network.

3 If you are connecting to a remote logic analysis system that requires a password (see Setting Up 
Passwords for Remote Access (see page 68)), enter the password in the "Please enter connection 
password:" dialog, and click OK.

When you are connected to a remote logic analysis system frame, the right-most part of the status 
bar shows "Remote".

Connecting to the U4154A/B Logic Analyzer Module

Connection to the U4154A/B Logic Analyzer module is different from connecting to other logic 
analysis systems and logic analyzers in terms of the hardware setup of the involved components.

The U4154A/B Logic Analyzer module is installed in a slot of the Keysight AXIe chassis. The Keysight 
Logic Analyzer application is hosted on a host PC (a laptop or a desktop) or a remote PC connected 
to the host PC. The U4154A/B module connects to the host PC through the PCIe interface of the 
AXIe chassis.

The connection to the U4154A/B Logic Analyzer module can be:

• Local — the Keysight Logic Analyzer application is installed and running on the host PC which is 
connected to the U4154A/B module through the PCIe interface of the AXIe chassis.

• Remote — the Keysight Logic Analyzer application is installed and running on a computer other 
than the host PC and is remotely connected to the host PC.

If the PCIe connection between the host PC and AXIe chassis is made, you are most likely already 
connected to the U4154A/B Logic Analyzer module installed in the AXIe chassis. (The right-most 
part of the status bar shows "Local".) However, if you are offline (the right-most part of the status bar 
shows "Offline") and you want to connect to the U4154A/B module locally or remotely, you can do so 
from the File menu. The procedures for connection are the same as described above.
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For more on using the Select System to Use dialog, see:

• To add a logic analysis system to the list (see page 61)

• To delete a logic analysis system from the list (see page 62)

• To refresh the logic analysis system list (see page 63)

• To view logic analysis system details (see page 64)

• To enter your "System In Use" comments (see page 65)

• To select a logic analysis system for auto-connect (see page 66)

• To chat with another logic analysis system user (see page 67)

See Also • Offline Analysis (see page 217)

NOTE
It is recommended that you turn off the standby mode and disable hibernation 
on the host PC connected to the AXIe chassis via PCIe.

For Windows 7/8, it is also recommended that you disable PCIe power 
management modes on the host PC.



Keysight Logic and Protocol Analyzer User Guide 61

Connecting to a Logic Analysis System 4

To add a logic analysis system to the list

1 In the Select System to Use dialog (see page 459) (which appears after choosing File>Go Online 
To...), click Add.

2 Enter the logic analysis system frame hostname or IP address in the dialog, and click OK.

See Also • Returning to Online Analysis (see page 59)
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To delete a logic analysis system from the list

1 In the Select System to Use dialog (see page 459) (which appears after choosing File>Go Online 
To...), select the logic analysis system you wish to delete.

2 Click Delete.

See Also • Returning to Online Analysis (see page 59)
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To refresh the logic analysis system list

1 In the Select System to Use dialog (see page 459) (which appears after choosing File>Go Online 
To...), click Refresh.

The logic analysis system status and detailed information is updated. Status can be:

See Also • Returning to Online Analysis (see page 59)

Status Description

Available

Host offline The logic analysis system has been powered down or taken off the network.

In use The "System In Use" comment is displayed in parentheses.

Incompatible remote service 
version

The version information is displayed in parentheses. The Keysight Logic Analyzer application 
software on the logic analysis system frame needs to be updated to match the version of 
software installed on the machine displaying this dialog.
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To view logic analysis system details

1 In the Select System to Use dialog (see page 459) (which appears after choosing File>Go Online 
To...), select the logic analysis system whose details you wish to view.

2 Click Details... (you may have to click More >> first).

The logic analysis system details are displayed in the Frame/Module Information dialog (see 
page 439).

See Also • Returning to Online Analysis (see page 59)
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To enter your "System In Use" comments

1 In the Select System to Use dialog (see page 459) (which appears after choosing File>Go Online 
To...), select the logic analysis system whose details you wish to view.

2 Click Set My Comments (you may have to click More >> first).

3 In the dialog that opens, enter your "system in use" comments.

These comments usually contain your contact information.

See Also • Returning to Online Analysis (see page 59)
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To select a logic analysis system for auto-connect

1 In the Select System to Use dialog (see page 459) (which appears after choosing File>Go Online 
To...), select the logic analysis system that you wish to auto connect to.

2 Click Set As Auto-Connect (you may have to click More >> first).

See Also • Returning to Online Analysis (see page 59)
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To chat with another logic analysis system user

1 In the Select System to Use dialog (see page 459) (which appears after choosing File>Go Online 
To...), select the logic analysis system to which you want to send a chat message.

2 Click Chat (you may have to click More >> first).

3 In the Chat Select Destination dialog (see page 430), select whether you want to chat with the 
person logged into the logic analysis system or the person connected to the frame; then, click 
OK.

4 In the Chat dialog (see page 429), enter your message; then, click Send.

5 When you are finished with the chat session, click Close.

See Also • Returning to Online Analysis (see page 59)
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Setting Up Passwords for Remote Access

The Keysight Logic Analyzer application lets you connect to and remotely control logic analysis 
systems on the network.

If you have a logic analysis system you want to restrict remote frame connections to, you can set up 
a remote access password. You can password-protect hosted instruments too, by setting a password 
on the host PC. Because any user on the network with the Keysight Logic Analyzer application 
software installed can force any other user off of a frame, you may wish to protect your local system 
with a password to prevent this from happening.

On the logic analysis systems that you want to restrict remote connections to:

1 From the Windows Start menu, choose Start>Programs>Keysight Logic 
Analyzer>Utilities>Remote Access Password Utility.

(You can also run this utility by clicking Set Local Password in the Select System to Use dialog 
(see page 459).)

2 In the Remote Access Password Utility dialog, if a password is currently set, click Clear Password.

3 Enter the new password in the Enter New Password and Re-enter New Password fields; then, 
click Set Password.

4 Click OK to make the password changes and close the dialog.

Password changes take effect immediately; however, they do not affect users currently 
connected to the local frame.

Clicking Cancel closes the dialog without making any password changes.

Notes: • The remote access password is completely separate from Windows user logon passwords. Setting 
or clearing remote access passwords does not affect Windows user logon passwords.

• Remote access passwords are encrypted using a one-way encryption algorithm and securely 
stored.

• In order to set or clear remote access passwords using this utility, the currently logged-on user 
must have administrative credentials.

NOTE
For multiframe logic analysis systems, the remote access password must be the same on every 
frame. If this is not the case, you will not be able to connect to the multi-frame set. If a password is 
not set (blank) on one frame, then you will be able to connect to the entire set of frames so long as 
the remaining frames have identical passwords or a blank password. In other words, a blank 
password is a don't care condition.
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• Establishing a remote access password does not password-protect access via Windows Remote 
Desktop.

See Also • Returning to Online Analysis (see page 59)
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Configuring Logic Analyzer Modules

A logic analyzer module is a logical collection of channels on a single timebase and trigger. A module 
can be a single card (see page 614) or several cards. Modules give you the flexibility to increase logic 
analyzer channel count by using more than one card.

Combining cards to increase channel count is done when installing cards into a frame/chassis (see 
page 615 and page 614). For more information, see the "AXIe based Logic and Protocol Analysis – 
Installation Guide".

See Also • To disable and enable modules (see page 72)

• Memory Depth and Channel Count Trade-offs (see page 363)

To disable and enable modules

By default, all modules in a logic analysis system are enabled; however, you can disable modules to 
stop them from participating in measurements.

To disable modules 1 In the window, choose Disable... from the module's menu.

Or, choose Setup>(Logic Analyzer Module)>Disable... from the main menu.

2 In the Disable dialog:

a Select the modules you want to disable.

b Check Delete All Connections if you want to delete module connections to tools and windows. 
This causes tools and windows connected only to the disabled modules to be deleted as well.

Uncheck Delete All Connections if you want to leave module connections to tools and 
windows. The disabled modules' buses and signals are hidden from tools and windows, but 
they will reappear when the modules are re-enabled.

c Click OK.

When a module is disabled:

CAUTION
You must power down the AXIe chassis before inserting, replacing, or removing 
the Logic Analyzer module. The enclosure surface of the module may become 
hot during use. If you need to remove the module, first power down the AXIe 
chassis, wait for at least five minutes to allow the module to cool, and then pull 
the module out of the chassis.
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• It no longer runs or sends data to downstream tools or windows, and no data is saved to 
configuration files.

• The buses and signals defined in the module are hidden from windows and tools.

• You cannot change the setup of the module.

In the widow, disabled modules have the  icon:

To enable modules 1 In the window, choose Enable... from the module's menu.

Or, choose Setup>(Logic Analyzer Module)>Enable... from the main menu.

2 In the Enable dialog:

a Select the modules you want to enable.

b Click OK.

See Also • Configuring Logic Analyzer Modules (see page 72)
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Creating a Logic Analyzer Multi-card Set

You can interconnect multiple modules together and then install these interconnected modules into 
adjoining slots of an AXIe chassis to make a multi-card set. This multi-card set is represented as a 
single logical instrument module in the Logic and Protocol Analyzer application. Combining modules 
in a multi-card set provides an increased channel count required to support various testing scenarios 
for different memory technologies.

The multi-card set configuration is available only for specific logic analyzer module types, for 
instance, U4154A, U4154B, and U4164A. 

To interconnect U4164A or U4154A/B modules in a multi-card set, use a pair of U4154-61601 flex 
cables provided in the accessory pouch shipped with each module.

For more information on how to interconnect and install multiple modules in an AXIe chassis, see the 
AXIe based Logic and Protocol Analysis – Installation Guide.

Once a multi-card set is configured, you can use the Instrument Details Dialog (page 441) to view the 
number of modules installed and the slots in which these are installed and to reconfigure the 
modules in the set. 

See Also 

“Repartitioning a U4164A Multi-card Set" on page 75

Memory Depth and Channel Count Trade-offs

NOTE
You may physically configure as many modules into a multi-card set as the 
chassis slots allow. However, the maximum number of interconnected 
modules that can operate together in a multi-card set is 3. 

You may require different numbers of interconnected modules to support 
different memory technologies testing scenarios. For such situations, you can 
connect and install logic analyzer modules as a set in the chassis for larger 
configurations and then reconfigure these interconnected modules into 
smaller configurations using the Logic and Protocol Analyzer GUI. You need 
not physically connect/disconnect modules for such reconfigurations.  See 
“Repartitioning a U4164A Multi-card Set" on page 75 to know more.
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Repartitioning a U4164A Multi-card Set

Once you have interconnected the U4164A modules into a multi-card set, you can easily perform the 
reconfiguration (repartitioning) of this multi-card set using the Logic and Protocol Analyzer software 
GUI. You need not physically disconnect and reconnect the modules for this repartitioning. This 
feature is specially useful when you have requirements for different number of interconnected 
modules for different memory technologies testing scenarios. To support these different 
configuration requirements, you can connect and install modules as a set in the chassis for larger 
configurations and then simply adjust the module partitioning boundaries into smaller/different 
configurations using the software GUI. 

For instance, you may require a multi-card set with three U4164A modules for DDR4 DIMM testing 
and two multi-card sets with each set having two U4164A modules for a DDR5 DIMM testing. To 
support both these configurations without reconfiguring the hardware setup and cabling, you can 
connect four U4164A modules together when installing these in the AXIe chassis. This larger 
configuration would allow you to subsequently reconfigure into smaller configurations of one set with 
three modules and then two sets with two modules each using the software GUI. 

To repartition a U4164A multi-card set

1 Power on the AXIe chassis. Ensure that the Logic analyzer modules are powered on but not in the 
Run State. The Logic and Protocol Analyzer GUI should not be active. 

2 Use the Keysight Notification Center icon present on the Windows taskbar (lower, right-hand 
corner of your desktop). 

The Instrument Details dialog box is displayed.  You can review the current configuration of 
modules in the multi-card set(s). 

3 Click the Partitioning button to reconfigure modules in the multi-card set. 

NOTE
You can repartition modules only in a U4164A multi-card set.
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The Module Partitioning dialog box is displayed. The modules that you physically interconnected 
using flex cables are displayed with checkboxes indicating that these modules are part of the 
larger multi-card set and therefore can be reconfigured (included/excluded) to make 
smaller/alternate configurations. For example, in the screen below, four U4164A modules are 
interconnected in the chassis. Out of these, two multi-card sets of two modules each are 
configured to support a DDR5 DIMM testing scenario.  

4 Select the checkbox displayed for a module to include it in the multi-card set and deselect the 
checkbox to exclude the module from the multi-card set. For example, the four interconnected 
modules have been reconfigured in the screen below to create one multi-card set with three 
U4164A modules to support a DDR4 DIMM testing scenario. The module in Slot 4 has been 
excluded from the set. 
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Setting the Logic Analyzer Threshold Voltage

It is very important that you specify a threshold voltage that matches what your device under test is 
using. Incorrectly specified threshold voltages result in incorrect data.

For a logic analyzer, you can set threshold voltages on a per pod basis and an independent threshold 
offset for each of the pod channels.

You use the Threshold Settings dialog box to set threshold voltages and offsets.

The threshold offset settings slightly differ based on the logic analyzer model you are using. The 
following table highlights the threshold offset settings available for each of the supported logic 
analyzer model.
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U4154A/B or 16850-series Logic Analyzers

One threshold offset can be set for each channel in all Timing and State sampling modes.

U4164A Logic Analyzer

In Full Channel and Half Channel 
Timing Modes

One threshold offset can be set for each channel of a pod. 

In quarter Channel Timing Mode



Keysight Logic and Protocol Analyzer User Guide 79

Setting Up the Logic Analyzer 5

1 From the menu bar, select Setup>(Logic Analyzer Module)>Bus/Signal....

2 In the Buses/Signals Setup dialog, click any Threshold button. The Threshold buttons are located 
under the Pod or Clocks label.

In Master State Sampling Mode One threshold offset can be set for each channel. 

In Dual Sample State Sampling 
Mode

Two threshold offsets can be set for each of the channels of a pod that you set to Dual sampling. 
One for the Master sample and other for the Second sample.
For pods not set to Dual sampling, one threshold offset can be set for each channel. 
For differential signals, only one threshold offset is available even in dual sampling.

In Quad Sample State Sampling 
Mode

Two threshold offsets can be set for each of the Even channels of a pod that you set to Quad 
sampling. One for the Master and Third samples and other for the Second and Fourth samples.
For pods not set to Quad sampling, one threshold offset can be set for each channel.
For differential signals, only one threshold offset is available even in quad sampling.

U4154A/B or 16850-series Logic Analyzers
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3 In the Threshold Settings dialog:

a If offline, select the Probe Type; this may affect other settings that can be selected.

When online, the currently connected probe type (if any) is shown in a read-only field.

b Select the Common Threshold; you can do this using the Threshold Type drop-down or by 
dragging the slider to the desired setting. You can enter a value from -3.00 to 5.00 V.

• Click Apply to All Other Pods (excluding clocks) if you want the common settings to apply 
to all pods (excluding clock inputs); otherwise, the settings apply only to the selected 
pod.

• Click Apply to All Other Pods and Clocks if you want the common settings to apply to all 
pods and clock inputs.

4 If you want to specify individual channel offsets, click Click to Show Offsets, and enter the offsets 
or drag the sliders.
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5 The logic analyzer lets you specify threshold voltages for clock channels individually. This may be 
useful in situations, for example, where the clock channels are probing differential signals while 
the data channels are probing single-ended signals. Also see clock qualifiers for U4164A to know 
more about how threshold offsets are set for U4164A clock qualifiers.

In the Threshold Settings for Clock Channels dialog:
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a Select the first clock channel's threshold using the threshold type drop-down or by dragging 
the slider to the desired setting. You can enter a value from -3.00 to 5.00 V.

b If you want to specify individual clock channel threshold offsets, enter the offsets or drag the 
sliders. (To reset all clock channel offsets, click Clear All Offsets to Zero.)

c Set up thresholds and offsets for the remaining clock channels, or click Apply the first 
channel's settings to all clock channels.

See Also • “Pod and Channel Naming Conventions" on page 361

NOTE
In the state sampling mode, threshold voltages can be adjusted automatically (along with sample 
positions). See “To automatically adjust state sampling positions and threshold voltages" on 
page 128.



Keysight Logic and Protocol Analyzer User Guide 83

Setting Up the Logic Analyzer 5

Defining Buses and Signals

Before you can use the logic analyzer, you must define buses and signals by:

1 Adding bus/signal names.

2 Assigning logic analyzer channels to bus/signal names.

Click  in the analyzer setup toolbar, or choose Setup>(Logic Analyzer Module)>Bus/Signal... from 
the menu bar to open the Buses/Signals setup tab (see page 426).

The following tasks are performed in the Buses/Signals setup tab:

• To add a new bus or signal (see page 84)

• To delete a bus or signal (see page 84)

• To rename a bus or signal (see page 85)

• To rename the bits of a bus (see page 86)

• To assign channels in the default bit order (see page 88)

• To assign channels, selecting the bit order (see page 89)

• To use clock channels as extra data channels (see page 89)

• To define buses and signals by importing netlist files (see page 90)

• To reorder bits by editing the Channels Assigned string (see page 91)

• To set the default number base (see page 93)

• To set polarity (see page 94)

• To add user comments (see page 94)

• To add a folder (see page 95)

• To alias a bus/signal name (see page 95)

• To sort bus/signal names (see page 95)

Through the Display button, you can select what bus/signal setup information is displayed (channels 
assigned, width, polarity, default base, comment, threshold, activity, or channel numbers).

The bus and signal icons in the Bus/Signal Name column are normally red, but they turn gray if the 
bus/signal is locked by an inverse assembler.
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See Also • Setting the Logic Analyzer Threshold Voltage (see page 77)

To add a new bus or signal

The add bus/signal feature allows you to add new buses and signals to the configuration. Once 
added to the configuration, the new bus/signal is automatically inserted into the data displays and 
also becomes available in any bus/signal insert function.

1 From the menu bar, select Setup>(Logic Analyzer Module)>Bus/Signal....

2 Select Add Bus/Signal to add a new bus or signal.

3 The new bus/signal will appear with a system generated default name. Rename (see page 85) 
the new bus/signal if desired.

See Also • To delete a bus or signal (see page 84)

• To rename a bus or signal (see page 85)

• To assign channels in the default bit order (see page 88)

• To assign channels, selecting the bit order (see page 89)

• Defining Buses and Signals (see page 83)

To delete a bus or signal

The delete bus or signal feature allows you to remove buses and signals individually or all at once. 
The delete bus or signal feature is accessed through the setup menu or the setup toolbar.

• To delete an individual bus or signal (see page 85)

• To delete all buses and signals (see page 85)

NOTE
In previous versions of the Keysight Logic Analyzer application, the Buses/Signals setup tab had a 
Define Probes... button; now, probes are defined differently (see "To define probes" (in the online 
help)).

NOTE
Before a new bus/signal can be added to the configuration, at least one channel must be assigned 
to the bus/signal.
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To delete an
individual bus or

signal

1 From the menu bar, select Setup>(Logic Analyzer Module)>Bus/Signal....

2 Highlight the bus or signal you want to delete.

3 Click Delete.

To delete all buses
and signals

1 From the menu bar, select Setup>(Logic Analyzer Module)>Bus/Signal....

2 Click Delete All.

See Also • Defining Buses and Signals (see page 83)

To rename a bus or signal

The rename bus/signal feature allows you to change bus and signal names. All channel, pod, and 
clock assignments for the renamed bus/signal remain unchanged.

1 From the menu bar, select Setup>(Logic Analyzer Module)>Bus/Signal..., or click the  icon in 
the setup toolbar (see page 399).

2 Right-click the bus or signal name and choose Rename...

NOTE
Some tools "lock" buses and signals because they use the bus or signal to produce their own 
output. Delete and Delete All will not delete these locked buses and signals. A locked bus or signal 
has a gray icon to the left of the name instead of a red icon.
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3 Enter the new bus or signal name.

4 Select OK.

See Also • To add a new bus or signal (see page 84)

• To delete a bus or signal (see page 84)

• To rename the bits of a bus (see page 86)

• Defining Buses and Signals (see page 83)

To rename the bits of a bus

When a bus is expanded in the Waveform display window, the names of the signals within the bus 
are like Bus[0], Bus[1], etc., by default. However, you can assign your own names to the bits within a 
bus.

1 From the menu bar, select Setup>(Logic Analyzer Module)>Bus/Signal..., or click the  icon in 
the setup toolbar (see page 399).

2 Right-click the bus name and choose Assign Names....
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3 In the Assign Names dialog, enter the new names of bits within the bus.

4 Click OK.

Now, you see your names when the bus is expanded in the Waveform window.
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See Also • To rename a bus or signal (see page 85)

• To add a new bus or signal (see page 84)

• Defining Buses and Signals (see page 83)

To assign channels in the default bit order

To make the logic analyzer display match your system's design, assign the physical channels of the 
logic analyzer to bus and signal names.

1 From the menu bar, select Setup>(Logic Analyzer Module)>Bus/Signal....

2 In the Buses/Signals tab, select squares in the grid to assign channels to bus and signal names. 
For each signal probed in your device under test, you should have a black check mark mapping 
the channel to a pod and to a signal name in the interface.

Example: In the picture below, channels 0-7 (pod 1) are mapped to My Bus 1, channels 8-15 (pod 
1) are mapped to My Bus 2, and channels 8 and 9 (pod 2) are mapped to My Signal 1 & 2, 
respectively.

TIP If clock channels are not connected to clock signals, they can be used as extra data channels. 
Clock channels are grouped together after the last pod in the channel assignment area.
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See Also • To define buses and signals by importing netlist files (see page 90)

• To reorder bits by editing the Channels Assigned string (see page 91)

• Pod and Channel Naming Conventions (see page 361)

To assign channels, selecting the bit order

In cases where buses in the device under test haven't been probed with consecutive logic analyzer 
channels, you can assign channels to a bus name in a selected bit order.

1 From the menu bar, select Setup>(Logic Analyzer Module)>Bus/Signal....

2 In the Buses/Signals tab, right-click the bus name, and choose Enable Channel Order Selection.

3 Start selecting squares in the grid to assign channels from the low order bit of the bus to the high 
order bit.

The bit numbers are displayed as you select squares.

To reset the default
bit order

The default bit order of assigned channels has higher bits on the left and lower on the right (in the 
Bus/Signal Setup dialog).

To reset to the default bit order:

• Right-click the bus name, and uncheck Enable Channel Order Selection.

See Also • To define buses and signals by importing netlist files (see page 90)

• To reorder bits by editing the Channels Assigned string (see page 91)

• Pod and Channel Naming Conventions (see page 361)

To use clock channels as extra data channels

When clock channels are not used for state mode sampling clock inputs, they can be used as extra 
data channels and assigned to bus/signal names just like ordinary data channels (see To assign 
channels in the default bit order (see page 88) or To assign channels, selecting the bit order (see 
page 89)).

NOTE
When you select a bit order other than the default, you can only trigger on a sample equal to (=) or 
not equal (!=) to some value on that bus. You lose the ability to trigger on a sample less than (<), 
greater than (>), less than or equal to (<=), or greater than or equal to (>=) some value, and you lose 
the ability to trigger on a sample "in range" or "not in range" of two values.
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Each pod in a logic analyzer module has a clock channel. In the Buses/Signals Setup dialog, all the 
clock channels are grouped together in a virtual Clocks pod. (Only ordinary data channels appear 
under the columns for each pod.)

The clock pod can grow to include as many channels as there are pods in the system. In other words, 
the clock pod can have more than 16 channels if there are more than 16 pods.

In the Channels Assigned string, the clock pod name is "Clks" and the channels are named "C1", 
"C2", etc.

See Also • To reorder bits by editing the Channels Assigned string (see page 91)

• Pod and Channel Naming Conventions (see page 361)

To define buses and signals by importing netlist files

You can create bus/signal names and assign logic analyzer probe channels by importing netlist files. 
These netlist files come from the Electronic Design Automation (EDA) tools used to design the device 
under test, and they contain information about the signals on the connectors built into the device 
under test for the logic analyzer probes.

1 If you haven't already defined probes, choose Setup>(Logic Analyzer Module)>New 
Probe>General Purpose Probe Set and define the probes whose connectors are mapped in the 
netlist file (see "To define probes" (in the online help)).

2 In the Bus/Signal Setup dialog, click Netlist Import....

3 Then, enter the netlist file to import bus/signal assignments from, and click OK.

After importing netlist files, connector pin numbers are displayed in the Bus/Signal Setup dialog.

NOTE
When clock channels are used for state mode sampling clock inputs, it is not useful to assign them 
to bus/signal names.

NOTE
There is no separate physical clock pod. Each pod has a single clock channel.
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Imported bus/signal definitions are placed in the "Netlist Import" folder.

Example Line from
Netlist File:

Netlist files created by Electronic Design Automation (EDA) tools have lines in the following format:

NET '/Bus1(3)' J1-7

Where:

• Bus1 = Four bit bus.

• (3) = Bit 3.

• J1-7 = Connector J1, pin 7.

See Also • To assign channels in the default bit order (see page 88)

• To assign channels, selecting the bit order (see page 89)

• To reorder bits by editing the Channels Assigned string (see page 91)

• Pod and Channel Naming Conventions (see page 361)

To reorder bits by editing the Channels Assigned string

You can change the order of the bits in a bus name (assigned in either the default order (see 
page 88) or a selected order (see page 89)) by editing the Channels Assigned text string.

1 In the Buses/Signals tab of the Analyzer Setup dialog, click the Channels Assigned to the bus 
name.

2 In the Assign Channels dialog, enter the appropriate order of bits in the bus.

CAUTION
The "Netlist Import" folder is deleted and re-created on each import. If you want to keep definitions 
from the "Netlist Import" folder, either rename the folder or move bus/signal definitions out of the 
folder before the next netlist import.
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See Pod and Channel Naming Conventions (see page 361) to understand naming conventions 
like "Pod B2".

You can easily Switch Big Endian <=> Little Endian or Reverse Channel Order by clicking these 
buttons.

3 Click OK.

Channel numbers are displayed for reordered bits in the Bus/Signal Setup dialog.

To reset the default
bit order

The default bit order of assigned channels has higher bits on the left and lower on the right (in the 
Bus/Signal Setup dialog).

Example Description

Pod B1[0] Signal consisting of the first channel in the first pod of slot B.

Pod B1[15:0] Bus consisting of all sixteen channels in Pod B1 in default order.

Pod B1[7:0], Pod B2[15:8] Bus with seven channels from first pod in slot B followed by seven channels from 
second pod in slot B.

Pod B1[7:0,15:8] Big endian, little endian switch on a 16-bit bus.

Pod B1[0,1,2,3] Bus with bits in reverse order.

Clks[C2:C1], Pod B1[0], Pod 
B2[0]

Four bit bus including two clock pod channels.

Clks[C2M:C1S], Pod B1M[0], 
Pod B1S[0]

Four bit bus with demultiplex.

NOTE
When bits have been reordered, you can only trigger on a sample equal to (=) or not equal (!=) to 
some value on that bus. You lose the ability to trigger on a sample less than (<), greater than (>), 
less than or equal to (<=), or greater than or equal to (>=) some value, and you lose the ability to 
trigger on a sample "in range" or "not in range" of two values.



Keysight Logic and Protocol Analyzer User Guide 93

Setting Up the Logic Analyzer 5

To reset to the default bit order:

1 Click the Channels Assigned to the bus name.

2 In the Assign Channels dialog, click Default Channel Order.

3 Click OK.

See Also • To assign channels in the default bit order (see page 88)

• To assign channels, selecting the bit order (see page 89)

• Pod and Channel Naming Conventions (see page 361)

To set the default number base

You can set the default number base for a bus when you create the bus. The default base is used to 
display bus and signal values in the listing (see page 241) and waveform (see page 232) views. 
Default base only affects new buses and signals; if you change default base for an existing bus or 
signal you will not see a change unless you add a new copy of the bus or signal to a listing or 
waveform view.

1 From the menu bar, select Setup>(Logic Analyzer Module)>Bus/Signal....

2 In the bus/signal setup dialog, select Display.

3 Select Default Base. 

4 To change the default base for a bus or signal, click the default base value. 

5 Select a new value.

6 Click OK to close the bus/signal dialog.



5 Setting Up the Logic Analyzer

94 Keysight Logic and Protocol Analyzer User Guide

To set polarity

You can define buses and signals to display with negative or positive polarity. This affects the display 
of values and waveforms. When a bus or signal is set to negative polarity, an incoming high voltage 
will be shown with a low waveform and a logical value of 0. The polarity is reflected in all places that 
use values, such as trigger and symbols.

The default polarity is positive (high = 1).

1 From the menu bar, select Setup>(Logic Analyzer Module)>Bus/Signal....

2 In the bus/signal setup dialog, select Display.

3 Select Polarity. 

4 In the polarity column that appears, toggle between + (positive) and — (negative).

To add user comments

You can attach comments to buses and signals. The comments show up in the tool tip when you 
hover the mouse over a bus or signal name in both the waveform and listing windows.

1 From the menu bar, select Setup>(Logic Analyzer Module)>Bus/Signal....

2 In the Buses/Signals setup tab that appears, select Display.

3 Select Comment. A new column labeled Comment appears.

4 In the Comment column, type your comment for the bus or signal.

5 Click OK to close the Analyzer Setup dialog.

NOTE
Comments are intended as a descriptor to embellish a bus/signal name and not as a notepad. 
Comments can be up to 64 character in length.
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To add a folder

The Add Folder... feature adds a windows style folder to the bus/signal list. Use folders to help 
organize bus and signal names when using many bus/signal names with inverse assemblers.

1 From the menu bar, select Setup>(Logic Analyzer Module)>Bus/Signal....

2 Right-click on a bus/signal name, then select Add Folder.

3 The new folder appears directly below the highlighted name. By default, the new folder has a 
system generated default name. If desired, rename (see page 85) the new folder in the same way 
you would a bus/signal name.

See Also • To alias a bus/signal name (see page 95)

To alias a bus/signal name

The Add Alias... feature adds an exact duplicate bus or signal name (same channel, polarity, etc. 
assignments). Use alias names along with folders (see page 95) to help organize the many bus and 
signal names with inverse assembly.

1 From the menu bar, select Setup>(Logic Analyzer Module)>Bus/Signal....

2 Right-click on the desired bus/signal name, then select Add Alias.

3 The new alias name appears directly below the highlighted name. The new alias name can be 
renamed (see page 85), however, the new name will also be applied to the original name.

See Also • To add a folder (see page 95)

To sort bus/signal names

You can sort bus/signal names and folder names to help organize them.

1 From the menu bar, select Setup>(Logic Analyzer Module)>Bus/Signal....

2 Right-click on one of the bus/signal or folder names to be sorted; then, select either 
Sort>Ascending or Sort>Descending.

See Also • To add a folder (see page 95)
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Choosing the Sampling Mode

The Sampling tab is accessed through the menu bar's Setup>(Logic Analyzer Module)>Timing/State 
(Sampling)... item. The Sampling setup tab is used to select and configure the acquisition mode.

In the Timing - Asynchronous Sampling acquisition mode, you set the sampling option and the 
sampling period. The device under test is sampled at regular intervals (the sampling period).

In the State - Synchronous Sampling acquisition mode, you set the sampling option, you set up the 
clocking signal(s) from the device under test that tells the logic analyzer when to sample data, and 
you adjust sampling positions on each channel relative to the sampling clock to make sure data is 
sampled when it is valid.

In both state and timing mode, you can set the acquisition (memory) depth and the position of the 
trigger event within the acquisition memory.

Some logic analyzers have the timing zoom feature which collects additional high-speed timing data 
around the logic analyzer trigger.

The following tasks are performed in the Sampling setup tab.

• Selecting the Timing Mode (Asynchronous Sampling) (see page 96)

• To select the timing acquisition mode (see page 97)

• To select the timing sampling option (see page 97)

• To set the timing mode sampling period (see page 98)

• Selecting the State Mode (Synchronous Sampling) (see page 98)

• To select the state acquisition mode (see page 98)

• To select the state sampling option (see page 98)

• Selecting the State Sampling Clock Mode (see page 99)

• To set up the state sampling clock (see page 124)

• To automatically adjust state sampling positions and threshold voltages (see page 128)

• To manually adjust state sampling positions (see page 128)

• In Either Timing Mode or State Mode (see page 128)

• To specify the trigger position (see page 128)

• To set acquisition memory depth (see page 129)

• Using Timing Zoom (see page 129)

• To turn timing zoom on or off (see page 131)

• To specify the timing zoom sample period (on some logic analyzers) (see page 131)

• To specify the timing zoom trigger position (see page 131)

See Also • Memory Depth and Channel Count Trade-offs (see page 363)

Selecting the Timing Mode (Asynchronous Sampling)

In timing mode, the logic analyzer samples asynchronously, based on an internally-generated 
sampling clock.
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• To select the timing acquisition mode (see page 97)

• To select the timing sampling option (see page 97)

• To set the timing mode sampling period (see page 98)

To select the timing acquisition mode

1 From the menu bar select Setup>(Logic Analyzer Module)>Timing/State (Sampling)..., or click 
the  icon from the setup toolbar (see page 399).

2 In the Acquisition area of the Sampling setup dialog, select the Timing - Asynchronous Sampling 
option.

To select the timing sampling option

In the timing (asynchronous) sampling mode, you can:

• Trade-off channel width for faster sampling. That is, if you want a smaller sampling period, you 
can set up the logic analyzer to use half of the maximum channels available.

• Get the most out of acquisition memory and measure an overall greater amount of time by 
choosing to store only transitions or other store-qualified patterns.

To select the timing mode sampling option:

1 From the menu bar, select Setup>(Logic Analyzer Module)>State/Timing (Sampling)....

2 Select Timing acquisition mode. Timing Options become selectable.

3 Select the sampling option you prefer. Your channel count may be different depending on the 
logic analyzer model.

NOTE
Changing the sampling option will affect the sampling period and may affect bus assignments.

Mode Description

Full Channel Timing Mode Default. All channels are available.

Half Channel Timing Mode Uses one pod from each pod pair.

Quarter Channel Timing 
Mode

Available only if you have installed the 01G or 02G Speed license option of the 
U4164A module.
Only odd pod of each pod pair is available that is, Pod 1, 3, 5, and 7.
Only even channels (0, 2, 4, 6, 8, 10, 12, 14) for each odd pod are available.
Two clock channels are available per U4164A module.

Transitional / Store Qualified 
Timing Mode (see page 536)

Provides maximum duration of acquisition because data is only stored when a 
change from the last value is detected. See transitional timing (see page 365).
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See Also • Logic Analyzer Notes, Timing Mode Sampling Options/Period (see page 536)

To set the timing mode sampling period

In timing mode, a logic analyzer takes a sample of the device under test's activity once per sample 
period. You can set this sample period in the Sampling Setup tab.

1 From the menu bar select Setup>(Logic Analyzer Module)>Timing/State (Sampling)..., or click 
the  icon from the setup toolbar (see page 399).

2 Select Timing - Asynchronous Sampling.

3 In the Timing Mode area of the Sampling setup dialog, increase or decrease the Sample Period.

See Also • Logic Analyzer Notes, Timing Mode Sampling Options/Period (see page 536)

Selecting the State Mode (Synchronous Sampling)

In state mode, the logic analyzer samples synchronously, based on a sampling clock signal from the 
device under test. Typically, the signal used for sampling in state mode is a state machine or 
microprocessor clock signal.

• To select the state acquisition mode (see page 98)

• To select the state sampling option (see page 98)

• Selecting the State Sampling Clock Mode (see page 99)

• To set up the state sampling clock (see page 124)

• To automatically adjust state sampling positions and threshold voltages (see page 128)

• To manually adjust state sampling positions (see page 128)

To select the state acquisition mode

1 From the menu bar select Setup>(Logic Analyzer Module)>Timing/State (Sampling)..., or click 
the  icon from the setup toolbar (see page 399).

2 In the Acquisition area of the Sampling setup dialog, select the State - Synchronous Sampling 
option.

To select the state sampling option

In the state (synchronous) sampling mode, the sampling option specifies the speed up to which the 
state mode sampling clock will match input clock edges from the device under test. You can 
trade-off triggering and clocking capability to allow faster state mode sampling speeds.

To select the state mode sampling option:

1 From the menu bar, select Setup>(Logic Analyzer Module)>State/Timing (Sampling)....

2 Select the State acquisition mode. State Sampling Options becomes selectable.

NOTE
To capture signal level changes reliably, the sample period should be less than half of the period of 
the fastest signal you want to measure. Time interval measurements are made by counting the 
number of samples in the desired waveform area. These measurements are made to a +/- one 
sample error, so measurement accuracy is improved if the number of samples is maximized.

NOTE
The state sampling options are only available for the U4164A logic analyzer and 16860-series 
logic analyzers. 
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3 Select the sampling option you prefer.

For details and comparison between these sampling options for a particular logic analyzer model, 
see:

• Selecting the State Sampling Option for a U4164A Logic Analyzer

• Selecting the State Sampling Option for a 16860-Series Logic Analyzer

See Also • “To set up the state sampling clock" on page 124

Selecting the State Sampling Clock Mode

The state sampling clock inputs let signals from the device under test specify when data should be 
captured.

The state sampling clock mode specifies how the clock inputs are used for sampling. The availability 
of these state sampling clock modes depends on the logic analyzer model and the state sampling 
option that you select.

• Master (see page 100) — all pods sampled on one master clock.

• Dual Sample (see page 106) — one pod of pair dual sampled on one master clock with different 
delays. Different (two) thresholds are used for two samples in case of the U4164A and 
16860-series logic analyzers.

• Quad Sample (see page 110)— odd pod of pair sampled on one master clock but with two 
thresholds and independent sampling positions. Two samples for each threshold making a total of 
four samples. (Available only for the U4164A and 16860-series logic analyzers)

• Master/Slave (see page 101)- Master pod is sampled on master clock and slave pod is sampled 
on slave clock but the captured data of both slave and master clocks is saved together when the 
master clock occurs.

• Demux (see page 103)-  Data being probed by one pod is demultiplexed into the logic analyzer 
memory that is normally used for two pods.

For instructions on setting up these state sampling clock modes, see:

• “To set up the master only sampling clock mode" on page 114

• “To set up the dual sample sampling clock mode" on page 116

• “To set up the quad sample sampling clock mode" on page 119

• “To set up the master/slave sampling clock mode" on page 114

• “To set up the demultiplex sampling clock mode" on page 115

Mode Description

Single Clock Faster state mode sampling speeds are supported, but some triggering, advanced 
clocking features, and multiple clocks are not available.

Multiple Clocks Advanced clocking capabilities and multiple clocks are supported, but at a slower 
state sampling speed.
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See Also • “To set up the state sampling clock" on page 124

• “Pod and Channel Naming Conventions" on page 361

Master Only Sampling Clock Mode

In the Master only state sampling clock mode, there is one sampling clock signal. When a clock edge 
occurs, data is captured and saved into one sample of logic analyzer memory.

When using the Master clock mode:

• You can set one master clock in the single clock sampling option and up to four master clocks (in 
Ored combination) in the multiple clocks sampling option.

• All pods are set to the Master clock mode.

• All logic analyzer pods and channels are available in this clock mode.

• For each channel, you can set one threshold offset.

• One sample position can be set for each channel.

• Clock channel for all pods are available and one threshold can be set for each clock channel.

Activity Indication and Thresholds for Clock Qualifiers in Master Clock Mode 

All the supported clock qualifiers are available and you can view the activity individually on these 
qualifiers as High or Low. You can also set individual clock thresholds for each of these clock 
qualifiers.

NOTE
This clock mode is available in the Single Clock as well as Multiple Clocks sampling options of 
all currently supported logic analyzers.
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See Also • To set up the master only sampling clock mode (see page 114)

Master/Slave Sampling Clock Mode

In the Master/Slave state sampling clock mode, you can save data captured on different clock edges 
(Master and Slave) into the same sample of logic analyzer memory.

When the slave clock occurs, data captured on the pods that use the slave clock is saved in a slave 
latch. Then, when the master clock occurs, data captured on the pods that use the master clock, as 
well as the slave latch data, are saved into logic analyzer memory. The captured data of both slave 
and master clocks is saved together when the master clock occurs. Therefore, the data captured by 
slave is not presented until the master clock occurs. 

If multiple slave clocks occur before the next master clock, only the most recently acquired slave 
data is saved into logic analyzer memory.

NOTE
This clock mode is only available for the Multiple Clocks sampling option in the U4164A and 
16860-series logic analyzers.
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Example - Master/Slave Clock Mode

In this example:

• the Master clock is set to occur on both edges of clock 4. 

• The Slave clock is set to occur on falling edge of clock 1. 

• These master and slave clocks have been qualified using the clock qualifier on clock 2. 

• Pod 1 is set to slave clock and Pod 2 is set to Master clock.

With the above settings, the data on pod 1 is captured according to the slave clock (on falling edge 
of clock 1). The master clock occurs on both edges of clock 4 and then data is captured on Pod 2. 
The master clock then saves the data captured by it as well as the slave clock to the logic analyzer 
memory. 

When using the Master/Slave clock mode

• Up to four Ored master clocks and four Ored slave clocks can be set separately. This number may 
differ based on the 16860-series model you have purchased. 

• You can choose the specific pod(s) of logic analyzer that you want to set as master or slave. 
Master/slave sampling can be combined with Demultiplex sampling on different pod-pairs.

• From the pod-pair that you set to Master and Slave sampling, both the pods in the pair are used 
and these pods capture data separately as per their clocks.

• You can set one threshold offset for each channel.

• Clock channels for all pods (Master or Slave) are available and one threshold can be set for each 
clock channel.
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Activity Indication and Thresholds for Clock Qualifiers in Master/ Slave Clock Mode 

All the supported clock qualifiers are available and you can view the activity individually on these 
qualifiers as High or Low. You can also set individual clock thresholds for each of these clock 
qualifiers. The threshold setting for a clock channel is applicable to both master as well as slave clock 
qualifier. 

See Also • To set up the master/slave sampling clock mode (see page 114)

Demultiplex Sampling Clock Mode

In the Demultiplex state sampling clock mode, you can demultiplex data being probed by one pod 
into the logic analyzer memory that is normally used for two pods. The Demultiplex mode uses the 
master and slave clocks to demultiplex the data.
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When the slave clock occurs, data captured on the pod is saved into the slave latch for the other pod 
in the pod pair. Then, when the master clock occurs, data captured on the pod, as well as the slave 
latch data, are saved in logic analyzer memory. If multiple slave clocks occur before the next master 
clock, only the most recently acquired slave data is saved into logic analyzer memory.

Example - Demultiplex Clock Mode

In this example:

• The Master clock is set to occur on the falling edge of clock 1. 

• The Slave clock is set to occur on the rising edge of clock 1. 

• These master and slave clocks have been qualified using the clock qualifier on clock 2. 

• Pod 3 has been demultiplxed.

NOTE
This clock mode is only available for the Multiple Clocks sampling option in the U4164A logic 
analyzer and the 16860-series logic analyzer.
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With the above settings. one set of data is captured on Pod 3 with the rising edge of the clock 1 
(slave clock). This data is saved into the slave latch for the other pod (pod 4) in the pod pair. A 
different set of data is then captured on pod 3 with the falling edge of the clock 1 (master clock). 
Both these sets of data are then saved into the logic analyzer memory together. So, the pod 3 is 
demultiplexed by allowing 16 bits of signals to be used to capture two different sets of data on 
different clocks.

When using the Demultiplex clock mode

• Up to four Ored master clocks and four Ored slave clocks can be set separately. This number may 
differ based on the 16860-series model you have purchased. 

• You can choose the specific pod pair(s) of logic analyzer that you want to set to the Demultiplex 
mode. From this pod-pair, the Even pod is NOT used. The Demultiplex mode allows the usage of 
only the Odd pod from the pod pair.

• The Demultiplex sampling can be combined with Master/Slave sampling on different pod-pairs.

• You can set one threshold offset for each data channel of the Demultiplexed Odd pod from the 
pod pair. The same threshold and its offsets are applied to the channels of the Even pod in this 
pod-pair.

• For the pod-pair that you set to Demultiplex, only the clock channel of the Odd pod is displayed 
and is used for both master as well as slave in the Demultiplexed pod pair. The master and slave 
share the commonly set clock threshold for this clock channel on the Odd pod. 
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Activity Indication and Thresholds for Clock Qualifiers in Demux Clock Mode

When you set a pod-pair to the Demux mode, 

• the clock channel on the even pod of this pair becomes unavailable as a channel in the 
Buses/Signals tab but is still available as a clock qualifier and you can view the activity 
individually on this qualifier as High or Low in the Sampling tab. The clock threshold that you set 
for this clock channel on the Even pod is still used for its clock qualifier. 

• the clock channel on the odd pod of this pair is available as a channel in the Buses/Signals tab 
and also as a clock qualifier. You can view the activity individually on this qualifier as High or Low 
in the Sampling tab. The clock threshold that you set for this clock channel on the Odd pod is 
used for the master as well as slave clock. 

See Also • To set up the demultiplex sampling clock mode (see page 115)

Dual Sample Sampling Clock Mode
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The topic describes and illustrates dual sampling mode as supported in different models of logic 
analyzers.

Dual Sample in U4164A and 16860-series Logic Analyzers

In the Dual Sample clock mode, you can capture two samples per clock edge with two different 
threshold offsets and separate sampling positions. These separate threshold offsets and sampling 
positions allows you to set independent thresholds and sampling positions for Read and Write in 
DDR/LPDDR captures and for Rising and Falling edge in general-purpose data captures. One 
threshold offset and sampling position is used for the Master sample and the other for the Second 
sample.

When using the Dual Sample clock mode in U4164A or 16860-series logic analyzers:

• One master clock can be set. The state sampling clock input is always from Pod1 of the logic 
analyzer.

• You can choose the specific pod-pair(s) of logic analyzer that you want to set as dual-sampled. 
Dual sampling is set for individual pod-pairs and can be combined with Master only pod-pairs.

• From the pod-pair that you set to Dual sampling, only the Odd pod of logic analyzer is used. The 
Even pod is not used.

• For each single-ended dual-sampled channel, you can set two separate threshold offsets - one 
for the Master sample and the other for the second sample. For differential signals, you can set 
only one threshold offset.

NOTE
This clock mode is available only for the Single Clock sampling option.
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• For the pod-pair that you set to dual-sample, only the clock channel of the Odd pod is displayed 
and is dual-sampled. You can set two threshold offsets for a single-ended dual-sampled clock 
channel.

• For each dual-sampled channel, you can set independent sampling positions for Master and 
Second sample.
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Activity Indication and Thresholds for Clock Qualifiers in Dual Sample Clock Mode (Single Clock only)

When you enable dual sampling on Pod-pair 1 and 2, the Pod 2 clock qualifier becomes unavailable 
as a channel and its activity cannot be seen in the Sampling tab. Similarly, when you enable dual 
sampling on Pod-pair 3 and 4, the Pod 4 clock qualifier becomes unavailable as a channel and its 
activity cannot be seen in the Sampling tab. You cannot then set the clock thresholds for these two 
clock qualifiers. In such a situation, the clock threshold that you set for Pod 3 clock qualifier is then 
used automatically for Pod 2 and Pod 4 clock qualifiers. This way Pod 2 and Pod 4 clock qualifiers 
can still be used as clock qualifiers even though the activity on these qualifiers cannot be seen and 
threshold cannot be set individually for these.

Dual Sample in U4154A/B and 16850-series Logic Analyzers

In the Dual Sample state sampling clock mode, you can save data captured using the master clock at 
each of two different sample times into the same sample of analyzer memory. Unlike U4164A, two 
threshold offsets are not supported for a dual-sampled channel. You can set only a single threshold 
offset for each of dual-sampled channels. When the master clock occurs, data on the pod is sampled 
twice using two independent sampling positions. Each of the two sample positions can be set using 
the Eye-Scan - Thresholds and Sample Positions dialog.
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Dual sampling in the U4154A/B or 16850-series logic analyzers allows you to set either odd or even 
pod from the pod-pair as the dual-sampled pod. The other pod in the pair is not used.

The Dual Sample mode is often used to capture DDR memory bus activity using the common bus 
clock as the master clock. One sample position is used to capture write data and another is used to 
capture read data.

See Also • “To set up the dual sample sampling clock mode" on page 116

Quad Sample Sampling Clock Mode

In the Quad Sample state sampling clock mode, you can capture the following four samples per 
clock edge with two different threshold offsets (one threshold offset for the Master and Third samples 
and the other for the Second and Fourth samples).

• Read rising clock, Read falling clock

• Write rising clock, Write falling clock 

NOTE
This mode is only available for the U4164A module with 02G license installed and state 
sampling set to Single Clock.
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The Quad Sample mode is used to provide separate read rising, read falling, write rising, and write 
falling edge captures for data rates up to 4 Gb/s from a single probe point. This mode is suitable for 
DDR/LPDDR data captures with data rates greater than 2500 Mb/s from a single probe load placed 
on each DQ.

When using the Quad Sample clock mode

• You can set up a single clock. The state sampling clock input is always from Pod1 of the logic 
analyzer. 

• You can choose the specific pod-pair(s) of logic analyzer that you want to set as quad-sampled. 
Quad sampling is set for individual pod-pairs and can be combined with Master or Quad-sampled 
pod-pairs.

• From the pod-pair that you set to Quad sampling, only the Odd pod of logic analyzer is used. Even 
pod is not used. Only even channels (0, 2, 4, 6, 8, 10, 12, 14) for each quad-sampled pod are 
available.

You can set two separate threshold offsets - one for the Read (Read rising and Read falling) and the 
other for Write (Write rising and Write falling). This makes two samples per threshold that you can 
set.
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• For the pod-pair that you set to quad-sample, only the associated clock channel of the Odd pod is 
available and is dual-sampled on the master card and quad-sampled on the slave cards. 

• You can set two thresholds for a quad-sampled clock channel.
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• You can set independent sampling positions for Read rising, Read falling, Write rising, and Write 
falling edge captures.

Activity Indication and Thresholds for Clock Qualifiers in Quad Sample Clock Mode

In Quad Sample clock modes, when you enable quad sampling on Pod-pair 1 and 2, the Pod 2 clock 
qualifier becomes unavailable as a channel and its activity cannot be seen in the Sampling tab. 
Similarly, when you enable quad sampling on Pod-pair 3 and 4, the Pod 4 clock qualifier becomes 
unavailable as a channel and its activity cannot be seen in the Sampling tab. You cannot then set the 
clock thresholds for these two clock qualifiers. In such a situation, the clock threshold that you set for 
Pod 3 clock qualifier is then used automatically for Pod 2 and Pod 4 clock qualifiers. This way Pod 2 
and Pod 4 clock qualifiers can still be used as clock qualifiers even though the activity on these 
qualifiers cannot be seen and threshold cannot be set individually for these.
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See Also “To set up the quad sample sampling clock mode" on page 119

To set up the master only sampling clock mode 1

1 From the menu bar, select Setup>(Logic Analyzer Module)>Timing/State (Sampling)....

2 Select State.

3 In the State Options, change Clock Mode to Master.

4 Set up your master clock (see To set up the state sampling clock (see page 124)).

See Also • Master Only Sampling Clock Mode (see page 100)

To set up the master/slave sampling clock mode

1 From the menu bar, select Setup>(Logic Analyzer Module)>Timing/State (Sampling)....

2 Select State.

3 For U4164A/16860-series, select the Multiple Clocks option from the Sampling Option listbox. 

This listbox is displayed only for the U4164A and 16860-series logic analyzers as these support 
multiple clocks. 

The Master/slave clock mode is available only for the Multiple clocks sampling option.

4 From the Clock Mode listbox, select Master/Slave/Demux.

5 Set up your master and slave clocks (see To set up the state sampling clock (see page 124)).

6 Select the Buses/Signals tab.

7 For each pod, click the clock button under the pod heading and choose either Master Clock or 
Slave Clock.
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See Also • Master/Slave Sampling Clock Mode (see page 101)

To set up the demultiplex sampling clock mode

1 From the menu bar, select Setup>(Logic Analyzer Module)>Timing/State (Sampling)....

2 Select the State acquisition mode.

3 For U4164A/16860-series, select the Multiple Clocks option from the Sampling Option listbox. 

This listbox is displayed only for the U4164A and 16860-series logic analyzers as these support 
multiple clocks. 

The demultiplex clock mode is available only for the Multiple clocks sampling option.

4 From the Clock Mode listbox, select Master/Slave/Demux.

5 Set up your master and slave clocks (see To set up the state sampling clock (see page 124)).

6 Select the Buses/Signals tab.

7 Click the clock button under the pod heading and choose Demultiplex.

The display of the pod and the other pod in the pair changes. For example, if you set Pod 1 to 
demultiplex, Pod 2 goes away and you see two Pod 1 columns. The first Pod 1 column is labeled 
Pod 1 (Master Clock), and the second column is Pod 1 (Slave Clock).

Note that you can adjust sampling positions relative to the master clock and to the slave clock by 
assigning master and slave bus/signal names. (Note the "M" and "S" suffixes on pods in the 
Channels Assigned column to indicate "master clock" and "slave clock".) For more information on 
adjusting sampling positions, see To automatically adjust state sampling positions and threshold 
voltages (see page 128) or To manually adjust state sampling positions (see page 128).

See Also • Demultiplex Sampling Clock Mode (see page 103)

NOTE
To capture demultiplexed data, use only one pod of a pod pair.
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To set up the dual sample sampling clock mode

1 Set the clock mode to Dual Sample

a From the menu bar, select Setup>(Logic Analyzer Module)>Timing/State (Sampling)....

b Select State - Synchronous Sampling.

c For U4164A/16860-series, select the Single Clock option from the Sampling Option listbox. 

This listbox is displayed only for the U4164A and 16860-series logic analyzers as these support 
single clock as well as multiple clocks. 

The Dual sample clock mode is available only for the single clock sampling option.

d From the Clock Mode listbox, select Dual Sample.

e Set up your master clock and qualifiers (see To set up the state sampling clock and State 
Sampling Clock and Qualifiers for U4164A).

2 Set the logic analyzer pod(s) as Dual-sampled on which dual sampling is required

a Select the Buses/Signals tab.

b Click the clock button displayed under the pod which you want to set as Dual-sampled and 
choose Dual Sample from the displayed menu. In the Dual Sample mode, a combination of 
dual sample and master can be set on a pod-pair basis. You can choose which pod pairs you 
want to set as Dual-sampled or Master. 

• For U4154A/B or 16850-series logic analyzers - You can set either Odd or Even pod from a pod 
pair for dual sampling and accordingly the display of the pod and the other pod in the pair 
changes. For example, if you set Pod 2 to dual sample, Pod 1 goes away and you see two Pod 
2 columns. One Pod 2 column is labeled Pod 2 (Master Sample), and the other column is Pod 2 
(Second Sample).

• For U4164A or 16860-series logic analyzers - On selecting Dual Sample for any of the two 
pods in a pod-pair, the Odd pod out of the two pods is used for dual sampling. Only Odd pods 
are used for dual sampling. For example, if you set Pod 3 to dual sample, Pod 4 goes away and 
you see two Pod 3 columns. The first Pod 3 column is labeled Pod 3 (Master Sample), and the 
second column is Pod 3 (Second Sample).

3 Assign appropriate bus/signal names to the channels in the two samples - master and second

NOTE
The Dual Sample clock mode for the U4164A and 16860-series logic analyzers has some 
differences when compared to this mode for other logic analyzer models such as U4154A/B or 
16850-series logic analyzer.

In this topic, the setting up of the dual sample clock mode is described along with these 
differences based on logic analyzer models.

NOTE
Note that timing zoom data is only valid for the selected pod.
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You can give names to clearly reflect Read and Write samples for DDR/LPDDR captures or Rising 
and Falling edge samples for general-purpose data captures. Note the "M" and "S" suffixes on 
dual-sampled pods in the Channels Assigned column to indicate "master sample" and "second 
sample" respectively.

4 Set the threshold offsets for the dual-sampled channels 

(This step is applicable only for dual sampling in the U4164A or 16860-series logic analyzers.)

In U4164A/16860-series, you can set two separate threshold offsets for each dual-sampled 
channel  - one for the Master sample and the other for the second sample. This enables you to 
have separate thresholds for Read and Write in DDR/LPDDR captures and separate thresholds 
for Rising and Falling edge in general-purpose data captures. Other logic analyzer modules such 
as U4154A/B and 16850-series analyzers provide only one threshold and offset per 
dual-sampled channel. 

You can either use the Eye Scan - Sample Position and Threshold Settings dialog box or the 
Threshold Settings dialog box to set the thresholds. (see To automatically adjust state sampling 
positions and threshold voltages or To manually adjust state sampling positions).

a Click the Threshold button displayed under the pod that you set as Dual-sampled. 

The Threshold Settings dialog box is displayed. Click the Click to Show Offsets button. Two 
threshold offset setting options are then displayed for each channel of the dual-sampled pod.

NOTE
The differential signals for which you have set the clock mode to Dual 
sample have only one threshold offset instead of two threshold offsets as 
available for single-ended signals. 
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b For dual-sampled channels, the Threshold Voltage range available in the above dialog box is 
from -4 to +4 V unlike the threshold voltage range of -5 to +5 V for Master sampled channels.

c Set the threshold offsets for the channels and click Done. 

5 Adjust the state sampling positions independently for the two samples

This allows you to set independent sampling positions for Read and Write in DDR/LPDDR 
captures and for Rising and Falling edge in general-purpose data captures. You can set separate 
sampling positions for the two sampled. 

You use the Eye Scan - Sample Position and Threshold Settings dialog box to set the sampling 
positions. (see To automatically adjust state sampling positions and threshold voltages or To 
manually adjust state sampling positions).

6 Set threshold offsets for clock channels of dual-sampled pods

For U4154A/B and 16850-series logic analyzers

You can set threshold offsets for clock channels of all the pods - dual sampled or not. Each clock 
channel has a single threshold offset. 

For U4164A and 16860-series logic analyzers

The pods that you set as dual-sampled have their associated clock channels set to dual 
thresholds (dual-sampled). Only the clock channel of the odd pod in a dual-sampled pod pair is 
available. You can set two threshold offsets for this clock channel. 

Notice that in the following screen, the clock channel of pod1 is available from the dual-sampled 
pod pair (pod 1 and pod 2) and this clock channel is dual-sampled. 
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a Click the Clock Thresholds button displayed under the Clocks column in the Buses/Signals 
tab.

b The Threshold Settings for Clock Channels dialog box is displayed. For a dual-sample clock 
channel, you can set two clock thresholds, one for the Clock and the other for the clock 
qualifier. 

See Also • “Dual Sample Sampling Clock Mode" on page 106

To set up the quad sample sampling clock mode

NOTE
If you set a dual-sampled clock channel as Differential, then this clock 
channel provides only one clock threshold instead of two thresholds. 
Differential signals do not have Dual Thresholds. 

NOTE
The Quad Sample clock mode is only available for the U4164A logic analyzer module. Other logic 
analyzers do not support this clock mode.

For the U4164A module, this clock mode is displayed only if you have installed the 02G State 
speed license of U4164A and selected the Single Clock sampling option.
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1 Set the clock mode to Quad Sample

a From the menu bar, select Setup> (Logic Analyzer Module) > Timing/State (Sampling)....

b Select State - Synchronous Sampling.

c Select the Single Clock option from the Sampling Option listbox. 

This listbox is displayed only for the U4164A and 16860-series logic analyzers as these support 
single clock as well as multiple clocks. 

The Quad sample clock mode is available only for the single clock sampling option.

d From the Clock Mode listbox, select Quad Sample.

e Set up your master clock and qualifiers (see topics To set up the state sampling clock and 
State Sampling Clock and Qualifiers for U4164A).

2 Set the logic analyzer pod(s) as Quad-sampled on which quad sampling is required

a Select the Buses/Signals tab.

b Click the clock button displayed under the pod pair which you want to set as Quad-sampled 
and choose Quad Sample from the displayed menu. In the Quad Sample mode, a combination 
of quad sample, dual sample, and master can be set on a pod-pair basis. You can choose 
which pod pairs you want to set as Quad-sampled, Dual-sampled, or Master.

On selecting Quad Sample for a pod, the display of the pod and the other pod in the pair 
changes. For example, if you set Pod 1 to quad sample, Pod 2 goes away and you see two Pod 1 
columns. The first Pod 1 column is labeled Pod 1 (Master + Second Sample), and the second 
column is Pod 1 (Third + Fourth Sample). Only even channels (0, 2, 4, 6, 8, 10, 12, 14) for each 
quad-sampled pod are available.

NOTE
Irrespective of the pod that you select from a pod pair for quad sampling, only the Odd pod from 
the pair is used. Therefore, only pod 1, 3, 5, and 7 are available for quad sampling. 
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3 Assign appropriate bus/signal names to the channels in the four samples - master, second, third, 
and fourth.

You can give names to clearly reflect Read rising, Read falling, Write rising, and Write falling 
edge captures for data signals. Note the "m" "s", "t", and "f" suffixes on quad-sampled pods in the 
Channels Assigned column to indicate "master sample", "second sample", "third sample" and 
"fourth sample" respectively.

4 Set the threshold offsets for the quad-sampled channels

For each quad-sampled channel, you can set two separate threshold offsets - one for the Master 
and Third samples and the other for the second and fourth samples. This enables you to have 
separate thresholds for Read and Write with one threshold for Read Rising and Read Falling and 
the other threshold for Write Rising and Write Falling.

You can either use the Eye Scan - Sample Position and Threshold Settings dialog box or the 
Threshold Settings dialog box to set the thresholds. (see To automatically adjust state sampling 
positions and threshold voltages or To manually adjust state sampling positions).

a Click the Threshold button displayed under the pod that you set as Quad-sampled. 

b The Threshold Settings dialog box is displayed. Click the Click to Show Offsets button. Two 
threshold offset setting options are then displayed for each even channel of the quad-sampled 
pod.

NOTE
The differential signals for which you have set the clock mode to Quad sample have only one 
threshold offset instead of two threshold offsets as available for single-ended signals. 
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For Quad-sampled channels, the Threshold Voltage range available in the above dialog box is 
from -4 to +4 V unlike the threshold voltage range of -5 to +5 V for Master sampled channels. 

c Set the threshold offsets for the channels and click Done. 

5 Adjust the state sampling positions independently for the four samples

This allows you to set independent sampling positions for Read rising, read falling, write rising, 
and write falling edge captures. 

You use the Eye Scan - Sample Position and Threshold Settings dialog box to set the sampling 
positions. (see To automatically adjust state sampling positions and threshold voltages or To 
manually adjust state sampling positions).
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6 Set threshold offsets for clock channels of quad-sampled pods

The pods that you set as quad-sampled have their associated clock channel set to dual 
thresholds (dual-sampled). Only the clock bit of the odd pod in a quad-sampled pod pair is 
available. You can set two threshold offsets for this clock channel.  Notice that in the following 
screen, the clock channel of pod1 is available from the quad-sampled pod pair (pod 1 and pod 2) 
and this clock channel is dual-sampled. 

a Click the Clock Thresholds button displayed under the Clocks column in the Buses/Signals 
tab. 

b The Threshold Settings for Clock Channels dialog box is displayed. For a quad-sample clock 
channel, you can set two clock thresholds. Note that in some cases the clock bit can be used 
as a clock qualifier input.  The indication of Clock Qualifier tells you which of the clock 
thresholds will be associated with the clock qualifier input.

c Click Done to confirm threshold settings.

NOTE
There are a few exceptions to the availability of two samples and two clock thresholds for 
quad-sampled clock channels. These exceptions are:

• In case of a mulit-card set, the second and third U4164A modules support four samples 
per clock bit when all four pods are set to Quad Sample.

• If you set a quad-sampled clock channel as Differential, then this clock channel provides 
only one clock threshold instead of two thresholds. Differential signals do not have Dual 
Thresholds. 
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See Also • “Quad Sample Sampling Clock Mode" on page 110

• “State Mode Sampling Option" on page 540

To set up the state sampling clock

The state clock should be set to match the clock signal on your device under test. Some logic 
analyzer models support only a single clock and some support multiple clocks as well. Clocks can be 
as simple as a single rising edge, or a complicated combination of edges and highs or lows. The logic 
analyzer can handle clock signals comprised of up to four lines in case of multiple clocks. 

The following sections provide details on a single clock and multiple clocks for logic analyzers.

Single Clock

• In case you select the Single Clock sampling option or the logic analyzer supports only a single 
clock, the state sampling clock input is always from Pod1 of the logic analyzer. You cannot use the 
signals from other pods clock inputs as the sampling clock inputs.

• You can choose the sampling to occur on rising, falling, or both edges of the input clock signal.

• The clock qualifiers available in a single clock setup can be set with the "AND"/ "OR" conditional 
operators with the state clock qualifiers to add conditions and completely describe the clock as a 
combination of edges and highs or lows.
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Multiple Clocks (applicable to U4164A and 16860-series logic analyzers only)

• If your logic analyzer model supports multiple clocks, you can select the Multiple Clocks sampling 
option to set multiple clocks.

• When setting multiple clocks, you can use the signals from multiple pods' clock inputs (Pod 1, 2, 
3, and 4) as the sampling clock inputs. It is not restricted to pod 1 only. 

• Depending on model, your logic analyzer may have more pods. However, only the clock lines on 
the first 4 pods can be used to generate the state clock signal. Clock lines on extra pods can be 
used like normal data lines.

• You can choose the sampling to occur on rising, falling, or both edges of these multiple clock 
input signals.

• The multiple clocks that you set are used in an Ored combination. For a master/slave clock 
description, an Ored master and Ored slave combination is used.

• If the input clock edges from your DUT are faster than the highest speed allowed in multiple 
clocks, you will get an error or a warning message. In such a situation, measurements may be 
available but there is a risk of some missing data. You can use the Single Clock option in such a 
situation.

• You can set a maximum of two qualifiers for each clock in a multiple clock description. 

NOTE
Note on Overlapping Multiple Clocks

When setting up multiple clocks, do not define overlapping ORed clocks, that is the clocks 
occurring on top of each other. An example of overlapping clocks is to set a clock on clock 1 
on both edges and on clock 2 on both edges where the edges of clock 1 and clock 2 occur at 
or near the same instant in time. In such a situation, an error is displayed for such a clocking 
setup.
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• You can set up complex clock description using the Advanced Clocking feature available with 
multiple clocks. For instance, you can use a specific clock channel both as an edge and a qualifier 
in the same clock description or set different qualifiers for different clocks.

To set up state sampling clock

1 Attach logic analyzer pods to your device under test. Clock signals must be connected to the 
clock lines on pods 1 through 4.

2 From the menu bar, select Setup>(Logic Analyzer Module)>Timing/State (Sampling)....

3 Select State - Synchronous Sampling. The State Options area becomes active.

4 Select Single Clock or Multiple Clocks from the Sampling Option listbox. Only the U4164A and 
16860-series logic analyzers have this listbox as these analyzers support multiple clocks. 

5 Select the state clock mode (see page 99). Most measurements use only the master clock.

6 Set up a clock description to match the clock(s) in your device under test. A clock description 
must have at least one edge.

See Also • “Setting up the State Sampling Options for a U4164A Logic Analyzer" on page 542

• “Setting up the State Sampling Options in U4154A Logic Analyzer" on page 547

• “Setting up the State Sampling Options in U4154B Logic Analyzer" on page 551

Symbols Description

Don't care. Clock line not used in this clock.

Rising edge.

Falling edge.

Both edges.

Qualifier - high.

Qualifier - low.

NOTE
Note on adjusting the clock and qualifier's setup and hold time

In Synchronous sampling, the input logic signals need to be stable for a specific period of time 
before the clock qualifier event and for a specific period of time after the clock qualifier event. 
These time periods are called clock qualifier setup time and clock qualifier hold time 
respectively and vary based on the model of your logic analyzer. These time period 
requirements need to be met to ensure that the logic level is properly interpreted. When these 
time requirements are not met, it can result in missed clocks and measurements are not 
captured. 

For instance, when the clock and clock qualifier transition at the same time, there may not be 
enough setup time for the clock qualifier resulting in missing out some samples that should 
have been captured on the occurrence of the clock event. 

In such a situation, you can manually adjust the delay value for the clock qualifier channel to 
provide enough setup time as per your logic analyzer model. You can use the Signal Deskew 
tool to do this.  This tool is accessible by selecting  Tools > External Applications > Signal 
Deskew Tool from the Logic and Protocol Analyzer GUI's menubar.

To know about the clock and clock qualifier setup and hold time requirements for your model 
of logic analyzer, refer to your logic analyzer's specifications.
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• “Selecting the State Sampling Clock Mode" on page 99

• “To automatically adjust state sampling positions and threshold voltages" on page 128

To set up advanced clocking

If you want to specify more complex clock setups than you can with the normal Master or Slave 
selections (for example, if you want to use a specific clock channel both as an edge and a qualifier in 
the same clock description), you need to use advanced clocking.

1 From the menu bar, select Setup>(Logic Analyzer Module)>State/Timing (Sampling)....

2 Select State mode. The state options become selectable.

3 Select the Multiple Clocks option from the Sampling Option listbox.

4 Next to the clock mode, the Advanced Clocking checkbox becomes visible. Select this checkbox. 
The clock controls are replaced by a Master Clock button. In case of Master/slave clock mode, 
the clock controls are replaced by two buttons - Master Clock and Slave Clock. 

5 Select Master Clock... or Slave Clock... button as appropriate to set advanced clocking options 
for master clock(s) or slave clock(s).

6 In the Advanced Clocking Setup Dialog (see page 422), choose settings as appropriate for clock 
edges and their qualifiers.

Clock channels can be used both as primary clocks and as clock qualifiers.

Clock qualifiers can be set with "And" or "Or" conditional operators. 

Different qualifiers can be set for different clocks.

7 Click OK to close the dialog. The clock description in the Analyzer Setup window updates as per 
the clock definition in the Advanced Clocking Setup dialog.

See Also • Pod and Channel Naming Conventions (see page 361)

NOTE
The advanced clocking feature is only available for logic analyzers that support multiple 
clocks, that is, the U4164A and 16860-series logic analyzers.

NOTE
If you un-check the Advanced clocking checkbox, all qualifiers that you set are erased from 
the clock description.
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To automatically adjust state sampling positions and threshold voltages

When adjusting the state mode sampling position with eyescan, the logic analyzer looks at signals 
from the device under test, figures out the threshold voltage that results in the widest possible data 
valid window, then figures out the location of the data valid window in relation to the sampling clock, 
and automatically sets the threshold voltage and sampling position.

Because eyescan automatically sets the sample position on individual channels, it can correct for the 
small skew effects caused by probe cables and circuit board traces. This makes the logic analyzer's 
setup/hold window smaller and lets you accurately capture data at higher clock speeds.

To manually adjust state sampling positions

For U4154A/B Logic Analyzer and 16850 series of Logic Analyzers you use the Eye Scan - Sample 
Positions and Thresholds Settings dialog to manually adjust state sampling positions.

In the Eye Scan - Sample Positions and Thresholds Settings dialog, you can manually adjust state 
mode sampling positions without running eye scan (which automatically adjusts state sampling 
positions).

1 Select the state (synchronous sampling) mode (see To select the state acquisition mode).

2 In the Sampling Setup dialog, click Eye Scan: Sample Positions and Thresholds.... button.

3 In the Eye Scan - Sample Positions and Thresholds Settings dialog, drag the blue sampling 
position bars to the proper locations.

You can expand or collapse the channels in a bus.

Sampling positions are saved with the logic analyzer configuration (see To save a configuration file 
(see page 198)).

See Also • Understanding State Mode Sampling Positions (see page 367)

• To automatically adjust state sampling positions and threshold voltages (see page 128)

In Either Timing Mode or State Mode

• To specify the trigger position (see page 128)

• To set acquisition memory depth (see page 129)

To specify the trigger position

The trigger position specifies the amount of trace memory used for samples captured after the 
trigger. For example, when 10% poststore is selected, 90% of trace memory is used for samples 
captured before the trigger. When 90% poststore is selected, 10 % of trace memory is used for 
samples captured before the trigger.

When Force Prestore is checked, the amount of pre-trigger and post-trigger memory is always what 
you expect because, after a run, the logic analyzer fills pre-trigger memory before it starts looking for 
a trigger. If the event you want to trigger on occurs while pre-trigger memory is being filled, the logic 
analyzer does not trigger.

NOTE
You use the Eyescan feature with the U4154A/B Logic Analyzer and 
16850-series logic analysis system to automatically adjust sampling positions 
and threshold voltages on individual channels. Refer to the topic “Setting up and 
Running Eyescans in Logic Analyzers" on page 567 to know more about the 
eyescan feature.



Keysight Logic and Protocol Analyzer User Guide 129

Setting Up the Logic Analyzer 5

When Force Prestore is unchecked, the trigger position may not end up being where you expect 
because the logic analyzer starts looking for a trigger immediately after a run (it does not wait for 
pre-trigger memory to be filled). For example, if you set the trigger position to 50%, but the logic 
analyzer finds the trigger right away, the amount of pre-trigger memory is less than you expect.

1 From the menu bar select Setup>(Logic Analyzer Module)>Timing/State (Sampling)..., or click 
the  icon from the setup toolbar (see page 399).

2 Select the trigger position, and check or uncheck Force Prestore as desired.

See Also • Understanding Logic Analyzer Triggering, The Conveyor Belt Analogy (see page 369)

• To set the acquisition memory depth (see page 129)

To set acquisition memory depth

The acquisition depth control lets you set the amount of memory that is filled with data on an 
acquisition. The choices available depend on the maximum memory depth available in the analyzer 
that is being used.

1 From the menu bar select Setup>(Logic Analyzer Module)>Timing/State (Sampling)....

2 Set the acquisition mode and any state or timing options. These will affect the available memory 
choices.

3 In the Options box to the right, set Acquisition Depth.

See Also • Memory Depth and Channel Count Trade-offs (see page 363)

• Logic Analyzer Notes, Channels and Memory Depth (see page 536)

• Understanding Logic Analyzer Triggering, The Conveyor Belt Analogy (see page 369)

• To specify the trigger position (see page 128)

Using Timing Zoom

Timing zoom collects additional high-speed timing data around the trigger of the logic analyzer.

The timing zoom settings are accessed through the TimingZoom box in the Sampling tab.

• To turn timing zoom on or off (see page 131)

• To specify the timing zoom sample period (on some logic analyzers) (see page 131)
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• To specify the timing zoom trigger position (see page 131)

What is Timing
Zoom?

Timing zoom collects a window of additional high-speed timing data around the trigger of the logic 
analyzer.

Because of timing zoom's faster sample rate, you get a higher-resolution view of transitions than 
with the normal timing mode. Timing zoom data appears in rows with "(TZ)" after bus/signal names.

Because of the faster sample rate and the relatively smaller amount of memory for samples, the 
overall window of time captured by timing zoom is smaller. Timing zoom data is captured around the 
trigger.

See Also • Logic Analyzer Notes, Timing Zoom (see page 536)
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To turn timing zoom on or off

If you are not interested in the timing zoom data for a measurement, you can improve logic analyzer 
performance by turning off timing zoom.

1 In the Sampling tab, check or uncheck Enable in the TimingZoom box.

To specify the timing zoom sample period (on some logic analyzers)

With some logic analyzers (see Logic Analyzer Notes, Timing Zoom (see page 536)), you can change 
the sampling period to see more or less sampling resolution around the trigger.

1 In the Sampling tab, check Enable in the TimingZoom box.

2 Click Setup... in the TimingZoom box.

3 In the TimingZoom Setup dialog (see page 476), select the Sampling Period.

See Also • Logic Analyzer Notes, Timing Zoom (see page 536)

To specify the timing zoom trigger position

1 In the Sampling tab, check Enable in the TimingZoom box.

2 Click Setup... in the TimingZoom box.

3 In the TimingZoom Setup dialog (see page 476), drag the Trigger Position slider bar to the 
desired setting.

The trigger position specifies the amount of timing zoom memory used for samples captured 
after the trigger. For example when "10% poststore" is selected, 90% of timing zoom memory is 
used for samples captured before the trigger.

See Also • Logic Analyzer Notes, Timing Zoom (see page 536)
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Setting Up Symbols

You can use symbol names in place of bus/signal data values when:

• Setting up triggers.

• Displaying captured data.

• Searching for bus/signal values in the display windows.

• Setting up the Filter/Colorize tool.

Symbol names can be: variable names, procedure names, function names, source file line numbers, 
etc.

You can enter user-defined symbol names, or you can load symbol name definitions from a 
program's object file or from a general-purpose ASCII format symbol file.

• To create and edit user-defined symbols (see page 132)

• To load symbols from a file (see page 134)

• To run the symbol reader outside the application (see page 135)

• To create an ASCII symbol file (see page 135)

• To change symbol reader options (see page 136)

Multiple user-defined symbols can have the same name and different values. Symbol value lookups 
are based on the name and the value.

Multiple symbols with the same name are not allowed when loading symbols from a file. When a 
symbol file has multiple symbols with the same name, the first is accepted and the rest are ignored.

When two or more symbols have the same value, the first symbol name matching the value is used 
(even though you may have selected one of the others).

The following figure shows an example of symbols used for data presented in Waveform Viewer. 
Notice that different colors have been assigned to symbols for differentiation in the presented data. 

See Also • To enter symbolic bus/signal values (see page 138)

To create and edit user-defined symbols

You can create and edit user-defined symbols for bus/signal values.
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To add a
user-defined

symbol

1 Select Setup>(Logic Analyzer Module)>Symbols....

2 In the Symbols dialog (see page 471), select the bus or signal for which the new symbol should 
be displayed.

Each symbol is defined for a particular bus/signal.

3 Click Add....

4 In the Add Symbol dialog, define a value or range of values.

There are no restrictions on the characters you can use in the name of a symbol. You can also 
colorize the symbol by setting its background and foreground colors. These colors will then be 
used for this symbol in the data presented in Listing and Waveform Viewers. By default, white 
foreground and black background is used for symbols.

Many identical symbols for a bus/signal can be entered, all with unique or identical values. 
During symbol lookup by a window or tool, the first symbol that matches the pattern is used. This 
is why the Symbol dialog has Move Up and Move Down buttons for reordering symbols. 

5 Click Apply.

To see the symbols in the listing or waveform display, click OK in the Symbols dialog and change the 
base (see page 241) for the bus/signal to Symbols.

Inverse Assemblers (IA) can also create Symbols. These symbols are generated by the IA on run or on 
.ala load.  For such IA generated symbols, the Add and Edit buttons are disabled in the Symbols 
dialog.

NOTE
Because XML format logic analyzer configuration files save and load user-defined symbols, you can 
also add symbols by (1) using text processing tools to re-format symbol information from software 
development tools, (2) inserting them into an XML format configuration file, and (3) loading the 
configuration file into the Keysight Logic Analyzer application (see "XML Format" (in the online 
help)).
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To edit a
user-defined

symbol

1 Select Setup>(Logic Analyzer Module)>Symbols....

2 Select the symbol you want to edit.

3 Click Edit and modify the details such as name or background/foreground colors used for the 
symbol.

To delete a
user-defined

symbol

1 Select Setup>(Logic Analyzer Module)>Symbols....

2 Select the symbol you want to delete.

3 Click Delete.

To save symbols Save symbols as part of a configuration file (see page 198). Symbols are saved in the configuration 
whether or not you select Setup only in the Save As dialog.

You can move user-defined symbols from one bus/signal to another by saving to an XML format 
configuration file, editing, then reloading the file.

See Also • Displaying Names (Symbols) for Bus/Signal Values (see page 243)

To load symbols from a file

You can load symbols from object files, which are created by your compiler/linker or other software 
development tools, or you can load symbols from a general-purpose ASCII (GPA) format symbol files.

1 Create the symbol file:

• Generate an object file with symbolic information using your software development tools (see 
Object File Formats Supported by the Symbol Reader (see page 513)).

• Generate an Keysight Symbol Reader ".sym" file by running the symbol reader outside of the 
Keysight Logic Analyzer application (see page 135); loading symbols from ".sym" files is faster 
than loading them from object files.

• If your language tools cannot generate object file formats that are supported by the logic 
analyzer, create an ASCII symbol file (see page 135).

2 From the Keysight Logic Analyzer application's main menu bar, choose Setup>(Logic Analyzer 
Module)>Symbols....

3 In the Symbols dialog (see page 471), select the bus/signal name you want to load object file 
symbols for.

In most cases, you will select the bus/signal representing the address bus of the processor you 
are analyzing.

4 Click Load....

5 In the Select Symbol File dialog, select the file from which you want to load symbols.

6 Click Open.

The name of the symbol file is saved when a configuration file is saved. The symbol file will be 
reloaded when the configuration is loaded.
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To reload symbols
from a file

1 Choose Setup>(Logic Analyzer Module)>Symbols....

2 In the Symbols dialog (see page 471), select the symbol file whose symbols you want to reload.

3 Click Load....

The values of the symbols being used in the trigger sequence are updated automatically each time a 
symbol file is reloaded.

To delete a symbol
file

1 Choose Setup>(Logic Analyzer Module)>Symbols....

2 In the Symbols dialog (see page 471), select the symbol file whose symbols you want to delete.

3 Click Delete.

See Also • Object File Formats Supported by the Symbol Reader (see page 513)

To run the symbol reader outside the application

You can run the symbol reader outside the Keysight Logic Analyzer application to create an Keysight 
Symbol Reader ".sym" file that loads faster than the object file.

1 Open a Command Prompt window.

2 Run the command:

agSymbolBuild.exe [-r <readers.ini>] <object_file> <dest_file>.sym

For example:

agSymbolBuild.exe q.elf q.sym

The agSymbolBuild.exe symbol reader program is located in the directory:

<Drive letter>:\<Install directory>\SymbolReaders\

For example:

C:\Program Files\Keysight Technologies\Logic Analyzer\SymbolReaders\

To change the symbol reader options, copy the readers.ini file from the SymbolReaders directory, 
edit it, and use the -r <readers.ini> option when running the agSymbolBuild.exe program.

For more information on the symbol reader program, see the README.txt file in the 
SymbolReaders directory.

See Also • To load symbols from a file (see page 134)

• To change symbol reader options (see page 136)

To create an ASCII symbol file

General-purpose ASCII (GPA) symbol files are created by converting object file symbols to a GPA 
format symbol files and/or by using text editing/processing tools.

To convert object
file symbols to GPA
format symbol files

When you need to apply different offsets to different symbols or sections of code, you can convert 
object file symbols to general-purpose ASCII (GPA) format symbol files. Then, you can use text 
editing/processing tools to adjust the symbol or section offset values in the GPA format file before 
loading the file into the Keysight Logic Analyzer application.

1 Open a Command Prompt window.

2 Run the command:

agSymbolQuery.exe -a <object_file> <dest_file>.sym > GPA_file

For example:

agSymbolQuery.exe -a q.elf q.sym > q.gpa
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The agSymbolQuery.exe program is located in the directory:

<Drive letter>:\<Install directory>\SymbolReaders\

For example:

C:\Program Files\Keysight Technologies\Logic Analyzer\SymbolReaders\

For more information on the agSymbolQuery.exe program, see the README.txt file in the 
SymbolReaders directory.

See Also • General-Purpose ASCII (GPA) Symbol File Format (see page 514)

To change symbol reader options

You can change how ELF/Stabs, Ticoff, or Coff/Stabs symbol files are processed by editing the 
readers.ini file.

1 Make a backup copy of the readers.ini file.

The readers.ini file is located in the directory:

<Drive letter>:\<Install directory>\SymbolReaders\

For example:

C:\Program Files\Keysight Technologies\Logic Analyzer\SymbolReaders\

2 Edit the readers.ini file.

For more information on the symbol reader options, see the comments in the readers.ini file.

Reader Options

SectionReloc Use the following options to specify the relocation. Replace <sectionname> with the name of your 
section. Replace <hex_relocation_value> with the hex relocation amount (32-bit max). You can set 
the relocation for section to an absolute value or you can add a relative relocation amount. The 
relocation value will be calculated using unsigned 32-bit math.

[SectionReloc]
Place this before all relocation options.

AddReloc_AllSections=<hex_relocation_value>
Relocates all sections by an amount specified.
If this command is used with subsequent relocation commands
the subsequent commands will override this operation.

AddReloc_<sectionname>=<hex_relocation_value>
Adds a relative relocation value.

SetReloc_<sectionname>=<hex_relocation_value>
Relocates the section to the absolute address specified.

NonReloc_<sectionname>=TRUE
Inhibits a section from being relocated.
It is only useful when it follows a AddRloc+AllSections.

C++Demangle 1= Turn on C++ Demangling (Default)
0= Turn off C++ Demangling

C++DemOptions 803= Standard Demangling
203= GNU Demangling (Default Elf/Stabs)
403= Lucid Demangling
800= Standard Demangling without function parameters
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200= GNU Demangling without function parameters
400= Lucid Demangling without function parameters

MaxSymbolWidth 80= Column width max of a function or variable symbol
Wider symbols names will be truncated.
(Default 80 columns)

OutSectionSymbol
Valid

0= Symbols whose addresses aren't within the
defined sections are invalid (Default)

1= Symbols whose addresses aren't within the
defined sections are valid

This option must be specified in the Nsr section of the Readers.ini file:

[Nsr]
OutSectionSymbolValid=1

ReadElfSection 2= Process all globals from ELF section (Default)
Get size information of local variables

1= Get size information of global and local variables
Symbols for functions will not be read, and
only supplemental information for those symbols in
the Dwarf or stabs section will be read.

0= Do not read the Elf Section

If a file only has an ELF section this will have no effect and the ELF section will be read completely. 
This can occur if the file was created without a "generate debugger information" flag (usually -g). 
Using the -g will create a Dwarf or Stabs debug section in addition to the ELF section.

StabsType StabsType=0 Reader will determine stabs type (Default)
StabsType=1 Older style stabs

(Older style stabs have individual symbol
tables for each file that was linked into
the target executable, the indexes of each
symbol table restart at 0 for each file.)

StabsType=2 Newer style stabs
(New style stabs have a single symbol table
where all symbols are merged into a large
symbol array).

ReadOnlyTicoffPag
e

ReadOnlyTicoffPage tells the ticoff reader to read only the symbols associated with the specified 
page (as an example 'ReadOnlyTicoffPage=0' reads only page 0 symbols). A value of -1 tells the ticoff 
readers to read symbols associated with all pages.

ReadOnlyTicoffPage=-1 Read all symbols associated will all
ticoff pages (Default)

ReadOnlyTicoffPage=p Read only symbols associated with
page 'p' (where p is any integer
between 0 and n the last page of
the object file).

AppendTicoffPage AppendTicoffPage tells the ticoff reader to append the page number to the symbol value. This 
assumes that the symbol value is 16-bits wide and that page number is a low positive number which 
can be ORed into the upper 16 bits of an address to create a new 32-bit symbol address. For 
example, if the page is 10 decimal and the symbol address is 0xF100 then the new symbol address 
will be 0xAF100.

AppendTicoffPage=1 Append the ticoff page to the symbol
address
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AppendTicoffPage=0 Do not append the ticoff page to the
symbol address (Default)

Examples

Example for
Elf/Stabs

[ReadersElf]
C++Demangle=0
C++DemOptions=203
MaxSymbolWidth=60
StabsType=2

Example for
Coff/Stabs (using

Ticoff reader)

[ReadersTicoff]
C++Demangle=0
C++DemOptions=203
MaxSymbolWidth=60
StabsType=2

Example for Ticoff [ReadersTicoff]
C++Demangle=0
C++DemOptions=203
MaxSymbolWidth=60
ReadOnlyTicoffPage=4
AppendTicoffPage=1

To enter symbolic bus/signal values

When entering bus/signal values while setting up triggers, searching display windows, or setting up 
the Filter/Colorize tool:

1 Select the desired operator for the bus/signal value.

2 Select the Symbol number base.

3 Click the value button.

4 In the Select Symbol dialog (see page 458), select the symbol you want to use.

All of the symbols for the current bus/signal, regardless of type, are available in the dialog.

5 Click OK.

See Also • Select Symbol Dialog (see page 458)
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Installing Licensed Hardware Upgrades

Some of the newer logic analysis system cards (like the 16850-series logic analyzers) have hardware 
features (like state speed and memory depth) that can be upgraded by purchasing a license.

To install a licensed hardware upgrade:

1 After you have ordered the hardware upgrade product/option and have received your license file, 
copy the license file to the directory:

C:\Program Files (x86)\Agilent Technologies\Logic Analyzer\License

If you have installed the Keysight Logic Analyzer application in a different directory, copy the 
license file to the directory:

<Drive letter>:\<Install directory>\License\

If upgrade options were ordered for several cards at the same time, there will be one license file 
for all submitted serial numbers.

License file names must have the ".lic" extension in order to work.

2 In the Keysight Logic Analyzer application, choose Help>Logic Analyzer Upgrade....

Or, from the Windows Start bar, click Start>All Programs>Keysight Logic 
Analyzer>Utilities>Hardware Update Utility.

3 In the Keysight Logic Analyzer Upgrade dialog's "Install a Logic Analyzer Upgrade" tab, select the 
card that has an upgrade pending.

NOTE
When installing licensed hardware upgrades, you must run the Hardware Update Utility program 
on the frame that contains the cards you want to upgrade. In other words:

• In a multiframe logic analysis system, you must run the Hardware Update Utility program on 
each frame that has cards to be upgraded.

• You cannot install module upgrades over a remote connection (including remote connections 
via Remote Desktop, NetOp, or RealVNC).
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4 Click Upgrade....

5 When the upgrade completed information dialog appears, click OK.

The Keysight Logic Analyzer Upgrade dialog shows the upgraded hardware.

6 Click Close to close the Keysight Logic Analyzer Upgrade dialog.

Once you complete the hardware upgrade, the hardware will retain its new settings and can be 
moved to any 16850-series logic analysis system frame.

CAUTION
The Keysight Logic Analyzer application will be taken offline in order to perform the upgrade. 
Therefore, complete any acquisitions and save data before performing the upgrade.
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6 Capturing Data from the 
Device Under Test

After you have probed the device under test (see page 57) and set up the logic analyzer (see 
page 71) (by defining buses and signals (see page 83) and choosing the sampling mode (see 
page 96)), you are ready to tell the logic analyzer when to capture/acquire data (in other words, set 
up a trigger) and run the measurement.

You can set up:

• Quick Triggers by drawing a box in a display window around the data to trigger on,

• Simple Triggers in a display window by specifying bus/signal values to trigger on, or

• Advanced Triggers by opening a dialog box and choosing from collections of predefined trigger 
functions (see page 478).

Advanced triggers let you trigger the logic analyzer after a sequence of events occur in the device 
under test.

Once you have set up a trigger, you can run the measurement. When the measurement completes, 
you can view the captured data (see page 207) and save it (along with the logic analyzer setup).

• Setting Up Quick (Draw Box) Triggers (see page 143)

• To set a Quick Trigger in the Waveform window (see page 143)

• To set a Quick Trigger in the Listing window (see page 144)

• To set a Quick Trigger in the Source window (see page 145)

• Specifying Simple Triggers (see page 146)

• To specify bus patterns in a simple trigger (see page 147)

• To specify signal levels in a simple trigger (see page 148)

• To set a bus/signal edge in a simple trigger (see page 148)

• Specifying Advanced Triggers (see page 152)

• To replace or insert trigger functions into trigger sequence steps (see page 158)

• To specify bus/signal patterns (see page 159)

• To set a bus/signal edge in an advanced trigger (see page 160)

• To specify packet events (in "Find a packet" trigger function) (see page 164)

• To specify a trigger sequence step's goto or trigger action (see page 166)

• To specify default storage (see page 167)

• To insert or delete events (see page 168)

• Using burst patterns (see page 170)

• To negate events (see page 177)

• To change the evaluation order of AND/OR'ed events (see page 177)

• To choose between a duration or occurrence count for events (timing mode) (see page 178)

• To insert or delete actions (in a trigger sequence step) (see page 179)

• To cut, copy, and paste trigger sequence steps (see page 182)

• To delete trigger sequence steps (see page 182)

• To show a trigger sequence step as Advanced If/Then trigger functions (see page 182)
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• To convert a trigger sequence step to Advanced If/Then trigger functions (see page 183)

• To display or hide "If" clause comments (see page 183)

• To clear the trigger sequence (see page 185)

• Triggering From, and Sending Triggers To, Other Modules/Instruments (see page 186)

• Storing and Recalling Triggers (see page 194)

• To store a trigger (see page 194)

• To recall a trigger (see page 194)

• To set the trigger history depth (see page 195)

• Running/Stopping Measurements (see page 196)

• Saving Captured Data (and Logic Analyzer Setups) (see page 198)

• To save a configuration file (see page 198)

• To export data to standard CSV format files (see page 199)

• To export data to module CSV format files (see page 201)

• To export data to module binary (ALB) format files (see page 203)

• Extending Capture Capability with COM/DCOM (see page 206)

See Also • Probing the Device Under Test (see page 57)

• Setting Up the Logic Analyzer (see page 71)

• Defining Buses and Signals (see page 83)

• Choosing the Sampling Mode (see page 96)

• Analyzing the Captured Data (see page 207)
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Setting Up Quick (Draw Box) Triggers

Within the Waveform, Listing, and Source windows, you can quickly set up a simple trigger by 
drawing a rectangle with the mouse or right-clicking on a source line.

After the simple trigger has been defined, and the analyzer is run, the trigger saved in the most 
recently used triggers list and can be recalled (see page 194) at any time.

• To set a Quick Trigger in the Waveform window (see page 143)

• To set a Quick Trigger in the Listing window (see page 144)

• To set a Quick Trigger in the Source window (see page 145)

To set a Quick Trigger in the Waveform window

In the Waveform window, you can quickly set up a simple trigger by drawing a rectangle with the 
mouse.

1 Make sure the Waveform window's Fast Zoom In (see page 230) option is not selected.

2 Using the mouse, point to the upper-left corner of your desired trigger rectangle.

3 While holding down the mouse button, drag the mouse pointer to the lower-right corner of your 
desired rectangle, then release the mouse button.

As you draw the rectangle, you can monitor the trigger as it is set with the tool tip readout that 
appears.

As you move the mouse left-to-right and top-to-bottom, the signal edge/level or bus value in 
contact with the left of the rectangle becomes the trigger.

Only one edge can be set.

If a bus is expanded into its separate signals, three conditions apply:

a If drawing starts on a bus, none of its expanded signals can be included.

b If drawing starts on a signal, the bus cannot be included.

c Edges and levels are mutually exclusive. That is, either one edge can be set, or all levels can be 
set, but not both at the same time.

4 Select Set Quick Trigger.

NOTE
In the Waveform display window, it may be necessary to redraw the rectangle if you do not get 
your desired trigger points dictated by the left-side line of the rectangle. You could also try 
drawing the rectangle backwards leaving the left-side rectangle line set last.
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General Guidelines • Any bus/signals with overlapping bits are not included within the trigger specification.

Example: Bus_1 has channels 0 through 7 of pod 1 assigned and Bus_2 has channels 3 through 6 
of pod 1 assigned. At this point, you have the same probed signals (channels 3 through 6 of pod 
1) assigned in both Bus_1 and Bus_2. Now you draw the rectangle over both bus_1 and bus_2. 
Since Bus_1 channels 3 through 6 are repeated (overlapped) on Bus_2, they will not be included 
in the trigger specification.

• Only a single sequence step can be defined by a drawn rectangle.

• As you draw the rectangle, a tool tip is displayed showing the current trigger specification that 
would be set.

To set a Quick Trigger in the Listing window

In the Listing window, you can quickly set up a simple trigger by drawing a rectangle with the mouse.

1 Using the mouse, point to the sample that you want to use as the quick trigger.

2 While holding down the mouse button, drag the mouse pointer horizontally to draw a rectangle 
around the buses/signals you want to include in the trigger; then, release the mouse button.

As you draw the rectangle, a tool tip shows the trigger that will be set.

Dragging the mouse pointer vertically does not affect the sample used for the quick trigger; the 
sample used is always the one from which the drawn rectangle originates.

3 Select Set Quick Trigger.

General Guidelines • Any bus/signals with overlapping bits are not included within the trigger specification.

Example: Bus_1 has channels 0 through 7 of pod 1 assigned and Bus_2 has channels 3 through 6 
of pod 1 assigned. At this point, you have the same probed signals (channels 3 through 6 of pod 
1) assigned in both Bus_1 and Bus_2. Now you draw the rectangle over both bus_1 and bus_2. 
Since Bus_1 channels 3 through 6 are repeated (overlapped) on Bus_2, they will not be included 
in the trigger specification.

• Only a single sequence step can be defined by a drawn rectangle.
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• As you draw the rectangle, a tool tip is displayed showing the current trigger specification that 
would be set.

To set a Quick Trigger in the Source window

1 In the Source window's source pane, right-click the source line you want to set a Quick Trigger 
on, and choose Set Quick Trigger.

See Also • To change the "Set Quick Trigger" alignment (see page 282)

• Running/Stopping Measurements (see page 196)

• Viewing Source Code Associated with Captured Data (see page 277)
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Specifying Simple Triggers

Simple triggers let you quickly set up triggers on edges and bus/signal patterns from within display 
windows.

Buses are compared to entered pattern values using a relational operator (=, !=, <, >, <=, >=, In 
Range, Not In Range) or to one of multiple edges.

Signals are compared to edges (Rising Edge, Falling Edge, Either Edge, or a logic level pattern (High, 
Low). Edge options are available in timing mode only. For 16850 series and U4154A/B Logic Analyzer 
modules, edge options are also available in the state mode.

You can specify multiple bus/signal pattern values and one edge, all of which must evaluate to true 
for a sample to trigger the logic analyzer. (If you try to specify multiple edges, the last edge specified 
has priority, and the previously specified edge is changed to don't care.)

When buses/signals overlap (that is, the same logic analyzer channels are assigned to multiple 
buses/signals), the last change has highest priority. For example, if you specify a pattern on Bus A 
and then specify a rising edge on Signal B, which is bit 0 on Bus A, the previously specified pattern is 
erased.

When the desired trigger condition requires more than a simple AND expression (for example, one 
pattern OR another pattern on a bus, patterns in a sequence of samples, testing timer or counter 
values, etc.), you can choose Advanced Trigger... to specify an advanced trigger (see page 152). 
When an advanced trigger surpasses the functional limits of a simple trigger, the simple trigger fields 

Waveform Display Window Listing/Compare/Source Display Window

Bus Trigger

Signal Trigger
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go away; to restore them, you must either change the advanced trigger so that it doesn't surpass the 
limits of a simple trigger, or click Click here for trigger menu and choose Simple Trigger... to reset 
the trigger.

• To specify bus patterns in a simple trigger (see page 147)

• To specify signal levels in a simple trigger (see page 148)

• To set a bus/signal edge in a simple trigger (see page 148)

See Also • Setting Up Quick Triggers (see page 143)

• Specifying Advanced Triggers (see page 152)

• To store a trigger (see page 194)

• To recall a trigger (see page 453)

To specify bus patterns in a simple trigger

When specifying simple triggers (see page 146), you can specify bus patterns to trigger on.

To specify a bus
pattern

1 In the Simple Trigger field for a bus, click the  operator button; then, choose from one of the 
following operators:

• = (Equal To)

• != (Not Equal To)

• < (Less Than)

• > (Greater Than)

• <= (Less Than Or Equal To)

• >= (Greater Than Or Equal To)

Waveform Display Window Listing/Compare/Source Display Window

Bus Trigger
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• In Range

• Not In Range

2 In the text entry field , enter the bus pattern value to compare.

To specify signal levels in a simple trigger

When specifying simple triggers (see page 146), you can specify signal levels to trigger on.

To specify a signal
level

1 In the Simple Trigger field for a signal, click the  edge/level button; then, choose 
from:

• High

• Low

See Also • To specify bus patterns in a simple trigger (see page 147)

To set a bus/signal edge in a simple trigger

You can set a trigger on Rising, Falling, or Either Edge when the logic analyzer is configured in the 
Timing - Asynchronous sampling mode. 

Trigger on edge options are available in a simple trigger, an advanced trigger, and an eyescan 
trigger. 

NOTE
The <, >, <=, >=, In Range, and Not In Range operators are not available when a bus with reordered 
bits has been selected. Also, these operators cannot be used when the selected bus contains clock 
bits that span pod pairs. The In Range and Not In Range operators are limited to buses that span 2 
or fewer pod pairs (up to 64 bits wide).

Waveform Display Window Listing/Compare/Source Display Window

Signal Trigger

NOTE
For 16850-series and U4154A/B logic analyzer modules, you can set a trigger on edge in 
the Timing - Asynchronous sampling mode as well as State –Synchronous sampling mode.
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You can configure trigger on edge in a simple trigger from the Waveform or Listing display window. 
The trigger settings that you configure in one of these windows is reflected automatically in the other 
window.

From Waveform
Viewer

For a simple trigger created from Waveform Viewer, you can set a trigger on edge at an individual 
bit/signal level or at bus level. 

At the bus level, you can set trigger on edge on one or more signals within the bus. If you set trigger 
on edge on multiple signals within a bus, then trigger on edge for these signals is ORed. 

Figure 1 Figure - Trigger on edge set from Waveform viewer for a bus

At the individual signal level, you can set trigger on edge for one signal at a time. If you try to specify 
multiple edges, the last edge specified has priority, and the previously specified edge is changed to 
"Don't Care".

NOTE
The trigger event occurs between the previous state clock and the state clock at which the 
trigger point is marked. 

If there is a rising edge and a falling edge on the same signal between the previous state 
clock and the state clock at which the trigger point is marked, such that the actual state of 
the signal is the same at both the previous state clock and the state clock at which the 
trigger point is marked, then the trigger will not occur.
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Figure 2 Trigger on edge set from Waveform viewer for a signal

From Listing
Viewer

For a simple trigger created from Listing Viewer, you can set a trigger on edge on one or more 
signals within a single bus. For multiple signals, trigger on edge is ORed.

Figure 3 Trigger on edge set from Listing viewer for a bus

To specify edges
on a bus

1 In the Simple Trigger field for a bus, click the  operator button; then, choose Edge.

2 Click Edge Spec....

3 In the Set Edge dialog, specify edges you are looking for; use the Set All button to make a 
selection for all signals in the bus.
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4 Click OK to close the Set Edge dialog.

To specify a signal
edge 1 In the Simple Trigger field for a signal, click the  edge/level button; then, choose 

from:

• Rising Edge

• Falling Edge

• Either Edge

See Also • To specify signal levels in a simple trigger (see page 148)

• Understanding Logic Analyzer Triggering, Edges (see page 369)
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Specifying Advanced Triggers

When you need to set up triggers that are more complex than just finding particular bus/signal 
values (for example, when you need to trigger on a sequence of events in the device under test), you 
set up advanced triggers.

To open the Advanced Trigger dialog, click  in the analyzer setup toolbar, or choose Setup>(Logic 
Analyzer Module)>Advanced Trigger... from the menu bar.

Advanced triggers are specified by dragging-and-dropping predefined trigger functions (see 
page 478) into trigger sequence steps. If the trigger function you need doesn't exist, start with a 
trigger function that is close, convert the trigger sequence step to advanced If/Then trigger 
functions, and edit the If/Then trigger functions.

Each step in the trigger sequence looks for events (see page 153) in data samples captured from the 
device under test (or in logic analyzer timers, counters, or flags), and when those events are found, 
takes some action (see page 153) (like triggering or going to another step in the sequence). You can 
also insert actions for timers, counters, or flags.

Default storage lets you ignore the question, in individual trigger sequence steps, of which captured 
samples should be stored in logic analyzer memory. However, you can insert storage control actions 
in individual trigger sequence steps to specify whether samples should be stored or to specify 
whether default storage should be turned on or off. Sequence step storage control actions override 
the default storage specification.

• To replace or insert trigger functions into trigger sequence steps (see page 158)

• To specify bus/signal patterns (see page 159)

• To set a bus/signal edge in an advanced trigger (see page 160)

• To specify packet events (in "Find a packet" trigger function) (see page 164)

• To specify a trigger sequence step's goto or trigger action (see page 166)

• To specify default storage (see page 167)

• To insert or delete events (see page 168)

• To insert a timer event (see page 169) (see also Using Timers (see page 153))

• To insert a counter event (see page 169) (see also Using Counters (see page 154))

• To insert a flag event (see page 170) (see also Using Flags (see page 157))

• To insert an "Arm in from" event (see page 170)

• To negate events (see page 177)

• To change the evaluation order of AND/OR'ed events (see page 177)
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• To choose between a duration or occurrence count for events (timing mode) (see page 178)

• To insert or delete actions (in a trigger sequence step) (see page 179)

• To insert a timer action (see page 179) (see also Using Timers (see page 153))

• To insert a counter action (see page 180) (see also Using Counters (see page 154))

• To insert a reset occurrence counter action (see page 180)

• To insert a flag action (see page 180) (see also Using Flags (see page 157))

• To insert a storage control action (see page 181)

• To cut, copy, and paste trigger sequence steps (see page 182)

• To delete trigger sequence steps (see page 182)

• To show a trigger sequence step as Advanced If/Then trigger functions (see page 182)

• To convert a trigger sequence step to Advanced If/Then trigger functions (see page 183)

• To display or hide "If" clause comments (see page 183)

• To clear the trigger sequence (see page 185)

See Also • Understanding Logic Analyzer Triggering (see page 369)

• State Mode Trigger Functions (see page 490)

• Timing Mode Trigger Functions (see page 478)

• Specifying Simple Triggers (see page 146)

Reading Event and Action Statements

Event and action statements in trigger sequence steps read from left-to-right like:

Find an event in the device under test; when the event is found, take some action.

Or:

If an event is found in the device under test; then, take an action.

For example, suppose you want to see what happens after a read from the address 406F6H. To do 
this, set up the trigger to look for a rising edge on the RD (memory read) signal and an address bus 
pattern of 406F6H (hexadecimal):

As you set up the trigger, think of it as constructing a sentence that reads left-to-right. For example:

Find a Signal named RD with a Rising Edge And a Bus named ADDR with All bits= (equal) to the 
pattern 406F6 Hex. When found, then Trigger and fill memory.

See Also • Specifying Advanced Triggers (see page 152)

• Understanding Logic Analyzer Triggering, Sequence Steps (see page 371)

Using Timers

Timers are like stopwatches. Use timers to create either a user-defined delay or a time standard 
which valid data duration is evaluated against. The timer can Start from reset, Stop and reset, Pause, 
or Resume.

Timer considerations:
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• It takes a certain amount of time for timers to reset; this is called the timer reset latency. To find 
the timer reset latency for your logic analyzer, see the description of its characteristics (see 
page 587).

• The number of timers available in a module depends on the selected acquisition mode and 
sampling option:

Refer to your logic analyzer characteristics (see page 587) for the actual number of timers 
available. For information on when pod pairs are reserved for time tag storage, see Why Are Pods 
Missing? (see page 362).

• Timers are checked in event statements, and started in action statements.

• Timers must be started before they can be checked. This is done by either including the timer 
start action with the timer check event within the same trigger step or starting the timer in a 
preceding trigger step.

The following example shows the timer start action and check event within the same trigger step.

• Once a timer event is configured, you can reuse the timer by selecting its identification number. 
The same timer must always be checked against the same value. To check for different durations, 
use different timers.

See Also • To insert a timer action (see page 179)

• To insert a timer event (see page 169)

• Understanding Logic Analyzer Triggering, Timers (see page 374)

Using Counters

Counters are used to count eventual occurrences during an acquisition. Like other events, these 
counters evaluate to either true or false. You can use counters to create a user-defined delay, or to 
create a standard against which valid data duration is evaluated.

There are three types of counters available for use within trigger sequence steps. Based on your logic 
analyzer model and the sampling option you select, the availability of counters changes. 

The following table lists and compares these three types of counters.

Acquisition Mode Sampling Option # Timers Available

State mode (synchronous 
sampling)

Single Clock 1

Multiple clocks 3

Timing mode (asynchronous 
sampling)

all 1
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Global Counter's Terminal and Current Values

For a global counter, the following two values are relevant in a trigger setup:

• Terminal value -  This value is defined for a global counter by using the counter as an event in an 
"If" clause. For example, the following "If" clause defines the terminal value of the global counter 1 
as 7: 

A global counter's terminal value remains zero until it is defined in an "If clause". 

In a trigger setup, a global counter can have only one terminal value. This means that you cannot 
compare a global counter's current value to two different terminal values in the trigger setup. 

• Current value - This is the current value of the global counter which is compared against the 
terminal value defined for the counter. At the beginning of an acquisition, a global counter's 
current value is always zero. 

You can use Increment, Decrement, or Reset actions in trigger steps to change the current value 
of the global counter during an acquisition. A Reset action sets the global counter's current value 
to zero.

Event counter Global counter Occurrence counter

Available in Single Clock state sampling option All timing sampling options Multiple Clocks state sampling option 
only
 All sampling options

Number of counters 2 per trigger sequence 2 per trigger sequence 1 per trigger sequence step

Usage  To increment/reset the counter's value on 
the occurrence of an event and observe the 
counter's value in the Status button during 
acquisition.

To guide the trigger sequence by testing the 
counter's value in the "If" clause.

 To count eventual occurrences in a 
sequence step.

Used in  Only the Action statements of a trigger 
sequence
(Cannot be tested in an If clause of a step.)

 Event and Action statements of a trigger 
sequence

(Can be tested in an If clause of a step.)
 Steps that contain the "occurs" phrase

Counter Attributes  Increment
Reset

Increment
Decrement
Reset

 Reset occurrence counter

Reuse  Once configured, the counter persists 
throughout the steps of a trigger sequence 
and you can reuse it by selecting its 
identification number.

 Once configured, the counter persists 
throughout the steps of a trigger sequence 
and you can reuse it by selecting its 
identification number.

Once configured, the counter persists 
within a trigger sequence step and can 
be reused within that step using the 
Reset occurrence counter action.

NOTE
During acquisition, once the global counter's current value reaches the counter's terminal 
value, then Increment or Decrement actions have no effect on the current value. In such a 
case, only resetting the counter can change its current value to zero. After the reset, the 
counter's current value can again be incremented.

Another situation in which Increment or Decrement have no effect on the current value is 
when you have not defined the global counter's terminal value by using it as an event in an If 
clause and trying to increment the current value. In such a situation, the global counter’s 
terminal value as well as current value is zero and therefore equal, resulting in Increment and 
Decrement actions having no effect.



6 Capturing Data from the Device Under Test

156 Keysight Logic and Protocol Analyzer User Guide

Examples

Global Counter

Event Counter 

Occurrence Counter 

Viewing the Status of Counters

You can use the Status dialog box to view the current value of a counter. To access this dialog box, 
click the Status button in the Status bar at the bottom of the GUI. 
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See Also • To insert a counter action (see page 180)

• To insert a counter event (see page 169)

• Understanding Logic Analyzer Triggering, Counters (see page 373)

Using Flags

Flags can be used to signal between modules in the logic analysis system including a multiframe 
logic analysis system as well as between modules installed in an Keysight AMP/AXIe chassis. Using 
flags, logic analyzer modules can communicate back and forth with each other multiple times during 
a data acquisition, both before and after their trigger events occur. (By comparison, a module can 
arm another module one time when its trigger occurs.)

There are 4 flags that are shared across all connected logic analysis/AMP/AXIe system frames. By 
default, flags are cleared. In the Advanced Trigger dialog of the module, you can insert actions to set, 
clear, pulse set, or pulse clear a flag. You can also insert flag events in the Advanced Trigger dialog of 
different modules to test whether a particular flag is set or clear.

Setting a Flag

In legacy logic analysis systems, a particular flag may be driven (set) or received by multiple 
modules. However, in newer AMP/AXIe based instrument modules, only one module can set a 
particular flag. Multiple modules cannot set the same flag. But multiple modules can insert flag 
events for the same flag to test whether the flag is set or clear.
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Clearing a Flag

A flag that is set by a module remains set until that module clears it. In legacy logic analysis systems, 
if multiple modules set the same flag, then all those modules must clear the flag before it becomes 
clear. In newer AMP/AXIe based instrument modules, multiple modules cannot set the same flag and 
therefore, the module that sets the flag can only clear it. 

Flags can also be used to drive the logic analysis system's Port Out signal.

Viewing the Status of Flags

You can use the Status dialog box to view the current status of a flag. To access this dialog box, click 
the Status button in the Status bar at the bottom of the GUI. 

The flag status is not available if you selected the Multiple Clocks state sampling option for your logic 
analyzer.

See Also • To insert a flag action (see page 180)

• To insert a flag event (see page 170)

• Understanding Logic Analyzer Triggering, Flags (see page 373)

To replace or insert trigger functions into trigger sequence steps

Multiple steps in the trigger sequence are necessary when you want to trigger on a sequence of 
events in the device under test. When you want to trigger on one event in (that is, a single sample 
from) the device under test, a single step in the trigger sequence is all you need.

1 In the Advanced Trigger dialog, drag-and-drop the desired Trigger Function (see page 478) into 
the Trigger Sequence display area.

To replace an existing step:

• Drag-and-drop the trigger function on top of an existing step in the trigger sequence. A red 
box around the old function indicates the replace operation.

To insert a trigger function as a new step:

• Drag-and-drop the trigger function above or below an existing step in the trigger sequence. 
When the mouse is positioned above or below an existing step, a red insert bar appears to 
indicate the relative insert location of the trigger function.

See Also • Understanding Logic Analyzer Triggering, Sequence Steps (see page 371)

• To delete trigger sequence steps (see page 182)

• State Mode Trigger Functions (see page 490)

• Timing Mode Trigger Functions (see page 478)
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To specify bus/signal patterns

1 In the Advanced Trigger dialog, select the bus or signal.

Clicking  lets you select from recently used bus/signal names. Clicking elsewhere on a 
bus/signal name button opens a Select dialog for selecting a different name.

2 If a bus has been selected, either select All bits on the bus or select an individual bit.

3 Specify the bus/signal value:

If a signal or one bit of a bus has been selected, select the signal pattern value (High, Low, or 
Don't Care). 

If all bits of a bus have been selected:

a Select one of the operators: = (equal to), != (not equal to), < (less than), > (greater than), <= 
(less than or equal to), >= (greater than or equal to), In Range, Not In Range, or Edge.

b Select the number base (Binary, Hex, Octal, Decimal, Signed Decimal, also known as two's 
complement, Ascii, or Symbol).

NOTE
The <, >, <=, >=, In Range, and Not In Range operators are not available when a bus with reordered 
bits has been selected. Also, these operators cannot be used when the selected bus contains clock 
bits that span pod pairs. The In Range and Not In Range operators are limited to buses that span 2 
or fewer pod pairs (up to 64 bits wide).
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c Enter the pattern value(s).

When the Symbol number base is selected, you use the Select Symbol dialog (see page 458) 
to specify the pattern values.

See Also • To specify default storage (see page 167)

• To insert or delete events (see page 168)

• Understanding Logic Analyzer Triggering, Ranges (see page 373)

To set a bus/signal edge in an advanced trigger

You can set a trigger on Rising, Falling, or Either Edge when the logic analyzer is configured in the 
Timing - Asynchronous sampling mode. 

Trigger on edge options are available in a simple trigger, an advanced trigger, and an eyescan 
trigger. 

In an advanced trigger step, you can set a trigger on edge on an individual bit/signal or multiple 
signals of a bus (edges are ORed in this case). The following screen displays an example of the Edge 
options available in an advanced trigger in timing mode.

NOTE
For 16850-series and U4154A/B logic analyzer modules, you can set a trigger on edge in the 
Timing - Asynchronous sampling mode as well as State –Synchronous sampling mode. 

NOTE
The trigger event occurs between the previous state clock and the state clock at which the 
trigger point is marked. 

If there is a rising edge and a falling edge on the same signal between the previous state 
clock and the state clock at which the trigger point is marked, such that the actual state of 
the signal is the same at both the previous state clock and the state clock at which the trigger 
point is marked, then the trigger will not occur.
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Figure 4 Trigger on edge options for the timing mode

To specify trigger
on edge on a signal

in an advanced
trigger

1 In the Advanced Trigger dialog, select the bus and then its signal on which you want to set 
trigger on edge.

2 Select the edge value (Rising Edge, Falling Edge, or Either Edge) for the signal.



6 Capturing Data from the Device Under Test

162 Keysight Logic and Protocol Analyzer User Guide

To specify
bus/signal edges in

advanced trigger

1 In the Advanced Trigger dialog, select the bus on which you want to set trigger on edge.

2 Select the All bits option for the bus.

3 Select the Edge option.

When the Edge operator is selected, the Edge Spec... button is displayed. 

4 Click the Edge Spec... button to open the Set Edge dialog for specifying multiple edges on a bus. In 
the Set Edge dialog, specify edges you are looking for; use the Set All button to make a selection 
for all signals in the bus.
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5 Click OK to close the Set Edge dialog.

Trigger on edge in
an eyescan trigger

You can also set a trigger on edge when configuring an eyescan trigger. This trigger allows you to 
control when logic analyzer should take samples to be used in the eyescan for determining the 
optimal threshold and sample positions. 

To know more about eyescan triggers and how to configure these, refer to the topic Modifying 
General or Target-specific Scan Qualification. 

Figure 5 Trigger on edge in an eyescan trigger

See Also • To specify default storage (see page 167)

• To insert or delete events (see page 168)

• Understanding Logic Analyzer Triggering, Edges (see page 373)
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To specify packet events (in "Find a packet" trigger function)

1 In the Advanced Trigger dialog, replace or insert the Find a packet (see page 496) trigger 
function into the trigger sequence (see To replace or insert trigger functions into trigger 
sequence steps (see page 158)).

2 In the "Find a packet" trigger sequence step, click Select a bus.

3 In the Choose a Protocol Family and Bus dialog (see page 430), select the protocol family and the 
type of bus being probed; then, click OK.

4 In the "Find a packet" trigger sequence step, click Select a packet.

5 In the Event Editor Dialog (see page 433), select the type of packet event and enter packet field 
values to trigger on; then, click OK.

See Also • Using the Packet Event Editor (see page 164)

Using the Packet Event Editor

The packet event editor lets you specify packet events in the "Find a packet" trigger function.

To use the packet event editor:

1 Select the event type from the left side of the dialog.

2 Enter or select field values on the right side of the dialog.

To clear a field value, click .

3 If desired, you can enter or modify the Name of the event.

4 When you are done editing the packet event, click OK.

The packet event editor also allows you:

• To view a packet event as bits (see page 165)

• To save favorite packet events (see page 165)

• To organize favorite packet events (see page 165)

See Also • Find a packet (see page 496) trigger function



Keysight Logic and Protocol Analyzer User Guide 165

Capturing Data from the Device Under Test 6

To view a packet event as bits

1 While specifying packet events using the Event Editor Dialog (see page 433), click View as Bits....

The packet event is displayed in format similar to packet descriptions in specification documents.

2 If desired, you can select a different number Base.

3 When you are finished viewing the packet event as bits, click Close.

See Also • To specify packet events (in "Find a packet" trigger function) (see page 164)

To save favorite packet events

While specifying packet events using the Event Editor Dialog (see page 433), you can save the event 
as a favorite.

1 If desired, enter or modify the Name of the event.

2 Click Add to Favorites.

The packet event appears in the event list tree on the left side of the dialog.

See Also • To organize favorite packet events (see page 165)

• To specify packet events (in "Find a packet" trigger function) (see page 164)

To organize favorite packet events

While specifying packet events using the Event Editor Dialog (see page 433), you can organize saved 
packet event favorites.

1 Click Organize Favorites....

2 In the Organize Favorites dialog, you can:



6 Capturing Data from the Device Under Test

166 Keysight Logic and Protocol Analyzer User Guide

• Create folders, move selected events to folders, and rename or delete selected events.

• Save favorites to a file, or load saved favorites from a file.

3 When you are done organizing packet event favorites, click Close.

See Also • To save favorite packet events (see page 165)

• To specify packet events (in "Find a packet" trigger function) (see page 164)

To specify a trigger sequence step's goto or trigger action

1 In the Advanced Trigger dialog, within a sequence step, select the desired trigger action:

You can select:

• Goto—To go to another trigger sequence step.

• Trigger and fill memory—To trigger the logic analyzer and fill memory, without going to any 
other steps in the trigger sequence.

• Trigger and goto—To trigger the logic analyzer and go to another trigger sequence step. (This 
can be useful when you use trigger sequence steps to specify what samples get stored.)

• Trigger, send e-mail, and fill memory—To trigger the logic analyzer, send e-mail, and fill 
memory, without going to any other trigger sequence steps. Clicking E-Mail Setup... opens the 
E-mail dialog (see page 432) for entering the e-mail address, subject, and message.
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2 If you selected one of the actions that specify fill memory and you are in the state mode or in the 
store qualified timing mode with custom storage selected, enter the storage qualifier used to fill 
memory.

See Also • To insert or delete events (see page 168)

• To specify default storage (see page 167)

• To insert or delete actions (in a trigger sequence step) (see page 179)

To specify default storage

Storage qualifiers are used to specify which samples (captured from the device under test) are stored 
in logic analyzer memory. By storing only the samples you are interested in, you can make better use 
of the available memory and capture activity for a greater amount of time.

Default Storage means "unless storage control actions or fill memory storage qualifiers in trigger 
sequence steps specify otherwise, this is what should be stored". Storage qualifiers in trigger 
sequence steps always override default storage.

The default storage qualifier is available in state sampling mode and in the store qualified 
(transitional) timing mode.

In Transitional /
Store Qualified

Timing Mode

1 Select the type of storage qualification: either Transitional or Custom.

• When Transitional is selected, samples that have transitions from the previous sample are 
stored.

If you want to exclude certain bus/signal transitions from being stored, click Exclude 
buses/signals..., and specify which buses/signals should be excluded.

• When Custom is selected, edit or insert events that should be stored (or not stored) in logic 
analyzer memory.
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In State Mode 1 Edit or insert events that should be stored (or not stored) in logic analyzer memory.

See Also • To insert or delete events (see page 168)

• To negate events (see page 177)

• To change the evaluation order of AND/OR'ed events (see page 177)

• To insert a storage control action (see page 181) (in a trigger sequence step)

• To specify a trigger sequence step's goto or trigger action (see page 166)

• Understanding Logic Analyzer Triggering, Storage Qualification (see page 375)

To insert or delete events

1 In the Advanced Trigger dialog, in a trigger sequence step, click the  button associated with 
an event (after Find or If in trigger sequence step conditions, or after Store or with in storage 
qualifiers), and choose Insert Event After (AND/OR), Insert Event Before (AND/OR), or Delete 
Event.

2 If inserting an event, select the type of event.

Depending on where you are inserting the event, the following event types may be available:

• Bus/Signal—Bus/signal value, To specify bus/signal patterns or edges (see page 159).

• Anything—Any sample.

• Nothing—No sample.

• Timer—A timer value, see To insert a timer event (see page 169).

• Counter—A counter value, see To insert a counter event (see page 169).

• Flag—A flag value, see To insert a flag event (see page 170).

• Arm in from—An arming signal from another logic analyzer module or an external instrument, 
see To insert an "Arm in from" event (see page 170).

3 If inserting an event, specify whether the event should be And'ed or Or'ed with the other events.
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See Also • To negate events (see page 177)

• To change the evaluation order of AND/OR'ed events (see page 177)

• Understanding Logic Analyzer Triggering, Boolean Expressions (see page 372)

To insert a timer event

1 Select the timer that you want to check.

2 Select the timer compare operator.

3 Enter the timer value to compare against.

For more information on timers, see Using Timers (see page 153).

See Also • To insert or delete events (see page 168)

To insert a counter event

A counter must be started with a counter action before it can be evaluated with a counter event.

1 Select the counter that you want to check.

2 Select the counter compare operator.

3 Enter the counter value to compare against.

For more information on counters, see Using Counters (see page 154).

See Also • To insert or delete events (see page 168)

NOTE
The Start from reset timer action can be placed in either the same sequence step as the timer 
check event, or it can be placed in a preceding trigger step. Checking a timer without starting it 
will generate an error.
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To insert a flag event

1 Select the flag that you want to check.

2 Enter the flag value to compare against.

There is approximately 100 ns of delay before a flag action can be seen by a flag event.

Multiple modules can insert flag events for the same flag to test whether the flag is set or clear. 

For more information on flags, see Using Flags (see page 157).

See Also • To insert or delete events (see page 168)

To insert an "Arm in from" event

1 Specify the source of the arming signal by selecting another module or External trigger.

For more information on triggering on signals from other logic analyzer modules or external 
instruments, see Triggering From, and Sending Triggers To, Other Modules/Instruments (see 
page 186).

See Also • To insert or delete events (see page 168)

Using Burst Patterns

While configuring the trigger sequence step(s) of an Advanced trigger, you can use burst patterns to:

• define the "If" and "Else If" clauses in the trigger steps based on burst patterns.

• define the trigger's "default storage" and the "fill memory storage qualifiers in the trigger steps" 
based on burst patterns.

When using a burst pattern in an If/Else If clause, the trigger occurs when the complete burst pattern 
condition is met.  If you have specified an occurrence counter greater than 1 for a burst pattern, then 
the trigger occurs when the complete burst pattern condition has consecutively occurred for the 
number of times specified as the occurrence counter.

When using a burst pattern in the trigger's storage qualification, the complete burst pattern found is 
stored. 
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To know how to specify burst patterns in "If", "Else If", or "storage qualification", refer to the topic “To 
specify burst patterns" on page 173.

Setting the Burst Mode for a Trigger Sequence

Depending on whether you want to use burst patterns in "storage qualification" or in "If/Else 
If"clauses in a trigger sequence, you need to set the burst mode matching the usage. 

By setting the correct burst mode, you ensure that the burst patterns work as per their intended 
usage (described below). 

To set the burst mode, click the Burst Options... button displayed with a burst pattern in the trigger 
sequence. 

On clicking the Burst Options... button, the Burst Options dialog box is displayed. Select a burst mode 
from the two burst modes for the entire trigger sequence. 

NOTE
The burst mode that you set is applicable to all burst patterns that you use in a trigger 
sequence. 

The Burst Options... button is available with each burst pattern that you use in a trigger 
sequence. Changing the mode by clicking any of these buttons reflects that change across all 
the burst patterns in the trigger sequence.
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General trigger sequence mode Store qualification mode

Select this mode when you want to use burst patterns in "If/Else If" clauses in 
the trigger sequence steps.

Select this mode when you want to use burst patterns in "default storage" or the "fill 
memory storage qualifiers in the steps".

On selecting this mode, the trigger occurs on the last sample that you 
specified in a burst pattern, that is, when the entire burst pattern condition is 
met. 
The trigger point is therefore, when the last sample specified in the burst 
pattern is found. 

On selecting this mode, each sample of the burst pattern that is found in the trace is 
stored. The entire burst pattern that you specified in the default storage is therefore 
stored, when found in the trace.
This default storage, however, is overridden by any storage actions that you set in 
individual trigger steps. 
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To specify burst patterns

1 In the Advanced Trigger dialog, select the Burst event type.

2 Select the number of samples in the burst pattern.

You can have up to eight 2-sample burst patterns or four 3- or 4-sample burst patterns.

3 Select the bus or signal.

Clicking   lets you:

• Select from recently used bus/signal names.

• Select from other bus/signal names (More...).

• Add another bus/signal to the burst pattern.

Additional buses/signals are AND'ed in the burst pattern. You can add as many buses/signals as 
you like, without consuming additional trigger resources.

• Delete the bus/signal from the burst pattern.

Clicking elsewhere on a bus/signal name button opens a Select dialog for selecting a different name.

NOTE
Add buses/signals to the burst pattern instead of inserting AND'ed events. AND'ed events 
consume trigger resources. 
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4 Specify the burst pattern values:

a Select the number base (Binary, Hex, Octal, Decimal, Signed Decimal, also known as two's 
complement, Ascii, or Symbol).

b Enter the burst pattern value(s).

When the Symbol number base is selected, you use the Select Symbol dialog to specify the 
pattern values.

5 You can insert events AND'ed or OR'ed with the burst pattern.

As previously mentioned, instead of inserting AND'ed events, add buses/signals to the burst pattern 
whenever possible to conserve trigger resources.

You can OR burst patterns to effectively increase the sample depth of a pattern (for example, find 3 
occurrences of burst A OR burst B OR burst C) provided that the device under test does not send the 
bursts out of order (or you don't care if it does).

Burst Patterns in "If" and "Else If" Clauses

"If" Clauses

The occurrence counter associated with the "If" clause in a trigger sequence step takes action on 
complete burst patterns. For example, you can look for the fifth eventual occurrence of a 4-sample 
burst:
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The "If" clause action occurs after the last sample of the last burst. 

AND'ed events consider complete burst patterns. In the following example, the action occurs after:

• 5 complete bursts during which the flag is set.

"Else If" Clauses

Burst patterns used in "Else If" clauses work the same way as the burst patterns in "If clauses". Unlike 
"If clauses", you cannot set an occurrence counter for a burst pattern in "Else if" clauses. 

Burst Patterns in Default Storage

When a single burst pattern event is specified as default storage, all burst samples that you specify in 
that pattern are stored, when found.
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When a burst pattern is OR'ed with other events, the union of burst samples and other event samples 
are stored.

When a burst pattern is AND'ed with other events, the intersection of burst samples and other event 
samples are stored.
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To negate events

Everywhere in the Advanced Trigger dialog where you can edit or insert events, you can also negate 
the events.

1 Click the  button associated with the events, and choose Negate.

Text in the dialog changes to indicate that events are negated.

See Also • To insert or delete events (see page 168)

To change the evaluation order of AND/OR'ed events
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When specifying advanced triggers (or after converting trigger functions to advanced if/then steps) 
and there are multiple events in an event list, you can specify their evaluation order by grouping the 
events.

1 In the Trigger tab's Trigger Sequence area, select the If, If not, Else if, or Else if not button; then, 
choose Group Events....

2 In the Parenthesis dialog, either select Add Parens button to group events or select Remove 
Parens to ungroup events.

3 When you have finished grouping events, click OK.

See Also • To insert or delete events (see page 168)

To choose between a duration or occurrence count for events (timing mode)

When specifying advanced triggers in the timing mode, you can choose between specifying an 
occurrence count for events or a time that the events must be present for.

1 In the trigger sequence step, select either occurs or present for > to change the setting.

See Also • To convert a trigger sequence step to Advanced If/Then trigger functions (see page 183)
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To insert or delete actions (in a trigger sequence step)

1 In the Advanced Trigger dialog, in a trigger sequence step, click the  button associated with 
an action (after Then), and choose Insert Action After, Insert Action Before, or Delete Action.

2 If inserting an action, select the type of action.

The following action types are available:

• Timer—For starting, stopping, pausing, or resuming a timer, see To insert a timer action (see 
page 179).

• Counter—For incrementing or resetting a counter, see To insert a counter action (see 
page 180).

• Reset occurrence counter—For resetting the occurrence counter, see To insert a reset 
occurrence counter action (see page 180).

• Flag—For setting or clearing a flag, see To insert a flag action (see page 180).

• Storage control—For storing samples or not or for turning on/off default storage, see To insert 
a storage control action (see page 181).

See Also • To insert or delete events (see page 168)

To insert a timer action

1 Select the timer that you want to specify an action for.

2 Specify the timer action by selecting either Start from reset, Stop and reset, Pause, or Resume.

For more information on timers, see Using Timers (see page 153).

NOTE
The Start from reset timer action can be placed in either the same sequence step as the timer 
check event, or it can be placed in a preceding trigger step. Checking a timer without starting it 
will generate an error.
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See Also • To insert or delete actions (in a trigger sequence step) (see page 179)

To insert a counter action

1 Select the counter that you want to specify an action for.

2 Specify the counter action by selecting either Increment or Reset.

For more information on counters, see Using Counters (see page 154).

See Also • To insert or delete actions (in a trigger sequence step) (see page 179)

To insert a reset occurrence counter action

The trigger sequence step below shows how the Reset occurrence counter action is used.

While searching for a number of occurrences of one event, if some other event is found, you can 
reset the occurrence counter and restart the search.

See Also • To insert or delete actions (in a trigger sequence step) (see page 179)

• Understanding Logic Analyzer Triggering, Occurrence Counters (see page 373)

To insert a flag action

1 Select the flag that you want to specify an action for.

2 Specify the flag action by selecting either Set, Clear, Pulse set, or Pulse clear.
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Flags in pulse mode sit in the opposite state when not being pulsed. If you insert a Pulse set 
action for a flag in one module, you cannot insert a Pulse clear action for the same flag in a 
different module.

3 If you selected Pulse set or Pulse clear, enter the pulse width.

For more information on flags, see Using Flags (see page 157).

See Also • To insert or delete actions (in a trigger sequence step) (see page 179)

To insert a storage control action

1 Specify the storage control action by selecting either Store sample, Don't store sample, Turn on 
default storage, or Turn off default storage.

For more information on sequence step storage and storage control actions, see Understanding 
Logic Analyzer Triggering, Storage Qualification (see page 375).

See Also • To insert or delete actions (in a trigger sequence step) (see page 179)

NOTE
Within a module, the same flag cannot be used in both pulse and level (Set/Clear) modes. If a flag 
action is inserted or modified with a different mode than other actions for the same flag, all actions 
for that flag will change to match the new mode.

In case of multiple modules, legacy logic analysis systems allow a particular flag to be set by 
multiple modules. However, in newer AMP/AXIe based instrument modules, only one module can 
set a particular flag. Multiple modules cannot set the same flag.

A flag that is set by a module remains set until that module clears it. In legacy logic analysis 
systems, if multiple modules set the same flag, then all those modules must clear the flag before it 
becomes clear. In newer AMP/AXIe based instrument modules, multiple modules cannot set the 
same flag and therefore, the module that sets the flag can only clear it. 

NOTE
Within a module, a flag's pulse width must be the same in every action for that flag. Whenever the 
pulse width is changed in a flag action, it changes in all other actions for that flag.
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To cut, copy, and paste trigger sequence steps

1 In a trigger sequence step, click Step N and choose Cut, Copy, Paste Before, or Paste After.

There must be at least one step in the trigger sequence.

See Also • To delete trigger sequence steps (see page 182)

To delete trigger sequence steps

1 In a trigger sequence step, click Step N and choose Delete.

There must be at least one trigger sequence step.

To show a trigger sequence step as Advanced If/Then trigger functions

1 In a trigger sequence step, click Step N and choose Show trigger step as if/then (read-only).

The trigger sequence step will be shown as the equivalent Advanced If/Then trigger functions in 
read-only form.

NOTE
The Advanced (If/Then or N-Way Branch) trigger functions do not allow alternative display types. 
By default, they are in the expanded graphical form that cannot be changed.
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To undo a trigger
sequence step

shown as
Advanced If/Then
trigger functions

1 In a trigger sequence step, click Step N and choose the checked Show trigger step as if/then 
(read-only) item to return to the normal view of the trigger function.

See Also • To convert a trigger sequence step to Advanced If/Then trigger functions (see page 183)

To convert a trigger sequence step to Advanced If/Then trigger functions

If the trigger function you need doesn't exist, start with a trigger function that is close, convert the 
trigger sequence step to advanced If/Then trigger functions, and edit the If/Then trigger functions.

1 In a trigger sequence step, click Step N and choose Convert trigger step to if/then (can't undo).

The trigger sequence step will be converted to the equivalent Advanced If/Then trigger functions.

See Also • To show a trigger sequence step as Advanced If/Then trigger functions (see page 182)

• Understanding Logic Analyzer Triggering, Branches (see page 373)

To display or hide "If" clause comments

When using Advanced If/Then trigger functions, you can include comments with the "If" clauses in a 
trigger sequence step. It is useful to have descriptions in complex trigger functions.

NOTE
The Advanced (If/Then or N-Way Branch) trigger functions do not allow alternative display types. 
By default, they are in the expanded graphical form that cannot be changed.
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To show all "If"
clause comments

1 In a trigger sequence step, click Step N and choose If Clause Comments>Show All.

All "If" clause comments are show, including empty comments.

To hide empty "If"
clause comments

1 In a trigger sequence step, click Step N and choose If Clause Comments>Hide Empty.

Empty "If" clause comments are hidden.
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To hide all "If"
clause comments

1 In a trigger sequence step, click Step N and choose If Clause Comments>Hide All.

All "If" clause comments are hidden.

See Also • To convert a trigger sequence step to Advanced If/Then trigger functions (see page 183)

To clear the trigger sequence

1 In the Advanced Trigger dialog, click Clear at the bottom of the dialog.
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Triggering From, and Sending Triggers To, Other Modules/Instruments

ARM In from modules

You can cause the trigger from one module to arm another module installed in the same chassis or in 
a chassis/logic analysis system (interconnected via multi-frame cables in a multi-frame setup). Refer 
to the topic “To arm one module with another module's trigger" on page 186 to know about ARM In 
feature in detail.

External triggering

You can also send a module's trigger signal to an external instrument, or you can allow a signal from 
an external instrument to arm a module.

There are Trigger In and Trigger Out BNC connectors located on the logic analyzer (front panel of 
AXIe chassis for the U4154A/B module). Use these connectors to connect the analyzer to an external 
instrument and either send or receive a trigger signal. To know more about external triggering, refer 
to the topics “To trigger other instruments - Trigger Out" on page 191 and “To trigger analyzer from 
another instrument - Trigger In" on page 192.

To arm one module with another module's trigger

A module can receive ARM In from a single or multiple modules installed in the same chassis or in an 
interconnected chassis of a multiframe setup. To use this ARM In feature, you use the Wait for arm 
from another module trigger function in the Advanced Trigger dialog. This topic describes various 
ARM In scenarios.

ARM In from a module to another module in the same/different chassis

1 Click  in the analyzer setup toolbar, or choose Setup>(Logic Analyzer Module)>Advanced 
Trigger... from the menu bar.

2 In the Advanced Trigger dialog (see page 424), select the Other trigger functions tab; then, 
drag-and-drop the Wait for arm from another module trigger function into the trigger sequence 
area.

3 From the module name drop-down, select the module whose trigger will arm this module (and 
satisfy the event condition in the trigger sequence step).

4 Click OK in the Advanced Trigger dialog.

The arming setup in the Overview window looks like:
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5 Run the measurement (see Running/Stopping Measurements (see page 196)).

When the arm from another module (U4154A/B-2 in this case) is received, the module 
(U4154A/B-1 in this case) takes the action(s) described in its trigger sequence step.
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And vice-versa

You may have a situation where you have two modules looking for trigger events, and when either 
module finds its trigger event, the other should be armed. To do this:

1 Set up the first module's trigger:

2 Set up the second module's trigger:

NOTE
You can create an ARM In trigger in the same manner (as described above) 
between modules installed in different chassis of a multiframe setup. In a 
multiframe setup, flags are consumed for each ARM IN trigger configuration that 
you create. There are 4 flags available. If all these flags are unused, then you can 
create a maximum of four ARM In configurations across the connected chassis 
of the multiframe chain. An example of two ARM In configurations in a 
multiframe setup is displayed below.
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The arming setup in the Overview window looks like:

3 Run the measurement.

ORed ARM In from multiple modules to a module in the same chassis

You can set the trigger configurations of a module to receive ARM In from multiple modules in the 
same chassis. On doing so, the trigger configuration acts as an ORed combination of ARM In from 
multiple modules. Any of the selected modules can send ARM In to trigger the module. In such a 
scenario, the trigger configuration of the module receiving the ARM In consists of multiple Wait for 
arm from another module trigger sequence steps as displayed below.

The arming setup in the Overview window looks like:
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As displayed in the above figure, an ORed ARM In trigger is represented by multiple unidirectional 
lines merging together before pointing to the destination module receiving the ARM In. 

ORed ARM In from multiple modules to a module in a multiframe setup

You can also set the ORed ARM In for a module from multiple modules in other connected chassis of 
a multiframe setup. To create an ORed ARM In in a multiframe scenario, you need to create multiple 
Wait for arm from another module trigger sequence steps for the receiving module. The following 
screen displays the ORed ARM In trigger for the U4154A/B-2 modules from three modules in a 
multiframe setup.
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See Also • Wait for arm from another module (state) (see page 499)

• Wait for arm from another module (timing) (see page 487)

To trigger other instruments - Trigger Out

1 Connect a BNC cable from the Trigger Out BNC to the external instrument you want to trigger.

2 Choose Setup>External Trigger....

3 In the External Trigger dialog (see page 437):

• Enable the output.

• Select the polarity (active high or active low).

• Select the output mode (use feedthrough to see flag settings on the output).

• Select the trigger and flag events that cause Trigger Out.

• Click OK.

4 Configure the logic analyzer as you would normally for any other measurement.
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5 When the analyzer's trigger sequence becomes true and the analyzer triggers, a trigger signal is 
sent out through the Trigger Out BNC to the external instrument.

Correlating the external instrument to your logic analyzer

If you are using a 16850-series or a U4154-series logic analyzer then the Trig Out value in the Status 
dialog will help you correlate the external instrument to your 16850-series or U4154-series analyzer.

The Trig Out column in the Status dialog box provides a time measurement that you can use to 
correlate the trace captured on the logic analyzer with a second analyzer or a scope. 

This time represents the time interval from a trigger condition appearing on a probe tip of the 
analyzer to the occurrence of a trigger pulse on the Trigger Out BNC.

This value varies depending upon the number of channels in the analyzer and the State speed of the 
target or the Timing Speed selected for the measurement. Knowing this Trig Out time will allow you 
to properly correlate an external scope or other analyzer.

This time is calculated only for the 16850-series and the U4154- series of analyzers.

If you are using a Keysight multiframe cable between your analyzers or you have added an external 
Keysight Oscilloscope with the “Setup->Add External Oscilloscope” to your measurement, then the 
correlation of the instruments will be determined automatically.

See Also • External Trigger Dialog (see page 437)

To trigger analyzer from another instrument - Trigger In

1 Connect a BNC cable from the TRIGGER IN BNC to the external instrument that will send the 
trigger signal.

2 Choose Setup>External Trigger....

3 In the External Trigger dialog (see page 437), specify whether a rising or falling edge on the 
Trigger In BNC will indicate a trigger; then, click OK.

4 Click  in the analyzer setup toolbar, or choose Setup>(Logic Analyzer Module)>Advanced Trigger... 
from the menu bar.

5 In the Advanced Trigger dialog (see page 424), select the Other trigger functions tab; then, 
drag-and-drop the Wait for external arm trigger function into the trigger sequence area.
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6 Click OK in the Advanced Trigger dialog, and run the measurement (see Running/Stopping 
Measurements (see page 196)).

7 Run the measurement on the external instrument.

When the arm from the external instrument is received, the logic analyzer takes the actions 
described in the trigger sequence step.

See Also • Wait for external arm (state) (see page 498)

• Wait for external arm (timing) (see page 486)

• External Trigger Dialog (see page 437)
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Storing and Recalling Triggers

Triggers are stored in three ways:

• Automatically, after measurements are run, to the recently-used list.

• By storing them (see page 194) to the favorites list.

• By storing them (see page 194) to XML format trigger specification files.

You can recall triggers (see page 194) from the recently-used list, the favorites list, or from 
XML-format trigger specification files.

You can move recently-used triggers to the favorites list (see page 195).

You can control the length of the recently-used and favorites list by setting the trigger history depth 
(see page 195).

To store a trigger

1 Choose the Setup>(Logic Analyzer Module)>Store Trigger... command, or in the Advanced 
Trigger dialog, click Store....

2 In the Store Trigger dialog:

To store the trigger in the favorites list:

a Enter the name of the trigger.

b Click Store as favorite.

To store the trigger in an XML format file:

a Click Save to file....

b In the Save As dialog, enter the name of the file, and click Save.

See Also • To recall a trigger (see page 194)

• To set the trigger history depth (see page 195)

To recall a trigger

1 Choose Setup>(Logic Analyzer Module)>Recall Trigger... from the menu, or in the Advanced 
Trigger dialog, click Recall....

2 In the Recall Trigger dialog (see page 453):

• Select the desired trigger from the favorites or recently-used list; then, click OK.

• Or, to recall a trigger from a previously saved XML format trigger specification file, click Open... 
and select the file.

NOTE
The current trigger setup (and the favorites list) are stored as part of the logic analyzer 
configuration. If you load a new configuration file, the trigger setup (and the favorites list) will be 
overwritten.
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To move a
recently-used
trigger to the
favorites list

1 Choose Setup>(Logic Analyzer Module)>Recall Trigger... from the menu.

2 In the Recall Trigger dialog (see page 453), select the trigger from the recently-used list.

3 Click Store Selected Recent Trigger To Favorites List.

See Also • To store a trigger (see page 194)

To set the trigger history depth

1 Choose the Edit>Options... command.

2 In the Options dialog, enter the Trigger History Depth.

The number you enter is used for both the recently-used trigger list and the favorites list.

See Also • To store a trigger (see page 194)

• To recall a trigger (see page 194)
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Running/Stopping Measurements

To run the analyzer
in single run mode

The single run measurement captures data and fills trace memory one time. The amount of data 
stored during a single run is equal to the amount of trace memory allotted. For example, if trace 
memory is equal to 2M, the amount of data stored after one run is equal to 2M.

• From the menu bar, choose Run/Stop>Run, or click the  icon from the run/stop toolbar (see 
page 401).

See also To save captured data after each run (see page 196) below.

To run the analyzer
in repetitive run

mode

The run repetitive measurement captures data and fills trace memory repetitively. The amount of 
data stored in a repetitive run is the same as a single run. During a repetitive run, once the trace 
memory is full, the system clears the trace memory and begins to refill with new data. This cycle 
continues until the run is stopped.

• From the menu bar, choose Run/Stop>Run Repetitive, or click the  icon from the run/stop 
toolbar (see page 401).

See also To save captured data after each run (see page 196) and To stop repetitive runs after a 
certain number of acquisitions (see page 196) below.

To view analyzer
run status

• From the menu bar, choose Run/Stop>Status..., or click Status... in the status bar.

The run status is displayed in the System Status tab of the Status dialog (see page 469).

To stop the
analyzer

When a measurement is stopped, the amount of data gathered is equal to the amount of trace 
memory used up until the stop occurred. For example, if trace memory is equal to 2M and the 
measurement is stopped exactly half way through the run, the amount of data in trace memory 
would equal 1M.

• From the menu bar, choose Run/Stop>Stop, or click the  icon from the run/stop toolbar (see 
page 401).

To save captured
data after each run

1 From the menu bar, choose Run/Stop>Run Properties....

2 In the Run Properties dialog (see page 454), check Save after every acquisition and set the 
additional options for saving data after each run; then, click OK.

3 Run the analyzer in either single run mode or repetitive run mode.

To stop repetitive
runs after a certain

number of
acquisitions

1 From the menu bar, choose Run/Stop>Run Properties....

2 In the Run Properties dialog (see page 454), check Stop running after and enter the number of 
acquisitions; then, click OK.

3 Run the analyzer in repetitive run mode.

See Also • To change the "Go to Trigger on Run" option (see page 196)

• Run Properties Dialog (see page 454)

To change the "Go to Trigger on Run" option

After a measurement is run and it completes, the default behavior of the Keysight Logic Analyzer 
application is to display the data captured around the system trigger.

NOTE
If you are repeatedly making measurements and looking at data some fixed time after the trigger 
(for example), you can change the "go to trigger on run" behavior (see page 196) so that the 
location being displayed doesn't change after each measurement.
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If you are repeatedly making measurements and looking at data some fixed time after the trigger (for 
example), you can change the "go to trigger on run" behavior so that the location being displayed 
doesn't change after each measurement.

1 Choose Edit>Options....

2 In the Options dialog (see page 447), check or uncheck the Go to Trigger on Run box.

Option settings are saved in the registry; this means your changes will be present the next time 
you start the Keysight Logic Analyzer application.
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Saving Captured Data (and Logic Analyzer Setups)

You can save logic analyzer setups and captured data to configuration files. Later, the configuration 
files can be opened to set up the logic analyzer and re-load the data. When saving configuration 
files, you can choose to save only the logic analyzer setup (that is, without the data).

You can also save captured data to comma-separated value (CSV) files.

• To save a configuration file (see page 198)

• To export data to standard CSV format files (see page 199)

• To export data to module CSV format files (see page 201)

• To export data to module binary (ALB) format files (see page 203)

To save a configuration file

The save feature allows you to save a configuration file for later use. The first time a file is saved the 
logic analyzer configuration file dialog box will appear. The Save As... feature allows an existing 
configuration file to be saved under a different name.

1 From the menu bar, select File>Save or select the  icon in the standard toolbar (see 
page 398).

2 Enter the File name.

3 Select the Save as type.

For information on when to use the ALA (*.ala) format and when to use the XML (*.xml) format, 
see ALA vs. XML, When to Use Each Format (see page 380).

4 If you are saving as an XML format file, select the Source.

You can save configuration information and data from all modules or individual modules.

5 If desired, fill-in the Owner, Project, and Description fields under the file header information. 
These fields help identify the configuration file when it is reopened.
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6 Select the file options:

• All Data and Setup — if you wish to save captured data and instrument settings.

• Setup Only — if you wish to save only the instrument settings and not the captured data.

• Range — if you wish to save instrument settings and a range of captured data. Click 
Properties...; in the Range Properties dialog, specify the range.

7 Click Save.

See Also • To open a configuration file (see page 208)

• Offline Analysis (see page 217)

• ALA vs. XML, When to Use Each Format (see page 380)

• ALA Format (see page 504)

• "XML Format" (in the online help)

To export data to standard CSV format files

You can export captured data to standard comma-separated value (CSV) files.

1 From the menu bar, select File>Export....

2 In the Export dialog, select Standard CSV text file; then, click OK.

3 In the following Export dialog:

NOTE
Configuration files that include data are much larger than files that do not contain data.

NOTE
If you are using the logic analyzer without a keyboard, you can access an on-screen keyboard by 
selecting Start>Programs>Accessories>Accessibility>On-Screen Keyboard.
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a Enter the CSV file name.

b Select the Source module, tool, or display window from which to export data.

c If you want to use a delimiter other than a comma, or if you want to specify that line numbers 
be written, click Options.... In the File Export Options dialog, make your selections; then, click 
OK.

d If you want to export a range of data and/or selected bus/signal data, uncheck All Data.

e To specify a range of data to export, click Data Range.... In the Data Range tab of the Range 
Properties dialog, select the range by time or by markers; then, click OK.
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f To select certain bus/signal data to export, click Bus Signal Selection.... In the Bus/Signal 
Selection tab of the Range Properties dialog, select the buses/signals whose data you want to 
export; then, click OK.

4 Click Save.

See Also • Standard CSV Format (see page 504)

To export data to module CSV format files

You can export captured data to module comma-separated value (CSV) files. Module CSV files can 
be post-processed.

NOTE
You can only choose particular buses/signals when a module or tool is selected as the Source of 
the data export. When a display window is selected as the Source, all buses/signals are exported. 
(You can, however, delete unwanted buses/signals from a display window before exporting its 
data.)

CAUTION
Do not modify module CSV files with Microsoft Excel.
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1 From the menu bar, select File>Export....

2 In the Export dialog, select Module CSV text file; then, click OK.

3 In the following Export dialog:

a Enter the CSV file name.

b Select the Source module from which to export data.

You can export data to module CSV format files from logic analyzer. You can export timing 
zoom data from a logic analyzer module, but it must be exported separately from the module's 
main data.

c If you want to use a delimiter other than a comma, if you want to specify that line numbers be 
written, or if you want to exclude the header information, click Options.... In the File Export 
Options dialog, make your selections; then, click OK.
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Header-less files may be easier for external tools to use.

d If you want to export a range of data and/or selected bus/signal data, uncheck All Data.

e To specify a range of data to export, click Data Range.... In the Data Range tab of the Range 
Properties dialog, select the range by time or by markers; then, click OK.

f To select certain bus/signal data to export, click Bus Signal Selection.... In the Bus/Signal 
Selection tab of the Range Properties dialog, select the buses/signals whose data you want to 
export; then, click OK.

4 Click Save.

See Also • Module CSV Format (see page 504)

To export data to module binary (ALB) format files



6 Capturing Data from the Device Under Test

204 Keysight Logic and Protocol Analyzer User Guide

You can export captured data to module binary files.

1 From the menu bar, select File>Export....

2 In the Export dialog, select Module binary file; then, click OK.

3 In the following Export dialog:

a Enter the ALB file name.

b Select the Source module from which to export data.

You can export data to module binary format files from logic analyzer modules only. You can 
export timing zoom data from a logic analyzer module, but it must be exported separately from 
the module's main data.

c If you want to exclude the header information, click Options.... In the File Export Options 
dialog, make your selections; then, click OK.
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Header-less files may be easier for external tools to use.

d If you want to export a range of data and/or selected bus/signal data, uncheck All Data.

e To specify a range of data to export, click Data Range.... In the Data Range tab of the Range 
Properties dialog, select the range by time or by markers; then, click OK.

f To select certain bus/signal data to export, click Bus Signal Selection.... In the Bus/Signal 
Selection tab of the Range Properties dialog, select the buses/signals whose data you want to 
export; then, click OK.

4 Click Save.

See Also • Module Binary (ALB) Format (see page 511)
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Extending Capture Capability with COM/DCOM

With the integrated COM/DCOM, you can extend the data capture capabilities of the logic analyzer. 
For example:

• In the case that the logic analyzer isn't able to trigger on the event of interest, COM/DCOM can be 
used to do a run, analyze the captured data looking for the event and if not found, run again. For 
events that are relatively frequent, this allows the logic analyzer to find events that are too 
complex to be able to define a trigger.

• In situations where you need a lot of data to find an elusive fault, you can set up the logic analyzer 
to repetitively run and save data.

• You can create dynamic triggers between repetitive runs by performing a run, modifying the 
trigger based on analysis of the captured data, and then running again.

These are all things you could previously do with the logic analyzer's COM automation capabilities; 
however, it's easier and more convenient now that COM/DCOM is integrated with the Keysight Logic 
Analyzer application.

See Also • "Using the Advanced Customization Environment (ACE)" (in the online help)
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Loading Saved Data and Setups

You can set up the logic analyzer and load data by opening previously saved configuration files. This 
lets you return to the stopping point of a previous logic analysis session, load previously saved data 
for offline analysis, or just load saved logic analyzer setups. When opening configuration files that 
contain data, you can choose to load only the logic analyzer setup (that is, without the data).

• To open a configuration file (see page 208)

• To recall a recently used configuration file (see page 210)

• To transfer module setups to/from multi-module systems (see page 210)

• To transfer module setups to/from multi-module systems (see page 210)

• Using Data Import Modules (see page 211)

• To create a data import module (see page 211)

• To edit data import module bus/signal definitions (see page 213)

• To view data import module file information (see page 215)

• To re-read data import module files (see page 215)

See Also • Offline Analysis (see page 217)

To open a configuration file

You can open configuration files to return to a previous logic analysis session, to load previously 
saved data for offline analysis, or to load saved logic analyzer setups.

A quick way to start the Keysight Logic Analyzer application and open a configuration file is by 
double-clicking an ALA format configuration file in Windows Explorer. (An association for the .ala file 
extension was set up when the application was installed.) When you do this, however, there are no 
options for partial loading (setup only, modules only, etc.).

NOTE
To avoid pod truncation (see page 616) when opening configuration files for offline analysis, open 
the configuration file in a second instance of the Keysight Logic Analyzer application (which runs in 
Offline mode).
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To open a configuration file from within the Keysight Logic Analyzer application:

1 From the menu bar, select File>Open... or select the  icon in the standard toolbar (see 
page 386).

The file browser portion of the Open dialog behaves the same as other standard Windows file 
browser dialogs (that is, you can rename files, use right-mouse operations, etc.).

2 Select the type of configuration file you wish to open (either *.ala or *.xml).

For information on when ALA (*.ala) and XML (*.xml) formats are used, see ALA vs. XML, When to 
Use Each Format (see page 380).

3 Select the name of the configuration file you wish to open.

The Content, Date, Version, Owner, Project, and Description fields show information about the 
selected configuration file. The file was created with the Keysight Logic Analyzer version shown in 
the Version field. The Date field displays the date the configuration file was created.

4 Select the appropriate Setup/Data option.

• Select All Data and Setup to load the logic analyzer setup and data.

• Select Setup Only to load only the logic analyzer setup.

5 Select the appropriate Tools/Viewers option.

• Select Include Tools/Viewers to load tools and viewers, as well as modules, from the 
configuration file.

• Select Modules Only to load only the module information from the configuration file.

6 Select Open.

NOTE
If you are using the logic analyzer without a keyboard, you can access an on-screen keyboard by 
selecting Start>Programs>Accessories>Accessibility>On-Screen Keyboard.
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See Also • To recall a recently used configuration file (see page 210)

• To save a configuration file (see page 198)

• To transfer module setups to/from multi-module systems (see page 210)

• Offline Analysis (see page 217)

• ALA vs. XML, When to Use Each Format (see page 380)

• ALA Format (see page 504)

• "XML Format" (in the online help)

To recall a recently used configuration file

1 From the menu bar, select File.

2 Select the configuration file you wish to open from the list provided.

To transfer module setups to/from multi-module systems

You can move logic analyzer setups from one logic analysis system to another by saving/opening 
setups to/from configuration files. When systems have multiple modules, you must map which 
module setup from the configuration file gets loaded into which module in the logic analysis system.

1 Make sure the setup (configuration file) you want to load is in the proper format:

• If the modules are compatible (for example, in the same or similar logic analyzer families), you 
can use ALA format configuration files to move a setup from one module to another.

• If the modules are not compatible, you must use XML format configuration files to move a 
setup from one module to another.

2 Open the configuration file (see To open a configuration file (see page 208)).

3 Answer the question about clearing all modules before loading.

4 In the Module Mapping dialog (see page 444), select Manually specify module mapping; then, 
click Specify Mapping....

5 In the Specify Mapping dialog (see page 468), for the module you want load the setup into, select 
the module setup from the configuration file to load.

6 Click OK to close the Specify Mapping dialog.

7 Click OK to close the Module Mapping dialog and load the setup.

When loading module setups from XML format configuration files, an information dialog 
describes any parsing errors or warnings.

See Also • To save a configuration file (see page 198)
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• To open a configuration file (see page 208)

• ALA vs. XML, When to Use Each Format (see page 380)

Using Data Import Modules

Data import modules read data from module CSV or module binary (ALB) files and make it available 
to tools and display windows. Module CSV or module binary (ALB) files can be created by external 
tools or saved from any module using the main menu's File>Export... command.

• To create a data import module (see page 211)

• To edit data import module bus/signal definitions (see page 213)

• To view data import module file information (see page 215)

• To re-read data import module files (see page 215)

Data import modules (and import file names) are saved with logic analyzer configurations (both ALA 
and XML format). If a configuration is saved "with data" and then opened again, the import module's 
data is present, and is not re-read from the import file. If a configuration is saved "without data" 
(setup only) and opened again, you must re-read the data import module file (see To re-read data 
import module files (see page 215)).

See Also

• To export data to module CSV format files (see page 201)

• Module CSV Format (see page 510)

• To export data to module binary (ALB) format files (see page 203)

• Module Binary (ALB) Format (see page 505)

To create a data import module

1 From the menu bar, select File>Import....

2 In the Import dialog, select Module CSV text file or Module binary file, and click OK.

NOTE
Data import modules are a licensed feature. You can use data import modules without a 
license, but the amount of data that can be imported is limited to 16 rows.

NOTE
Copy module CSV or module binary (ALB) files to the local hard disk before importing them. 
Performance of the Agilent Logic Analyzer application is much better when importing files 
from the local hard disk than when importing them from a network drive.
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In the following Import dialog:

a Select or enter the File name of the data file you wish to import.

b Select the Destination of the data file you wish to import. You can choose an existing data 
import module or "<New Data Import Module>".

c Click Open.

Data import modules appear in the Overview window like other logic analyzer modules. Because the 
data does not come from acquisition hardware in a logic analysis system frame, a virtual frame is 
created for data import modules. You can add tools and display windows to data import modules just 
like you add them to logic analyzer modules.
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See Also

• To edit data import module bus/signal definitions (see page 213)

• To view data import module file information (see page 215)

• To re-read data import module files (see page 215)

• Module CSV Format (see page 505)

• To export data to module CSV format files (see page 201)

• Module Binary (ALB) Format (see page 505)

• To export data to module binary (ALB) format files (see page 203)

To edit data import module bus/signal definitions

1 Click  in the data import toolbar, or choose Setup>(Data Import Module)>Bus/Signals... from the 
menu bar.

2 In the Import Setup dialog's Buses/Signals tab (see page 442):
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Notice that pods are created for data value columns in the imported data file. These are like pods in 
logic analyzer modules except they can be any bit width.

When editing bus/signal definitions in an import module, you can:

• Add a new bus or signal.

• Delete a bus or signal.

• Rename a bus or signal.

• Assign channels in the default bit order.

• Assign channels, selecting the bit order.

• Reorder bits by editing the Channels Assigned string.

• Set the default number base.

• Set the polarity.

• Add comments.

• Add a folder.

• Alias a bus/signal name.

• Sort bus/signal names.

These operations are just like defining buses and signals in logic analyzer modules (see Defining 
Buses and Signals (see page 104)).

Through the Display button, you can select what bus/signal setup information is displayed (channels 
assigned, width, polarity, default base, comment, or channel numbers).

The bus and signal icons in the Bus/Signal Name column are normally red, but they turn gray if the 
bus/signal is locked by an inverse assembler.

See Also

• To view data import module file information (see page 215)

• To re-read data import module files (see page 215)

• Module CSV Format (see page 510)
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To view data import module file information

1 Click  in the data import toolbar, or choose Setup>(Data Import Module)>File Info... from the 
menu bar.

2 In the Import Setup dialog's File Information tab (see page 443):

• The file name and other file information is displayed.

• The time column and trigger row are displayed. The trigger correlation offset is displayed.

• The module data import file's column name, width, type, and format are displayed.

See Also

• To edit data import module bus/signal definitions (see page 213)

• To re-read data import module files (see page 215)

• Module CSV Format (see page 510)

To re-read data import module files

When you create a data import module, data is read from the imported file. You can also cause the 
data import file to be re-read without going through the file selection dialog again.

To re-read the data import file

Do one of the following:

• From the menu bar, choose Run/Stop>(Data Import Module)>Read.

• Click the  icon from the data import toolbar (see page 400) or from the data import module in 
the Overview window.

To view data import module read status

From the menu bar, choose Run/Stop>Status..., or click Status... in the status bar.

The read status is displayed in the System Status tab of the Status dialog (see page 542).

See Also
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• To view data import module file information (see page 215)
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Offline Analysis

Offline analysis lets you analyze captured data while the logic analyzer's data acquisition hardware is 
used for making other measurements.

You can use the Keysight Logic Analyzer application on stand-alone personal computers, 
16850-series logic analysis systems to perform offline analysis.

By placing configuration/data files on shared file systems, offline analysis can be performed from 
remote locations on the network.

Example: A typical scenario is to use the Keysight Logic Analyzer application to configure and 
exchange logic analyzer configuration files containing trigger setups with a team of colleagues 
located on-site or in remote locations.

General offline
analysis

considerations

• When analyzing data offline, there is no data acquisition hardware, so functions such as 
triggering, hardware assist, and run functions are not available.

• Multiple instances of the Keysight Logic Analyzer application can be displayed side-by-side on a 
logic analyzer or a personal computer, but their data cannot be time-correlated.

• You can install the Keysight Logic Analyzer on any computer meeting the minimum PC 
requirements (see page 218); however, licensed tools require a license for each computer they run 
on.

For more specific information about offline analysis, see:

• Offline Analysis on Logic Analyzers (see page 217)

• Offline Analysis on Personal Computers (see page 218)

To return to online analysis, see:

• Connecting to a Logic Analysis System (see page 59)

See Also • Offline File Formats (see page 218)

Offline Analysis on Logic Analyzers

You can perform offline analysis with 16850-series logic analyzers, in general, by running a second 
instance of the Keysight Logic and Protocol Analyzer application and loading previously saved data 
into that instance. With two instances of the application running, one in online (either Local or 
Remote) mode and one in Offline mode, you can continue making measurements in one instance 
while you perform offline analysis in the other.

Keep these things in mind when performing offline analysis with a logic analyzer or logic analysis 
system:

• You can start multiple instances of the Keysight Logic Analyzer application.

If logic analyzer acquisition hardware is present, the first instance opens in online (either Local or 
Remote) mode. If acquisition hardware is not present, the first instance opens in Offline mode.

• Logic analyzer run functions do not work in Offline mode.

• In the Offline mode, you can continue to create triggers and save them in configuration files that 
can be opened by other instances of the Keysight Logic Analyzer application.

• If you open a logic analyzer configuration (.ala) file for offline analysis in an online (either Local or 
Remote) instance of the Keysight Logic Analyzer application, run functions will overwrite the data 
that has been loaded.

NOTE
To open, copy, or save files directly from shared disk drives, make sure to configure all LAN 
connections (see page 315) to enable file sharing.
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See Also • To open a configuration file (see page 208)

• To save a configuration file (see page 198)

Offline Analysis on Personal Computers

A personal computer (PC) with the Keysight Logic Analyzer application installed can perform offline 
analysis on configuration files (.ala format) from any 16850-series logic analysis system.

When using the Keysight Logic Analyzer application by itself on a PC for offline analysis:

• The logic analyzer run functions are not available (because there is no acquisition hardware).

• You can save logic analyzer setups (including trigger sequences) to .ala format configuration files, 
and you can pass these files between personal computers (running the Keysight Logic Analyzer 
application).

• You can have more than one instance of the Keysight Logic Analyzer application running.

• Licensed tools require a license for each computer they run on.

See Also • To open a configuration file (see page 208)

• To save a configuration file (see page 198)

• Minimum PC Requirements (see page 218)

Minimum PC Requirements

Minimum PC requirements for offline analysis:

• Processor and Memory: 1 GHz processor, 512 M RAM.

• Operating System: 

• Windows Vista

• Windows 7

• Windows 8

• Windows 8.1

• Windows 10

• Windows Server 2008

• Windows Server 2008 R2

• Windows Server 2012

• Windows Server 2012 R2

Offline File Formats

.ala Format You can open logic analyzer configuration files (.ala (see page 504) extension) for offline analysis. 
These files are saved by the Keysight Logic Analyzer application.

The logic analyzer configuration (.ala) file format is an internal format used by the Keysight Logic 
Analyzer application for saving and re-opening setups and data. ALA format configuration files 
contain everything that is needed to restore a session (in other words, the information necessary to 
reconstruct the display appearance, instrument settings, and optionally, captured data).

NOTE
To open, copy, or save files directly from shared disk drives, make sure to configure all LAN 
connections (see page 315) to enable file sharing.
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.xml Format Generic configuration files (".xml" (in the online help) extension) can be used when setting up the 
logic analysis system configuration. XML format configuration files are saved by the Keysight Logic 
Analyzer application.

The generic configuration (.xml) file format is an eXtensible Markup Language format that can be 
edited (using an ASCII text editor) and post-processed by scripts (or other tools) and re-opened by 
the Keysight Logic Analyzer application. These files contain buses/signals, channels assigned to 
buses/signals, and user-defined symbols.

CSV Format You can export captured data to CSV (Comma-Separated Values) Format (see page 504) files (.csv 
extension) for offline analysis in other applications like Excel. These files contain buses/signals and 
data.
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Analyzing Waveform Data

The Waveform window displays captured data as a digital waveform. You can configure the window 
to display selected buses and signals with time or pattern markers in the data. You can also set up 
bus pattern triggers and signal trigger options.

The Waveform window is accessed through the menu bar's Window>Waveform command. If you 
have Tabbed Windows (see page 313) turned on, you can also select a tab at the bottom of the 
window.

• To change the display scale (time/division) (see page 221)

• To go to different locations in the captured data (see page 222)

• To re-arrange waveforms (see page 223)

• To overlay waveforms (see page 223)

• To find a bus/signal row (see page 224)

• To view bus data as a chart (see page 224)

• To show/hide parts of the waveform display (see page 226)

• To insert or delete buses/signals (see page 227)

• To group signals into a bus (see page 227)

• To expand/collapse buses (see page 227)

• To insert separator rows (see page 227)

• Changing Waveform Window Properties (see page 227)

• To change the waveform background color (see page 228)

• To change the overlaid waveform color (see page 228)

• To change the filtered data color (see page 229)

• To change the timing zoom background color (see page 229)

• To change the waveform font size (see page 229)

• To change the Fast Zoom In option (see page 230)

• To lock scrolling with other display windows (see page 229)

• To change the waveform tool tip display (see page 230)

• Changing Bus/Signal Row Properties (see page 230)

• To change a waveform's color (see page 231)

• To change a waveform's height (see page 232)

• To change a bus/signal's number base (see page 232)
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• To show/hide a bus/signal's numeric data values (see page 232)

• Changing Analog Signal Row Properties (see page 233)

• To change the analog properties (see page 234)

See Also • Defining Buses and Signals (see page 83)

• Setting Up Quick (Draw Box) Triggers (see page 143)

• Specifying Simple Triggers (see page 146)

• Marking, and Measuring Between, Data Points (see page 245)

• Setting Up Symbols (see page 132)

• Displaying Names (Symbols) for Bus/Signal Values (see page 243)

• Searching the Captured Data (see page 264)

To change the display scale (time/division)

The Waveform window displays data similarly to an oscilloscope, that is, waveforms on a horizontal 
time axis. Therefore, to zoom in or out on a waveform, you simply change the Scale (time/division) of 
the time axis that the waveform is viewed with.

To change the
scale by clicking
the zoom out/in

buttons

1 Click the zoom out/in buttons to raise/lower the time/division scale.

The scale ranges from 1 ps/div to 1 ks/div.

You can also change the time/division by entering a numeric value in the Scale field.

To zoom in by
drawing a

rectangle in the
data

1 Point the mouse to the upper-left corner of the desired view area; then, click and hold while 
moving the mouse to the lower-right corner; then, release the mouse button.

2 If the Fast Zoom In (see page 230) option is not selected, choose Zoom In from the popup menu.

The new display scale is adjusted to the width of the box drawn.

To center about
edges

1 Position the mouse cursor over a waveform, between the edges you want to center the display 
about.

2 Right-click and choose Center About>Edges.
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The new display scale is adjusted to the width of the waveform edges.

To go to different locations in the captured data

In the Waveform display window, you can go to different locations in the captured data by using the 
horizontal scroll bars, by using the Delay field and buttons, or by choosing Go To commands from 
popup menus.

To go to different
locations by

changing the delay

1 Click one of the buttons in the Delay field or enter a delay value.

The delay adjusts the display window relative to the waveform data. The display window's relative 
position in time is dependent on the trigger point, and the beginning and end of data. Use the 
following delay controls to position the display window over the desired data.
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To go to different
locations using

popup menus

1 Right-click in the waveform display area, and choose one of the Go To commands.

Or, click in the marker overview bar, and choose one of the Go To commands.

You can choose Beginning Of Data, End Of Data, Trigger, a marker, a Time, or a Sample.

To re-arrange waveforms

1 Position the mouse pointer over the bus/signal name associated with the waveform you want to 
move.

2 Click and hold the mouse button.

3 Drag-and-drop the bus/signal to its new position.

The name is placed above the red position indicator that appears.

See Also • To overlay waveforms (see page 223)

• To expand/collapse buses (see page 227)

To overlay waveforms

Menu Description

Use the keypad to enter a numeric value. If the value you enter is greater than or less 
than the time of the data range, the window will be moved to the beginning or end 
limit.

Moves the window over the beginning of data.

Scrolls the window towards the beginning of data.

Moves the window over the trigger point.

Scrolls the window towards the end of data.

Moves the window over the end of data.
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Use the Overlay feature to place multiple bus or signals into one row of displayed data. When 
multiple signals are overlaid, you can see the relationships visually between all signals. The overlaid 
bus or signal is drawn first, then the main bus/signal is drawn last as to overwrite the overlaid 
bus/signals for clarity.

1 Right-click on the bus or signal you want to overlay another bus or signal onto, then select 
Overlay....

2 From the Overlay selection dialog that appears, select the bus or signal you want to overlay onto 
the highlighted bus or signal.

You can overlay analog signals (from an “ external oscilloscope module" (in the online help)) with 
digital signals or with other analog signals.

3 If you want to change the color of the overlaid bus or digital signal, see To change the overlaid 
waveform color (see page 228).

When analog signals are overlaid onto other signals, the overlay signal color comes from the 
external oscilloscope module's setup options (which you can access by right-clicking the analog 
signal name, choosing Assign Channels..., and selecting the " Options tab" (in the online help)) 
instead of the Waveform window's overlay color setting.

To find a bus/signal row

When there are many bus/signal rows in the Waveform display window, you can search for a 
particular bus/signal row instead of scrolling through all the rows.

1 In the Waveform display window, right-click in the Bus/Signal column, and choose Find 
Bus/Signal....

2 In the Find Bus/Signal dialog, enter the name (or part of the name) of the bus/signal you wish to 
find.

3 Then, click:

• Prev — to search for the string backward in the bus/signal rows.

• Next — to search for the string forward in the bus/signal rows.

• Close — to close the Find Bus/Signal dialog.

To view bus data as a chart

NOTE
The scaling for an original analog signal is used for all signals overlaid onto its row; therefore, if 
user-defined scaling and offset values are used, it is possible that overlaid signals may not be 
visible. When automatic scaling is used, it will take into account the minimum and maximum 
voltages of all overlaid signals, and all signals will be visible.
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You can view bus data values as a chart instead of the conventional bus shape.

1 In the Waveform display window, right-click on a bus name, and choose View As Chart....

Or, in the Waveform Properties dialog's Row Properties tab, for the Bus property, click View As....

2 In the View As dialog, set the following options:

• Show Axis — causes a small axis, which represents the center of the range of values being 
displayed, to be drawn in the center of the waveform. When checked, you can also change the 
axis color.

• Connect Samples — causes lines to be drawn between samples.

• Lock to Setup — sets the range limits based on the width of the bus. For example, an 8-bit bus 
is set to a range of 0-255.

• Max/Min — sets the range limits of the displayed axis.

• Show Clipped — enables out-of-range data values to be displayed in a user-defined color.
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To view bus data as
a bus

You can return the bus waveform appearance to a conventional bus shape.

1 In the Waveform display window, right-click on a bus name, and choose View As Bus....

Or, in the Waveform Properties dialog's Row Properties tab, for the Bus property, click View As....

2 In the View As dialog, check or uncheck the following options as desired:

• MSB Ordering — the ordering of the signals in the bus are changed from least significant bit 
first to most significant bit first.

• Expand into signals — expands the bus into individual signals (as if you selected the Expand (+) 
field to the left of the bus name).

See Also • Changing Bus/Signal Row Properties (see page 230)

To show/hide parts of the waveform display

1 Right-click in the Bus/Signal column of the Waveform display, and choose Display>.

Then, check or uncheck one of the following to show or hide that part of the Waveform display 
window:

• Activity Indicators — either a low bar (low level), high bar (high level), or a transition arrow 
(transitioning signal) displayed to the left of bus/signal names.

• Simple Trigger — the Simple Trigger column.

• Markers — the markers display bar (see page 407).

• Time Axis — the time axis (and column headings).

You can also make these selections in the Display Options area of the Waveform Properties 
dialog's Window Properties tab.

See Also • Changing Waveform Window Properties (see page 227)

NOTE
Because there is no hardware to accelerate chart drawing, Waveform windows that have charts 
draw slowly. You may want to place buses viewed as charts in a separate Waveform window.
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To insert or delete buses/signals

To insert
buses/signals

1 In the Waveform display window, right-click in the Bus/Signal column; then, choose Insert Row.

2 In the Insert dialog, select the buses/signals you want to insert; then, click OK.

To delete selected
buses/signals

1 In the Bus/Signal column, highlight the buses/signals you want to delete (by clicking, 
Shift-clicking, or Ctrl-clicking the bus/signal names).

2 Right-click in the Bus/Signal column; then, choose Delete>Row.

See Also • Defining Buses and Signals (see page 83)

To group signals into a bus

1 While holding the shift key down, click on all desired signals.

2 With the mouse pointer over any one of the highlighted signals, right-click and select Group into 
Bus.

To expand/collapse buses

In the Waveform display window's Bus/Signal column:

• Click the "+" or "-" symbol associated with a bus.

• Right-click the bus, and choose Expand or Collapse.

See Also • Defining Buses and Signals (see page 83)

To insert separator rows

To add distance between waveforms, you can add separator rows to the Waveform display window.

1 In the Waveform display window, right-click in the Bus/Signal column; then, choose Insert 
Separator.

Separator rows can be sized, colored, re-arranged, and deleted just like bus/signal waveform rows.

Changing Waveform Window Properties
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You can change properties that affect the entire Waveform display window.

1 Right-click in a blank area of the waveform display, and choose Properties....

Or, with no bus/signal names selected, choose Edit>Window Properties... from the main menu.

2 In the Waveform Properties dialog's Window Properties tab:

You can:

• Change the waveform background color (see page 228)

• Change the overlaid waveform color (see page 228)

• Change the filtered data color (see page 229)

• Change the timing zoom background color (see page 229)

• Change the waveform font size (see page 229)

• Lock scrolling with other display windows (see page 229)

• Show/hide parts of the waveform display (see page 226)

• Change the accumulate waveforms option (see page 229)

• Change the Fast Zoom In option (see page 230)

• Change the waveform tool tip display (see page 230)

3 Click OK to apply the changes and close the Waveform Properties dialog.

See Also • Changing Bus/Signal Row Properties (see page 230)

To change the waveform background color

1 In the Waveform Properties dialog's Window Properties tab, select the Background color, click 
the selection button, and select the desired background color from the palette.

If you want to use a color that is not on the palette, click Other... to access the custom color 
dialog.

2 Click OK to apply the changes and close the Waveform Properties dialog.

To change the overlaid waveform color

When buses/signals are overlaid (see To overlay waveforms (see page 223)), the overlay property 
specifies the color used for the overlaid waveforms.

1 In the Waveform Properties dialog's Window Properties tab, select the Overlay color, click the 
selection button, and select the desired overlaid waveform color from the palette.

If you want to use a color that is not on the palette, click Other... to access the custom color 
dialog.

2 Click OK to apply the changes and close the Waveform Properties dialog.
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To change the filtered data color

When a filter tool is used to hide data from the Waveform display window, cross-hatching appears at 
locations where data is hidden; the filter property specifies the color used for the cross-hatched 
areas.

1 In the Waveform Properties dialog's Window Properties tab, select the Filter color, click the 
selection button, and select the desired filter color from the palette.

If you want to use a color that is not on the palette, click Other... to access the custom color 
dialog.

2 Click OK to apply the changes and close the Waveform Properties dialog.

To change the timing zoom background color

You can give waveforms from the timing zoom feature a different background color than other 
waveforms.

1 In the Waveform Properties dialog's Window Properties tab, select the TimingZoom color, click 
the selection button, and select the desired timing zoom background color from the palette.

If you want to use a color that is not on the palette, click Other... to access the custom color 
dialog.

2 Click OK to apply the changes and close the Waveform Properties dialog.

To change the waveform font size

The font size property adjusts the data display, bus/signal, and simple trigger text size.

1 In the Waveform Properties dialog's Window Properties tab, enter the desired Font Size.

Fonts can range from size 6 through 72 points.

2 Click OK to apply the changes and close the Waveform Properties dialog.

As the font size is changed, the row height may be automatically increased to fit the new text size.

To lock scrolling with other display windows

You can lock display windows (for example, Waveform, Listing, Compare, etc.) so that when one 
window is scrolled, others are scrolled as well, such that the same time is centered in each display.

1 In the Waveform Properties dialog's Window Properties tab, click Lockstep Windows....

2 In the Lockstep Windows dialog, select the display windows whose scrolling should be locked 
with this window and specify any offset from this window.

3 Click OK to close the Lockstep Windows dialog.

4 Click OK to apply the changes and close the Waveform Properties dialog.

To accumulate waveforms

1 In the Waveform Properties dialog's Window Properties tab's Display Options area, check or 
uncheck Accumulate to specify whether waveforms are accumulated on the display.

2 Click OK to apply the changes and close the Waveform Properties dialog.

When the accumulate option is enabled and you run repetitively, waveforms overlay previously 
captured waveforms.
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To clear accumulated waveforms, click Clear Accumulation at the top of the Waveform window.

To change the Fast Zoom In option

When the Fast Zoom In option is selected, you can drag the mouse cursor over the area you want to 
zoom in on, and when you release the mouse button, the zoom happens immediately, without having 
to select Zoom In from a popup menu.

1 In the Waveform Properties dialog's Window Properties tab, select or deselect the Fast Zoom In 
option.

2 Click OK to apply the changes and close the Waveform Properties dialog.

See Also • To change the display scale (time/division) (see page 221)

• To set a Quick Trigger in the Waveform window (see page 143)

• To quickly find bus signal patterns (see page 264)

To change the waveform tool tip display

A tool tip (that is, a small box with text) can appear when the mouse pointer is over a waveform and 
held motionless for a second.

1 In the Waveform Properties dialog's Window Properties tab's Display Options area, check or 
uncheck Show Tooltip Values to specify whether bus/signal values are shown as tool tips.

If Show Tooltip Values is checked, check or uncheck Transition Width to specify whether transition 
(or pulse) width values are included in the tool tips.

2 Click OK to apply the changes and close the Waveform Properties dialog.

Changing Bus/Signal Row Properties
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In the Waveform display window, you can change the color or size of a waveform, and you can 
choose whether numeric values are displayed with the waveform.

To change the properties of a waveform in the Waveform window:

1 Right-click on a bus/signal name or on a waveform, and choose Properties....

Or, highlight the buses/signals whose properties you want to change (by clicking, Shift-clicking, 
or Ctrl-clicking the bus/signal names), and choose Edit>Window Properties... from the main 
menu.

2 In the Waveform Properties dialog's Row Properties tab:

You can:

• Select the Bus/Signal to which the property changes apply. You can select:

• Any bus/signal name that has been assigned (see Defining Buses and Signals (see 
page 83)).

• <all> buses/signals.

• <selected> buses/signals if more than one is highlighted in the Bus/Signal column.

• Change a waveform's color (see page 231)

• Change a waveform's height (see page 232)

• Change a bus/signal's number base (see page 232)

• Show/hide a bus/signal's numeric data values (see page 232)

• View bus data as a chart or a bus (see page 224)

3 Click OK to apply the changes and close the Waveform Properties dialog.

See Also • Changing Waveform Window Properties (see page 227)

To change a waveform's color

1 In the Waveform Properties dialog's Row Properties tab, click the Color selection button and 
select the desired waveform color from the palette.

If you want to use a color that is not on the palette, click Other... to access the custom color 
dialog.

2 Click OK to apply the changes and close the Waveform Properties dialog.

NOTE
Property changes to a bus affect all signals within the bus. For example, if you change the color of 
a bus and then expand the bus, you will see that the color is changed for all signals in the bus.
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See Also • Changing Analog Signal Row Properties (see page 233)

To change a waveform's height

1 In the Bus/Signal column of the Waveform display window, position the mouse pointer over a row 
separator line; when the cursor changes to a resizing cursor, drag the row border.

Or:

1 In the Waveform Properties dialog's Row Properties tab, enter the Height value in pixels.

The minimum row height is set by the font size (see To change the waveform font size (see 
page 229)). The maximum height is 1000 pixels.

2 Click OK to apply the changes and close the Waveform Properties dialog.

See Also • Changing Analog Signal Row Properties (see page 233)

To change a bus/signal's number base

When a bus/signal's numeric data values are displayed (see To show/hide a bus/signal's numeric 
data values (see page 232)), the base property specifies the number base to use.

1 In the Waveform Properties dialog's Row Properties tab, select the desired number Base from:

• Binary

• Hex

• Octal

• Decimal

• Signed Decimal (two's complement)

• Ascii

• Symbol (see Displaying Names (Symbols) for Bus/Signal Values (see page 243))

2 Click OK to apply the changes and close the Waveform Properties dialog.

To show/hide a bus/signal's numeric data values

You can display (and specify the color of) numeric data values with a waveform.

1 In the Waveform Properties dialog's Row Properties tab, check or uncheck Show Values to show 
or hide numeric data values with the waveform.

If Show Values is checked, click the color selection button and select the desired data value color 
from the palette.

If you want to use a color that is not on the palette, click Other... to access the custom color 
dialog.

NOTE
If an analog signal from an external oscilloscope module (see External Oscilloscope Time 
Correlation and Data Display help) column has been selected instead of a data column, then:

- Amperage is used as the Base for the signal's data if you have enabled the Current Probe 
checkbox for this signal in the External Oscilloscope Setup dialog box. 

- Voltage is used as the Base for the signal's data if you have NOT enabled the Current Probe 
checkbox for this signal in the External Oscilloscope Setup dialog box. 

NOTE
If the waveform time scale is small, "..." may appear in the data value to indicate that more text will 
be displayed if you expand the scale.
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2 Click OK to apply the changes and close the Waveform Properties dialog.

See Also • Changing Analog Signal Row Properties (see page 233)

Changing Analog Signal Row Properties

In the Waveform display window, you can change the color or size of an analog signal waveform, and 
you can choose whether voltage and volts/division values are displayed with the waveform. Analog 
signals come from an external oscilloscope module (see " External Oscilloscope Time Correlation and 
Data Display" (in the online help)).

To change the properties of an analog signal waveform in the Waveform window:

1 Right-click on an analog signal name or on a waveform, and choose Properties....

Or, highlight the analog signals whose properties you want to change (by clicking, Shift-clicking, 
or Ctrl-clicking the analog signal names), and choose Edit > Window Properties... from the main 
menu.

2 In the Waveform Properties dialog's Row Properties tab:

You can:

• Select the Bus/Signal to which the property changes apply. You can select:

• Any bus/signal name that has been assigned (see Defining Buses and Signals (see 
page 83)).

• <all> buses/signals.

• <selected> buses/signals if more than one is highlighted in the Bus/Signal column.

• Change a waveform's color (see page 231)

• Change a waveform's height (see page 232)

• Show/hide a signal's numeric data values (see page 232)

• Change the analog properties (see page 234)
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3 Click OK to apply the changes and close the Waveform Properties dialog.

See Also • To change Y-Axis Marker properties (see page 262)

To change the analog properties

You can change the properties of an analog signal in the Waveform display window.

1 In the Waveform Properties dialog's Row Properties tab, for the Analog property, click 
Properties....

2 In the Analog Properties dialog, set the following options:

• Scaling — you can select Automatic (to have the voltage/Amperage scale and offset 
automatically set) or User Defined (to be able to set your own voltage/amperage scale and 
offset values). Be careful not to enter scale and offset values that will move the waveform out 
of the display area. In this section, Amperage is used as the unit if you have enabled the 
Current Probe checkbox for this signal in the External Oscilloscope Setup dialog box. Voltage 
is used as the unit if you have NOT enabled the Current Probe checkbox for this signal in the 
External Oscilloscope Setup dialog box. 

• Grid Style/Color — you can select None, Axis (to have axis lines drawn through the center of 
the waveform display area), or Grid (to have grid lines drawn for voltage and time divisions). If 
you choose axis or grid, you can specify its color.

• Connect Samples — specifies whether lines are drawn between waveform data sample points.

• Show Clipped — enables out-of-range data values to be displayed in a user-defined color.

NOTE
The Base field is disabled because for analog signals:

- Amperage is used as the Base for the signal's data if you have enabled the Current Probe 
checkbox for this signal in the External Oscilloscope Setup dialog box. 

- Voltage is used as the Base for the signal's data if you have NOT enabled the Current Probe 
checkbox for this signal in the External Oscilloscope Setup dialog box. 
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Analyzing Listing Data

The Listing window displays your captured data as a state listing. You configure the window to 
display selected buses and signals in columns. Within the listed data, you can insert time or pattern 
markers. You can also configure the bus pattern triggers and signal trigger options.

The Listing window is accessed through the menu bar's Window>Listing. If you have Tabbed 
Windows (see page 313) turned on, you can also select a tab at the bottom of the window.

• To go to different locations in the captured data (see page 236)

• To re-arrange bus/signal columns (see page 237)

• To find a bus/signal column (see page 237)

• To show/hide parts of the listing display (see page 237)

• To insert or delete buses/signals (see page 238)

• Changing Listing Window Properties (see page 238)

• To change the listing background color (see page 239)

• To change the timing zoom background color (see page 239)

• To change the listing font size (see page 239)

• To lock scrolling with other display windows (see page 239)

• To show/hide the center rectangle (see page 239)

• Changing Bus/Signal Column Properties (see page 240)

• To change a bus/signal's data color (see page 240)

• To change the width of a bus/signal column (see page 241)

• To change the alignment of a bus/signal column (see page 241)

• To change a bus/signal's number base (see page 241)

• To select the marker for marker-relative times (see page 242)

• To select fixed time units (see page 242)

See Also • Defining Buses and Signals (see page 83)

• Setting Up Quick (Draw Box) Triggers (see page 143)

• Specifying Simple Triggers (see page 146)

• Marking, and Measuring Between, Data Points (see page 245)

• Setting Up Symbols (see page 132)

• Displaying Names (Symbols) for Bus/Signal Values (see page 243)
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• Searching the Captured Data (see page 264)

To go to different locations in the captured data

In the Listing display window, you can go to different locations in the captured data by using the 
vertical scroll bars, by using the Go To buttons on the standard toolbar, or by choosing Go To 
commands from popup menus.

To go to different
locations using
toolbar buttons

1 Click one of the Go To buttons in the standard toolbar.

To go to different
locations using

popup menus

1 Right-click in the waveform display area, and choose one of the Go To commands.

Or, click in the marker overview bar, and choose one of the Go To commands.

You can choose Beginning Of Data, End Of Data, Trigger, a marker, a Time, or a Sample.

Menu Description

Go to Beginning — centers the beginning of the acquisition data.

Go to Trigger — centers the trigger point of the acquisition.

Go to End — centers the end of the acquisition data.
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To re-arrange bus/signal columns

1 Position the mouse pointer over the bus/signal name associated with the column you want to 
move.

2 Click and hold the mouse button.

3 Drag-and-drop the bus/signal to its new position.

The name is placed to the left of the red position indicator that appears.

To find a bus/signal column

When there are many bus/signal columns in the Listing display window, you can search for a 
particular bus/signal column instead of scrolling through all the columns.

1 In the Listing display window, right-click in any Bus/Signal column heading, and choose Find 
Bus/Signal....

2 In the Find Bus/Signal dialog, enter the name (or part of the name) of the bus/signal you wish to 
find.

3 Then, click:

• Prev — to search for the string backward in the bus/signal columns.

• Next — to search for the string forward in the bus/signal columns.

• Close — to close the Find Bus/Signal dialog.

To show/hide parts of the listing display

1 Right-click in the Bus/Signal column heading of the Listing display, and choose Display>.

Then, check or uncheck one of the following to show or hide that part of the Listing display 
window:

• Activity Indicators — either a low bar (low level), high bar (high level), or a transition arrow 
(transitioning signal) displayed to the left of bus/signal names.

• Column Base — the number base row in the column headings.

• Simple Trigger — the Simple Trigger row in the column headings (see Specifying Simple 
Triggers (see page 146)).

• Markers — the markers display bar (see page 407).
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You can also make these selections in the Display Options area of the Listing Properties dialog's 
Window Properties tab.

See Also • Changing Listing Window Properties (see page 238)

To insert or delete buses/signals

To insert
buses/signals

1 In the Listing display window, right-click in the Bus/Signal column headings; then, choose Insert 
Column.

2 In the Insert dialog, select the buses/signals you want to insert; then, click OK.

To delete selected
buses/signals

1 Highlight the headings of the bus/signal columns you want to delete (by clicking, Shift-clicking, 
or Ctrl-clicking the bus/signal names).

2 Right-click in an empty area of the column headings row; then, choose Delete>Column.

To delete all
buses/signals

1 Right-click anywhere in the column headings row; then, choose Delete>All Columns.

See Also • Defining Buses and Signals (see page 83)

Changing Listing Window Properties

You can change properties that affect the entire Listing display window.

1 Right-click in a blank area of the listing display, and choose Properties....

Or, with no bus/signal names selected, choose Edit>Window Properties... from the main menu.

2 In the Listing Properties dialog's Window Properties tab:

You can:

• Change the listing background color (see page 239)

• Change the timing zoom background color (see page 239)

• Change the listing font size (see page 239)

• Lock scrolling with other display windows (see page 239)

• Show/hide the center rectangle (see page 239)

• Show/hide parts of the listing display (see page 237)

3 Click OK to apply the changes and close the Listing Properties dialog.

See Also • Changing Bus/Signal Column Properties (see page 240)
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To change the listing background color

1 In the Listing Properties dialog's Window Properties tab, click the Background color selection 
button and select the desired background color from the palette.

If you want to use a color that is not on the palette, click Other... to access the custom color 
dialog.

2 Click OK to apply the changes and close the Listing Properties dialog.

To change the timing zoom background color

In the Listing display window, you can give columns from the timing zoom feature a different 
background color than other bus/signal data columns.

1 In the Listing Properties dialog's Window Properties tab, click the TimingZoom color selection 
button and select the desired timing zoom background color from the palette.

If you want to use a color that is not on the palette, click Other... to access the custom color 
dialog.

2 Click OK to apply the changes and close the Listing Properties dialog.

To change the listing font size

The font size property adjusts the data display, bus/signal, and simple trigger text size.

1 In the Listing Properties dialog's Window Properties tab, enter the desired Font Size.

Fonts can range from size 6 through 72 points.

2 Click OK to apply the changes and close the Listing Properties dialog.

As the font size is changed, the column width may be automatically increased to fit the new text size.

To lock scrolling with other display windows

You can lock display windows (for example, Waveform, Listing, Compare, etc.) so that when one 
window is scrolled, others are scrolled as well, such that the same time is centered in each display.

1 In the Listing Properties dialog's Window Properties tab, click Lockstep Windows....

2 In the Lockstep Windows dialog, select the display windows whose scrolling should be locked 
with this window and specify any offset from this window.

3 Click OK to close the Lockstep Windows dialog.

4 Click OK to apply the changes and close the Listing Properties dialog.

To show/hide the center rectangle

The center rectangle is the box that is drawn around the one sample displayed at center of the 
screen.

1 In the Listing Properties dialog's Window Properties tab's Center Rectangle area, check or 
uncheck Display Rectangle to specify whether the center rectangle is shown or hidden.

If Display Rectangle is checked, click the color selection button and select the desired center 
rectangle color from the palette.

If you want to use a color that is not on the palette, click Other... to access the custom color 
dialog.

2 Click OK to apply the changes and close the Listing Properties dialog.
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Changing Bus/Signal Column Properties

In the Listing display window, you can change the color, width, alignment, or number base of 
bus/signal data columns.

To change the properties of a bus/signal data column in the Listing window:

1 Right-click on a bus/signal name or on a waveform, and choose Properties....

Or, highlight the buses/signals whose properties you want to change (by clicking, Shift-clicking, 
or Ctrl-clicking the bus/signal names), and choose Edit>Window Properties... from the main 
menu.

2 In the Listing Properties dialog's Column Properties tab:

You can:

• Select the Bus/Signal to which the property changes apply. You can select:

• Any bus/signal name that has been assigned (see Defining Buses and Signals (see 
page 83)).

• <all> buses/signals.

• <selected> buses/signals if more than one column is highlighted.

• Change a bus/signal's data color (see page 240)

• Change the width of a bus/signal column (see page 241)

• Change the alignment of a bus/signal column (see page 241)

• Change a bus/signal's number base (see page 241)

• Select the marker for marker-relative times (see page 242)

• Select fixed time units (see page 242)

3 Click OK to apply the changes and close the Listing Properties dialog.

See Also • Changing Listing Window Properties (see page 238)

To change a bus/signal's data color

1 In the Listing Properties dialog's Column Properties tab, click the Color selection button and 
select the desired bus/signal data color from the palette.

If you want to use a color that is not on the palette, click Other... to access the custom color 
dialog.

2 Click OK to apply the changes and close the Listing Properties dialog.
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To change the width of a bus/signal column

1 In the bus/signal headings row of the listing display window, position the mouse pointer over a 
column separator line; when the cursor changes to a resizing cursor, drag the column border.

Or:

1 In the Listing Properties dialog's Column Properties tab, enter the Width value in pixels.

The minimum column width is 1 pixel, while the maximum width is 1000 pixels.

2 Click OK to apply the changes and close the Listing Properties dialog.

To change the alignment of a bus/signal column

The Alignment property sets the display of data to be left-justified, right-justified, or centered within 
the column.

1 In the Listing Properties dialog's Column Properties tab, select the Alignment from:

• Left

• Center

• Right

2 Click OK to apply the changes and close the Listing Properties dialog.

To change a bus/signal's number base

The base property specifies the number base to use when displaying the captured data.

1 In the Listing Properties dialog's Column Properties tab, select the desired number Base from:

• Binary

• Hex

• Octal

• Decimal

• Signed Decimal (two's complement)

• Ascii

• Symbol (see Displaying Names (Symbols) for Bus/Signal Values (see page 243))

TIP You can autosize individual columns by placing the mouse pointer over the right border of the 
column header box; then, when the pointer icon changes to a resizing pointer, double-click.

TIP If your keyboard has a numeric keypad, you can autosize all columns by selecting any column 
header box (to highlight it) and by pressing Ctrl and "+" on the numeric keypad.

NOTE
If the Time column has been selected instead of a data column, your choices change from a 
numeric format to Absolute, Relative Previous, or Relative Marker.
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2 Click OK to apply the changes and close the Listing Properties dialog.

To select the marker for marker-relative times

In the Listing window, you can display times relative to a marker.

1 In the Listing Properties dialog's Column Properties tab, use the Bus/Signal selection to select 
the Time column.

2 For the Base property, select Relative Marker.

3 For the Marker property, select the marker to which relative times should be displayed.

4 Click OK to apply the changes and close the Listing Properties dialog.

To select fixed time units

In the Listing window, you can display time column values with a fixed unit.

1 In the Listing Properties dialog's Column Properties tab, use the Bus/Signal selection to select 
the Time column.

2 In the Time Column Properties box, check Use Fixed Unit; then, select the desired time unit from 
the drop-down list.

3 Click OK to apply the changes and close the Listing Properties dialog.

NOTE
If an analog signal from an external oscilloscope module (see External Oscilloscope Time 
Correlation and Data Display help) column has been selected instead of a data column, then:

- Amperage is used and displayed as the Base for the signal's data if you have enabled the Current 
Probe checkbox for this signal in the External Oscilloscope Setup dialog box. 

- Voltage is used and displayed as the Base for the signal's data if you have NOT enabled the 
Current Probe checkbox for this signal in the External Oscilloscope Setup dialog box. 
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Displaying Names (Symbols) for Bus/Signal Values

You can display a bus or signal using meaningful names rather than numeric values.

Symbols can be displayed in Waveform, Listing, Compare, and Source windows.

To display symbols:

1 Set up the symbols (see page 132).

2 Change the number base (see page 241) of the bus or signal to Symbols.

If the symbol is defined as a range, values in the range will be displayed with an offset from the 
lowest end of the range.

If the definitions of several symbols overlap, the first one listed in the Symbols dialog has precedence 
over the others.

In the Waveform display, "..." will be shown when the full name of the symbol will not fit into the 
space available.

Once you have set up symbols, it's usually a good idea to save (see page 198) the logic analyzer 
configuration. The symbol definitions will be stored as part of the configuration.

Example Here is what "My Bus 1" looks like before defining any symbols:
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When the symbols have been defined, they are shown in the Symbols dialog:

Here is what the bus looks like after the symbols are defined:
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Marking, and Measuring Between, Data Points

Once a marker is created, you can use it as a reference point in the data when measuring intervals or 
viewing the data value at the marker.

• To read the markers display and overview bars (see page 245)

• To create new markers (see page 246)

• To place markers in data (see page 247)

• To go to a marker (see page 249)

• To center the display about a marker pair (see page 249)

• To change a marker's snap to edge setting (see page 250)

• To delete a marker (see page 250)

• To create a new time interval measurement (see page 251)

• To create a new sample interval measurement (see page 252)

• To create a new value at measurement (see page 253)

• To rename a marker (see page 254)

• To send a marker to the back (see page 254)

• Changing Marker Properties (see page 255)

• To change a marker's background color (see page 256)

• To change a marker's foreground color (see page 256)

• To hide/show a marker (see page 256)

• To change a marker's lock in viewer setting (see page 256)

• To lock a marker relative to another marker (see page 257)

• To add comments to a marker (see page 257)

• Using Y-Axis Markers for Analog Signals (in the Waveform Display) (see page 257)

• To create new Y-Axis markers (see page 258)

• To place Y-Axis markers (see page 259)

• To delete Y-Axis markers (see page 260)

• To create a new Y-Axis interval measurement (see page 260)

• To rename a Y-Axis marker (see page 261)

• To send a Y-Axis marker to the back (see page 261)

• To change Y-Axis marker properties (see page 262)

See Also • Markers Display Bar (see page 407)

• Marker Measurement Display Bar (see page 403)

• Markers Menu (see page 391)

• Markers Toolbar (see page 400)

To read the markers display and overview bars
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In the upper markers display bar (see page 407), markers are color coded and displayed with arrows 
that point to the marker's location relative to the displayed data.

In the lower markers overview bar (see page 408), markers are displayed as color coded bars that 
show the location relative to the complete captured data set.

In the Waveform window (as shown above), the markers display and overview bars appear on the top 
and bottom of the window. In the Listing window, the markers display and overview bars appear on 
the left and right sides of the window in a similar way.

To create new markers

When creating a new marker, you can give it a name, specify its color, position it in the data, and add 
comments. Up to 1024 markers can be created.

1 From the menu bar, select Markers>New....

2 In the New Marker dialog, enter the marker name.

You can specify both a long name and an abbreviated name by using the "Long 
name[abbreviated name]" syntax; for example, "Location A[A]". When an abbreviated name is 
used, it appears on the marker in the marker display bar (see page 407) while the long name 
appears in the marker tool tip (see page 619).

3 Select the marker's background and foreground colors.

4 Specify the position of the new marker in the data by:

• Time - positions the marker by a time value from a reference point. Reference points are the 
Trigger, Beginning of Data, End of Data, or another marker.

TIP You can quickly display a different region of data by clicking on the markers overview bar at the 
bottom (waveform) or right side (listing) and selecting Go To Here from the popup menu.
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• Sample - positions the marker by a number of samples from a reference point. Reference 
points are the Trigger, Beginning of Data, End of Data, or another marker.

• Value - positions the marker at an occurrence of a bus/signal pattern. Click Occurs... to 
specify the bus/signal pattern value.

Bus/signal pattern specification is the same as when searching the captured data (see 
page 264).

5 Enter comments for the marker.

Comments appear in the marker's tool tip (see page 619).

6 Click OK.

See Also • To place markers in data (see page 247)

• To go to a marker (see page 249)

• To read the markers display and overview bars (see page 245)

• To center the display about a marker pair (see page 249)

• To delete a marker (see page 250)

• To rename a marker (see page 254)

• To send a marker to the back (see page 254)

• To change a marker's snap to edge setting (see page 250)

• Changing Marker Properties (see page 255)

To place markers in data

Use Place Markers to quickly position a marker in the data. Depending on how you access the Place 
Markers feature, the marker is placed in the data a little differently. You can also move markers by 
dragging them with the mouse or by using the front-panel knobs.

• To drag and drop markers in data (see page 247)

• To place marker at the mouse cursor (see page 248)

• To place marker at center screen (see page 248)

• To change a marker's position property (see page 248)

• You can also place markers where data is found when searching (see To specify "found" marker 
placement (see page 272)).

To drag and drop
markers in data

Using the drag and drop feature you can move markers to new positions in the data.

1 Click and hold down the mouse button on the marker you wish to move.

2 Move the mouse cursor to the new position.

When moving a marker in the Waveform display window, if the mouse cursor is over a waveform 
and the marker's Snap to Edge property is enabled, the cursor changes to a green "direction 
arrow" indicating the direction of the next valid edge. A yellow "cross hair" target is placed on the 
edge at which the marker will be placed if you decide to release the mouse button. If you don't 
want the marker to snap to an edge, move the mouse cursor so that it is not over any waveforms 
before releasing the mouse button.

3 Release the mouse button to reposition the marker.

NOTE
An enabled Snap to Edge property affects a marker's placement in the Waveform window if the 
mouse cursor is over a waveform when dragging and dropping or when placing at the mouse 
cursor.
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To place marker at
the mouse cursor

1 Point the mouse to the desired data point in the display.

2 Right-click, and select Place Marker>Time>(desired marker).

If the mouse cursor is over a waveform and the marker's Snap to Edge property is enabled, the 
marker is placed at nearest waveform edge; otherwise, the marker is placed at the mouse cursor 
location.

To place marker at
center screen

1 From the menu bar click Markers>Place On Screen....

2 In the Place Marker dialog, select the desired marker.

You can sort the list of markers by clicking on the Name, Position, or Comment column headings.

3 Click OK.

The marker will be placed at mid-screen.

To change a
marker's position

property

1 Right-click on a marker, and choose Properties....

Or, when viewing a display window that has markers, choose Markers>Properties... from the 
main menu.

2 In the display window properties dialog's Time Marker Properties tab, select the Marker to which 
the property changes apply.

3 In the Position box, select what to position the marker by:

• Time - positions the marker by a time value from a reference point. Reference points are the 
Trigger, Beginning of Data, End of Data, or another marker.

• Sample - positions the marker by a number of samples from a reference point. Reference 
points are the Trigger, Beginning of Data, End of Data, or another marker.

• Value - positions the marker at an occurrence of a bus/signal pattern. Click Occurs... to 
specify the bus/signal pattern value.

Bus/signal pattern specification is the same as when searching the captured data (see 
page 264), except you can click Properties... to open the Value Properties dialog. In the Value 
Properties dialog:

• Check Stop repetitive run if you want to stop a repetitive run when the specified 
bus/signal pattern is found (or not found).

• Check Send e-mail if you want to send an e-mail when the specified bus/signal pattern is 
found (or not found); then, click the E-mail... button. In the E-mail dialog (see page 432), 
enter the address to which e-mail will be sent, the subject, and the text of the message.

4 Click OK to apply the changes and close the properties dialog.

See Also • To specify "found" marker placement (see page 272) (for placing markers where data is found)

• To create new markers (see page 246)

• To go to a marker (see page 249)
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• To read the markers display and overview bars (see page 245)

• To center the display about a marker pair (see page 249)

• To delete a marker (see page 250)

• To rename a marker (see page 254)

• To send a marker to the back (see page 254)

• To change a marker's snap to edge setting (see page 250)

• Changing Marker Properties (see page 255)

To go to a marker

To quickly find a previously set marker in the data, or to go to the beginning of data, end of data, or 
the trigger point:

• Click in the markers display bar (see page 407) or the markers overview bar (see page 408), and 
choose Go To from the popup menu.

Or:

1 From the menu bar, select Markers>Go To... or select the  icon in the markers toolbar (see 
page 400).

2 In the Go To Marker dialog, select the marker you wish to find from the list provided.

You can sort the list of markers by clicking on the Name, Position, or Comment column headings.

3 Click OK.

The selected marker appears at the center of the display.

See Also • To create new markers (see page 246)

• To place markers in data (see page 247)

• To center the display about a marker pair (see page 249)

• To delete a marker (see page 250)

• To rename a marker (see page 254)

• To send a marker to the back (see page 254)

• To change a marker's snap to edge setting (see page 250)

• Changing Marker Properties (see page 255)

To center the display about a marker pair

Use the center about feature to center the display around a selected marker pair. If the marker pair is 
separated by a large time or sample amount, the scale of the display is automatically changed so 
both markers appear on screen.
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Since the center about feature centers the display around a pair (two) markers, if you have three or 
more markers defined, you will have available choices for all possible combinations of two.

1 From the menu bar, select Markers>Center About....

2 In the Center About dialog, select the desired marker combination.

3 Click OK.

The data between the two markers is displayed.

See Also • To create new markers (see page 246)

• To place markers in data (see page 247)

• To go to a marker (see page 249)

• To delete a marker (see page 250)

• To rename a marker (see page 254)

• To send a marker to the back (see page 254)

• To change a marker's snap to edge setting (see page 250)

• Changing Marker Properties (see page 255)

To change a marker's snap to edge setting

1 In a display window with markers, right-click on the marker, and choose Snap to Edge.

Or, in the display window properties dialog's Time Marker Properties tab, check or uncheck Snap 
to Edge to enable or disable the marker's snap to edge behavior.

See Also • To place markers in data (see page 247)

• Changing Marker Properties (see page 255)

To delete a marker

• In the markers display bar (see page 407), click the marker you want to delete, and choose Delete 
from the popup menu (or choose Delete All to delete all markers).

Or:

1 From the menu bar, select Markers>Delete....

2 In the Delete Marker dialog, select the markers you wish to delete.

You can sort the list of markers by clicking on the Name, Position, or Comment column headings.

3 Click OK.

See Also • To create new markers (see page 246)

• To place markers in data (see page 247)
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• To go to a marker (see page 249)

• To center the display about a marker pair (see page 249)

• To rename a marker (see page 254)

• To send a marker to the back (see page 254)

• To change a marker's snap to edge setting (see page 250)

• Changing Marker Properties (see page 255)

To create a new time interval measurement

Use the new time interval measurement feature to measure a time interval between two specified 
points in the captured data. Measurement results are displayed in the marker measurement display 
bar (see page 403).

1 From the menu bar select Markers>New Time Interval Measurement, or click the  icon in the 
markers toolbar (see page 400).

2 In the Time Interval dialog, select the markers you want to measure time between.

3 To specify interval properties, click Properties....

In the Interval Properties dialog:

• Check Stop repetitive run if you want to stop a repetitive run when the specified interval value 
is measured.

• Check Send e-mail if you want to send an e-mail when the specified interval value is 
measured; then, click the E-mail... button. In the E-mail dialog (see page 432), enter the 
address to which e-mail will be sent, the subject, and the text of the message.

• Check Show statistics if you want to show repetitive run statistics.

NOTE
If you have selected a "System Trigger - (module)" or "Trigger - (module)" marker, make sure you 
uncheck the First module to trigger designates the System Trigger option in the Module Skew 
and System Trigger dialog (see page 446). Otherwise, during a run, the system trigger could switch 
from one module to another, causing the module markers to be re-assigned and any 
measurements using these markers to be deleted.
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• Check Show as frequency if you want to show the measured frequency of changes in the 
interval.

• Click OK when you are done specifying interval properties.

4 Click OK to close the Time Interval dialog.

The result of the interval measurement is displayed in the marker measurements display bar:

If statistics are shown, the low, high, and average interval measurements are included.

See Also • To create a new sample interval measurement (see page 252)

• To create a new value at measurement (see page 253)

To create a new sample interval measurement

Use the new sample interval measurement feature to measure the number of samples between two 
specified points in the captured data. Measurement results are displayed in the marker measurement 
display bar (see page 403).

1 From the menu bar select Markers>New Sample Interval Measurement, or click the  icon in 
the markers toolbar (see page 400).

2 In the Sample Interval dialog, select the markers you want to measure samples between, and 
select the bus/signal.

3 To specify interval properties, click Properties....

CAUTION
If you have selected a "System Trigger - (module)" or "Trigger - (module)" marker as one of the 
markers you want to measure time between, make sure you uncheck the First module to trigger 
designates the System Trigger option in the Module Skew and System Trigger dialog (see 
page 446). Otherwise, during the repetitive run, the system trigger could switch from one module 
to another, causing you to lose all the statistical data you have accumulated.

NOTE
If you have selected a "System Trigger - (module)" or "Trigger - (module)" marker, make sure you 
uncheck the First module to trigger designates the System Trigger option in the Module Skew 
and System Trigger dialog (see page 446). Otherwise, during a run, the system trigger could switch 
from one module to another, causing the module markers to be re-assigned and any 
measurements using these markers to be deleted.
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In the Interval Properties dialog:

• Check Stop repetitive run if you want to stop a repetitive run when the specified interval value 
is measured.

• Check Send e-mail if you want to send an e-mail when the specified interval value is 
measured; then, click the E-mail... button. In the E-mail dialog (see page 432), enter the 
address to which e-mail will be sent, the subject, and the text of the message.

• Check Show statistics if you want to show repetitive run statistics.

• Click OK when you are done specifying interval properties.

4 Click OK to close the Sample Interval dialog.

The result of the interval measurement is displayed in the marker measurements display bar:

If statistics are shown, the low and high interval measurements are included.

See Also • To create a new time interval measurement (see page 251)

• To create a new value at measurement (see page 253)

To create a new value at measurement

Use the new value at measurement feature to measure the value of a bus/signal at a specified 
marker location in the captured data. Measurement results are displayed in the marker measurement 
display bar (see page 403).

1 From the menu bar select Markers>New Value At Measurement, or click the  icon in the 
markers toolbar (see page 400).

2 In the Value At dialog, select the numeric base of the data, the bus/signal, and the marker.

CAUTION
If you have selected a "System Trigger - (module)" or "Trigger - (module)" marker as one of the 
markers you want to measure samples between, make sure you uncheck the First module to 
trigger designates the System Trigger option in the Module Skew and System Trigger dialog (see 
page 446). Otherwise, during the repetitive run, the system trigger could switch from one module 
to another, causing you to lose all the statistical data you have accumulated.
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3 Click OK.

The result of the value at measurement  is displayed in the marker measurement 
display bar.

See Also • To create a new time interval measurement (see page 251)

• To create a new sample interval measurement (see page 252)

To rename a marker

You can give markers any name you choose.

1 In a display window with markers, right-click on the marker, and choose Rename....

Or, in the display window properties dialog's Time Marker Properties tab, select the Marker, and 
click Rename....

2 In the Rename dialog, enter the new marker name.

You can specify both a long name and an abbreviated name by using the "Long 
name[abbreviated name]" syntax; for example, "Location A[A]". When an abbreviated name is 
used, it appears on the marker in the marker display bar (see page 407) while the long name 
appears in the marker tool tip (see page 619).

3 Click OK.

See Also • To create new markers (see page 246)

• To place markers in data (see page 247)

• To go to a marker (see page 249)

• To center the display about a marker pair (see page 249)

• To delete a marker (see page 250)

• To send a marker to the back (see page 254)

• To change a marker's snap to edge setting (see page 250)

• Changing Marker Properties (see page 255)

To send a marker to the back

NOTE
If you have selected a "System Trigger - (module)" or "Trigger - (module)" marker, make sure you 
uncheck the First module to trigger designates the System Trigger option in the Module Skew 
and System Trigger dialog (see page 446). Otherwise, during a run, the system trigger could switch 
from one module to another, causing the module markers to be re-assigned and any 
measurements using these markers to be deleted.
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When markers overlap on the display, you can send the visible marker to the back in order to see the 
marker underneath.

1 Click the marker you wish to send to the back, and choose Send to Back from the pop-up menu.

See Also • To create new markers (see page 246)

• To place markers in data (see page 247)

• To go to a marker (see page 249)

• To center the display about a marker pair (see page 249)

• To delete a marker (see page 250)

• To rename a marker (see page 254)

• To change a marker's snap to edge setting (see page 250)

• Changing Marker Properties (see page 255)

Changing Marker Properties

Once a marker is created, you can modify any of its attributes from the Time Marker Properties tab..

1 Right-click on a marker, and choose Properties....

Or, when viewing a display window that has markers, choose Markers>Properties... from the 
main menu.

2 In the display window properties dialog's Time Marker Properties tab:

You can:

• Select the Marker to which the property changes apply.
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• Rename a marker (see page 254)

• Change a marker's background color (see page 256)

• Change a marker's foreground color (see page 256)

• Change a marker's position property (see page 248)

• Hide/show a marker (see page 256)

• Change a marker's lock in viewer setting (see page 256)

• Lock a marker relative to another marker (see page 257)

• Change a marker's snap to edge setting (see page 250)

• Add comments to a marker (see page 257)

3 Click OK to apply the changes and close the properties dialog.

See Also • To create new markers (see page 246)

• To place markers in data (see page 247)

• To go to a marker (see page 249)

• To center the display about a marker pair (see page 249)

• To delete a marker (see page 250)

• To rename a marker (see page 254)

• To send a marker to the back (see page 254)

• To read the markers display and overview bars (see page 245)

To change a marker's background color

1 In the Marker Properties tab, click the Background Color selection button and select the desired 
color from the palette.

If you want to use a color that is not on the palette, click Other... to access the custom color 
dialog.

2 Click OK to apply the changes and close the properties dialog.

See Also • To change Y-Axis marker properties (see page 262)

To change a marker's foreground color

1 In the Marker Properties tab, click the Foreground Color selection button and select the desired 
color from the palette.

If you want to use a color that is not on the palette, click Other... to access the custom color 
dialog.

2 Click OK to apply the changes and close the properties dialog.

See Also • To change Y-Axis marker properties (see page 262)

To hide/show a marker

1 In the Marker Properties tab, check or uncheck Hide to hide or show the marker.

When a marker is hidden, all other marker properties are retained; the marker is just hidden from 
view in the display.

2 Click OK to apply the changes and close the properties dialog.

See Also • To change Y-Axis marker properties (see page 262)

To change a marker's lock in viewer setting

When a marker's Lock in Viewer setting is enabled, moving or placing the marker in one display 
window causes other display windows to be updated so that the marker appears in them as well.



Keysight Logic and Protocol Analyzer User Guide 257

Analyzing the Captured Data 7

1 In the Time Marker Properties tab, check or uncheck Lock in Viewer to enable or disable the 
setting.

2 Click OK to apply the changes and close the properties dialog.

To lock a marker relative to another marker

When a marker is positioned relative to another marker and the marker's Lock to Relative setting is 
enabled, moving or placing either marker causes both to move such that the time between the 
markers remains the same. Both markers must be movable.

1 In the Marker Properties tab's Position box:

a Select Time.

b Select the relative marker.

c Enter the relative time between markers.

2 Check or uncheck Lock to Relative to lock or unlock relative marker movements.

3 Click OK to apply the changes and close the properties dialog.

To add comments to a marker

You can add comments to a marker that appear in the marker's tool tip (see page 619).

1 In the Marker Properties tab's Comments box, enter your comments.

2 Click OK to apply the changes and close the properties dialog.

See Also • To change Y-Axis marker properties (see page 262)

Using Y-Axis Markers for Analog Signals (in the Waveform Display)

When analog signals are added to the Waveform display window (from an external oscilloscope 
module), you can add Y-Axis (Voltage / Amperage) markers and interval measurements. If the 
signal's data is displayed in Amperage, then Amperage is used in the creation of a Y-Axis marker for 
the signal.   If the signal's data is displayed in Voltage, then Voltage is used in the creation of a Y-Axis 
marker for the signal.

NOTE
The lock in viewer behavior applies only when a marker is dragged within the immediate data 
viewing area. If a marker is moved by defining a new position in the Time Markers Properties tab, 
the marker is not guaranteed to be visible in other display windows.
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• To create new Y-Axis markers (see page 258)

• To place Y-Axis markers (see page 259)

• To delete Y-Axis markers (see page 260)

• To create a new voltage interval measurement (see page 260)

• To rename a Y-Axis marker (see page 261)

• To send a Y-Axis marker to the back (see page 261)

• To change Y-Axis marker properties (see page 262)

See Also • " External Oscilloscope Time Correlation and Data Display" (in the online help)

To create new Y-Axis markers

When creating a new Y-Axis marker, you can give it a name, specify its color, position it, and add 
comments.

1 In an analog signal row's Y-Axis marker/vertical scale display bar (to the left of the waveform), 
click (where you would like to place the marker) and choose New....

Or, right-click on an analog signal waveform (where you would like to place the marker) and 
choose Place Marker>Y-Axis>New Marker....

2 In the New Y-Axis Marker dialog, enter the marker name.

You can specify both a long name and an abbreviated name by using the "Long 
name[abbreviated name]" syntax; for example, "Location A[A]". When an abbreviated name is 
used, it appears on the marker in the Y-Axis marker display bar while the long name appears in 
the marker tool tip (see page 619).
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3 Select the marker's background and foreground colors.

4 Specify the position of the new Y-Axis marker by its voltage / amperage from ground or another 
Y-Axis marker. If the signal's data is displayed in Amperage, then Amperage is used in the 
creation of the Y-Axis marker for the signal.   If the signal's data is displayed in Voltage, then 
Voltage is used in the creation of the Y-Axis marker for the signal.

5 Enter comments for the Y-Axis marker.

Comments appear in the marker's tool tip (see page 619).

6 Click OK.

See Also • To place Y-Axis markers (see page 259)

• To delete Y-Axis markers (see page 260)

• To create a new Y-Axis interval measurement (see page 260)

• To rename a Y-Axis marker (see page 261)

• To send a Y-Axis marker to the back (see page 261)

• To change Y-Axis marker properties (see page 262)

To place Y-Axis markers

Use Place Markers to quickly position a Y-Axis marker. Depending on how you access the Place 
Markers feature, the marker is placed in the data a little differently. You can also move markers by 
dragging them with the mouse or by using the front-panel knobs. Where Y-Axis markers intersect 
time markers, you can drag both markers at the same time.

• To drag and drop Y-Axis markers (see page 259)

• To place a Y-Axis marker at the mouse cursor (see page 259)

• To change a Y-Axis marker's position property (see page 259)

To drag and drop
Y-Axis markers

Using the drag and drop feature you can move Y-Axis markers to new positions in the data.

1 Click and hold down the mouse button on the marker you wish to move.

2 Move the mouse cursor to the new position.

3 Release the mouse button to reposition the marker.

To place a Y-Axis
marker at the
mouse cursor

1 Point the mouse to the desired data point in the display.

2 Right-click, and select Place Marker>Y-Axis>(desired marker).

To change a Y-Axis
marker's position

property

1 Right-click on a Y-Axis marker, and choose Properties....

Or, when viewing a display window that has Y-Axis markers, choose Markers>Properties... from 
the main menu.



7 Analyzing the Captured Data

260 Keysight Logic and Protocol Analyzer User Guide

2 In the Waveform Properties dialog's Y-Axis Marker Properties tab, select the Marker to which the 
property changes apply.

3 In the Position box, position the marker by its voltage / amperage from ground or another Y-Axis 
marker. 

4 Click OK to apply the changes and close the properties dialog.

See Also • To create new Y-Axis markers (see page 258)

• To delete Y-Axis markers (see page 260)

• To create a new Y-Axis interval measurement (see page 260)

• To rename a Y-Axis marker (see page 261)

• To send a Y-Axis marker to the back (see page 261)

• To change Y-Axis marker properties (see page 262)

To delete Y-Axis markers

• In an analog signal's Y-Axis markers/vertical scale display bar (to the left of the waveform), click 
the Y-Axis marker you want to delete, and choose Delete from the popup menu (or choose Delete 
All to delete all Y-Axis markers).

Or:

1 From the menu bar, select Markers>Delete....

2 In the Delete Marker dialog, select the markers you wish to delete.

You can sort the list of markers by clicking on the Name, Position, or Comment column headings.

3 Click OK.

See Also • To create new Y-Axis markers (see page 258)

• To place Y-Axis markers (see page 259)

• To create a new Y-Axis interval measurement (see page 260)

• To rename a Y-Axis marker (see page 261)

• To send a Y-Axis marker to the back (see page 261)

• To change Y-Axis marker properties (see page 262)

To create a new Y-Axis interval measurement
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Use the Y-Axis interval measurement feature to measure a voltage / amperage between two Y-Axis 
markers. Measurement results are displayed in the marker measurement display bar (see page 403).

1 In an analog signal row's Y-Axis marker/vertical scale display bar (to the left of the waveform), 
click and choose Measurements>New Y-Axis Interval Measurement.

Or, right-click in the marker measurement display bar and choose New Y-Axis Interval 
Measurement>(analog signal name).

2 In the Y-Axis Interval dialog, select the markers you want to measure voltage between.

3 Click OK to close the Y-Axis Interval dialog.

The result of the interval measurement is displayed in the marker measurements display bar:

To rename a Y-Axis marker

You can give Y-Axis markers any name you choose.

1 In a Waveform window with voltage markers, right-click on the marker, and choose Rename....

Or, in the display window properties dialog's Y-Axis Marker Properties tab, select the Marker, and 
click Rename....

2 In the Rename dialog, enter the new marker name.

You can specify both a long name and an abbreviated name by using the "Long 
name[abbreviated name]" syntax; for example, "Location A[A]". When an abbreviated name is 
used, it appears on the marker in the Y-Axis marker display bar while the long name appears in 
the marker tool tip (see page 619).

3 Click OK.

See Also • To create new Y-Axis markers (see page 258)

• To place Y-Axis markers (see page 259)

• To delete Y-Axis markers (see page 260)

• To create a new Y-Axis interval measurement (see page 260)

• To send a Y-Axis marker to the back (see page 261)

• To change Y-Axis marker properties (see page 262)

To send a Y-Axis marker to the back
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When Y-Axis markers overlap on the display, you can send the visible marker to the back in order to 
see the marker underneath.

1 Click the Y-Axis marker you wish to send to the back, and choose Send to Back from the pop-up 
menu.

See Also • To create new voltage markers (see page 258)

• To place Y-Axis markers (see page 259)

• To delete Y-Axis markers (see page 260)

• To create a new Y-Axis interval measurement (see page 260)

• To rename a Y-Axis marker (see page 261)

• To change Y-Axis marker properties (see page 262)

To change Y-Axis marker properties

Once a Y-Axis marker is created, you can modify any of its attributes from the Y-Axis Marker 
Properties tab.

1 Right-click on a Y-Axis marker, and choose Properties....

Or, when viewing a Waveform display window that has Y-Axis markers, choose 
Markers>Properties... from the main menu.

2 In the Waveform Properties dialog's Y-Axis Marker Properties tab:

You can:

• Select the Marker to which the property changes apply.
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• Rename a Y-Axis marker (see page 261)

• Change a marker's background color (see page 256)

• Change a marker's foreground color (see page 256)

• Change a Y-Axis marker's position property (see page 259)

• Hide/show a marker (see page 256)

• Add comments to a marker (see page 257)

3 Click OK to apply the changes and close the properties dialog.

See Also • To create new Y-Axis markers (see page 258)

• To place Y-Axis markers (see page 259)

• To delete Y-Axis markers (see page 260)

• To create a new Y-Axis interval measurement (see page 260)

• To rename a Y-Axis marker (see page 261)

• To send a Y-Axis marker to the back (see page 261)
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Searching the Captured Data

You can search for bus/signal patterns in the captured data.

• To quickly find bus/signal patterns (see page 264)

• To find bus/signal patterns in the captured data (see page 265)

• To find packet patterns in the captured data (see page 267)

• To find complex patterns in the captured data (see page 270)

• To store, recall, or delete favorite find patterns (see page 271)

• To specify "found" marker placement (see page 272)

To quickly find bus/signal patterns

In the Waveform or Listing windows, you can quickly draw a rectangle and find the next or previous 
occurrence of that bus/signal pattern.

1 In the Waveform window, make sure the Fast Zoom In (see page 230) option is not selected.

2 Using the mouse, point to the upper-left corner of your desired bus/signal pattern.

3 While holding down the mouse button, drag the mouse pointer to the lower-right corner of your 
bus/signal pattern.

As you draw the rectangle, a tool tip shows the selected bus/signal pattern.

As you move the mouse left-to-right and top-to-bottom, the signal edge/level or bus value in 
contact with the left of the rectangle becomes the bus/signal pattern.

Only one edge can be set.

If a bus is expanded into its separate signals, three conditions apply:

a If drawing starts on a bus, none of its expanded signals can be included.

b If drawing starts on a signal, the bus cannot be included.

c Edges and levels are mutually exclusive. That is, either one edge can be set, or all levels can be 
set, but not both at the same time.

4 When the desired bus/signal pattern has been selected, release the mouse button, and select 
Find Next or Find Previous from the popup menu.

NOTE
In the Waveform display window, it may be necessary to redraw the rectangle if you do not get 
your desired bus/signal pattern dictated by the left-side line of the rectangle. You could also try 
drawing the rectangle backwards leaving the left-side rectangle line set last.



Keysight Logic and Protocol Analyzer User Guide 265

Analyzing the Captured Data 7

5 Click the Previous  or Next  icons to see more occurrences.

General Guidelines • Any bus/signals with overlapping bits are not included within the bus/signal pattern.

Example: Bus_1 has channels 0 through 7 of pod 1 assigned and Bus_2 has channels 3 through 6 
of pod 1 assigned. At this point, you have the same probed signals (channels 3 through 6 of pod 
1) assigned in both Bus_1 and Bus_2. Now, you draw the rectangle over both bus_1 and bus_2. 
Because Bus_1 channels 3 through 6 are repeated (overlapped) on Bus_2, they will not be 
included in the bus/signal pattern.

See Also • To find bus/signal patterns in the captured data (see page 265)

• To find packet patterns in the captured data (see page 267)

• To find complex patterns in the captured data (see page 270)

• To store, recall, or delete favorite find patterns (see page 271)

To find bus/signal patterns in the captured data

This search option locates a specified data pattern. You can qualify your search by specific bits, data 
patterns, equality, and range operators. The search result is placed at the center of the display.

1 From the menu bar, choose Edit>Find..., or click the  icon in the standard toolbar (see 
page 398).

2 In the Find dialog, enter the number of the occurrences you wish to find, select whether you want 
to search forward or backward from the start location; then, select the start location.

3 In the event specification area, select the Bus/Signal pattern type.

4 Specify the bus/signal pattern event you wish to locate.

In addition to the usual pattern matching operators (=, !=, <, >, <=, >=, In Range, and 
Not In Range), there are three additional operators you can use:



7 Analyzing the Captured Data

266 Keysight Logic and Protocol Analyzer User Guide

• Entering — the first sample of one or more consecutive samples that match the pattern. (By 
comparison, the "=" equals operator considers every sample that matches the pattern as an 
occurrence.)

• Exiting — the sample after one or more consecutive samples that match the pattern.

• Transitioning — entering or exiting one or more consecutive samples that match the pattern.

You can find analog signal values as well as digital signal values.

5 Select the desired When find qualifier (which further qualifies the find criteria with a time 
duration or other operator):

• Present

• Not Present

• Present> (time duration)

• Present>= (time duration)

• Present< (time duration)

• Present<= (time duration)

• Present for Range (of time)

• Not Present for Range (of time)

• Entering

• Exiting

• Transitioning

6 Click Find.

7 Click the Previous  or Next  icons to see more occurrences.

See Also • To quickly find bus/signal patterns (see page 264)

• To find packet patterns in the captured data (see page 267)

• To find complex patterns in the captured data (see page 270)

TIP As you configure the find function, try to think of it as constructing a sentence that reads 
left-to-right. For example: "Find 1 occurrence Forward from the Display Center of a bus named My 
Bus 1, and on All bits a pattern that Equals XX Hex, display the event When all criteria is Present."

NOTE
The find qualifiers:
• Present>
• Present>=
• Present<
• Present<=
• Present for Range
• Not Present for Range

allow you to specify a time duration. This means that the find event specified in the expression area 
will be found based upon the given time and operator.

The other qualifiers:
• Present
• Not Present
• Entering
• Exiting
• Transitioning

do not allow a time duration.
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• To store, recall, or delete favorite find patterns (see page 271)

• To specify "found" marker placement (see page 272)

To find packet patterns in the captured data

In the Protocol Viewer window, you can search for packets, packet errors, and field values.

1 With the Protocol Viewer window open, choose Edit>Find... from the menu bar or click the  
icon in the standard toolbar (see page 398).

2 In the Find dialog, enter the number of the occurrences you wish to find, select whether you want 
to search forward or backward from the start location; then, select the start location.

3 In the event specification area, select the Packet, Packet Error, or Field pattern type.

• To find packet events (see page 267)

• To find packet errors (see page 268)

• To find field values (see page 269)

To find packet
events

1 You can click packet type button to open a selection dialog.

2 Click the packet event button to open the Event Editor dialog.



7 Analyzing the Captured Data

268 Keysight Logic and Protocol Analyzer User Guide

For more information, see Using the Packet Event Editor (see page 164)

3 Select the desired When find qualifier (which further qualifies the find criteria with a time 
duration or other operator). For more information, see To find bus/signal patterns in the captured 
data (see page 265).

4 Click Find.

5 Click the Previous  or Next  icons to see more occurrences.

To find packet
errors

1 You can click packet type button to open a selection dialog.

2 Select the packet error value:
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3 Select the desired When find qualifier (which further qualifies the find criteria with a time 
duration or other operator). For more information, see To find bus/signal patterns in the captured 
data (see page 265).

4 Click Find.

5 Click the Previous  or Next  icons to see more occurrences.

To find field values 1 Select the field name.

Clicking  lets you select from recently used field names. Clicking elsewhere on a field name 
button opens a Select dialog for selecting a different name.

2 Specify the field value:

If a single-bit field has been selected, select the signal pattern value (High, Low, or Dont Care).
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If a multiple-bit field has been selected:

a Select one of the operators: = (equal to), != (not equal to), < (less than), > (greater than), <= 
(less than or equal to), >= (greater than or equal to), In Range, or Not In Range.

b Select the number base (Binary, Hex, Octal, Decimal, or Signed Decimal, also known as two's 
complement).

c Enter the pattern value(s).

3 Select the desired When find qualifier (which further qualifies the find criteria with a time 
duration or other operator). For more information, see To find bus/signal patterns in the captured 
data (see page 265).

4 Click Find.

5 Click the Previous  or Next  icons to see more occurrences.

See Also • To quickly find bus/signal patterns (see page 264)

• To find bus/signal patterns in the captured data (see page 265)

• To find complex patterns in the captured data (see page 270)

• To store, recall, or delete favorite find patterns (see page 271)

• To specify "found" marker placement (see page 272)

To find complex patterns in the captured data

You can expand search criteria to include more than one event describing data patterns.

1 From the menu bar, choose Edit>Find..., or click the  icon in the standard toolbar (see 
page 398).

2 In the Find dialog, select the number of the occurrences you wish to find, select whether you 
want to search forward or backward from the start location; then, select the start location.

3 Select the pattern event drop down menu to choose Insert Event After (AND/OR) or Insert Event 
Before (AND/OR) to insert new find events.
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The Delete Event option will delete the current event only if there is more than one event present.

4 For each event you add, select either And or Or to specify how the event patterns are combined.

AND'ed searches find occurrences of both events, while OR'ed searches find occurrences of 
either event.

When you have AND'ed and OR'ed events, a button appears above the events for changing the 
event evaluation order.

5 For each event, select the bus or signal name and enter the value you want to locate.

6 Click Find.

See Also • To quickly find bus signal patterns (see page 264)

• To find bus/signal patterns in the captured data (see page 265)

• To find packet patterns in the captured data (see page 267)

• To store, recall, or delete favorite find patterns (see page 271)

• To specify "found" marker placement (see page 272)

To store, recall, or delete favorite find patterns

• To store a favorite pattern (see page 271)

• To recall a favorite pattern (see page 271)

• To delete a favorite pattern (see page 272)

To store a favorite
pattern

1 From the menu bar select, Edit>Find..., or click the  icon.

2 Set up the pattern you want to find (see To find bus/signal patterns in the captured data (see 
page 265) or To find complex bus/signal patterns in the captured data (see page 270)).

3 Click Store Favorite.

4 Enter the name of the find pattern.

5 Click OK to save the find pattern.

To recall a favorite
pattern

1 From the menu bar select, Edit>Find..., or click the  icon.

2 Select Recall Favorite; then, select the find pattern you want to use from the drop down menu.
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3 Click Find.

To delete a favorite
pattern

1 From the menu bar select, Edit>Find..., or click the  icon.

2 Select Recall Favorite; then, select Delete....

3 In the Delete Favorites dialog, select the find patterns you wish to delete; then, click Delete.

See Also • Searching the Captured Data (see page 264)

• To specify "found" marker placement (see page 272)

To specify "found" marker placement

When searching for a pattern, you can place an existing marker on the last occurrence, or you can 
place a new marker on the last occurrence or on all occurrences.

1 From the menu bar select, Edit>Find..., or click the  icon in the standard toolbar (see 
page 398).

2 In the Find dialog, set up the pattern you want to find.

3 Click Options....

To place an
existing marker on

the last occurrence

1 Select the Place option.

2 Select the marker you want to place from the drop down menu.

3 Click OK.

To place a new
marker

1 Select Place new marker named:.

2 Enter the name of the new marker.

3 Select whether you want to place the new marker on the last occurrence or on all occurrences.

The on all occurrences option is only available when you are finding more than one occurrence.
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4 Click OK.

See Also • Searching the Captured Data (see page 264)

• To store, recall, or delete favorite find patterns (see page 271)

• To place markers in data (see page 247)
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Comparing Captured Data to Reference Data

By comparing data from different acquisitions, you can look for differences between a known-good 
device under test and a device under test with a problem or one that is operating under different 
conditions.

To compare captured to reference data:

1 Capture (or load) the data you want to use as the reference data.

2 Select Window>New Compare... to open a new Compare display window.

3 In the Compare display window, click the Copy... button to select the current data that should be 
copied to the reference buffer.

4 Capture (or load) the data that you want to compare to the reference.

Differences are highlighted in the Compare window.

For more information on comparing captured data to reference data, see:

• To copy data to the reference buffer (see page 274)

• To find differences in the compared data (see page 274)

• To compare only a range of samples (see page 275)

• To offset the reference data (see page 275)

• To run until a number of compare differences (see page 275)

• To set Compare window properties (see page 276)

See Also • Compare Display Window (see page 411)

• Capturing Data from the Device Under Test (see page 141)

• Loading Saved Data and Setups (see page 208)

To copy data to the reference buffer

1 In the Compare display window, click the Copy... button.

2 In the Select Buses/Signals dialog:

a From the available buses and signals, select the ones to be copied to the reference buffer and 
click Add>>.

To remove buses and signals from the selected list, select them and click <<Remove.

b Select either All data or a range of data using markers.

3 When you are ready to begin the copy, click OK.

To find differences in the compared data

In the Compare display window:

• Click the >> button to find the next difference (below the center reference).

• Click the << button to find the previous difference (above the center reference).

NOTE
Copying generated bus/signal columns, such as those created by an inverse assembler or an 
analysis tool, takes longer because of the extra processing to re-create the data.

NOTE
If your logic analyzer has deep memory, it takes a while to copy data to the reference buffer.



Keysight Logic and Protocol Analyzer User Guide 275

Analyzing the Captured Data 7

• Click a blue tick mark in the Compare Overview bar (between the vertical scroll bar and the 
Marker Overview bar on the right side of the window) to go to that difference.

To compare only a range of samples

1 In the Compare display window, click the Range & Offset... button.

2 In the Range & Reference dialog, select either All data or a range of data using markers.

3 Click OK.

To offset the reference data

When there are differences in the number of samples captured before the trigger, or when you are 
comparing a range of samples, you can offset the reference data so that the samples being 
compared are properly aligned.

1 In the Compare display window, click the Range & Offset... button.

2 In the Range & Reference Offset dialog, enter the number of samples to offset the reference by.

3 Click OK.

See Also • To compare only a range of samples (see page 275)

To run until a number of compare differences

The Compare display lets you stop comparing, stop a repetitive run, or send e-mail after a run has 
more than a specified number of differences when compared to the reference data.

1 In the Compare display window, click Compare Until....

2 In the Difference Properties tab of the Compare Properties dialog, enter the number of 
differences that will stop comparing, stop a repetitive run, or send an e-mail message.

3 To stop a compare after the number of differences have been found, select the Stop comparing 
check box.

4 To stop a repetitive run after the number of differences have been found, select the Stop 
repetitive run check box.

5 To send e-mail after the number of differences have been found, select the Send e-mail check 
box; then, click the E-mail... button. In the E-mail dialog (see page 432), enter the address to 
which e-mail will be sent, the subject, and the text of the message.

6 Click OK in the Compare Properties dialog.

NOTE
When a difference occurs on a subrow (for example, when the data is inverse-assembled or 
decoded by an analysis tool), the next and previous buttons go to the sample row instead of the 
subrow.

NOTE
When you specify a range to compare, the range is compared to the top of the reference buffer 
(unless the reference data has been offset (see page 275) by a number of samples) and not the 
same range in the reference buffer as you might expect. This behavior allows multiple ranges in the 
input data to be compared with the reference data. 
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7 Start the repetitive run measurement.

See Also • Running/Stopping Measurements (see page 196)

To set Compare window properties

1 In the Compare display window, right-click on the bus/signal column name; then, select 
Properties... from the popup menu.

2 In the Compare Properties dialog:

• The Window Properties tab lets you select the reference data background color, the 
background color that indicates no reference data, and the difference foreground and 
background colors.

• The Column Properties tab's Display field lets you display All of the reference data, just the 
reference data where a difference was found (Difference Pair), or only the highlighted 
differences in the data being compared (Input Only).

• The Difference Properties tab lets you select the options for running until a number of 
compare differences are found.

All other Compare property options are the same as in the Listing window.

See Also • To set Listing window properties (see page 238)

• To run until a number of compare differences (see page 275)
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Viewing Source Code Associated with Captured Data

1 Add and configure the appropriate inverse assembler tool (see "Using Inverse Assembler Tools" 
(in the online help)).

2 Load line number symbols (see To load symbols from a file (see page 134)).

3 Select Window>New Source... to open a new Source display window.

4 In the Add New Window after dialog, select the inverse assembler or filter/colorize tool that the 
Source window should be added after.

Generally, you want the Source window getting the same data as other display windows (Listing, 
Waveform, etc.).

5 In the source display pane of the Source window, right-click, and choose Properties....

6 In the Source Viewer Properties dialog's Source Code Directories tab, click Add... tab.

7 In the Browse for Folder dialog, select the directory that contains the source files, and click OK.

8 Click OK to close the Source Viewer Properties dialog.

For more information on viewing the source code associated with captured data, see:

• To step through captured data by source lines (see page 277)

• To go to captured data associated with a source line (see page 278)

• To browse source files (see page 278)

• To search for text in source files (see page 279)

• To set a Quick Trigger in the Source window (see page 145)

•  To go to the source line associated with the listing center rectangle (see page 279)

• To edit the source code directory list (see page 279)

• To select the correlation bus (see page 280)

• Changing Source Window Properties (see page 281)

• To change the source background color (see page 282)

• To change the source text color (see page 282)

• To change the source font size (see page 282)

• To change the source tab width (see page 282)

• To show/hide source line numbers (see page 282)

• To change the "Set Quick Trigger" alignment (see page 282)

See Also • Analyzing Listing Data (see page 235)

• Source Display Window (see page 412)

To step through captured data by source lines
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1 In the Source window's source pane, click the  step to next source line or  step to 
previous source line buttons.

The listing pane is updated to show the captured data associated with the next or previous source 
line, and the source pane is updated to show the next or previous source line.

See Also • Viewing Source Code Associated with Captured Data (see page 277)

To go to captured data associated with a source line

1 In the Source window's source pane, click the source line whose associated captured data you 
want to view.

2 Click the  find next selected source line or  find previous selected source line buttons.

Or, right-click the selected source line and choose Find Next Selected Source Line or Find Prev 
Selected Source Line.

If captured data associated with the source line is found, the listing pane is updated to show the 
captured data, and the source pane is updated to show the selected source line.

If captured data associated with the source line is not found, an information dialog is displayed.

See Also • Viewing Source Code Associated with Captured Data (see page 277)

To browse source files

1 In the Source window's source pane, click Browse....

2 In the Select Source File to Open dialog, select the source file to browse, and click Open.

The selected source file appears in the source pane.
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See Also • To search for text in source files (see page 279)

• To set a Quick Trigger in the Source window (see page 145)

•  To go to the source line associated with the listing center rectangle (see page 279)

• Viewing Source Code Associated with Captured Data (see page 277)

To search for text in source files

1 In the Source window's source pane, right-click choose Find in Source....

2 In the Find dialog, enter the text to search for, select the direction to search, and click Find Next.

If the text is found, the source line is highlighted.

If the text is not found, an information dialog is displayed.

See Also • To set a Quick Trigger in the Source window (see page 145)

•  To go to the source line associated with the listing center rectangle (see page 279)

• Viewing Source Code Associated with Captured Data (see page 277)

To go to the source line associated with the listing center rectangle

After browsing or searching for text in source files, you may want to return to displaying the source 
line associated with the captured data displayed in the listing pane.

1 In the Source window's source pane, click the  show correlated source line button.

The source pane is updated to show either the source line associated with the listing center 
rectangle or "No matching symbol found.".

See Also • Viewing Source Code Associated with Captured Data (see page 277)

To edit the source code directory list
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Because source file paths specified in the symbol file may not be valid if you compile on one 
computer and debug on another, you can specify the directories where source code is located.

1 In the Source window display areas, right-click, and choose Properties....

2 Or, choose Edit>Window Properties... from the main menu.

3 In the Source Viewer Properties dialog's Source Code Directories tab:

You can:

• Add a directory to the search list by clicking Add....

• Specify whether subdirectories are included in or excluded from the search by checking or 
unchecking Search subdirectories.

• Change a directory's order in the search list by highlighting a directory and clicking Move Up 
or Move Down.

• Delete directory from the search list by highlighting a directory and clicking Delete.

4 Click OK to apply the changes and close the Source Viewer Properties dialog.

See Also • Viewing Source Code Associated with Captured Data (see page 277)

To select the correlation bus

1 In the Source window display areas, right-click, and choose Properties....

2 Or, choose Edit>Window Properties... from the main menu.

3 In the Source Viewer Properties dialog's Correlation Bus tab, select the bus on which the Source 
window should look for line number symbols.
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Typically, you will select the "software address" bus generated by an inverse assembler tool or 
another address bus.

4 Click OK to apply the changes and close the Source Viewer Properties dialog.

See Also • Viewing Source Code Associated with Captured Data (see page 277)

Changing Source Window Properties

You can change properties that affect the source code pane of the Source display window.

1 In the source display pane of the Source window, right-click, and choose Properties....

2 Or, choose Edit>Window Properties... from the main menu.

3 In the Source Viewer Properties dialog's Source Properties tab:

You can:

• Change the source background color (see page 282)

• Change the source text color (see page 282)

• Change the source font size (see page 282)

• Change the source tab width (see page 282)

• Show/hide source line numbers (see page 282)

• Change the "Set Quick Trigger" alignment (see page 282)
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4 Click OK to apply the changes and close the Source Viewer Properties dialog.

See Also • Changing Listing Window Properties (see page 238)

• Changing Bus/Signal Column Properties (see page 240)

To change the source background color

1 In the Source Viewer Properties dialog's Source Properties tab, click the Background color 
selection button and select the desired background color from the palette.

If you want to use a color that is not on the palette, click Other... to access the custom color 
dialog.

2 Click OK to apply the changes and close the Source Viewer Properties dialog.

To change the source text color

1 In the Source Viewer Properties dialog's Source Properties tab, click the Source Text selection 
button and select the desired color from the palette.

If you want to use a color that is not on the palette, click Other... to access the custom color 
dialog.

2 Click OK to apply the changes and close the Source Viewer Properties dialog.

To change the source font size

1 In the Source Viewer Properties dialog's Source Properties tab, enter the desired Font Size.

Fonts can range from size 6 through 72 points.

2 Click OK to apply the changes and close the Source Viewer Properties dialog.

To change the source tab width

1 In the Source Viewer Properties dialog's Source Properties tab, enter the desired Tab Width.

Tab widths can range from 1 to 10 spaces.

2 Click OK to apply the changes and close the Source Viewer Properties dialog.

To show/hide source line numbers

1 In the Source Viewer Properties dialog's Source Properties tab, check or uncheck Display Line 
Numbers to specify whether source file line numbers are shown or hidden.

2 Click OK to apply the changes and close the Source Viewer Properties dialog.

To change the "Set Quick Trigger" alignment

For microprocessors that fetch blocks of instructions at a time (from block boundary addresses only), 
the address alignment property lets you adjust the source line symbol values to be on block 
boundary addresses when setting up Quick Triggers on a source line.

1 In the Source Viewer Properties dialog's Source Properties tab, select the desired Address 
Alignment.

2 Click OK to apply the changes and close the Source Viewer Properties dialog.

See Also • To set a Quick Trigger in the Source window (see page 145)
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Analyzing Packet Data

You can use a Protocol Viewer window to display the captured data. The following screen displays an 
instance of Protocol Viewer added to the U4301A PCIe Gen3 Analyzer module to display the PCIe 
data captured by this module.

Unlike the Listing window, the Protocol Viewer windows let you view summarized and detailed 
packet information at the same time within two panes. The following screen displays the captured 
packets in a Protocol Viewer window. 
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The upper packet summary pane is similar to a Listing window except that its columns display 
packets and fields instead of bus/signal values. Like a Listing window, you can insert time or pattern 
markers.

The lower pane contains tabs for viewing selected packet details, header, payload, and lane 
information.

The Protocol Viewer window is customized for the protocol family for which the data is displayed.

You can add new Protocol Viewer windows using the Window menu. You can view Protocol Viewer 
windows that have already been added by choosing from the open window names at the bottom of 
the menu. If tabbed windows (see page 313) are turned on, you can also view Protocol Viewer 
windows by selecting the tab at the bottom of the window.

• Viewing the Packet Summary (see page 285)

• To go to different locations in the displayed data (see page 286)

• To re-arrange packet columns (see page 287)

• To insert or delete packet columns (see page 288)

• To show/hide parts of the packet summary display (see page 292)

• To lockstep Protocol Viewer with other display windows (see page 293)

• Viewing a Selected Packet (see page 293)

• To view and compare packet details (see page 294)

• To view a packet header (see page 297)

• To view a packet payload (see page 298)

• To view a packet's lanes (see page 299)

• To show/hide Protocol Viewer panes (see page 301)
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• Changing Packet Summary Event Colors (see page 301)

• Changing Protocol Viewer Window Properties (see page 302)

• To change the selected row box color (see page 303)

• To change the Protocol Viewer font size (see page 303)

• To lock scrolling with other display windows (see page 303)

• Changing Packet Summary Column Properties (see page 304)

• To change the directions of a packet column (see page 305)

• To change the width of a packet column (see page 305)

• To change the alignment of a packet column (see page 305)

• To change a packet column's number base (see page 306)

• To select the marker for marker-relative times (see page 306)

• To select fixed time units (see page 306)

• Viewing LTSSM States and Transitions (in the U4301 PCIe Gen3 Analyzer Online help).

• Viewing Decoded Transactions (in the U4301 PCIe Gen3 Analyzer Online help)

• Viewing Offline Performance Summary (in the U4301 PCIe Gen3 Analyzer Online help)

• Viewing PCIe Gen3 Packets (in the U4301 PCIe Gen3 Analyzer Online help)

• Customizing Protocol Descriptions for Protocol Viewer (in the online help)

See Also • To specify packet events (in "Find a packet" trigger function) (see page 164)

• To find packet patterns in the captured data (see page 267)

• "To specify packet patterns to filter" (in the online help)

• Marking, and Measuring Between, Data Points (see page 245)

• Displaying Names (Symbols) for Packet Summary Column Values (see page 243)

• Searching the Captured Data (see page 264)

Viewing the Packet Summary

The upper packet summary pane of the Protocol Viewer window is similar to a Listing window except 
that its columns display packets and fields instead of bus/signal values. Like a Listing window, you 
can insert time or pattern markers.

Upper pane of the Protocol Viewer

Click a line to select a packet. Notice that a colored box highlights the selected line. You can use the 
up-arrow or down-arrow keys to select the previous or next packets.

• “To go to different locations in the displayed data" on page 286
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• “To re-arrange packet columns" on page 287

• “To insert or delete packet columns" on page 288

• “To show/hide parts of the packet summary display" on page 292

• To lockstep Protocol Viewer with other display windows (page 293)

See Also • “Changing Packet Summary Event Colors" on page 301

• “Changing Protocol Viewer Window Properties" on page 302

• “Changing Packet Summary Column Properties" on page 304

• “Viewing a Selected Packet" on page 293

• “Marking, and Measuring Between, Data Points" on page 245

• “Searching the Captured Data" on page 264

• Viewing LTSSM States and Transitions (in the U4301 PCIe Gen3 Analyzer Online help).

• Viewing PCIe Gen3 Packets (in the U4301 PCIe Gen3 Analyzer Online help)

To go to different locations in the displayed data

In the Protocol Viewer window, you can go to different locations in the captured data by using the 
vertical scroll bars, by using the Go To buttons on the standard toolbar, or by choosing Go To 
commands from popup menus.

To go to different
locations using
toolbar buttons

1 Click one of the Go To buttons in the standard toolbar.

Menu Description

Go to Beginning — centers the beginning of the displayed data.

Go to Trigger — centers the trigger point in the displayed data.

Go to End — centers the end of the displayed data.
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To go to different
locations using
popup/context

menus

1 Right-click in the packet summary display area, and choose one of the Go To commands.

You can choose Beginning Of Data, End Of Data, Trigger, a marker, a Time, or a Sample.

Or, click in the marker overview bar, and choose one of the Go To commands.

To re-arrange packet columns

1 Position the mouse pointer over the packet field column you want to move.

2 Click and hold the mouse button.

3 Drag-and-drop the packet decode column to its new position.

The column is placed to the left of the red position indicator that appears.
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To insert or delete packet columns

To insert packet
columns

1 In the Protocol Viewer window, right-click in the column headings; then, choose Insert Column..., 
Insert Column Before..., or Insert Column After....

2 In the Insert dialog, select the packet fields/column(s) you want to insert.

3 In the Insert Options area of the Insert dialog, you can:

• Specify the Insert Order by dragging items in the list to the desired order. (Clicking the "X" in the 
list removes the item.)

• Specify the Column Channels (directions) associated. For a more in-depth discussion, see: 
“Understanding Column Channels (Directions)" on page 288.

• Choose to Overlay Fields; that is, you can choose to include multiple fields in one column.

• When fields are overlaid, you can specify the Column Name.

4 Click OK.

To delete selected
packet columns

1 Highlight the headings of the columns you want to delete (by clicking, Shift-clicking, or 
Ctrl-clicking the column names).

2 Right-click in (one of) the selected column heading(s); then, choose Delete>Column(s).

Understanding Column Channels (Directions)

When a column is inserted into a Protocol Viewer, the Insert column dialog lets you optionally select 
the channels whose data is shown in the column:
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By default, columns are inserted with all channels selected. This means the new column will display 
the data for any of the available channels attached to the Protocol Viewer. 

Channels are associated with directions which are simply another name for unidirectional links and 
represent the directional flow of protocol data along a particular network within the target platform's 
topology.

For example, say we have a bidirectional communication path between two PCI Express components: 
a root complex and a device as seen below:

Assume that we are probing both directions of PCIe traffic by using a single PCIe Gen3 Analyzer 
module. In this case, we have two directions of PCI Express packet traffic being generated and then 
displayed using Protocol Viewer. 

When inserting a new column within the Protocol Viewer window, you can specify for which of the 
channels the data in the inserted column should appear:

Figure 6 The Insert column dialog from the Protocol Viewer context menu

Figure 7 Two directions of PCI Express traffic

Direction 1 (Upstream)

Root
Complex

Device

Direction 2 (Downstream)
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For example, if you specify that a new PCI Express Packet column should show data for All Channels 
(directions), it looks like: 

Figure 8 Insert a PCI Express Packet column for both directions
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Alternatively, you can specify that a column be dedicated to certain channels (directions). Dedicating 
a column to certain channels (directions) can be useful when trying to visualize the flow of packets 
across a topology. For example, viewing the packets flow across both directions can be 
accomplished by creating two PCI Express Packet columns, each dedicated to a unique direction 
like: 

Note that you can also use the Show:Channels button drop-down to specify the channels (directions) 
that should be displayed in the Packet summary.

Figure 9 A PCI Express Packet column that displays data for both the Upstream and Downstream directions

Figure 10 Two PCI Express Packet columns that are each dedicated to a unique direction
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To show/hide parts of the packet summary display

1 Click one of the Show: buttons in the Packet Summary toolbar.

The Packet Summary toolbar contains the following Show buttons: 

The Packet Summary toolbar also contains the following Show buttons to show/hide Protocol 
Viewer panes (see page 301).

Menu Description

Displays the column channels (directions) and allows you to select the 
required directions for which data will be displayed in Protocol Viewer. The 
channels you select here are displayed in the Direction column of 
Summary pane. For more information, see “Understanding Column 
Channels (Directions)" on page 288.

Resize columns based on column content.

Resize columns based on column headers.

Toggles marker visibility. Markers appear in the far left column.

Toggles tool tip visibility. Tool tips are the information pop-ups that appear 
when the mouse cursor is held still over a packet row for a couple seconds:
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You can also make these selections in the Pane Display Options area of the Protocol Viewer 
Properties dialog box.

See Also • “Changing Protocol Viewer Window Properties" on page 302

To lockstep Protocol Viewer with other display windows

You can use the Lockstep windows feature to ensure that when a Protocol Viewer window is scrolled, 
other lockstepped windows are scrolled as well, such that the same time is centered in each 
lockstepped display window. This allows you to easily map and view correlated data in multiple 
display windows. 

You can lockstep a Protocol Viewer window with display windows such as another Protocol Viewer, 
Waveform, Listing, or Compare. 

1 From the Protocol Viewer toolbar, click the  Lockstep windows toolbar button.

2 In the Lockstep Windows dialog, select the display window(s) whose scrolling should be locked 
with this window and specify any offset from this window.

3 Click OK to close the Lockstep Windows dialog.

NOTE: In Waveform Viewer and Listing, you can access the Lockstep Windows dialog by clicking 
Lockstep Windows... from the Window Properties tab of the display window's Properties dialog,

Viewing a Selected Packet

When a packet is selected in the upper packet summary portion of the Protocol Viewer window (by 
clicking on a line or by using the up arrow or down arrow keys to highlight the previous or next line), 
information about the selected packet appears in the lower part of the window.

Menu Description

Toggles Header pane visibility from the Details pane.

Toggles Payload pane visibility from the Details pane.

Toggles Details pane visibility from the Details pane.

Toggles Lanes pane visibility from the Details pane.

Toggles Traffic Overview pane visibility from the Details pane.

Toggles LTSSM Overview pane visibility from the Details pane.
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Lower pane of the Protocol Viewer

• “To view and compare packet details" on page 294

• “To view a packet header" on page 297

• “To view a packet payload" on page 298

• “To view a packet's lanes" on page 299

• “To view LTSSM States and Transitions" on page 300

• “To show/hide Protocol Viewer panes" on page 301

See Also • “Viewing the Packet Summary" on page 285

To view and compare packet details

To view packet
details

1 Select a packet in the upper packet summary portion of the Protocol Viewer window (by clicking 
on a line or by using the up arrow or down arrow keys to highlight the previous or next line).

2 Select the Details tab in the lower portion of the window.

Packet details are displayed in the left pane of the lower portion of the window.

If you hold the mouse pointer motionless for a second over one of the packets, a tool tip (that is, 
a small box with text) appears with more information.
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3 You can expand or collapse the displayed information by clicking "+" or "-" in the packet 
hierarchy tree.

To compare packet
details

1 In the lower pane of the window, display the details of the packet that you want to compare. To 
do this, select the required packet from the list of packets in the upper pane.

The details of the packet are now displayed in the lower-left pane. The Compare buffer in the 
lower-right pane is currently empty. 

2 Click the  button displayed in the Compare buffer in the lower-right pane. Clicking this 
button copies the details of the packet currently displayed in the lower-left pane to the compare 
buffer at the right.



7 Analyzing the Captured Data

296 Keysight Logic and Protocol Analyzer User Guide

3 From the list of the packets displayed in the upper pane, select the other packet with which you 
want to compare the packet already displayed in the compare buffer.

The details of the selected packet are now displayed in the lower-left pane and the differences 
between the two packets are highlighted in the compare buffer in the lower-right pane.
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4 You can customize the display of packet information in the compare buffer as per the following 
options available in the compare buffer. 

• If you want to display only the differences between the two packets, then select the Show only 
Differences option from the listbox in the compare buffer.

• If you want to display only a few selected fields in the comparison, then click the Favorites 
button in the compare buffer, uncheck the fields that you do not want to display, and click OK. 
Finally, select the Show only Favorite Fields option from the listbox in the compare buffer. 
Doing so, displays only those fields in the lower pane that you selected for display. If you want 
to display the differences in only the favorite fields of the two packets, then select the Show 
only Favorite Differences option from the listbox in the compare buffer. 

• If desired, you can change the name for the packet information displayed in the compare 
buffer. A text field next to the Favorites button in the compare buffer displays the packet type. 
You can alter this text while comparing packets.

See Also • “To view a packet header" on page 297

• “To view a packet payload" on page 298

• “To view a packet's lanes" on page 299

• “To view LTSSM States and Transitions" on page 300

To view a packet header

1 Select a packet in the upper packet summary portion of the Protocol Viewer window (by clicking 
on a line or by using the up arrow or down arrow keys to highlight the previous or next line).

2 Select the Header tab in the lower portion of the window.
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If you hold the mouse pointer motionless for a second over one of the header fields, a tool tip 
(that is, a small box with text) appears with more information about the field.

3 If desired, you can select a different number Base.

See Also • “To view and compare packet details" on page 294

• “To view a packet payload" on page 298

• “To view a packet's lanes" on page 299

• “To view LTSSM States and Transitions" on page 300

To view a packet payload

1 Select a packet in the upper packet summary portion of the Protocol Viewer window (by clicking 
on a line or by using the up arrow or down arrow keys to highlight the previous or next line).

2 Select the Payload tab in the lower portion of the window.

Payload data bytes are displayed in the selected number of bytes per column and columns per 
row. The right-most column displays the row data in ASCII format.

3 You can format the display of payload bytes by selecting the Bytes Per Column, Columns Per 
Row, and Column Byte Order (when there is more than one byte per column).

See Also • To view and compare packet details (see page 294)

• To view a packet header (see page 297)

• To view a packet's lanes (see page 299)

• “To view LTSSM States and Transitions" on page 300
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To view a packet's lanes

1 Select a packet in the upper packet summary portion of the Protocol Viewer window (by clicking 
on a line or by using the up arrow or down arrow keys to highlight the previous or next line).

2 Select the Lanes tab in the lower portion of the window.

Lanes view in Protocol Viewer

The Lanes view in Protocol Exerciser shows vertical listing of packet data with respect to the logical 
lanes. In this view, you can see not just the packet data for the packet selected in the Summary pane 
but also the post packet data represented by different color codes. This helps you identify the start 
and end of data. The packet data in the lanes view is shown by the same color as used for the packet 
in the summary pane.

Context-menu of the Lanes view 

If you right-click anywhere in the Lanes view, a context-menu is displayed. 
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You can use this menu to customize the display of data in the Lanes view. For instance, if you disable 
the Lockstep option, then the upper summary pane and the lower Lanes view of Protocol viewer are 
not synchronized. Clicking on a packet in the summary view does not show its details in the Lane 
view and vice versa. You can also choose to color the packet data in the Lanes view with the color of 
the packet in the Summary pane or not to color the packets data.

See Also • To view and compare packet details (see page 294)

• To view a packet header (see page 297)

• To view a packet payload (see page 298)

To view LTSSM States and Transitions

You can use the LTSSM Overview tab to display the LTSSM states and their transitions as detected 
from the PCIe data captured in a trace. To know more about how to view these states, refer to the 
topic Viewing LTSSM States and Transitions in the U4301 PCIe Gen3 Analyzer online help.
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To show/hide Protocol Viewer panes

1 Click the toolbar buttons in the Packet Summary toolbar to toggle the visibility of various panes.

Alternatively, make these selections in the Pane Display Options area of the Window Properties 
tab in the Packet Viewer Properties dialog box.

See Also • Changing Protocol Viewer Window Properties (see page 302)

Changing Packet Summary Event Colors

To change the colors associated with events in the Protocol Viewer window:

1 Right-click in the packet summary portion of the window, and choose Properties....

2 In the Protocol Viewer Properties dialog, select the Colors tab.
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3 In the Colors tab:

a Select the packet event type whose color you want to change.

b Select the Background color.

c Select the Foreground color or click Contrast Foreground to automatically get a color with good 
contrast to the selected background color.

4 Click OK to apply the changes and close the Protocol Viewer Properties dialog.

To restore event
color defaults

1 In the Protocol Viewer Properties dialog's Colors tab, click Restore All Defaults or Restore Selected 
Defaults.

2 Click OK to apply the changes and close the Protocol Viewer Properties dialog.

See Also • “Changing Protocol Viewer Window Properties" on page 302

• “Changing Packet Summary Column Properties" on page 304

Changing Protocol Viewer Window Properties

You can change properties that affect the entire Protocol Viewer display window.

1 Right-click in the packet summary portion of the window, and choose Properties....

2 In the Protocol Viewer Properties dialog, select the Window Properties tab.
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3 In the Window Properties tab, you can:

• Change the selected row box color (see page 303)

• Change the Protocol Viewer font size (see page 303)

• Lock scrolling with other display windows (see page 303)

• Show/hide parts of the packet summary display (see page 292)

• Show/hide Protocol Viewer panes (see page 301)

4 Click OK to apply the changes and close the Protocol Viewer Properties dialog.

See Also • Changing Packet Summary Event Colors (see page 301)

• Changing Packet Summary Column Properties (see page 304)

To change the selected row box color

To highlight the selected line in the upper packet summary area of the Protocol Viewer window, a 
box is drawn around it.

1 In the Window Properties tab of the Protocol Viewer Properties dialog, click the Selected Row 
color selection button and select the desired highlight box color from the palette.

If you want to use a color that is not on the palette, click Other... to access the custom color 
dialog.

2 Click OK to apply the changes and close the Protocol Viewer Properties dialog.

To change the Protocol Viewer font size

The font size property adjusts the data display and packet decode column heading text size.

1 In the Window Properties tab of the Protocol Viewer Properties dialog, enter the desired Font 
Size.

Fonts can range from size 6 through 72 points.

2 Click OK to apply the changes and close the Protocol Viewer Properties dialog.

As the font size is changed, the column width may be automatically increased to fit the new text size.

To lock scrolling with other display windows
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You can lock display windows (for example, Waveform, Listing, Compare, etc.) so that when one 
window is scrolled, others are scrolled as well, such that the same time is centered in each display.

1 In the Window Properties tab of the Protocol Viewer Properties dialog, click Lockstep Windows....

2 In the Lockstep Windows dialog, select the display windows whose scrolling should be locked 
with this window and specify any offset from this window.

3 Click OK to close the Lockstep Windows dialog.

4 Click OK to apply the changes and close the Protocol Viewer Properties dialog.

Changing Packet Summary Column Properties

In the Protocol Viewer display window, you can change the color, width, alignment, or number base 
of bus/signal data columns.

To change the properties of a bus/signal data column in the Protocol Viewer window:

1 Right-click on a packet decode column, and choose Properties....

Or, highlight the packet decode columns whose properties you want to change (by clicking, 
Shift-clicking, or Ctrl-clicking the column headings), and choose Edit>Window Properties... from 
the main menu.

2 In the Protocol Viewer Properties dialog's Column Properties tab:

You can:

• Select the Column to which the property changes apply. You can select:

• Any packet decode column that is being displayed.

• <all> packet decode columns.
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• Overlay... to include multiple fields in a column.

• “To change the channels (directions) of a packet column" on page 305

• “To change the width of a packet column" on page 305

• “To change the alignment of a packet column" on page 305

• “To change a packet column's number base" on page 306

• “To select the marker for marker-relative times" on page 306

• “To select fixed time units" on page 306

3 Click OK to apply the changes and close the Protocol Viewer Properties dialog.

See Also • “Changing Packet Summary Event Colors" on page 301

• “Changing Protocol Viewer Window Properties" on page 302

To change the channels (directions) of a packet column

1 In the Protocol Viewer Properties dialog's Column Properties tab, check or uncheck the Channels 
All Channels checkbox.

If you want the column to display data for specified channels (directions) only, uncheck All and 
check the desired directions in the drop-down list.

If you want the column to display data for all channels (directions), check All Channels.

For more information, see “Understanding Column Channels (Directions)" on page 288.

2 Click OK to apply the changes and close the Protocol Viewer Properties dialog.

To change the width of a packet column

1 In the packet headings row of the Protocol Viewer window, position the mouse pointer over a 
column separator line; when the cursor changes to a resizing cursor, drag the column border.

Or:

1 In the Protocol Viewer Properties dialog's Column Properties tab, enter the Width value in pixels.

The minimum column width is 1 pixel, while the maximum width is 1000 pixels.

2 Click OK to apply the changes and close the Protocol Viewer Properties dialog.

To change the alignment of a packet column

The Alignment property sets the display of data to be left-justified, right-justified, or centered within 
the column.

1 In the Protocol Viewer Properties dialog's Column Properties tab, select the Alignment from:

• Left

• Center

• Right

2 Click OK to apply the changes and close the Protocol Viewer Properties dialog.

TIP You can autosize individual columns by placing the mouse pointer over the right border of the 
column header box; then, when the pointer icon changes to a resizing pointer, double-click.

TIP If your keyboard has a numeric keypad, you can autosize all columns by selecting any column 
header box (to highlight it) and by pressing Ctrl and "+" on the numeric keypad.
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To change a packet column's number base

The base property specifies the number base to use when displaying the decoded packet values.

1 In the Column Properties tab of the Protocol Viewer Properties dialog, select the desired number 
Base from:

• Binary

• Hex

• Octal

• Decimal

• Signed Decimal (two's complement, the only choice for the "Sample Number" column)

• Ascii

• Symbol (see Displaying Names (Symbols) for Bus/Signal Values (see page 243))

• Hardware Address

• Dot Notation

• Field Decode

For the main packet decode information column, you can select from:

• Packet Summary

• Packet Bytes

For other generated packet columns, the only choice may be:

• String

If the "Time" column has been selected instead of a data column, your choices change from a 
numeric format to:

• Absolute

• Relative Previous

• Relative Marker

2 Click OK to apply the changes and close the Protocol Viewer Properties dialog.

To select the marker for marker-relative times

In the Protocol Viewer window, you can display times relative to a marker.

1 In the Column Properties tab of the Protocol Viewer Properties dialog, use the Bus/Signal 
selection to select the Time column.

2 For the Base property, select Relative Marker.

3 For the Marker property, select the marker to which relative times should be displayed.

4 Click OK to apply the changes and close the Protocol Viewer Properties dialog.

To select fixed time units

In the Protocol Viewer window, you can display time column values with a fixed unit.

1 In the Column Properties tab of the Protocol Viewer Properties dialog, use the Bus/Signal 
selection to select the Time column.

2 In the Time Column Properties box, check Use Fixed Unit; then, select the desired time unit from 
the drop-down list.

3 Click OK to apply the changes and close the Protocol Viewer Properties dialog.
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Analyzing the Same Data in Different Ways (Using the Overview Window)

The Overview window lets you specify how the data is sent from the logic analyzer data acquisition 
module to post-processing tools and display windows. For example, you can display the same data 
filtered in one Listing window and unfiltered in another Listing window.

To analyze the same data in different ways:

1 Open or display the Overview window.

2 Add new windows.

If the Add New Window After dialog appears, select the module or tool that the new window 
should be placed after.

3 Add new tools.

If the New Tool dialog appears, select where the new tool should be placed.

For more information on using the Overview window, see:

• To open or display the Overview window (see page 307)

• To add, duplicate, or delete windows and tools (see page 307)

• To edit window or tool properties (see page 310)

• To rename windows, tools, and modules (see page 311)

• To redraw the Overview window (see page 311)

• To delete the Overview window (see page 311)

See Also • Overview Window (see page 418)

• Waveform Display Window (see page 404)

• Listing Display Window (see page 409)

• Compare Display Window (see page 411)

• Source Display Window (see page 412)

• "Filter/Colorize Tool" (in the online help)

• "Inverse Assembly Tools" (in the online help)

• "Bus Analysis Tools" (in the online help)

• "Tools" (in the online help)

To open or display the Overview window

• Select Tools>Overview.

• Select Window>Overview.

• If the Overview window is already open and you have Tabbed Windows (see page 313) turned on, 
you can display the Overview window by selecting the Overview tab at the bottom of the window.

See Also • Analyzing the Same Data in Different Ways (Using the Overview Window) (see page 307)

To add, duplicate, or delete windows and tools

You can add new listing and waveform display windows to the interface. As new windows are added, 
they appear in the list under Window in the menu bar. The active window will have a check mark. All 
available windows can be accessed either through the menu bar or through the use of tabs.

When you add a new tool to the logic analyzer's measurement configuration, its name appears at the 
bottom of the Tools menu. The tools interact with each other, so that you can progressively filter data 
or color parts of an inverse-assembled listing.
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To add new
windows

• From the menu bar, select Window>New type....

• If the windows are tabbed, you can also right-click on the tab and select Window>New type....

• In the Overview window, right-click in the background, and select New Window from the popup 
menu.

• In the Overview window, select New Window from a module or tool menu.

The new window is placed after the module or tool.

To delete windows • From the window's menu in the menu bar, select Delete.

• If the windows are tabbed, you can right-click on the tab and select Delete.

• In the Overview window, select Delete from the window's menu.

To add new tools • From the menu bar, select Tools>New type....

• In the Overview window, right-click in the background, and select New Tool from the popup 
menu.

• In the Overview window, select New Tool from a module or tool menu.

The new tool is placed after the module or tool.

If the tool you want is not listed, make sure that you have "installed" (in the online help) and licensed 
(see page 323) the tool.
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To delete tools • In the Overview window, select Delete from the tool's menu.

To duplicate
windows

In the Overview window, you can duplicate windows from window menus. Duplicating a window is 
the same as adding a new window except that the new window has the same properties of the 
duplicated window.

To delete
connections

1 In the Overview window, select the connection you wish to delete.

2 Select Delete Connection.

TIP Many tools come with a configuration file. Loading the configuration file will add the tool, as well as 
set up the bus names, symbols, or filters used by the tool.
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Deleting a connection has the effect of deleting the window or tool at the end of the connection.

To add connections There is no way to draw connections between modules, tools, and windows other than by adding 
new windows or tools. See: Connection Rules (see page 418).

See Also • Analyzing the Same Data in Different Ways (Using the Overview Window) (see page 307)

• To turn window tabs on/off (see page 313)

To edit window or tool properties

To edit window
properties

• In the Overview window, select the Properties... command from the window menu.

Or, from the menu bar, select the Properties... command from the window's menu.

Or, right-click in the display window and select the Properties... command from the popup menu.

• In the window's properties dialog, make the desired changes.

• Select OK to apply the changes and close the dialog.

To edit tool
properties

After adding a new tool such as a filter or inverse assembler, you can modify its properties as you 
refine your analysis of the data.

1 In the Overview window, click Properties on the tool.

Or, from the menu bar, select Tools>tool name.

2 In the tool dialog box, change properties.

3 Select OK to apply the changes and close the box.

See Also • Analyzing the Same Data in Different Ways (Using the Overview Window) (see page 307)

• To set waveform window properties (see page 227)
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• To set listing window properties (see page 238)

• To set Compare window properties (see page 276)

To rename windows, tools, and modules

1 Display the Overview window.

2 Select the Rename... command from the window, tool, or module menu.

See Also • Analyzing the Same Data in Different Ways (Using the Overview Window) (see page 307)

To redraw the Overview window

1 Display the Overview window.

2 Select the Overview>Redraw command, or:

Right-click in the Overview window and select Redraw.

See Also • Analyzing the Same Data in Different Ways (Using the Overview Window) (see page 307)

To delete the Overview window

1 Display the Overview window.

2 Select the Overview>Delete command, or:

If Tabbed Windows (see page 313) are turned on, right-click the Overview tab and select Delete.

See Also • Analyzing the Same Data in Different Ways (Using the Overview Window) (see page 307)
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Setting the System Trigger and Skew Between Modules

When there are multiple module (see page 616)s in a logic analyzer or logic analysis system, there is 
a single Time=0 point for all modules. If one module arms another, the second module has a trigger 
that is not at Time=0 with respect to the first module. Because there is a single Time=0 point, when 
you see one module captures an event at Time=-435 ns and another module captures an event at 
-835 ns, you know the two events occurred 400 ns apart.

This means one module's trigger reference point must be designated the system trigger (which is 
Time=0).

You can specify the skew between the system trigger and the trigger reference points of other 
modules. When two modules are looking at the same data, you may want to specify skew so that the 
waveforms from the two modules line up.

In all display windows, there are global, immovable trigger markers for each module. The marker for 
the system trigger has a special icon.

Each display window has its own Beginning Of Data and End Of Data markers based upon the buses 
and signals displayed in that window. For example, if Bus1 is acquired on Logic Analyzer-1 and Bus2 
is acquired on Logic Analyzer-2 and both buses are included in Viewer1, then the Beginning Of Data 
will be the earliest sample in either Logic Analyzer-1 or Logic Analyzer-2, and the End Of Data will be 
the latest sample in either Logic Analyzer-1 or Logic Analyzer-2. If Viewer1 only contains buses from 
Logic Analyzer-1, then its beginning and end of data are only based upon Logic Analyzer-1.

To set the system trigger and skew between modules:

1 From the main menu, choose Setup>Skew & System Trigger....

2 In the Module Skew and System Trigger dialog (see page 446), select the module whose trigger 
reference point is to be Time=0 as the System Trigger.

3 To specify skew for other modules, enter the appropriate values in their Skew fields.

4 If you want the system trigger to be changed after the next run to the first module that triggers, 
check First module to trigger designates the System Trigger.

5 Click OK.

If a module is not the system trigger, the module icon in the Overview window is the standard logic 
analyzer icon:

When a module is designated the system trigger, an additional red "T" icon appears:



Keysight Logic and Protocol Analyzer User Guide 313

Analyzing the Captured Data 7

Using Display Windows

• To add or delete display windows (see page 313)

• To turn window tabs on/off (see page 313)

See Also • To change the "Go to Trigger on Run" option (see page 196)

To add or delete display windows

You can add new listing and waveform display windows to the interface. As new windows are added, 
they appear in the list under Window in the menu bar. The active window will have a check mark. All 
available windows can be accessed either through the menu bar or through the use of tabs.

To add a new
display windows

1 In the menu bar, click Window>New Listing or New Waveform. If the windows are tabbed, you 
can also right-click on the tab, then select New Listing or New Waveform.

To delete display
windows

1 From the menu bar, click Window>Close. If windows are tabbed, you can also right-click on the 
tab, then select Close.

See Also • To turn window tabs on/off (see page 313)

To turn window tabs on/off

By default, the Listing and Waveform display windows are tabbed for ease of switching between 
displays.

To turn on or off window tabs, select View>Tabbed Windows.

To switch display windows when tabs are turned off, you must select Window>"display window 
name".

See Also • To add or delete display windows (see page 313)
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Printing Captured Data

There are three ways to create printed documentation of your measurement:

• To print captured data (see page 314)

• To copy text to the clip board (see page 314)

• To copy a screen to the clip board (see page 315)

See Also • To install a printer (see page 315)

• To connect a LAN (see page 315)

To print captured data

1 From the menu bar, select File>Print....

2 In the Print What section, select the desired display window.

3 To change the headers, footers, or margins, click Options... and specify the changes in the 
resulting dialog box. When you are done, click OK.

4 In the Print range section, select either:

• All

• Time range

• Sample range

• Marker range

If you selected Time, Sample, or Marker, set the desired range by entering or selecting the from 
and to values.

5 Click OK to print the specified data.

Data is printed from the smallest time/sample to the largest.

To print captured
data to ASCII text

files

Set up a generic/text only printer that prints to the "FILE:" port. In the Windows Add Printer Wizard:

1 Select a Local printer. (Do not automatically detect and install a plug and play printer.)

2 Select the FILE: port.

3 Select the Generic manufacturer and the Generic / Text Only printer model.

After you have set up the generic/text only printer, you can print captured data to it just like any 
other printer.

Note that you can also export captured data to CSV format ASCII text files (see page 199).

See Also • To export data to CSV format files (see page 199)

• To install a printer (see page 315)

To copy text to the clip board

1 From the listing display area, position the mouse cursor over the upper-left corner of the desired 
display region.

2 Click and hold the left mouse button, then drag the mouse cursor to the lower-right corner. 
Release the mouse button. A rectangle is drawn around the defined region (snaps to state lines 
and bus/signal columns).

NOTE
The first time you access the print dialog, you are asked to install a printer (see page 315). Follow 
the directions in the printer install dialogs that appear.
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3 From the shortcut list that appears, click Copy Text.

4 Open a word processor or spreadsheet program, paste the text into the program, and print the 
pasted data text.

To copy a screen to the clip board

1 Click Edit>Copy Screen. The currently displayed window is copied into the windows clip board 
buffer.

2 Paste the contents of the clip board buffer into a graphics editing program of your choice.

3 Print the screen from the graphics program.

To install a printer

Local and network printers are installed outside of the logic analyzer environment using the Windows 
printer install wizard.

1 Click Start>Settings>Printers.

2 Click on an existing printer, or click Add Printer.

3 Follow the Windows printer install wizard instructions.

See Also • To connect a LAN (see page 315)

To connect a LAN

Local area networks (LAN) are installed outside of the logic analyzer environment using the Windows 
network configuration wizard.

1 Click Start>Settings>Network and Dial-up Connections.

2 Click an existing connection, or click Make New Connection.

3 Follow the Windows network install wizard instructions.

See Also • "AXIe based Logic and Protocol Analysis – Quick Start Guide"

• "AXIe based Logic and Protocol Analysis – Installation Guide"

• "16850 Series Portable Logic Analyzers Installation/Quick Start Guide"

• "Changing the Windows XP Firewall Settings" (in the online help)

• Network Troubleshooting Guide (see page 348)
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8 B4661A Memory Analysis 
Software Tools

The B4661A software package includes a variety of tools that can help you perform DDR/LPDDR 
post-process as well as real-time protocol compliance violation testing, monitor and improve 
performance of your SDRAM, decode and view memory transactions, and set up your logic analyzer 
for DDR/LPDDR data capture and analysis.

You can download and install this package from www.keysight.com/find/B4661A page.

www.keysight.com/find/B4661A 
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Tools installed with the B4661A Memory Analysis Software

When you install the B4661A Memory Analysis software package, the following tools are installed. 
Some of these tools require that you purchase and install the required software license to use them. 
Others are standard tools and do not require any license for use. 

Software Tool Description and Usage License Requirement Where to find detailed information on tool?

DDR Bus Decoder
(With Address Conversion and 
Trigger Tool)

Allows you to decode and view 
transactions, commands, and data 
from a DDR2, DDR3, or DDR4 memory 
bus in your target system.
Includes default configurations for 
DDR probing solutions for Keysight 
logic analyzers

Licensed tool
Requires B4661A-1 software 
license for the Address 
Conversion and Trigger 
functionality

Refer to the tool's online help that gets installed 
with this tool.
DDR Bus Decoder Online Help

LPDDR Bus Decoder
(With Address Conversion and 
Trigger Tool)

Allows you to decode and view 
transactions, commands, and data 
from a LPDDR1,  LPDDR2, LPDDR3 or 
LPDDR4 SDRAM memory bus in your 
device under test.
Includes default configurations for 
LPDDR probing solutions for Keysight 
logic analyzers

Licensed tool
Requires B4661A-2 software 
license for the Address 
Conversion and Trigger 
functionality

Refer to the tool's online help that gets installed 
with this tool. 
LPDDR Bus Decoder Online Help

DDR/LPDDR Post Process 
Compliance 

 Evaluates a captured DDR/LPDDR 
trace against a set of user-defined 
limits to help you validate that a 
memory system is operating properly. 

Licensed tool
Requires B4661A-3 software 
license

Refer to the tool's online help that gets installed 
with this tool and is available in the tool's GUI. 

Real-Time Compliance Evaluates DDR/LPDDR data captured 
by a Keysight Logic Analyzer in 
real-time to detect and report 
violations to compliance limits 
specified in DDR/LPDDR 
specifications.

Licensed tool
Requires B4661A-3 software 
license

Refer to the tool's online help that gets installed 
with this tool and is available in the tool's GUI. 

DDR3/4 and LPDDR2/3/4 
Performance Analysis 
(Available as Memory Analysis 
window in Logic and Protocol 
Analyzer GUI)

Helps you to decode and process the 
captured memory data to analyze the 
performance of your SDRAM.

Licensed tool
Requires B4661A-4 software 
license to get the full feature 
set and capabilities of the 
tool

Refer to the help book Analyzing Memory Data 
using the Memory Analysis Window in the Logic 
and Protocol Analyzer help.
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For all the above-mentioned tools, you can download the user guides from 
www.keysight.com/find/B4661A page. These guides are also available at the following location when 
you install the Logic and Protocol Analyzer software and B4661A software:

<logic Analyzer Install location>\help\pdfs

ONFi Analysis 
(Available as ONFi Analysis window 
in Logic and Protocol Analyzer GUI)

Helps you to decode and process the 
captured ONFi data to analyze the 
performance of your NAND Flash 
memory device.

Licensed tool
Requires B4661A-4 software 
license to get the full feature 
set and capabilities of the 
tool

Refer to the help book Analyzing ONFi Data using 
the ONFi Analysis Window in the Logic and 
Protocol Analyzer help.

DDR Setup Assistant A wizard-like application that helps 
you set up your logic analyzer properly 
for DDR/LPDDR data capture and 
analysis.

Standard tool
Does not require a license

Refer to the online help book DDR Setup 
Assistant Online Help that gets installed when 
you install this tool.

DDR/LPDDR Custom Configuration 
Creator

Allows you to define the footprints 
layout as per your custom probing 
solution used in the DDR/LPDDR setup 
and then create an XML configuration 
file based on this footprint information. 

Standard tool
Does not require a license

Refer to the tool's online help that gets installed 
with this tool and is available in the tool's GUI. 

Software Tool Description and Usage License Requirement Where to find detailed information on tool?

www.keysight.com/find/B4661A 
www.keysight.com/find/B4661A 
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9 Managing Software Licenses

To view active software license information  /  322
To activate software licenses  /  323
To access floating license servers  /  324
To borrow floating licenses and return them early  /  326

Starting with the 3.20 release of the Keysight Logic Analyzer application, you are able to order 
floating (also known as counted) licenses for tools and other add-in software. (Previously, all licenses 
were node-locked.)

Before you can use floating licenses, you need to set up a license server.

See Also • "License Server Administration Guide" for more information on setting up license server.

• Software Licensing Dialog (see page 461)

NOTE
With the 3.20 release of the Keysight Logic Analyzer application, you had to set up the 
LM_LICENSE_FILE environment variable to access floating license servers. Starting with the 3.30 
release, license servers are accessed from within the Keysight Logic Analyzer application, and you 
must not use the LM_LICENSE_FILE environment variable any more.
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To view active software license information

1 From the main menu, choose Help>Software Licensing....

2 In the Software Licensing dialog's Summary tab (see page 461):

• You see all the software licenses that can be used.

• Red check marks show floating licenses that are already in use.

• Red "X"s show that software is not installed.

• You can select a license and click Show Details... to see detailed information about the license.

• You can copy all licensing summary information to the clip board.

See Also • To activate software licenses (see page 323)

• To access floating license servers (see page 324)

• To borrow floating licenses and return them early (see page 326)

NOTE
When an "Advanced Customization Environment - Development Package" floating license is used, 
it is taken for the whole session. You must open a new configuration to return the license.

NOTE
When an "ASCII Remote Programming Interface Package" floating license is used, it is taken for as 
long as the Keysight Logic Analyzer application runs. You must close the application to return the 
license.
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To activate software licenses

1 Follow the instructions on the Entitlement Certificate you received with your software purchase.

2 From the Keysight Logic Analyzer application's main menu, choose Help>Software Licensing....

3 In the Software Licensing dialog's Activation tab (see page 463), copy the Licensing Host ID. You 
will need this when activating licenses.

4 Visit the Keysight license redemption web site. The URL should be printed on the Entitlement 
Certificate.

The license redemption web site will use the order number or other license activation code which 
is printed on the certificate, along with the Licensing Host ID, to generate a license file. The 
license file will be e-mailed to you.

5 To install the license file and enable the software, follow the instructions in the e-mail that 
contains the license file.

Those instructions will tell you to install the license file in the proper directory on the logic 
analysis system or floating license server and restart the Keysight Logic Analyzer application or 
license server. On a logic analysis system, the license directory is usually "C:\Program Files (x86)\
Agilent Technologies\Logic Analyzer\License". For the proper directory on a license server, see 
the "License Server Administration Guide".

The license file must have a .lic extension.

See Also • To view active software license information (see page 322)

• To access floating license servers (see page 324)

• To borrow floating licenses and return them early (see page 326)
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To access floating license servers

Before you can use floating licenses, you need to set up a license server (see "License Server 
Administration Guide").

1 Open the Keysight Logic Analyzer application (with the default configuration) so that no floating 
licenses are in use.

2 From the main menu, choose Help>Software Licensing....

3 Select the Software Licensing dialog's Floating License Servers tab (see page 464).

To add a floating
license server

1 Click Add Server....

2 In the Add License Server dialog, enter the port number and name of the floating license server.

The port number is typically 27000, but it can be different depending on how the floating license 
server was set up.

3 Click OK to close the Add License Server dialog.

4 In the Software Licensing dialog, click Apply.

To move a server
up or down in the

search order

1 In the License Servers list, select the license server you want to move.

2 Click Move Up or Move Down.

3 Click Apply.

CAUTION
Only enter names of computers (or logic analyzers) that are floating license servers. Otherwise, the 
license manager interface hangs up for many minutes trying to determine if the computer is really 
a floating license server.
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To refresh floating
license server

status

1 Click Refresh.

The green or red server availability indicators are only a check of whether the computer is on the 
network, not of whether the license server software is running on that computer.

To delete a floating
license server

1 In the License Servers list, select the license server you want to delete.

2 Click Delete Server.

3 Click Apply.

See Also • "License Server Administration Guide"

• To view active software license information (see page 322)

• To activate software licenses (see page 323)

• To borrow floating licenses and return them early (see page 326)
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To borrow floating licenses and return them early

You can borrow floating licenses from a server for a period of time, for example, if you're taking a 
logic analyzer (or a computer running the Keysight Logic Analyzer application) out of the office (or 
just off the network). When a borrowed license's time expires, the license is automatically returned to 
the server. However, you can also return licenses early.

To access the
Software Licensing
dialog's Borrow tab

1 From the main menu, choose Help>Software Licensing....

2 Select the Software Licensing dialog's Borrow tab (see page 465).

To borrow floating
licenses

1 Set up the configuration (or open a configuration file) that uses the software you need to borrow 
licenses for.

2 Access the Software Licensing dialog's Borrow tab.

3 In the Borrow Licenses area, enter the date and time when the borrowed license will be returned.

The default time is seven days. The minimum time is ten minutes.

4 Click Borrow.

Repeat these steps to borrow additional licenses.

To return floating
licenses early

When returning borrowed floating licenses early, all borrowed licenses must be returned. You are not 
able to return borrowed licenses while any licenses are checked out.

1 Open the Keysight Logic Analyzer application (with the default configuration).

2 Access the Software Licensing dialog's Borrow tab.

3 In the Return Borrowed Licenses area, click Return.

See Also • To view active software license information (see page 322)

• To activate software licenses (see page 323)

• To access floating license servers (see page 324)
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10 Updating Software

You may be able to install logic analyzer software from the logic analysis system's hard disk 
(depending on when it shipped from the factory or the application install CD that was last used).

To update, add, or remove logic analyzer software, or to remove the install packages from previous 
releases (and free disk space):

1 In the Keysight Logic Analyzer application, choose Help>Software Update....

2 In the Add or Remove Keysight Logic Analyzer Software tool:

• To update software: click Update Software and select the software you want to update; then, 
click Update Selected.

• To add software: click Add New Software and select the software you want to add; then, click 
Add Selected.

When adding new software, you can show all versions or just the latest version.
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• To remove software: click Remove Software and select the software you want to remove; then, 
click Remove Selected.

• To remove old releases and free disk space: click Manage Releases and select the release 
whose files you want to remove; then, click Remove Selected.
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Note that, when adding updating, or removing software, you can select all software or none, and 
you can sort the software list by name, version, size, or date.

See Also You can also download and install the latest versions of logic analyzer software from the Keysight 
web site:

• "http://www.keysight.com/find/la-sw-download"

http://www.agilent.com/find/la-sw-download
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11 Solving Problems

When troubleshooting problems or looking for more information, see:

• If starting in offline mode is unexpected (see page 332)

• If an ALA format configuration file won't open (see page 333)

• Interpreting Error Messages (see page 334)

• License Problems (see page 342)

• Running Self Tests (see page 343)

• Network Troubleshooting Guide (see page 348)

• Remote Desktop Set Up (see page 350)

See Also • For More Information (see page 351)

• Keysight Logic Analyzer Readme
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If starting in offline mode is unexpected

When starting the Keysight Logic Analyzer application on a logic analysis system or logic analyzer, 
you expect to connect to local hardware. If you have set up to auto-connect to a remote logic 
analysis system or logic analyzer, you expect to connect to the remote hardware. If the Keysight 
Logic Analyzer application starts in offline mode instead:

• It could be that the Keysight Logic Analyzer application is already running a local session. You can 
run multiple instances of the application, but if there's a local session is already running, 
additional instances start in offline mode.

• In the case where you have set up to auto-connect to a remote logic analysis system or logic 
analyzer, it could be:

• The remote system is powered-down or off the network. In this case, you are given an 
information dialog about the system being offline before starting in offline mode.

• The remote system is in the process of having its software updated.

• The remote system software has been updated, resulting in an "incompatible remote service". 
In this case, make sure the same version of software is installed on the local computer or logic 
analysis system.
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If an ALA format configuration file won't open

If an ALA format configuration file won't open because modules are incompatible, you can still load 
the setup information from the ALA format configuration file:

1 Load the incompatible ALA format configuration file in offline mode.

(If you're only interested in looking at the data, you can ignore the following steps.)

2 Save the configuration's setup information as an XML format configuration file (see To save a 
configuration file (see page 198)).

3 Go back online (see Returning to Online Analysis (see page 59)).

4 Open the XML format configuration file (see To open a configuration file (see page 208) and 
possibly To transfer module setups to/from multi-module systems (see page 210)).

5 Save the loaded setup information to an ALA format configuration file.

This procedure converts an incompatible ALA format configuration file into one that is compatible.
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Interpreting Error Messages

To locate the error you received, use the help window's Search tab to search for key words in the 
error message.

• Error Messages (see page 334)

• Warning Messages (see page 339)

• Informational Messages (see page 340)

See Also • Solving Problems (see page 331)

Error Messages

• Acquisition Errors (see page 334)

• Bus/Signal Errors (see page 334)

• File Errors (see page 336)

• Hardware Errors (see page 337)

• Help File Errors (see page 337)

• Trigger Errors (see page 337)

See Also • Interpreting Error Messages (see page 334)

Acquisition Errors

An acquisition
error has occurred
due to state clock

edges occurring
too close together.

This could be the
result of: - Poor

state clock quality
(signal integrity). -
Inadequate probe

grounding (try
multiple grounds

around clock
signals). - State

clock edges
spaced closer than

specifications
allow. - Multiple
clocks selected

and spaced closer
than specifications

allow.

When in the state acquisition mode, the logic analyzer requires a clear clock signal no faster than the 
maximum state clock speed (see Specifications and Characteristics (see page 587)). Poor state clock 
quality may be caused by loading in the device under test. It may also be caused by a clock setup 
(see page 124) in the Sampling Setup dialog that is a combination of several signals which combined 
together violate the clock specification. When your clock setup uses multiple edges, the logic 
analyzer's setup/hold time typically increases (see Specifications and Characteristics (see 
page 587)). When you are using a clock speed near the specification, grounding every second or 
third probe connection is recommended.

Bus/Signal Errors

Maximum of 128
channels per Bus.

The logic analyzer cannot handle buses that contain more than 128 channels (signals). If you require 
wider buses, try breaking the bus into two or more buses, for example Data_HI and Data_LO.
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Cannot group into
Bus. Maximum of
128 channels per

Bus.

The logic analyzer cannot handle buses that contain more than 128 channels (signals). If you require 
wider buses, try breaking the bus into two or more buses, for example Data_HI and Data_LO.

The following
Bus/Signals are

required to have a
specific number of
assigned channels

because they are
locked. Please

correct the
following

Bus/Signals: name
(has num1

channels, requires
num2 channels)

Some tools may "lock" buses and signals that are necessary to produce their output. The locked 
buses and signals may have their specific channel assignments changed, but the total number of 
channels on each bus or signal must stay the same. Please change the channel assignment for each 
indicated bus or signal so that the width is num2. This message sometimes appears in combination 
with the next one. In these cases, you may have changed a configuration to use half the pods for 
sampling. Check the sampling tab.

Every Bus/Signal
requires at least

one assigned
channel. Please

assign channels to
the following
Bus/Signals:

Every bus or signal requires at least one channel. If you do not see the Bus/Signal named in the error 
dialog, try scrolling the Bus/Signal listing. Certain tools may also have created buses or signals 
within folders. If you are trying to avoid showing extra information on the viewer, delete the row (see 
page 227) or column (see page 238) the bus or signal is in. This removes the information from the 
viewer without losing the bus/signal setup information. This message sometimes appears in 
combination with the previous one. In these cases, you may have changed a configuration to use half 
the pods for sampling. Check the sampling tab.

Minimum of one
Bus/Signal with

assigned channels
required. Please

add a Bus/Signal.

The bus/signal setup cannot be closed because you have deleted all buses and signals. Folders only 
contain buses and signals, but do not represent data mappings of themselves. In order to close the 
dialog, select Add Bus/Signal. Assign at least one channel to the new bus or signal. Alternatively, 
you can select Cancel and revert to the previous bus and signal assignments.

name is locked and
cannot be deleted

because it is
required by

another tool in the
application. In

order to unlock it,
the following tools

must be deleted:
tool

Some tools may "lock" buses and signals that are necessary to produce their output. Until the tool is 
deleted via Tools>Overview, you cannot delete or rename the bus or signal.
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name is locked and
cannot be renamed

because it is
required by

another tool in the
application. In

order to unlock it,
the following tools

must be deleted:
tool

Some tools may "lock" buses and signals that are necessary to produce their output. Until the tool is 
deleted via Tools>Overview, you cannot delete or rename the bus or signal.

Cannot change pod
selection while

there are locked
Bus/Signals.

Some tools may "lock" buses and signals that are necessary to produce their output. Until the tool is 
deleted via Tools>Overview, you cannot modify the bus or signal by changing the pod in use.

Cannot delete
folder because it
contains one or

more locked
children.

Some tools may "lock" buses and signals that are necessary to produce their output. The folder you 
have tried to delete contains a unique copy of at least one locked bus or signal. You can move the 
locked buses or signals outside the folder, and then delete the folder. Alternatively, you can delete 
the tool locking the buses or signals via Tools>Overview, and then delete the folder.

Unable to set setup
and hold times for

this Bus/Signal
since no channels

have been
assigned. Please
assign channels

before using setup
and hold.

The possible valid range of setup and hold values depends on the clock setup used by the pods that 
the channels are attached to. Without knowing which pods' channels are part of the bus or signal, it 
is impossible for the logic analyzer to set appropriate ranges. Please assign channels to the bus or 
signal, and then set setup and hold.

Please enter a user
threshold value.

All pods will be set to the same threshold value. If you select OK without setting a value, the current 
threshold values (at least one of which is different from the rest) are retained. Please check the dialog 
and be sure all fields are filled in.

Please enter a
threshold value.

All pods will be set to the same threshold value. If you select OK without setting a value, the current 
threshold values (at least one of which is different from the rest) are retained. Please check the dialog 
and be sure all fields are filled in.

File Errors

Error trying to
remove file:

"directory/hardwar
e_log.txt".

When the logic analyzer is started up, it replaces the old hardware_log.txt file. For some reason, this 
time the old hardware log was not able to be deleted. This could indicate a problem with the disk 
that the file is stored on.

File "filename"
could not be

opened.

When the logic analyzer is started up, it creates a new hardware_log.txt file. For some reason, this 
time the log was not able to be opened after creation. This could indicate a file system or disk 
problem.
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Hardware Errors

Analyzer
Calibration Failed

[time] - Instrument
may need service.

The logic analyzer's pre-measurement calibration failed. Any data collected after receiving this error 
message is possibly incorrect. If the failure is transient, cycling power may fix the problem. If the 
failure is persistent, run Help>Self Test... or call your Keysight Sales Office to arrange for service.

High speed system
clock failure -

Instrument may
need service. Sleep

Duration and
Count: duration,

counted.

The internal 100 MHz clock did not pass initialization tests. Any measurements are likely to be faulty. 
Please contact Keysight Technologies sales or support at "http://www.keysight.com/find/contactus" 
for information on getting the instrument repaired.

Help File Errors

Help file
information was
not found in the

registry. You may
need to reinstall

the tool.

The logic analyzer could not find a registry entry for the help file associated with the tool. If you have 
done a custom installation of the tool, you must also install the help file to access help. If the problem 
persists after re-installing, please contact Keysight Technologies sales or support at 
"http://www.keysight.com/find/contactus" for assistance.

Help file
information not

found in registry.
Cannot display

help.

The logic analyzer could not find a registry entry for the help file associated with the tool. If you have 
done a custom installation of the tool, you must also install the help file to access help. If the problem 
persists after re-installing, please contact Keysight Technologies sales or support at 
"http://www.keysight.com/find/contactus" for assistance.

Help file not found.
Cannot display

help.

The help file was not found where specified by the registry. It may have been deleted or moved. You 
can search the drive where the logic analyzer software is installed for .chm files, or re-install the tool.

The HTML Help file
"filename" was not

found. You may
need to re-install

the product.

The help file was not found where specified by the registry. It may have been deleted or moved. You 
can search the drive where the logic analyzer software is installed for the file, or re-install. To 
re-install, close the logic analyzer application and run the setup program on the logic analyzer CD.

The HTML Help file
"filename" was not

found. You may
need to re-install

the tool.

The help file for the tool was not found where specified by the registry. It may have been deleted or 
moved. You can search the drive where the logic analyzer software is installed for .chm files, or 
re-install the tool.

Trigger Errors

Only one action per
timer per branch is

allowed.

A branch is the collection of actions after a "Then" in an Advanced Trigger step. Some steps, such as 
Advanced 2-Way Branch (see page 500), may have multiple branches. Within a branch, only one of 
Start from reset, Stop and reset, Pause, or Resume is allowed per timer. For more on timers, see To 
configure a timer (see page 153).

http://www.keysight.com/find/contactus
http://www.keysight.com/find/contactus
http://www.keysight.com/find/contactus
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Only one action per
counter per branch

is allowed.

A branch is the collection of actions after a "Then" in an Advanced Trigger step. Some steps, such as 
Advanced 2-Way Branch (see page 500), may have multiple branches. Within a branch, you can not 
both Increment and Reset the same counter. You can increment one and reset the other. For more 
on counters, see To configure a counter (see page 154).

Only one store
action per branch

is allowed.

A branch is the collection of actions after a "Then" in an Advanced Trigger step. Some steps, such as 
Advanced 2-Way Branch (see page 500), may have multiple branches. Within a branch, you can set 
Store sample or Don't store sample but not both in the same branch. If you do not specify any store 
actions, default storage (see page 167) is used.

Only one reset
occurrence

counter action per
branch is allowed.

A branch is the collection of actions after a "Then" in an Advanced Trigger step. Some steps, such as 
Advanced 2-Way Branch (see page 500), may have multiple branches. Within a branch, you can only 
specify Reset occurrence counter once.

No more edge
resources available

for this pod pair.

The logic analyzer hardware can only handle two edge statements per pod pair in Full Channel 
Timing Mode or Half Channel Timing Mode, or one edge statement per pod pair in Transitional / 
Store Qualified Timing Mode (see page 536). If the edges are on different signals, try probing one of 
the signals with another channel on another pod pair. If all the edges are being used on the same 
signal, replace the "either edge" terms with "rising edge OR falling edge". See To insert events (see 
page 179) for how to replace "either edge".

No more pattern
resources available

for this pod pair

The logic analyzer hardware has a limited number of pattern (bus value) variables per pod pair. If the 
values you are checking for are on different buses, try probing one of the buses with another pod 
pair.

Branch expression
is too complex

The expression in one of the branches of the trigger specification is too complicated for the logic 
analyzer. The logic analyzer first combines all AND terms and then ORs the expressions together. 
AND terms that have more than 4 events use twice the resources. Try rewriting the branch 
expression to use more OR terms, or delete some events.

One situation that leads to this error is using the In Range and Not In Range operators with buses 
that span more than 2 pod pairs. These operators are limited to buses that span 2 or fewer pod pairs 
(up to 64 bits wide).

Trigger
Specification is too

complex

Although no single branch expression is too complex, the total number of ANDs and ORs has 
exceeded the logic analyzer's resources. Try simplifying some expressions in some steps, or removing 
steps altogether.

Replacement
failed. Maximum

number of
sequence steps

exceeded.

The logic analyzer translates the trigger you specified into internal sequence steps. Different trigger 
functions use different numbers of internal sequence steps. Also, the "trigger and fill memory" action 
requires an additional internal sequence step each time it is used in state acquisition mode. One 
possible way to simplify the trigger specification is to replace all other "trigger and fill memory" 
actions with a "goto N" action that points to a "Find anything then trigger and fill memory" step.

Unable to insert
step. The maximum

number of
sequence steps are

already allocated.

The logic analyzer translates the trigger you specified into internal sequence steps. Different trigger 
functions use different numbers of internal sequence steps. Also, the "trigger and fill memory" action 
requires an additional internal sequence step each time it is used in state acquisition mode. One 
possible way to simplify the trigger specification is to replace all other "trigger and fill memory" 
actions with a "goto N" action that points to a "Find anything then trigger and fill memory" step.



Keysight Logic and Protocol Analyzer User Guide 339

Solving Problems 11

Too many
sequence steps.

The logic analyzer translates the trigger you specified into internal sequence steps. Different trigger 
functions use different numbers of internal sequence steps. Also, the "trigger and fill memory" action 
requires an additional internal sequence step each time it is used in state acquisition mode. One 
possible way to simplify the trigger specification is to replace all other "trigger and fill memory" 
actions with a "goto N" action that points to a "Find anything then trigger and fill memory" step.

Goto action
specifies an

undefined step.

The last step in the trigger sequence includes the action "Goto next". Because there is no next step, 
the logic analyzer cannot run and look for a trigger. Select Setup>(Logic Analyzer 
Module)>Advanced Trigger..., and change the action for the last trigger step.

Counter event
specified both true

and false in the
same product term

In the trigger specification, at least one branch ANDs together "bus equals X" and "bus not equal X". 
Because this condition can never be true, the logic analyzer will not trigger and does not start the 
acquisition. If you intend to have it run until you press stop, use the trigger function Run Until User 
Stop, found under the "Other" tab in advanced trigger.

Cannot use <, <=,
>, >= for a bus with

clock bits that
spans pod pairs

You have defined a bus that both spans pod pairs and includes a clock bit. The clock bits are 
numbered the same as the pod they are located on, and it is possible for them to be the channel that 
is not on the same pod pair as the others. Check the channel assignment in the Buses/Signals (see 
page 426) tab of the Setup dialog. The logic analyzer will not run until this problem is corrected.

Cannot specify a
range on a bus with

clocks bits that
spans pod pairs

You have defined a bus that both spans pod pairs and includes a clock bit. The clock bits are 
numbered the same as the pod they are located on, and it is possible for them to be the channel that 
is not on the same pod pair as the others. Check the channel assignment in the Buses/Signals (see 
page 426) tab of the Setup dialog. The logic analyzer will not run until this problem is corrected.

Warning Messages

You are currently
running "Offline,"

so running the
analyzer is not

possible. If you
wish to create

"fake" data while
offline, go to "Edit

-> Options" and
select "Create Data

When Offline".
Note: This setting
is persistent from

session to session.

The logic analyzer is running in offline mode. Offline mode means that the logic analyzer software 
does not have access to logic analyzer or logic analysis system hardware. If you have a logic analyzer 
attached, please check the connection. For more on running with fake data, see Options Dialog (see 
page 447). Fake data is useful when learning how to use the logic analyzer software.

This module is
already being used

by another
instance of the

application. You
are now working

Offline.

The logic analyzer hardware is attached to an open instance of the logic analyzer software. If you 
need to acquire data, locate that instance from the Windows taskbar. The Local/Remote/Offline 
indicator is at the bottom of the application window. In offline mode, the software can still work with 
saved data.
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Event specified
both true and false

in the same
product term

In the Advanced Trigger dialog, one of the branches for one of the steps checks that an event is both 
true and not true. An event may be a bus or signal equal to a value, a timer expiring, or a count 
exceeding some value. Because of the AND combination, the branch cannot be true. You may want 
to modify the trigger to use either an OR combination of the events, or separate them into different 
branches or steps. For more on constructing complex triggers, see To replace or insert trigger 
functions into trigger sequence steps (see page 158). For more on how to interpret the trigger 
sequence, see Reading Event and Action Statements (see page 153).

Timer n value
checked as an

event, but no start
action specified.

In the Advanced Trigger dialog, the trigger sequence checks the value of a timer that was never 
started. Timers need to be explicitly started in a previous trigger step. See To configure a timer (see 
page 153) for more information.

Counter n value
checked as an
event, but no

increment action
specified.

In the Advanced Trigger dialog, the trigger sequence checks the value of a counter that is never 
incremented. Counters need to be incremented in the action statements of a trigger step. See To 
configure a counter (see page 154) for more information.

The Bus/Signals
listed below could

not be loaded from
the configuration

file. Please recheck
your Trigger since

it may have
changed.

The configuration file you just loaded was created on a logic analyzer with more pods than this 
model. Because of this, some buses and signals which rely on the additional pods could not be 
loaded. If these buses or signals were used in the trigger sequence, the trigger sequence will have 
changed. You may be able to work around this by assigning different channels to the affected buses 
and signals, and re-creating the trigger sequence.

Slow or missing
clock in Trigger

Step n...

The logic analyzer is not able to detect the state clock, and is therefore unable to take samples and 
evaluate the trigger sequence. If your device under test's clock is bursty, this may be expected 
behavior. If it is not, please check all probing connections. To verify the clock signal is being received, 
you can assign the clock channels to a bus in timing acquisition mode and acquire data.

Informational Messages

Filling memory
after trigger...

The logic analyzer has triggered and is filling memory. Due to either a slow clock or storage 
qualification in state acquisition mode, or infrequent transitions in transitions-only timing acquisition 
mode, the logic analyzer is taking enough time to fill memory that this message is showing.

Trigger inhibited
during prestore...

The logic analyzer is in timing acquisition mode. In timing acquisition mode, the logic analyzer fills 
the designated amount of memory before searching for the trigger. If this message is showing, the 
logic analyzer is filling memory and has not yet begun to compare data to the trigger sequence. To 
capture triggers that happen during the beginning of a device under test's boot sequence, be sure to 
set the trigger position in the Sampling tab to 100% poststore.

Waiting in Trigger
Step n

The logic analyzer is waiting for a sample that matches the events defined in step n of the trigger 
sequence. Sometimes the event is rare, causing long waits. If you feel that the logic analyzer should 
have triggered already, check the trigger sequence in Advanced Trigger. For more on triggering, see 
Specifying Advanced Triggers (see page 152).

"No signal activity.
Check connection,

threshold, and
stimulus."

This channel appears to be completely quiet.

• Check the probe connection between the analyzer and the device under test.

• Check the threshold voltage setting (see Setting the Logic Analyzer Threshold Voltage (see 
page 77)).
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• Check that the device under test is turned on and is running the appropriate diagnostic or other 
stimulus program.

If all these things are set up correctly, activity will be shown in the Analyzer Setup dialog's 
Buses/Signals tab (see page 426).

"No stable regions.
Check clock and

thresholds."

A common possibilities exists:

1 The signal on this channel is asynchronous to the clock defined for the logic analyzer. If this is the 
case, there is no stable relationship between the times when the signal switches and when the 
clock arrives.

"No voltage scan:
Channel in pod

with assigned
clock."

"One or more
stable regions

found."

"Only a few
transitions

detected. Change
stimulus or

increase
measurement

duration."

The signal on this channel was observed to toggle fewer than 500 times. The characterization may be 
accepted as it stands or you may wish to change the stimulus program or diagnostic in the device 
under test to increase the toggle rate.

"Stable region at N
ns is an estimate."

This message only appears for certain bus probes (not general purpose probes).

"The stable region
extends beyond
the limits of the

display."

This channel is active, but the signal does not switch within 5 ns before or after the clock. For 
example, this could occur if the propagation delay in the device under test from clock to data is 
greater than 5 ns and the clock period is greater than 10 ns (slower than 100 MHz).



11 Solving Problems

342 Keysight Logic and Protocol Analyzer User Guide

License Problems

Some problems that can occur with licenses are:

• License Not Available (see page 342)

• Floating License Server Communication Timeout (see page 342)

License Not Available

If you attempt to use a software feature that requires a license, and a license is not available, the 
License Not Available dialog appears.

Depending on the situation, there are several ways to solve this problem:

• If all licenses are in use, you can wait until one of them becomes available again. If there is only 
one license, the License Not Available dialog shows you who is using the license. If there are 
multiple licenses, you can view the active software license information (see page 322) to see the 
license users.

• If all licenses are in use or there are no licenses, you may be able to get a license from another 
license server (see To access floating license servers (see page 324)).

• If the license management software detects that one of your license servers is unavailable, make 
sure the computer or logic analyzer hosting the license server is running, is accessible over the 
network, and is running the license service. For more information, see the "License Server 
Administration Guide".

• If an expected node-locked license is not found, make sure the license file is located in the 
"License" subdirectory under the installation directory (typically C:\Program Files (x86)\Agilent 
Technologies\Logic Analyzer), and make sure the license file has the .lic extension.

• If you decide to purchase additional licenses, contact Keysight Technologies (see 
"http://www.keysight.com/find/contactus"). When you get your Entitlement Certificate, activate 
your licenses by using the License Activation Wizard (see To activate software licenses (see 
page 323)).

See Also • Managing Software Licenses (see page 321)

Floating License Server Communication Timeout

When floating licenses are used, the license subsystem checks for communication with the license 
server every two minutes.

After 10 minutes of communication loss (6 checks), licenses are considered lost, and you are given a 
message about the server that is no longer communicating and the features that are disabled.

Depending on the feature, you may be able to continue working in the Keysight Logic Analyzer 
application, or you may be forced to exit the application. In either case, you are able to save your 
setup and data to a configuration file.

If you are able to continue using the Keysight Logic Analyzer application with disabled features, the 
communication checks continue every two minutes. If communication with the license server is 
re-established, an information dialog tells you about the server and features that have been 
re-enabled.

When communication with a floating license server is lost, make sure the computer or logic analyzer 
hosting the license server is running, is accessible over the network, and is running the license 
service. For more information, see the "License Server Administration Guide".

http://www.keysight.com/find/contactus
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Running Self Tests

The Self Test menu checks the major hardware functions of the logic analysis system to verify that it 
is working correctly.

1 From the menu bar select Help>Self Test....

If you have acquired data, a warning message appears, "Running self-tests will invalidate 
acquired data"; click OK to continue.

2 In the Analysis System Self Tests dialog, select the self test options:

• Include interactive tests — causes interactive tests to appear in the selection lists.

• Run repetitively — runs the selected tests repetitively until you click Stop.

• Stop on fail — if you are running multiple tests or running tests repetitively, this causes the 
tests to stop if there is a failure.

• Double-click item to start — lets you double-click a test to start it.

3 Set the reporting level.

Higher levels produce increasingly verbose output.

4 If you have a multiframe configuration, select the instruments you want to test.

5 If you have a slotted instrument, select the suites you want to run.

6 Select the tests you want to run.

7 Click Start.

CAUTION
Because the most recently acquired data will be lost, be sure to save important data before 
running self tests.
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As the tests are running, the results are reported in the lower part of the dialog and saved to a log 
file.

To stop running test, click Stop.

To reset the self-test options, click Reset.

To view the log file, click Logs..., select the log file you want to view, and click Open.

If, after completing the self tests, you have failures or you have questions about the performance of 
the logic analysis system, contact Keysight Technologies sales or support at 
"http://www.keysight.com/find/contactus".

See Also • For More Information (see page 351)

http://www.keysight.com/find/contactus
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Accessing Japanese Online Help 

1 From the Windows Start menu, choose Start>Control Panel>Regional and Language Options.
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2 In the Advanced tab of the Regional and Language Options dialog:

a In the "Language for non-Unicode programs" box, select Japanese.

b Click OK to close the Regional and Language Options dialog.

3 In the dialog that appears, select the files to copy:

• On a logic analyzer or logic analysis system, the dialog asks if you would like to use existing 
files or recopy files from the Windows CD-ROM; click Yes to use the existing files.

4 A dialog appears asking if you would like to restart your computer; click Yes to restart your 
computer.

5 After your computer restarts, start the Keysight Logic Analyzer application, and choose 
Help>Help Language>Japanese.

Now, when you access the online help, you get the Japanese version.

On Windows 7:

1 From the Windows Start menu, choose Start>Control Panel>Region and Language.

2 In the Administrative tab of the Region and Language dialog, click the Change system locale 
button.

3 In the Region and Language settings dialog box, select Japanese from the Current system locale 
listbox.
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4 Click OK and then click Apply.

5 After your computer restarts, start the Keysight Logic Analyzer application, and choose 
Help>Help Language>Japanese.
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Network Troubleshooting Guide

• Network Setup (see page 348)

• Network Access Issues (see page 348)

• Login Issues (see page 348)

• Using with Multiframe (see page 348)

• Network Hardware and Configuration (see page 348)

• Network Topology (see page 349)

• Known OS Issues (see page 349)

• Logic Analyzer Specific Issues (see page 349)

• Keep System Protected, Up-To-Date (see page 349)

Network Setup For information on setting up logic analysis systems on the network (and in multiframe 
configurations), refer to the "AXIe based Logic and Protocol Analysis – Installation Guide"

• Is the logic analysis system registered with DNS?

• Is the logic analysis system registered with DHCP?

Network Access
Issues

• The link activity light must be on. If these LEDs are not on, the LAN segment may be dead.

• Can system be accessed on the network from another computer?

• Note: if on a network without a DHCP server, it can take up to 5 minutes before auto-negotiation 
configures an IP address. Use ipconfig to verify that the IP address is not 0.0.0.0 before trying to 
do any network activity.

• What IP address does ping hostname yield?

• What IP address does nslookup hostname yield?

• Can system be accessed via UNC in a Windows Explorer (\\hostname)?

• Are the systems all in the same subnet? If not, do they have normal IP address (that is, not one of 
the following 'unroutable' IP addresses):

• 10.x.x.x

• 172.16.x.x

• 192.168.x.x

• 224.0.0.0 (multicast-reserved)

• Is the Windows Network Firewall enabled? If so, is it configured correctly? (See "Changing the 
Windows Firewall Settings" (in the online help))

Login Issues • How are you logged-in? (Workgroup vs. Domain).

• Are there different behaviors between workgroup and domain logins?

Using with
Multiframe

• Is the agLogicSvc.exe service running on each system?

• If you changed any network cables, you need to re-initialize the agLogicSvc.exe service by 
stopping it and restarting it or by rebooting. Has this been done?

• All Gbit LAN cards on a Gbit LAN must use the same "Jumbo Frames" setting (see the LAN cards' 
advanced properties dialog). Also, if a switch/hub is used, you must make sure it supports the 
same size "Jumbo Frames" setting.

Network Hardware
and Configuration

• Which OS is running? (Windows 7, Windows 8, or Windows Vista)

• How many network cards? (Motherboard built-in 100Base-T, gigabit LAN)

• From command prompt, run ipconfig /all for detailed configuration info.

• From command prompt, run ipconfig /release to release current IP addresses.

• From command prompt, run ipconfig /renew to re-obtain IP addresses.
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Network Topology • On public LAN? On private LAN? Cross-over cable? Multiple networks?

• Configurations:

• Stand-alone

• 1 network adapter - LAN.

• 1 network adapter - cross-over cable.

• 1 network adapter - private (switch or hub).

• 2 network adapters - LAN + cross-over cable.

• 2 network adapters - LAN + private (switch or hub).

Known OS Issues • Are the SSDP and UPnP services running? (SSDP = Manual, UPnP = Automatic).

On some systems, the SSDP Discovery Service suddenly wakes up and starts using a lot of CPU 
time. This is a 'manual' service, which listens for a Universal Plug-n-Play request, and is thus 
started when a particular packet is received.

When this happens, the SSDPSRW task starts, stops, and starts again in a loop.

To disable the service, choose My Computer>Manage>Services>SSDP Discovery 
Service>Properties and set to Disable.

Then, set the SSDP service back to manual.

Failure to do this can cause the system logger to fill up and other nasty side effects.

• Is the Computer Browser service running? If there is a DHCP server on the network, it may not be 
necessary for Computer Browser to be running. Furthermore, if the domain name server is NT 4.0, 
running computer browser on the network can lock out the 'real' domain server making it 
impossible for people on the network to log in reliably.

Logic Analyzer
Specific Issues

• Are there any Keysight Logic Analyzer application specific problems (application or service) being 
seen? (Connection error dialogs, crashes, other).

Keep System
Protected,

Up-To-Date

• Use Windows Update to keep up-to-date on critical updates and service packs.

• Keep the virus definitions up-to-date in your anti-virus software.

• Install any Keysight Logic Analyzer application updates using their InstallShield packages.

• The local Administrator password should not be empty.
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Remote Desktop Set Up

If your logic analysis system has the Windows 7/8 operating system, it supports Remote Desktop 
Protocol (RDP) connections.

To enable Remote Desktop connections to the logic analysis system, see the Remote Desktop topics 
in the Windows 7/8 online help:

1 From the Windows Start menu, choose Start>Help and Support.

2 In the Help and Support Center window, enter "Remote Desktop" in the Search field; then, click 
the green arrow button to start the search.

3 Go to the topic on setting up the computer to use Remote Desktop, and follow its instructions.

When you set up a computer to use Remote Desktop, it is enabled as an exception in the operating 
system's firewall.

See Also • " Changing Firewall Settings, Windows 7 “ (in the online help)
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For More Information

Documentation

Quick
Start/Installation

Guide

The Quick Start/Installation Guide gives you information on how to connect system peripherals and 
probing. Also included is an overview of the interface and information on installing software 
upgrades. Use this guide to quickly get familiar with the analyzer and also as a future reference for 
keeping your analyzer up-to-date and running properly.

• "AXIe based Logic and Protocol Analysis – Quick Start Guide"

• " AXIe based Logic and Protocol Analysis – Installation Guide"

• "16850 Series Portable Logic Analyzers Installation/Quick Start Guide"

Probing
Documentation

For more information on general-purpose probing, QFP package probing, target connector and 
connectorless probing, and other probing options, see:

• "Probing Selection Quick Reference Card"

• "Probing Solutions for Logic Analyzers" ( "latest version on web")

• "Logic Analyzer Probing Solutions"

For more information on analysis probes and other processor and bus solutions, see:

• "Processor and Bus Support for Logic Analyzers" ( "latest version on web")

• "Processor, Bus, and FPGA Support for Logic Analyzers"

Online Help
System

The online help gives you product reference and feature information. Also included is a tutorial (see 
page 40) showing you how to make a basic measurement and containing links to time-saving 
features and concepts.

Keysight
Technologies Web

Sites

Corporation/Conta
ct

• Corporation - "http://www.keysight.com"

• Contact Us - "http://www.keysight.com/find/contactus"

• Email Updates - "http://www.keysight.com/find/emailupdates"

Product
Information

• Logic Analysis - "http://www.keysight.com/find/logic"

• Logic Analysis Software Download - "http://www.keysight.com/find/la-sw-download"

• Software on CD - "http://software.cos.keysight.com/LogicAnalyzerSW"

See Also • Tutorial - Getting to know your logic analyzer (see page 40)

http://cp.literature.agilent.com/litweb/pdf/5968-4632E.pdf
http://www.agilent.com/find/logic_analyzer_probes
http://cp.literature.agilent.com/litweb/pdf/5966-4365E.pdf
http://www.agilent.com/find/upsolutions
http://www.keysight.com
http://www.keysight.com/find/contactus
http://www.agilent.com/find/emailupdates
http://www.keysight.com/find/logic
http://www.agilent.com/find/la-sw-download
http://software.cos.keysight.com/LogicAnalyzerSW
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Logic Analysis
Basics

• When should you use an oscilloscope? (see page 354)

• When should you use a logic analyzer? (see page 355)

• What is a logic analyzer? (see page 356)

Timing analyzer:

• Sampling clock (see page 356)

• Sampling (see page 356)

• Triggering (see page 357)

State analyzer:

• Sampling clock (see page 358)

• Sampling (see page 359)

• Triggering (see page 359)

Other Logic
Analysis Concepts

• Pod and Channel Naming Conventions (see page 361)

• Why Are Pods Missing? (see page 362)

• Memory Depth and Channel Count Trade-offs (see page 363)

• Transitional Timing (see page 365)

• Understanding State Mode Sampling Positions (see page 367)

• Understanding Logic Analyzer Triggering (see page 369)

• ALA vs. XML, When to Use Each Format (see page 380)

• Multiframe Logic Analysis Systems (see page 381)
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When should you use an oscilloscope?

[ Tutorial Home (see page 40) ] [ Next Topic (see page 355) ] [ Previous Topic (see page 40) ]

Generally, an oscilloscope is used when you need precise parametric information such as time 
intervals and voltage readings.

More specifically:

• When you need to measure small voltage excursions on your signals such as undershoot or 
overshoot.

• When you need high time-interval accuracy. Oscilloscopes can capture precise parametric 
information such as the time between two points on a rising edge of a pulse with very high 
accuracy.
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When should you use a logic analyzer?

[ Tutorial Home (see page 40) ] [ Next Topic (see page 356) ] [ Previous Topic (see page 354) ]

Generally, a logic analyzer is used to view timing relationships among many signals, or if you need to 
trigger on patterns of logic highs and lows. A logic analyzer reacts the same way as the logic circuits 
do when a voltage threshold is crossed by a signal in the device under test. It will recognize the 
signal to be either low or high.

More specifically:

• When you need to see many signals at once.

Logic analyzers are very good at organizing and displaying multiple signals. A common task is to 
group multiple signals into a bus and assign a custom name. Good examples are address, data, 
and control buses.

• When you need to look at signals in your system the same way your hardware does.

Signals are displayed on a time axis so you can see when transitions occur relative to other bus 
signals or clock signals.

• When you need to trigger on a unique bus pattern or signal edge.

Logic analyzers can be configured to store data when the high or low values of a group (bus) of 
signals match a predefined pattern.

Logic analyzers can be configured to store data when a specific edge or level is detected on a 
single signal.
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What is a logic analyzer?

[ Tutorial Home (see page 40) ] [ Next Topic (see page 356) ] [ Previous Topic (see page 355) ]

Now that we've talked a little about when to use a logic analyzer, let's look in more detail at what a 
logic analyzer is. Up to now, we've used the term "logic analyzer" rather loosely. In fact, most logic 
analyzers are really two analyzers in one.

What is a timing
analyzer?

A timing analyzer is the part of a logic analyzer that is analogous to an oscilloscope. As a matter of 
fact, they can be thought of as close cousins.

The timing analyzer displays information in the same general form as an oscilloscope, with the 
horizontal axis representing time and the vertical axis as voltage amplitude. Because the waveforms 
on both instruments are time-dependent, the displays are said to be in the "time domain".

The basic areas of functionality in a timing analyzer are as follows:

• Sampling clock in the timing analyzer (see page 356)

• Sampling in the timing acquisition mode (see page 356)

• Triggering the timing analyzer (see page 357)

What is a state
analyzer?

A state analyzer is very good at tracking down bugs in software or defective components in 
hardware. It can help eliminate the question whether a problem is in the software code or some 
hardware device.

Most often, state analyzers are used to find out what logic levels are present on a bus when a 
particular clock signal occurs. In other words, you want to know what "state of activity" is present 
when the clock occurs and data is suppose to be valid. Data captured in memory is displayed in a 
listing format with a time tag attached to every state.

The basic areas of functionality in a state analyzer are as follows:

• Sampling clock in the state analyzer (see page 358)

• Sampling in the state acquisition mode (see page 359)

• Triggering the state analyzer (see page 359)

Sampling clock in the timing analyzer

[ Tutorial Home (see page 40) ] [ Next Topic (see page 356) ] [ Previous Topic (see page 356) ]

The timing analyzer uses its own internal clock to control the sampling of data. This type of clocking 
makes the sampling of data in the logic analyzer asynchronous to the clocking in the device under 
test.

More specifically:

• A timing analyzer is good at showing you "When" signal activity occurs "Relative to other signals".

• A timing analyzer is more interested in viewing the timing relationships between individual 
signals, than the timing relationships to the signals that are controlling execution in the device 
under test.

• This is why a timing analyzer can sample data "out of sync", or asynchronous to the device under 
test clock signals.

Sampling in the timing acquisition mode

[ Tutorial Home (see page 40) ] [ Next Topic (see page 357) ] [ Previous Topic (see page 356) ]
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In the timing acquisition mode, the logic analyzer works by sampling the input waveforms to 
determine whether they are high or low. It determines a high or low by comparing the voltage level of 
the incoming signal to a user-defined voltage threshold. If the signal is above that threshold when it 
samples, it will be displayed as a 1 or high by the analyzer. By the same criterion, any signal sampled 
that is below threshold is displayed as a 0 or low.

The figure below illustrates how a logic analyzer samples a sine wave as it crosses the threshold 
level.

The sample points are then stored in memory and used to reconstruct a more squared-off digital 
waveform.

This tendency to square everything up would seem to limit the usefulness of a timing analyzer. 
However, a timing analyzer is not intended as a parametric instrument. If you want to check rise time 
of a signal, use an oscilloscope. If you need to verify timing relationships among several or hundreds 
of signals by seeing them all together, a timing analyzer is the right choice.

Sampling accuracy When the timing analyzer samples an input channel, it is either high or low. If the channel is at one 
state (high or low) on one sample, and the opposite state on the next sample, the analyzer "knows" 
that the input signal has transitioned sometime between the two samples. It doesn't know when, so it 
places the transition point at the next sample, as shown in the figure below.

This presents some ambiguity as to when the transition actually occurred and when it is displayed by 
the analyzer.

Worst case for this ambiguity is one sample period, assuming that the transition occurred 
immediately after the previous sample point.

With this technique however, there is a trade-off between resolution and total acquisition time. 
Remember that every sampling point uses one memory location. Thus, the higher the resolution 
(faster sampling rate), the shorter the acquisition window.

Triggering the timing analyzer

[ Tutorial Home (see page 40) ] [ Next Topic (see page 358) ] [ Previous Topic (see page 356) ]

At some point in a measurement, the logic analyzer has to know when to capture (store) the data 
that is flowing through its memory. This is know as the trigger point.
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One way to get the analyzer to trigger is to configure the analyzer to look for either a pattern of highs 
and lows from a group of signals (bus), or a rising or falling edge from a single signal. When the 
analyzer sees the specified patterns or edges in data, it triggers.

Pattern Trigger Pattern triggers are used to find specific patterns of highs and lows across a bus. You can specify 
different kinds of criteria such as equal, not equal, in or out of a range, or greater than/less than.

To make things easier for some users, the trigger point on most analyzers can be set not only in Hex, 
but in binary (1's and 0's), octal, ASCII, or decimal. For instance, the Hex trigger value of AA could 
also be set to an equivalent binary trigger value of 1010 1010. However, using hex for the trigger 
point is particularly helpful when looking at buses that are 16, 24, 32, or 64 bits wide.

Edge Trigger Edge triggering is a familiar concept to those accustomed to using an oscilloscope. When adjusting 
the "trigger level" knob on an oscilloscope, you could think of it as setting the level of a voltage 
comparator that tells the oscilloscope to trigger when the input voltage crosses that level. A timing 
analyzer works essentially the same on edge triggering except that the trigger level is preset to a 
logic threshold.

While many logic devices are level dependent, clock and control signals of these devices are often 
edge-sensitive. Edge triggering allows you to start capturing data as the device is clocked.

Sampling clock in the state analyzer

[ Tutorial Home (see page 40) ] [ Next Topic (see page 359) ] [ Previous Topic (see page 357) ]

The state analyzer requires a sampling clock signal from the device under test. This type of clocking 
makes the sampling of data in the logic analyzer synchronous to the clocked events on the device 
under test.

More specifically:

• A state analyzer is good at showing you "What" the signal activity is during a "Valid clock or 
control signal".

NOTE
Example: You have a bus containing 8 signal lines. You configure the Simple Trigger to specify that 
the analyzer triggers when the incoming data is equal to a pattern of "AA". 

NOTE
Example: Take the case of an edge-triggered shift register that is not shifting data correctly. Is the 
problem with the data or the clock edge? In order to check the device, we need to verify the data 
when it is clocked – on the clock edge. The analyzer can be told to capture data when the clock 
edge occurs (rising or falling) and catch all of the outputs of the shift register. 
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• A state analyzer is more interested in viewing signal activity during specified times of execution, 
than signal activity unrelated to the timing.

• This is why a state analyzer wants to sample data that is "synchronized" or synchronous to the 
device under test clock signals.

Sampling in the state acquisition mode

[ Tutorial Home (see page 40) ] [ Next Topic (see page 359) ] [ Previous Topic (see page 358) ]

In the world of microprocessors, you can have both data and address appearing on the same signal 
lines. To capture the correct data, the logic analyzer has to restrict the sampling of data to times 
when only the desired data is valid and appears on the signal lines. It does this by sampling data from 
the same signal lines but with different sampling clocks from the device under test.

Triggering the state analyzer

[ Tutorial Home (see page 40) ] [ Next Topic (see page 40) ] [ Previous Topic (see page 359) ]

Similar to a timing analyzer, a state analyzer has the capability to qualify the data we want to store. If 
we are looking for a specific pattern of highs and lows on the address bus, we can tell the analyzer to 
start storing when it finds that pattern and to continue storing until the analyzer's memory is full.

Simple Trigger
Example

Looking at the "D" flip-flop shown below, data on the "D" input is not valid until after a positive-going 
clock edge occurs. Thus, a valid state for the flip-flop is when the clock input is high.

Now imagine that we have eight of these flip-flops in parallel. All eight are connected to the same 
clock signal as shown below.

NOTE
Example: The following timing diagram shows that to capture addresses, we want the analyzer to 
sample when MREQ line goes low. To capture data, we want the analyzer to sample when the WR 
line goes low (write cycle) or when RD goes low (read cycle). 
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When a high level occurs on the clock line, all eight capture data at their "D" inputs. Again, a valid 
state occurs each time there is a positive level on the clock line.

The following simple trigger tells the analyzer to collect data on lines D0 - D7 when a high level is on 
the clock line.

Advanced Trigger
Example

You want to see what data is stored in memory at the address value 406F6. You configure the 
advanced trigger to look for the pattern 406F6 (hexadecimal) on the address bus and a high level on 
the RD (memory read) clock line.

As you configure the Edge And Pattern trigger dialog, try to think of it as constructing a sentence 
that reads left-to-right.

"Find the first occurrence of a Bus named ADDR, and on All bits a pattern that Equals406F6 Hex, 
And a Signal named RD with a High level. Then Trigger and fill memory with Anything.
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Pod and Channel Naming Conventions

In 16850-series logic analysis systems:

• Slots are named "A" through "F" starting with the top slot.

• There is a cable marked "Pod 2" connected to every logic analyzer card. It is important to know 
which slot a pod is connected to because if you have logic analyzer cards in slots A and B, there 
will be two pod cables labeled "Pod 2", but the Keysight Logic Analyzer application will refer to 
one as "Slot A Pod 2" and the other as "Slot B Pod 2". It's important not to mix up the two cables.

• Slot A Pod 2 is the same as "Pod A2". "A2" is used interchangeably with "Slot A Pod 2"; likewise, 
"D1" is used interchangeably with "Slot D Pod 1".

See Also • Pod and Channel Naming Conventions in U4154A/B Logic Analyzer (see page 561)
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Why Are Pods Missing?

There are a number of reasons all pods are not available to a logic analyzer module:

• In the state sampling mode, with the General State Mode sampling option selected, choosing the 
maximum acquisition memory depth requires one pod pair to be reserved for time tag storage. In 
this case, setting the memory depth to half of the maximum (or less) will return the pods.

• In the state sampling mode, with the Turbo State Mode (see page 536) sampling option selected, 
one pod pair is reserved for time tag storage.

• In the timing sampling mode, with the Transitional / Store Qualified Timing Mode (see page 536) 
sampling option selected:

• When the smallest sampling period is selected, one pod pair is reserved for time tag storage.

• When sampling periods other than the smallest are selected, choosing the maximum 
acquisition memory depth requires one pod pair to be reserved for time tag storage. In this 
case, setting the memory depth to half of the maximum (or less) will return the pods.

See Also • Memory Depth and Channel Count Trade-offs (see page 363)

• Configuring Logic Analyzer Modules (see page 72)
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Memory Depth and Channel Count Trade-offs

This topic describes the interaction between channel count, memory depth, and triggering in the:

• State Sampling Mode (see page 363)

• Transitional Timing Sampling Mode (see page 363)

State Sampling
Mode

Time Tag Storage
Requires 1 Pod

Pair or 1/2
Acquisition

Memory

• In the Keysight Logic Analyzer application, all modules are time-correlated; you cannot turn off 
time tag storage (as you could with previous Keysight logic analysis systems).

• To use more than 1/2 of a module's acquisition memory, one pod pair must be reserved for time 
tag storage. To use all pod pairs, you must use 1/2 (or less) of a module's acquisition memory.

• In general, the number of timers available = the number of pod pairs not reserved for time tag 
storage (refer to your logic analyzer characteristics (see page 587) for the actual number of timers 
available).

Default Settings • Time tag storage is always on (and cannot be turned off).

• Memory depth is set at 1/2 of the total acquisition memory.

• All pod pairs are available for capturing data.

• If full memory is selected, the default pod pair to be used for time tag storage is the leftmost, but 
any pod pair without buses or signals assigned can be used.

Selecting Full
Memory Depth

when No Channels
Assigned to a Pod

Pair

• The pod pair is automatically reserved for time tag storage.

Selecting Full
Memory Depth
when Channels

Assigned to All Pod
Pairs

A dialog appears to caution you that:

• Bus/signals will lose assigned channels.

• Trigger specifications that use timer resources may be affected.

Going from Full
Memory Depth to

Half Memory
Depth

• The pod pair reserved for time tag storage is automatically freed (assigned to the logic analyzer) 
so it can be used to capture data.

Transitional Timing
Sampling Mode

Time Tag Storage
Requires 1 Pod

Pair or 1/2
Acquisition

Memory

• The transitional timing sampling mode also requires time tag storage.

• When the smallest sampling period is chosen, one pod pair must be reserved for time tag storage. 
In this case, you cannot use 1/2 (or less) of a module's acquisition memory to gain back the pod 
pair.

• With other sampling periods, the memory depth and channel count trade-offs are the same as in 
the state sampling mode. That is, to use more than 1/2 of a module's acquisition memory, one 
pod pair must be reserved for time tag storage. To use all pod pairs, you must use 1/2 (or less) of 
a module's acquisition memory.
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• In general, the number of timers available = the number of pod pairs not reserved for time tag 
storage (refer to your logic analyzer characteristics (see page 587) for the actual number of timers 
available).

Default Settings • Time tag storage is required.

• If full memory is selected, the default pod pair to be used for time tag storage is the leftmost, but 
any pod pair without buses or signals assigned can be used.

See Also • Configuring Logic Analyzer Modules (see page 72)

• To set acquisition memory depth (see page 129)

• Choosing the Sampling Mode (see page 96)

• Logic Analyzer Notes, Channels and Memory Depth (see page 536)
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Transitional Timing

In the Transitional / Store qualified timing mode, the timing analyzer samples data at regular 
intervals, but only stores data when there is a signal transition across the threshold voltage level. 
Each time a transition occurs on any of the bits in the defined buses/signals (that haven't been 
excluded), data on all channels is stored. A time tag is stored with each stored data sample so the 
measurement can be reconstructed and displayed later.

More on Storing
Transitions

Minimum
Transitions Stored

Normally, transitions do not occur at each sample point. This is illustrated below with time tags 2, 5, 
7, and 14. When transitions do occur, two samples are stored for every transition. Therefore, with 2K 
samples of memory, 1K transitions are stored. You must subtract one, which is necessary for a 
starting point, for a minimum of 1023 stored transitions.

Maximum
Transitions Stored

If transitions occur at a fast rate, such that there is a transition at each sample point, only one sample 
is stored for each transition as shown by time tags 17 through 21 below. If this continues for the 
entire trace, the number of transitions stored is 2K samples. Again, you must subtract the starting 
point sample, which then yields a maximum of 2047 stored transitions.

In most cases a transitional timing trace is stored by a mixture of the minimum and maximum cases. 
Therefore, in this example the actual number of transitions stored will be between 1023 and 2047.

Transitional Timing
Considerations

Data Storage When an edge is detected, two samples are stored across all channels assigned to the timing 
analyzer. Two samples are needed to avoid data loss if a second edge occurs (after the first edge) 
before the edge detectors can reset.

Sequence Step
Branching

In transitional timing, only 2 branches are available per sequence step.

Global Counters In transitional timing, only one global counter is available.

Storing Time Tags Transitional timing requires time tags to recreate the data. Time tags are stored by interleaving them 
with measurement data in memory.
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Increasing
Duration of Storage

(Amount of Time
Measured)

By default, the analyzer looks for transitions on all buses/signals defined for the logic analyzer 
module. However, to increase usable memory depth and acquisition time, you can, in the Advanced 
Trigger dialog (see page 424), exclude certain bus/signal transitions from being stored (like clock or 
strobe signal transitions that add little useful information to the measurement).

Data on
Unassigned

Channels

When you run a measurement, data is captured on all logic analyzer channels, whether 
buses/signals are defined and assigned to those channels or not. In the transitional timing mode, 
captured samples are saved if there are transitions on the defined buses/signals (that haven't been 
excluded).

After a transitional timing measurement has been run, if you define new buses/signals for previously 
unassigned logic analyzer channels, the data captured on those channels appears, but it is unlikely 
that all transitions on those buses/signals have been stored; the data that appears is as if the new 
buses/signals had been excluded before the measurement was run.

Trigger Position In transitional timing, no data prestore (samples acquired before trigger) is required. Therefore, much 
like state mode, the trigger position (start/center/end) indicates the percentage of memory filled 
with samples after the trigger. The number of samples acquired/displayed before the trigger will vary 
between measurements.
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Understanding State Mode Sampling Positions

Synchronous sampling (state mode) logic analyzers are like edge-triggered flip-flops in that they 
require input logic signals to be stable for a period of time before the clock event (setup time) and 
after the clock event (hold time) in order to properly interpret the logic level. The combined setup 
and hold time is known as the setup/hold window.

A device under test (because of its own setup/hold requirements) specifies that data be valid on a 
bus for a certain length of time. This is known as the data valid window. The data valid window on 
most buses is generally less than half of the bus clock period.

To accurately capture data on a bus:

• The logic analyzer's setup/hold time must fit within the data valid window.

• Because the location of the data valid window relative to the bus clock is different for different 
types of buses, the position of the logic analyzer's setup/hold window must be adjustable (relative 
to the sampling clock, and with fine resolution) within the data valid window. For example:

To position the setup/hold window (sampling position) within the data valid window, a logic analyzer 
has an adjustable delay on each sampling input (to position the setup/hold window for each 
channel).

Sample Position
Adjustments on

Individual
Channels

When you can make sampling position adjustments on individual channels, you can make the logic 
analyzer's setup/hold window smaller because you can correct for the skew effects caused by the 
probe cables and the logic analyzer's internal circuit board traces, and you are left with the 
setup/hold requirements of the logic analyzer's internal sampling circuitry.

However, the process of manually positioning the setup/hold window for each channel is time 
consuming. For each signal in the device under test and each logic analyzer channel, you must 
measure the data valid window in relation to the bus clock (with an oscilloscope), repeatedly position 
the setup/hold window and run measurements to see if the logic analyzer captures data correctly, 
and finally position the setup/hold window in between the positions where data was captured 
incorrectly.
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With Keysight Technologies logic analyzers that have the eyescan feature, in a small fraction of the 
time that it takes to make the adjustments manually (and without the extra test equipment), you can 
automatically:

• Position the setup/hold window on each channel.

• Adjust the threshold voltage setting for the widest possible data valid window.

Eyescan is an easy way to get the smallest possible logic analyzer setup/hold window.

See Also • To automatically adjust state sampling positions and threshold voltages (see page 128)

• To manually adjust state sampling positions (see page 128)

• Selecting the State Mode (Synchronous Sampling) (see page 98)

• “Setting up and Running Eyescans in Logic Analyzers" on page 567

NOTE
You use the Eyescan feature with the U4154A/B Logic Analyzer to automatically 
adjust sample positions on individual channels. Refer to the topic “Setting up 
and Running Eyescans in Logic Analyzers" on page 567 to know more about the 
eyescan feature.
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Understanding Logic Analyzer Triggering

Setting up logic analyzer triggers can be difficult and time-consuming. You could assume that if you 
know how to program, you should be able to set up a logic analyzer trigger with no difficulty. 
However, this is not true because there are many concepts that are unique to logic analysis. The 
purpose of this section is to describe these key concepts and how to use them effectively.

• The Conveyor Belt Analogy (see page 369)

• Summary of Triggering Capabilities (see page 370)

• Sequence Steps (see page 371)

• Boolean Expressions (see page 372)

• Branches (see page 373)

• Edges (see page 373)

• Ranges (see page 373)

• Flags (see page 373)

• Counters (see page 373)

• Timers (see page 374)

• Storage Qualification (see page 375)

• Strategies for Setting Up Triggers (see page 376)

• Conclusions (see page 379)

See Also • Capturing Data from the Device Under Test (see page 141)

The Conveyor Belt Analogy

The memory of a logic analyzer can be compared to a very long conveyor belt, and the samples 
acquired from the device under test (DUT) as boxes on the conveyor belt. At one end, new boxes are 
placed on the conveyor belt, and at the other end the boxes fall off. In other words, because logic 
analyzer memory is limited in depth (number of samples), whenever a new sample is acquired the 
oldest sample currently in memory is thrown away if the memory is full. This is shown in the following 
figure.

The conveyor belt analogy

A logic analyzer trigger is similar to someone standing at the beginning of the conveyor belt placing 
more boxes on it. They are told to "look for a special box and to stop the conveyor belt when that box 
reaches a particular position on the belt". Using this analogy, the special box is the trigger. Once a 
logic analyzer detects a sample that matches the trigger condition, this is the indication that it 
should stop acquiring more samples when the trigger is located appropriately in memory.
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The location of the trigger in memory is known as the trigger position. Normally, the trigger position 
is set to the middle so that the maximum number of samples that occurred before and after the 
trigger are in memory. However, you can set the trigger position to any point in memory.

The concepts in this analogy are summed up in the following table.

Mapping of concepts in the Conveyor Belt Analogy to a Logic Analyzer

Next: Summary of Triggering Capabilities (see page 370)

Summary of Triggering Capabilities

Because logic analyzer triggering provides a great deal of functionality, the following table provides a 
brief summary of the capabilities covered in this article. Each of these capabilities will be described.

Summary of Logic Analyzer Triggering Capabilities

Next: Sequence Steps (see page 371)

Conveyor Belt Analogy Logic Analyzer

Boxes on the belt Samples acquired from the device under test

Number of boxes that will fit 
on the belt

Memory depth

Special box Trigger point

Capability Examples

Edges If there is rising edge on SIG1 then Trigger
If there is falling edge on SIG1 then Trigge
r

Boolean expressions If ADDR = 1000 and DATA = 2000

Ranges If ADDR in range 1000 to 2000

Storage qualification 1. If..
Else If ADDR in range 1000 to 2000 then
Store Sample
Go to 1

Else If ADDR not in range 1000 to 2000 th
en

Don't Store Sample
Go to 1

Counters 1. If DATA = 1000 Then
Increment Counter 1
Go to 2

2. If Counter 1 > 2 Then
Trigger

Timers 1. If DATA = 1000 Then
Start Timer 1
Go to 2

2. If Timer 1 > 500 ns Then
Trigger
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Sequence Steps

While logic analyzer triggers are often simple, they can require complex programming. For example, 
you may want to trigger on the rising edge of one signal that is followed by the rising edge of another 
signal. This means that the logic analyzer must first find the first rising edge before it begins looking 
for the next rising edge. Because there is a sequence of steps to find the trigger, this is known as a 
trigger sequence. Each step of the sequence is called a sequence step.

Each sequence step consists of two parts; the conditions and the actions. The conditions are Boolean 
expressions such as "If ADDR = 1000" or "If there is a rising edge on SIG1". The actions are what the 
logic analyzer should do if the condition is met. Examples of actions include triggering the logic 
analyzer, going to another sequence step, or starting a timer. This is similar to an If/Then statement 
in programming.

Each step in the trigger sequence is assigned a number. The first sequence step to be executed is 
always Sequence Step 1, but because of the Go To actions, the rest of the sequence steps can be 
executed in any order.

When a sequence step is executed and none of the Boolean expressions are true, the logic analyzer 
acquires the next sample and executes the same sequence step again. As a simple example, consider 
the following trigger sequence:

1. If DATA = 7000 then Trigger

If the following samples were acquired, the logic analyzer would trigger on sample #6.

Sample # ADDR DATA
1 1000 2000
2 1010 3000
3 1020 4000
4 1030 5000
5 1040 6000
6 1050 7000 <- This is where the logic analyzer triggers
7 1060 2000

In essence, Sequence Step 1 is equivalent to "Keep acquiring more samples until DATA=7000, then 
trigger".

If a Boolean expression in a sequence step is met, another sample is always acquired before the next 
sequence step is executed. In other words, if a sample meets the condition in Sequence Step 1, 
another sample will be acquired before executing Sequence Step 2. This means that it is not possible 
for a single sample to be used to meet the conditions of more than one sequence step. Each 
sequence step can be thought of as representing events that occur at different points in time. Two 
sequence steps can never be used to specify two events that happen simultaneously.

For example, consider the following trigger sequence:

1. If ADDR = 1000 then Go to 2
2. If DATA = 2000 then Trigger

If the following samples were acquired, the logic analyzer would trigger on sample #7.

Sample # ADDR DATA
1 1000 2000 <- This meets the condition in Sequence step #1
2 1010 3000
3 1020 4000
4 1030 5000
5 1040 6000
6 1050 7000
7 1060 2000 <- This is where the logic analyzer triggers



12 Concepts

372 Keysight Logic and Protocol Analyzer User Guide

Note that the logic analyzer will not trigger on Sample #1 because a new sample is acquired between 
the time that the condition in Sequence Step 1 is met and when the condition in Sequence Step #2 is 
tested. A good way to think of this trigger sequence is "Find ADDR = 1000 followed by DATA = 2000 
and then trigger". Multiple sequence steps in a trigger sequence imply a "followed by".

Once a logic analyzer triggers, it does not trigger again. In other words, even if more than one sample 
meets the trigger condition, the logic analyzer still only triggers once. For example, using 
"ADDR=1000" as our trigger, if the logic analyzer acquires the following samples, it will trigger on 
Sample #2 and only on Sample #2.

Sample # ADDR
1 0000
2 1000 <- The logic analyzer triggers here
3 2000
4 1000 <- The logic analyzer does NOT trigger again here
5 1040

A frequently asked question is "What happens if the conditions in a sequence step are not met?" For 
example, if there is a condition that says "If ADDR = 1000 Then Trigger", what happens if the current 
sample has ADDR = 2000? The logic analyzer simply acquires the next sample and tries to execute 
this sequence step again. In essence, if the trigger condition is "ADDR = 1000", this is equivalent to 
"Keep acquiring more samples until you find one that has ADDR=1000". Therefore, if you set up a 
trigger condition that is never met, the logic analyzer will never trigger.

When the conditions are met in a sequence step, it is clear which sequence step will be executed 
next when a "Go To" action is used, but it is not necessarily clear if there is no "Go To". On some logic 
analyzers, if there is no "Go To", this means that the next sequence step should be executed. On 
other logic analyzers, it means the same sequence step should be executed again. Because of this 
confusion, it is good practice to always use a "Go To" action rather than relying on the default. The 
state and timing modules deal with this problem by automatically including a "Go To" or "Trigger" 
action in every sequence step. For example:

If ADDR = 1000 and DATA = 2000 then
Go to 1 <- This is automatically added

Next: Boolean Expressions (see page 372)

Boolean Expressions

While multiple sequence steps imply a "followed by", within a sequence step Boolean expressions 
can be used. An example is:

If ADDR = 1000 and DATA = 2000

This expression means that for this expression to be met, ADDR must equal 1000 in the same sample 
that DATA equals 2000. In other words, ADDR equals 1000 at the same time that DATA equals 2000. 
Therefore, if you want to trigger on two events that occur at the same time, a Boolean expression 
should be used.

It's a common mistake to try to use two sequence steps when a Boolean expression should be used 
or to use a Boolean expression when two sequence steps should be used.

Next: Branches (see page 373)

NOTE
Boolean expressions are used for events that happen at the same time, and multiple sequence 
steps are used when one event follows another.
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Branches

Branches are similar to the Switch statement in the C programming language and the Select Case 
statement in Basic. They provide a method for testing multiple conditions. Each branch has its own 
actions. An example of multiple branches is shown below:

1. If ADDR < 1000 then Go To 2 <- This is a branch of Level 1
Else If ADDR > 2000 then Go To 3 <- This is a 2nd branch of Level 1
Else If DATA = 2000 then Trigger <- This is a 3rd branch of Level 1

2. If DATA <= 7000 then Trigger
3. If there is a Rising Edge on SIG1, then Trigger

In sequence step 1, there are three branches, so there are three possible actions that can be taken.

When the condition of one branch is met, none of the branches below it are tested. In other words, 
there is no way for more than one branch to be executed based upon a single sample, even if the 
sample causes the conditions for more than one branch to be met. In other words, each branch is an 
"Else If".

Next: Edges (see page 373)

Edges

Edges represent a transition from low to high or high to low on a single signal. Typically, edges are 
specified as "rising edge", "falling edge", or "either edge", where "rising edge" indicates a transition 
from a low to a high. On most logic analyzers, up to two edges can be included in the trigger 
sequence although some allow only one.

Next: Ranges (see page 373)

Ranges

Ranges are a convenient method for specifying a range of values, such as "ADDR in range 1000 to 
2000". Most logic analyzers also support a "not in range" function as well. Ranges are a convenient 
shortcut so that you don't have to specify "ADDR >= 1000 and ADDR <= 2000".

Next: Flags (see page 373)

Flags

Flags are Boolean variables that are used to send signals from one module to another. They can be 
set when a condition occurs in one module and tested later by another module. In the example 
below, flag 1 is used to keep track of what happens in the trigger sequence of Module 1 so that this 
information can be used in Module 2.

Trigger Sequence for Module 1:

1. If ADDR < 5000 then
Set Flag 1
Trigger and fill memory

Trigger Sequence for Module 2:

1. If DATA = 5000 and Flag 1 is set then Trigger
Else if DATA = 1000 and not Flag 1 then Trigger

Next: Counters (see page 373)

Counters
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Occurrence Counters are used in situations where you want to find the Nth occurrence of an event. 
For example, if you want to trigger on the 5th time that ADDR = 1000, you could set up the trigger as:

If ADDR = 1000 occurs 5 times then Trigger

Global Counters are like integer variables. They are more flexible than Occurrence Counters because 
they can be used to count complex events such as an edge followed by another edge. Global 
Counters can be incremented, tested, and reset. By default, Global Counters begin with zero and 
don't need to be reset unless they have already been used in the trigger sequence. In general, 
Occurrence Counters should be used in place of Global Counters, if possible, because they are easier 
to use and because there is a limited number of Global Counters.

Event counters are similar to global counters in that these are like integer variables used to count 
events and can be incremented or reset on the occurrence of the specified event. However, these 
counters cannot be used in an "If" clause to test a condition to be true or false. 

Next: Timers (see page 374)

Timers

Timers are used to check the amount of time that has elapsed between events. For example, if you 
want to trigger on one edge followed by another edge that occurs within 500 ns, use a timer. The 
most critical point to remember in using timers is that they need to be started before they are tested. 
In other words, timers do not start automatically.

The key to setting up a timer is to identify where it should be started and where it should be tested. 
Consider the example in the following figure. The timer should be started when the rising edge on 
SIG1 is detected and it should be tested when the rising edge occurs on SIG2.

An edge followed by an edge with a time limit

An example trigger sequence to set up this measurement is:

1. If there is a Rising Edge on SIG1, then
Start Timer1
Go to 2

2. If there is a Rising Edge on SIG2 AND Timer1 < 500ns then
Trigger

While the above trigger sequence seems correct, it actually has a critical flaw. What happens if there 
is a rising edge on SIG1 but SIG2 doesn't occur within 500 ns? The logic analyzer will never trigger, 
because timer1 will keep running and condition "Timer1 < 500 ns" will never be met. There might be 
another rising edge on SIG1 that is followed within 500 ns by the rising edge on SIG2 that occurs 
later on, so this situation is unacceptable.

To fix this problem, whenever the timer exceeds 500 ns without triggering, the sequence should loop 
back to Level 1 to look for another rising edge on SIG1. The following shows an example of the 
correct sequence:
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1. If there is a Rising Edge on SIG1, then
Start Timer1
Go to 2

2. If there is a Rising Edge on SIG2 AND Timer1 < 500ns then
Trigger

Else If Timer1 >= 500ns then
Reset Timer1
Go to 1

Occasionally, you may run out of timers. A counter can be used in place of a timer if the logic 
analyzer is sampling at regular intervals (that is, if it's in the timing sampling mode). A timer can be 
simulated by counting the number of samples that are acquired. For example, if the logic analyzer 
acquires a new sample every 10 ns and seven samples are acquired, this represents 70 ns.

Next: Storage Qualification (see page 375)

Storage Qualification

Storage qualification is used to determine if an acquired sample should be stored (that is, placed in 
memory) or thrown away. This keeps the logic analyzer memory from being filled with samples that 
are not needed.

Default Storage The simplest method to set up storage qualification is by setting up the Default Storage. Default 
Storage means "unless a sequence step specifies otherwise, this is what should be stored". As an 
example, you may want to only store samples if ADDR is in the range 1000 to 2000, so you should set 
the Default Storage to:

ADDR In Range 1000 to 2000

By default, the Default Storage is set to store all samples acquired. You can also set the Default 
Storage to store nothing, which means that no samples will be stored unless a sequence step 
overrides the default storage.

Sequence Step
Storage

Sequence step storage qualification means that within a particular sequence step only certain 
samples will be stored. This means that until a "Go To" or "Trigger" action is used to leave this 
sequence step, the storage qualification applies. This is useful when you want different storage 
qualification for each sequence step. For example, you may want to store nothing until ADDR = 1000 
and then store only samples with ADDR in the range 1000 to 2000 for the rest of the measurement.

Setting up sequence step storage requires the use of an additional branch. For example, if you want 
to store only samples with ADDR in the range 5000 to 6FFF while looking for DATA = 005E, the 
following sequence step could be used in some situations:

1. If DATA = 005E then Trigger
Else If ADDR in range 5000 to 6FFF then
Store Sample
Go to 1

Note the use of the store sample action. This means "store the most recently acquired sample in 
memory now". It does not mean, "From now on, start storing". It should be noted that since the store 
sample action is never executed unless ADDR is in the range 5000 to 6FFF, this branch essentially 
means "While in this sequence step, store only samples with ADDR between 5000 and 6FFF".

The above example seems to imply that only samples with ADDR between 5000 and 6FFF will be 
stored. However, this depends upon how the default storage has been set up. Using the previous 
example, if the default storage is set to "Store Everything", and a sample is outside of the range 5000 
to 6FFF, then the Else If branch is not executed and the Default Storage is applied. In essence, the 
sequence step has said what to do when a sample has a value in a particular range, but it doesn't say 
what to do for samples outside the range. Therefore, if you want to specify the sequence step storage 
unambiguously, use the following:
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1. If DATA = 005E then Trigger
Else If ADDR in range 5000 to 6FFF then
Store Sample
Go to 1

Else If ADDR not in range 5000 to 6FFF then
Don't Store Sample
Go to 1

Alternatively, if the default storage is set to "Store Everything", use the following:

1. If DATA = 005E then Trigger
Else If ADDR not in range 5000 to 6FFF then
Don't Store Sample
Go to 1

In summary, Sequence Step Storage always overrides the Default Storage, but only for the 
conditions specifically mentioned in the Sequence Step Storage. You must be very careful that you 
account for the interaction between Default Storage and Sequence Step Storage.

Next: Strategies for Setting Up Triggers (see page 376)

Strategies for Setting Up Triggers

• Trigger Functions (see page 376)

• Setting Up Complex Triggers (see page 378)

• Save and Document Your Trigger Sequences (see page 378)

Trigger Functions

While setting up logic analyzer triggers can be difficult, trigger functions can greatly simplify the 
process. Trigger functions are commonly-needed building blocks that can be combined to set up a 
trigger. Because the functions cover most common triggers, you can set up your trigger simply by 
selecting the appropriate function and filling in the data. The logic analyzer trigger user interface is 
shown in the following figure. Note that trigger functions are prominently located at the left of the 
screen.

The trigger user interface

Note that a picture (which corresponds to the selected function) is provided by hovering over the 
trigger function button.
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For example, if you want to trigger when a bus pattern is immediately followed by another bus 
pattern, you can drag-and-drop the "Pattern1 immediately followed by Pattern2" trigger function 
onto a trigger sequence step, as shown in the following figure.

Pattern1 immediately followed by Pattern2

Once you have selected this function, you simply fill in the names of the buses and the patterns. 
Contrast the previous figure with the following figure, which is the same trigger created using If/Then 
statements. The trigger function is easier to use because the additional details of the If/Then 
statements have been hidden. However, if you want to see the details, you can show trigger step as 
if/then.

The same trigger as If/Then statements

Trigger functions can be modified. For example, if you start with the function "Find Edge", you can 
add another event, and it becomes the same as "Find Edge and Pattern". Therefore, a function that is 
not exactly correct can often be converted into the desired trigger. It is also possible to convert a 
trigger sequence step to advanced If/Then trigger functions and modify them.

Trigger functions are like building blocks because they can be used together in a trigger sequence. 
For example, if you want to set up a trigger as "Find edge followed by pattern", you can use a "Find 
Edge" function for Level 1 and a "Find Pattern" function for Sequence Level 2 (see the following 
figure). So, functions are useful both as an entire trigger sequence and as one step in a trigger 
sequence.
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"Find Edge" and "Find Pattern" together

Next: Setting Up Complex Triggers (see page 378)

Setting Up Complex Triggers

Frequently, the most difficult part of setting up a complex trigger is breaking down the problem. In 
other words, how do you map a complex trigger into sequence steps, branches, and Boolean 
expressions? Here are step by step instructions:

1 Break down the problem into events that don't happen simultaneously. These correspond to the 
sequence steps.

2 Scan the list of trigger functions to try to find some that match the events identified in Step #1.

3 Within all remaining events, break them down into Boolean expressions and their corresponding 
actions. Each Boolean expression/Action pair corresponds to a separate branch within a 
sequence step. Remember that "Store" branches may exist that are used only to handle storage 
qualification for that sequence step.

Next: Save and Document Your Trigger Sequences (see page 378)

Save and Document Your Trigger Sequences

If a trigger sequence is important at one time, it is likely to be important again. This is why saving and 
documenting trigger sequences is so valuable. Complex trigger sequences generally are too difficult 
to understand without some accompanying explanation.

In Advanced If/Then trigger functions, you can include comments with the "If" clauses in a trigger 
sequence step. See “To display or hide "If" clause comments" on page 183.

When saving a trigger specification to a file, you can enter a description of the trigger sequence in 
the file header information (see “To store a trigger" on page 194 and the following figure).
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Also, because the trigger specification file is in XML format, you edit the file and annotate steps with 
additional HTML-style comments (for example, <!-- Comment. -->).

Next: Conclusions (see page 379)

Conclusions

Setting up logic analyzer triggers is very different than writing software. The job can be greatly 
simplified if other work can be leveraged by using pre-defined trigger functions and 
well-documented triggers that were written earlier. Only write your own trigger setup if there's 
nothing else available. Finally, when faced with a difficult trigger to set up, break down the problem 
into smaller chunks and deal with each one individually.
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ALA vs. XML, When to Use Each Format

See Also • To save a configuration file (see page 198)

• To open a configuration file (see page 208)

• To transfer module setups to/from multi-module systems (see page 210)

• ALA Format (see page 504)

• "XML Format" (in the online help)

If you want to: Then use:

Save and load sessions from 
a logic analysis system.

ALA Format — ALA format files are more complete, and the format is more efficient 
for saving and loading logic analyzer information.

Share captured data. ALA Format — In offline mode, you can read ALA format configuration files in any 
instance of the Keysight Logic Analyzer application, without having licenses for 
licensed tools, windows, etc. that may be used in the configuration. This provides 
"read-only" capability; licenses are required to go online or add any licensed tools, 
windows, etc.
XML Format — You can also share captured data using XML format configuration 
files. When loading an XML format file with data, you are forced into offline mode. 
Also, when viewing data from XML format configuration files, you need licenses for 
any licensed tools that may be used in the configuration.

Transfer module setup 
information between similar 
logic analyzers.

ALA Format — ALA format configuration files can only be loaded by logic analysis 
systems with compatible modules (for example, modules in the same or similar logic 
analyzer families.

Transfer module setup 
information between 
different logic analyzers.

XML Format — If you want to transfer setup information between incompatible 
modules, you must use XML format configuration files.

Transfer only part of a logic 
analyzer setup.

XML Format — You can load edited XML format configuration files.

Control the logic analysis 
system remotely using COM 
automation.

XML Format — The COM automation interface has commands for setting up parts of 
the logic analysis system with XML format strings. You can get these strings from 
XML format configuration files. (You can also load complete setups from ALA format 
configuration files using COM automation.)

Insert symbol information 
from software development 
tools.

XML Format — When a compiler-generated output file can't be loaded, you can save 
the configuration to an XML format file, edit it to include the symbol information 
(which has been translated into the logic analyzer's XML format), and open the XML 
format file again.
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Multiframe Logic Analysis Systems

If you need to make time-correlated measurements with more logic analysis channels than can be 
installed in a single frame/chassis, you can connect multiple M9505A, M9502A or M9595A chassis 
together.

The "AXIe based Logic and Protocol Analysis – Installation Guide" describes how to connect 
multiple frames/chassis. Basically, each M9505A, M9502A or M9595A chassis has two multiframe 
connectors, labeled "Input" and "Output". A multiframe cable connects the output of one frame to 
the input of another frame. You can chain as many frames as you like together this way. The master 
frame is the one with the open input connector; all other frames are slave frames, and the one with 
the open output connector is the terminating slave frame.

In addition to the multiframe cables, the frames must also be connected to a network. Usually, this is 
a Gbit LAN network. It can be a private or public network (see installation guide). The multiframe 
cable is used for time correlation, cross-triggering, and multiframe setup; all other inter-frame 
communication and data transfer take place over the network.

NOTE
Not all logic analysis systems have multiframe capability. If the back of your instrument does not 
have an "Input" and "Output" connector, it does not support multiframe. For example, the 
16850-series logic analyzers do not support multiframe.

CAUTION
Failing to follow one of the recommended multiframe configurations in the installation guide can 
result in unpredictable software behavior and/or poor analyzer performance!

NOTE
If (and only if) you encounter problems after changing multiframe connections, try rebooting all 
frames in the multiframe set. 

To ensure the smoothest multiframe startup, the following startup sequence is recommended:

• First, start up the system configured as the master frame. Let it fully boot and then log in as the 
preferred user. Once the desktop is available, wait until the Keysight Notification Center Icon 
(viewable in the system Tray) is displayed and in the green “ready” state. 

• Proceed to start the next intermediate slave system in the multiframe chain, again waiting until 
the instrument is in the ready state. 

• Continue sequentially with the rest of the slave systems, allowing each to get to the ready state. 
• Lastly, start the terminating slave system and allow it to reach the ready state.

You may now start the controlling Logic Analyzer application, which can run on the master system, 
any of the slave systems, or even remotely from another personal computer.

A “System” is considered to be a combination of the host controller and the instrument chassis. For 
the 16850 series of standalone instruments, the host controller and instrument chassis is 
contained in one, single frame package. For the M9505A, M9502A or M9505A chassis with one or 
more instrument modules installed, "system" is the combination of the chassis connected via some 
network connection to either an external remote host computer or an embedded host controller 
module installed in the chassis.

Remotely hosted systems may have their own boot sequence requirements. Usually this is to boot 
the chassis first and then the host computer.
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Some things to consider when using multiframe logic analysis systems:

• Use the Overview window to tell which frames are connected and which modules are in each 
frame.

CAUTION
Changing multiframe cables and/or network cables while a user is connected (online) with the 
multiframe set will force them offline—losing any unsaved changes.

NOTE
When an operating application on an instrument is forced offline due to a 
multiframe connection being made, multiple offline warning messages are 
displayed which require a user response to continue. For smoother 
multiframe startup, it is recommended to remove any startup menu 
shortcuts for the Logic Analysis application from all systems in the 
multiframe scenario so that no instrument systems can auto-start at login 
and enter online mode.
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• When triggering from, or sending a trigger to, an external, non-multiframe instrument, you must 
use the Trigger In or Trigger Out BNC connectors on the master frame.

• When you arm between modules in different frames, an unused flag line is implicitly used to 
facilitate the arming. (Flag lines already used in the trigger setup or to arm the external Trigger 
Out are not used.)

• The Keysight Notification Center Icon (lower, right-hand corner of the desktop) will be present 
when logged onto any standalone instrument. You can double-click this icon to get frame and 
module details on all frames in the multiframe set. If connected remotely from a PC, this 
information is available via the Overview window (mentioned above) and the System Summary 
dialog.
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Menus

• File Menu (see page 386)

• Edit Menu (see page 387)

• View Menu (see page 388)

• Setup Menu (see page 389)

• Tools Menu (see page 390)

• Markers Menu (see page 391)

• Run/Stop Menu (see page 392)

• Overview Menu (see page 393)

• Listing Menu (see page 393)

• Waveform Menu (see page 394)

• Compare Menu (see page 394)

• Source Menu (see page 395)

• Protocol Viewer Menu (see page 395)

• Window Menu (see page 396)

• Help Menu (see page 397)

File Menu

Menu Description

New Creates a new logic analyzer configuration file.

Open... Opens a previously saved logic analyzer configuration file.

Close Closes the active window after asking whether to save its data.

Save (see page 198) Saves changes to the currently open configuration file.

Save As... (see page 198) Saves the currently open configuration file to a new name.

Export... (see page 199) Saves captured data to comma-separated value (CSV) files.

Go Offline Disconnects the Keysight Logic Analyzer application from the currently connected 
frame.
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Edit Menu

Go Online To Local Frame Connects the Keysight Logic Analyzer application to the local frame. If there is no 
local frame, the Offline Startup Options dialog (see page 447) opens.

Go Online To... Opens the Select System to Use dialog (see page 459) for choosing a frame to 
connect the Keysight Logic Analyzer application to.

Print... Opens the Printing Data dialog (see page 451) for printing displayed data within a 
defined range.

Recent Configuration Files 
(see page 210)

Lists recently opened files for quick reference or access.

Exit Closes the logic analyzer user interface window.

Menu Description

Menu Description

Undo Undo the last user action. This includes any properties that have changed such as 
column color, column width, column move, column insert, column delete, etc. Items 
that cannot be undone include scrolling, acquisition runs and simple trigger 
modifications.

Cut Cuts the selection from alphanumeric fields in listing and waveform windows. 
Alphanumeric fields in lower level modal dialogs are cut using keyboard commands 
(see page 533) (accelerator keys). Cut selections are pasted to the clip board.

Copy Copies the selection from alphanumeric fields in listing and waveform windows. 
Alphanumeric fields in lower level modal dialogs are copied using keyboard 
commands (see page 533) (accelerator keys). Copied selections are pasted to the 
clip board.

Copy Screen (see 
page 315)

Copies the current screen to a bitmap and places it on the system clip board.

Paste Pastes the cut or copied data that is stored in the clip board into the alphanumeric 
field. Alphanumeric data is pasted into fields in lower level modal dialogs using 
keyboard commands (see page 533) (accelerator keys).
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View Menu

Insert Bus/Signal Into 
Window...

Inserts a predefined bus or signal into the display.

Remove Bus/Signal From 
Window

Deletes the highlighted bus or signal from the display window.

Window Properties... (see 
page 452)

Accesses the window properties dialog.

Symbols... Opens the Symbols dialog (see page 471) for setting up symbols for the selected 
bus/signal.

Find... (see page 264) Locates specific data in the acquisition.

Find Previous (see 
page 264)

Locates the previous occurrence of the specified data.

Find Next (see page 264) Locates the next occurrence of the specified data.

Go To Beginning (see 
page 249)

Places the beginning of the captured data trace at center screen.

Go To Trigger (see 
page 249)

Places the trigger point at center screen.

Go To End (see page 249) Places the end of the captured data trace at center screen.

Options... Accesses the System Options dialog (see page 447).

Menu Description

Menu Description

Zoom Out Full Zooms out on an active window as far as possible.

Zoom Out (see page 221) Zooms out on an active window.

Zoom In (see page 221) Zooms in on an active window.

Toolbars (see page 398) Access the Toolbar dialog window.
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Setup Menu

Full Screen Enables or disables full screen display.

Tabbed Windows (see 
page 313)

Enables or disables Listing and Waveform tabs.

Status Bar Enables or disables the status bar.

Menu Description

Menu Description

New Probe Lets you set up the FPGA Dynamic Probe (for probing signals internal to an FPGA) or 
set up definitions for other probes that are used (see "Setting Up Probes" (in the 
online help)).

Bus/Signal... Accesses the Buses/Signals (see page 426) tab of the Analyzer Setup dialog (see 
page 426).

Timing/State (Sampling)... Accesses the Sampling (see page 428) tab of the Analyzer Setup dialog (see 
page 426).

Simple Trigger... See Specifying Simple Triggers (see page 146).

Advanced Trigger... Accesses the Advanced Trigger (see page 424) dialog.

Store Trigger... Stores current trigger.

Recall Trigger... (see 
page 453)

Accesses a list of most recently used triggers.

Symbols... Opens the Symbols dialog (see page 471) for setting up symbols for the selected 
bus/signal.

Disable.../ Enable... Disabling a module prevents its captured data from being sent to tools and display 
windows; this will speed up the processing of data from other modules.

Rename... Lets you rename the logic analyzer module.
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Tools Menu

" Add External Scope..." (in 
the online help)

Runs the Add External Oscilloscope wizard for connecting an external oscilloscope 
to the logic analyzer.

Delete External Scope... Removes the setup for an externally connected oscilloscope.

External Trigger... Opens the External Trigger dialog (see page 437) for setting up triggers between 
the logic analyzer and other, external instruments.

Target Control Port... Opens the Target Control Port dialog (see page 475) for outputting signals on the 
logic analysis system frame's target control port.

Skew & System Trigger... Opens the Module Skew and System Trigger dialog (see page 446) for specifying 
which module (see page 616) is the system trigger (that is, which module's trigger 
reference point is Time=0) and for specifying the trigger reference point skew for 
modules that are not the system trigger.

Menu Description
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All add-in tools are grouped under the tools menu. The Keysight Logic Analyzer application comes 
with a filter/colorize tool built in. If you are using inverse assemblers, bus analysis tools, or other 
third-party tools, the tools will show up in the Tools menu under New.

As tools are created, they are added to the bottom of the Tools menu. The menus above show one 
active tool.

See Also • To add a new tool (see page 307)

• To change a tool (see page 310)

• To delete a tool (see page 307)

• "Using the Filter/Colorize Tool" (in the online help)

Markers Menu

Menu Description

New ... (see page 307) Creates a new inverse assembly, bus analysis, filter/colorize, packet decoder, serial 
to parallel, or signal extractor tool.

Overview (see page 307) Lets you manage the active tools.

Find... (see page 264) Locates specific data in the acquisition.

External Applications> Lets you run external applications from the Keysight Logic Analyzer application's 
menu. Setup... on the submenu opens the External Application Setup dialog (see 
page 436) that lets you add, edit, arrange, or remove items from the submenu.

Macro> Lets you:
• Open the Macros dialog for "choosing a Visual Basic macro to run" (in the online 

help).
• Open the Visual Basic Editor for "editing programs" (in the online help).
• "Export COM/DCOM project code to .zip files" (in the online help).
For more information, refer to the Visual Basic online help.

Run Macro> Opens the Add-In Manager dialog which lets you register an add-in (a customized 
tool that adds capabilities to the Visual Basic development environment), load or 
unload it, and set its load behavior. For more information, click Help in the Add-In 
Manager dialog.
Runs a sample macro. As shipped from the factory, the submenu contains:
• FindEdges (macro for displaying the time between two edges and placing 

markers on certain edge pairs).
• RepetitiveSaveToFile (macro for saving data from repetitive runs to incrementing 

file names).
• SendToExcel (macro for sending logic analyzer data to Microsoft Excel).
You can add your own COM/DCOM macros to this submenu by placing COM/DCOM 
project code .zip files in the directory:

<Drive letter>:\<Install directory>\
COM/DCOM\
For example:

C:\Program Files\Keysight Technologies\
Logic Analyzer\COM/DCOM\

1 tool name (see page 310) Edit an existing tool.
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Run/Stop Menu

Menu Description

New... (see page 246) Creates a new marker.

Place on Screen... (see 
page 248)

Places a new or selected (existing) marker at the middle of the screen.

Go To... (see page 249) Goes to a selected marker.

Center About... (see 
page 249)

Centers the display around a selected marker.

Delete... Deletes selected markers.

New Time Interval 
Measurement (see 
page 251)

Creates a new time interval measurement.

New Sample Interval 
Measurement (see 
page 252)

Creates a new sample interval measurement.

New Value At Measurement 
(see page 253)

Creates a new value at measurement.

Hide/Show Measurements 
List

Hides or shows the marker measurement display bar.

Properties... (see page 255) Accesses the markers properties dialog
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Overview Menu

Listing Menu

Menu Description

Run Starts sampling, fills logic analyzer memory with samples around the trigger, and 
stops.

Run Repetitive Starts sampling, fills logic analyzer memory with samples around the trigger, and 
repeats.

Stop Stops a logic analyzer measurement that is in progress.

Cancel When searching, using a filter, or exporting captured data, Cancel stops the 
operation.

Resume If you have used Cancel to stop a filter tool operation, Resume continues the filter 
operation.

Run Properties... Opens the Run Properties dialog (see page 454) which lets you enable, and set the 
options for, saving captured data after each run and stopping after a certain number 
of repetitive runs.

Status... Opens the Status dialog (see page 469).

Menu Description

Redraw Re-paints the Overview window.

System Summary... Opens the System Summary dialog (see page 472) which displays information 
about the frames (see page 615), modules (see page 616), cards (see page 614), 
and slots (see page 618) in the logic analysis system.

Delete Closes the Overview window.
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See Also • Analyzing Listing Data (see page 235)

• To set listing window properties (see page 238)

Waveform Menu

See Also • Analyzing Waveform Data (see page 220)

• To set waveform window properties (see page 227)

Compare Menu

Menu Description

Duplicate... Adds a new Listing window with the same properties as the window being displayed.

Delete Closes the Listing window.

Rename... Lets you rename the Listing window.

Properties... Lets you change Listing window properties.

Menu Description

Duplicate... Adds a new Waveform window with the same properties as the window being 
displayed.

Delete Closes the Waveform window.

Rename... Lets you rename the Waveform window.

Properties... Lets you change Waveform window properties.
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See Also • Compare Display Window (see page 411)

• Comparing Captured Data to Reference Data (see page 274)

• To set Compare window properties (see page 276)

Source Menu

See Also • Source Display Window (see page 412)

• Viewing Source Code Associated with Captured Data (see page 277)

• To set Source window properties (see page 281)

Protocol Viewer Menu

Menu Description

Copy... Copies data to the reference buffer.

Range & Offset... Lets you compare a range of samples and offset the reference data.

Next Difference Finds the next difference (below the center reference).

Previous Difference Finds the previous difference (above the center reference).

Duplicate... Adds a new Compare window with the same properties as the window being 
displayed.

Delete Closes the Compare window.

Disable..., Enable... Lets you disable or re-enable the Compare window.

Rename... Lets you rename the Compare window.

Properties... Lets you change Compare window properties.

Menu Description

Duplicate... Adds a new Source window with the same properties as the window being 
displayed.

Delete Closes the Source window.

Rename... Lets you rename the Source window.

Properties... Lets you change Source window properties.



13 Reference

396 Keysight Logic and Protocol Analyzer User Guide

See Also • Protocol Viewer Display Window (see page 413)

• Analyzing Packet Data (see page 283)

• Changing Protocol Viewer Window Properties (see page 302)

Window Menu

Menu Description

Duplicate... Adds a new Protocol Viewer window with the same properties as the window being 
displayed.

Delete Closes and deletes the Protocol Viewer window.

Rename... Lets you rename the Protocol Viewer window.

Properties... Lets you change Protocol Viewer window properties.
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Help Menu

Menu Description

New Compare... Creates a new Compare window (see page 411).

New Listing... Creates an additional Listing window (see page 409).

New Protocol Viewer... Creates an additional Protocol Viewer window (see page 413).

New Source... Creates a new Source window (see page 412).

Menu Description

Help Topics Accesses the online help.

Help On Probes Opens online help for probes.

Help On Windows Opens online help for the Waveform, Listing, Compare, or Source windows.

Help On Tools Opens online help for tools.

Help Language Lets you choose between the English and Japanese versions of the online help (see 
Accessing Japanese Online Help (see page 345)).

Show Demo... Launches the Demo Center (see page 55) application that demonstrates logic 
analysis system features.

Self Test... Accesses the Logic Analyzer Self-Tests dialog (see Running Self Tests (see 
page 343)).

Logic Analyzer Upgrade... Accesses the Keysight Logic Analyzer Upgrade dialog (see page 425) which 
provides information for upgrading hardware in logic analyzer modules.

Software Licensing... Opens the Software Licensing dialog (see page 461) for managing software 
licenses used by the logic analysis system.

Software Update... Opens the Add or Remove Keysight Logic Analyzer Software (see page 327) tool for 
managing your logic analyzer software and keeping it up to date.

About... Displays product version and copyright information.
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Toolbars

Toolbars are located under the menu bar, and are used to quickly access a function or perform a 
task. By default, not all toolbars, or individual tools within a given toolbar are displayed. For a 
complete list of all available toolbars, choose View>Toolbars>. For a complete list of all tools within a 
given toolbar, choose View>Toolbars>Customize...; then, select the Commands tab in the Customize 
dialog.

• Standard (see page 398)

• Analyzer Setup (see page 399)

• External Oscilloscope Setup (see page 399)

• Data Import (see page 400)

• Probes (see page 400)

• Markers (see page 400)

• Run/Stop (see page 401)

• Visual Basic (see page 401)

• Customize... (see page 402)

Standard Toolbar

Menu Description

New - Creates a new logic analyzer configuration file.

Open - Opens a previously saved logic analyzer configuration file.

Save - Saves changes to the currently open configuration file.

Print (see page 451) - Prints displayed data within a defined range.

Find (see page 264) - Locates specific data in the acquisition.

Find Previous (see page 264) - Locates the previous occurrence of the specified 
data.

Find Next (see page 264) - Locates the next occurrence of the specified data.

Go to Beginning (see page 249) - Centers the beginning of the acquisition data.

Go to Trigger (see page 249) - Centers the trigger point of the acquisition.

Go to End (see page 249) - Centers the end of the acquisition data.

Zoom Out (see page 221) - Zooms in on an active window.

Zoom In (see page 221) - Zooms out on an active window.

Overview - Opens or displays the Overview window (see page 418).

NOTE
The following are optional standard toolbar icons.
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See Also • To create a custom toolbar (see page 402)

Analyzer Setup Toolbar

See Also • To create a custom toolbar (see page 402)

External Oscilloscope Setup Toolbar

Menu Description

Cuts the selection and places it on the clip board.

Copies the selection and places it on the clip board.

Pastes the data that is stored on the clip board.

Provides online help information about the Keysight Logic Analyzer application.

Undo last user action.

Enables or disables full screen display.

Activate the next window.

Activates the previous window.

Arranges windows as cascaded overlapping tiles.

Arranges windows as non-overlapping horizontal tiles.

Arranges windows as non-overlapping vertical tiles.

Menu Description

Bus/Signal - Accesses the Buses/Signals (see page 426) tab of the Setup dialog.

Timing/State (Sampling) - Accesses the Sampling (see page 428) tab of the Setup 
dialog.

Advanced Trigger - Accesses the Advanced Trigger (see page 424) dialog.

Menu Description

Sets up the external oscilloscope connection attributes.

Sets up the external oscilloscope option attributes.

Sets up the external oscilloscope trigger attributes.
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See Also • "Infiniium Oscilloscope Time Correlation" (in the online help)

Data Import Toolbar

See Also • Using Data Import Modules (see page 211)

Probes Toolbar

Markers Toolbar

Menu Description

Lets you edit the data import module bus/signal definitions.

Displays data import module file information.

Re-reads the data import module file.

Menu Description

Opens the properties dialog for a particular probe.
• "Using the Xilinx FPGA Dynamic Probe" (in the online help)
• "Using the FPGA Dynamic Probe for Altera FPGAs" (in the online help)
• "Using General Purpose Probes" (in the online help)
• "PCI Express Analysis Probe" (in the online help)
• "Serial ATA Analysis Probe" (in the online help)

Menu Description

New (see page 246) - Creates a new marker.

Go To (see page 249) - Centers the display around the selected marker.

Creates a new value at a measurement (see page 253).

Creates a new time interval measurement (see page 251).
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See Also • To create a custom toolbar (see page 402)

Run/Stop Toolbar

See Also • To create a custom toolbar (see page 402)

Visual Basic Toolbar

See Also • "Using the Advanced Customization Environment (ACE)" (in the online help)

NOTE
The following are optional markers toolbar icons.

Menu Description

Place Maker (see page 248) - Places a new or selected (existing) marker at the 
middle of the screen.

Center About (see page 249) - Centers the display around two selected markers.

Creates a new sample interval measurement (see page 252).

Hides or shows the marker measurement display bar.

Accesses the markers properties (see page 255) dialog.

Menu Description

Starts sampling, fills logic analyzer memory with samples.

Starts Sampling, fills logic analyzer memory with samples around the trigger, and 
repeats.

Stops a logic analyzer measurement in progress, for example, when the trigger 
condition is not found.

Cancels the current operation.

Resumes the cancelled operation.

Menu Description

Runs a COM/DCOM macro.

Opens the Visual Basic Editor.
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To customize toolbars

• To add icons to a toolbar (see page 402)

• To remove icons from a toolbar (see page 402)

• To create a new toolbar (see page 402)

• To restore a toolbar to its original icons (see page 402)

To add icons to a
toolbar

1 From the menu bar, select View>Toolbars>Customize....

2 Select the Commands tab.

3 Select the Category that you want to add icons from.

4 Drag the desired icon from the Buttons area to the desired position on the toolbar; then, release 
the mouse button to insert the tool icon.

5 Repeat for any other icons you wish to add.

To remove icons
from a toolbar

1 From the menu bar, select View>Toolbars>Customize....

2 Select the Commands tab.

3 Drag the icon from the toolbar and drop it onto the Buttons area of the Customize dialog.

4 Repeat for any other icons you wish to remove.

To create a new
toolbar

1 From the menu bar, select View>Toolbars>Customize....

2 In the Customize dialog's Toolbars tab, click New....

3 In the New Toolbar dialog, enter the name of the new toolbar, and click OK.

4 Drag the new toolbar window to the desired position in the toolbar dock.

A second row of toolbars can be created by dragging a toolbar to the bottom of an existing 
toolbar row.

If a toolbar is hidden off-screen, drag a visible toolbar to create a second row of toolbars; that 
should then reveal the hidden toolbar.

Once you have created a new toolbar, you can add or remove icons as described above.

To restore a toolbar
to its original icons

1 From the menu bar, select View>Toolbars>Customize....

2 In the Customize dialog's Toolbars tab, select the name of the Toolbar you want to restore.

3 Click Reset.
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Marker Measurement Display Bar

Marker "interval" and "value at" measurements are displayed below the menu bar with the other 
toolbars.

• To create a new time interval measurement (see page 251)

• To create a new sample interval measurement (see page 252)

• To create a new value at measurement (see page 253)

• To hide/show measurement display bar (see page 391)
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Windows

• Waveform Display Window (see page 404)

• Markers Display Bar (see page 407)

• Markers Overview Bar (see page 408)

• Listing Display Window (see page 409)

• Compare Display Window (see page 411)

• Source Display Window (see page 412)

• Protocol Viewer Display Window (see page 413)

• Overview Window (see page 418)

Waveform Display Window

The Waveform window is accessed through the menu bar's Window>Waveform. If you have Tabbed 
Windows (see page 313) turned on, you can also select a tab at the bottom of the window.

The Waveform window displays captured data as a digital waveform. You can configure the window 
to display selected buses and signals with time or pattern markers in the data. You can also set up 
bus pattern triggers and signal trigger options.

The Waveform window consists of the following areas:

• Bus/Signal Configuration (see page 404)

• Simple Trigger (see page 146)

• Markers Display Bar (see page 407)

• Waveform Display Area (see page 406)

• Markers Overview Bar (see page 408)

• Delay Controls (see page 222)

• Scale (time/division) Controls (see page 221)

Bus/Signal
Configuration

To access the following Bus/Signal configuration options, right-click on any bus or signal name in 
the Bus/Signal column.
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Status Description

Undo Undo the last action performed.

Insert Row Before... Inserts a bus/signal before the highlighted row.

Insert Row After... Inserts a bus/signal after the highlighted row.

Delete> Deletes the bus/signal in the highlighted row or deletes all buses/signals.

Expand Expands the highlighted bus into separate displayed channels.

Collapse Collapses displayed channels to a single displayed bus.

Assign Channels... Access to the Buses/Signals tab of the Analyzer Setup dialog for mapping 
(assigning) the highlighted bus/signal to the desired pod and channel connection of 
the probes.

Rename... Access a keypad to rename the highlighted bus/signal.

Group into Bus (see 
page 227)

Groups highlighted signals into a bus.

Overlay... (see page 223) Overlays the highlighted bus or signal with another selected bus or signal.

Overlay Remove Separates overlaid bus/signals.

Symbols... Opens the Symbols dialog (see page 471) for setting up symbols for the selected 
bus/signal.

Find... Opens the Find dialog for searching the captured data (see page 264).

Find Bus/Signal... Searches for a bus/signal row.

View As Chart... (see 
page 224)

Opens the View As dialog for viewing the bus data as a chart or a bus.

Display> Lets you show or hide parts of the Waveform window (see page 226).

Properties... (see page 227) Access to properties dialog for waveform window, bus/signal row, bus/signal 
column, and marker properties.
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Waveform Display
Area

To access waveform display options, right-click anywhere in the display area.

Drawing Rectangle
in Data

Status Description

Undo Undo the last action performed.

Zoom Out (see page 221)

Zoom In (see page 221)

Go To (see page 222)

Place Marker> (see 
page 247)

Center About> Centers the display about a marker pair (see page 249) or waveform edges (see 
page 221).

Find... (see page 264)

Find Next (see page 264)

Find Previous (see 
page 264)

Properties... (see page 227)
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See Also • Analyzing Waveform Data (see page 220)

• Marking, and Measuring Between, Data Points (see page 245)

• Specifying Advanced Triggers (see page 152)

• Setting Up Symbols (see page 132)

• To add or delete display windows (see page 313)

• To turn window tabs on/off (see page 313)

Markers Display Bar

To access these tasks, right-click anywhere in the marker display bar.

Menu Description

Zoom In (see page 221)

Set Quick Trigger (see 
page 143)

Alternative way to set a Simple Trigger.

Find Next Data value on left edge of rectangle becomes Find search (see page 264) criteria 
and next occurrence of that data value is placed at center screen.

Find Previous Data value on left edge of rectangle becomes Find search (see page 264) criteria 
and previous occurrence of that data value is placed at center screen.
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See Also • To read the markers display and overview bars (see page 245)

• Markers Menu (see page 391)

• Markers Toolbar (see page 400)

• Markers Overview Bar (see page 408)

Markers Overview Bar

To access these menus, click anywhere in the marker overview bar.

Menu Description

New... (see page 246) To create new markers.

Place (see page 247) To place markers in data.

Go To (see page 249) To go to a marker.

Center About... (see 
page 249)

To center the display about a marker pair.

Snap to Edge (see 
page 250)

To toggle a marker's snap to edge property.

Delete (see page 250) To delete a marker.

Delete All (see page 250) To delete all markers.

Rename... (see page 254) To rename a marker.

Send to Back (see 
page 254)

To send a marker to the back.

Properties... (see page 255) To set marker properties.
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See Also • To read the markers display and overview bars (see page 245)

• Markers menu (see page 391)

• Markers toolbar (see page 400)

Listing Display Window

The Listing window is accessed through the menu bar's Window>Listing. If you have Tabbed 
Windows (see page 313) turned on, you can also select a tab at the bottom of the window.

The Listing window displays your captured data as a state listing. You configure the window to 
display selected buses and signals in columns. Within the listed data, you can insert time or pattern 
markers. You can also configure the bus pattern triggers and signal trigger options.

The Listing window consists of the following areas:

• Column Configuration (see page 409)

• Simple Trigger (see page 146)

• Markers Display Bar (see page 407)

• Listing Display Area (see page 410)

• Markers Overview Bar (see page 408)

Column
Configuration

To access the following column configuration options, right-click on any bus or signal name in the 
column head.

Menu Description

Go To (see page 249) To go to a marker.

Send to back (see 
page 254)

To send a marker to the back.
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Listing Display
Area

To access the Listing display options, right-click anywhere in the display area.

Menu Description

Undo Undo the last action performed.

Insert Column Before... (see 
page 238)

Insert Column After... (see 
page 238)

Delete> (see page 238)

Assign Channels... (see 
page 83)

Rename... Access a keypad to rename the highlighted bus/signal.

Base> (see page 241)

Symbols... Opens the Symbols dialog (see page 471) for setting up symbols for the selected 
bus/signal.

Find... Opens the Find dialog for searching the captured data (see page 264).

Find Bus/Signal... Searches for a bus/signal column.

Display> Lets you show or hide parts of the Listing window (see page 237).

Properties... (see page 238) Access to properties dialog for Listing window, bus/signal column, and marker 
properties.
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Draw Rectangle in
Data

See Also • Analyzing Listing Data (see page 235)

• Setting Up Symbols (see page 132)

• Marking, and Measuring Between, Data Points (see page 245)

• To add or delete display windows (see page 313)

• To turn window tabs on/off (see page 313)

Compare Display Window

Menu Description

Undo Same as Edit>Undo (see page 387).

Go To (see page 236)

Place Marker> (see 
page 247)

Find... (see page 264)

Find Next (see page 264)

Find Previous (see 
page 264)

Properties... (see page 238)

Menu Description

Set Quick Trigger (see 
page 143)

Alternative way to set a simple trigger.

Find Next Data value on top edge of rectangle becomes Find search (see page 264) criteria 
and next occurrence of that data value is placed at center screen.

Find Previous Data value on top edge of rectangle becomes Find search (see page 264) criteria 
and previous occurrence of that data value is placed at center screen.

Copy Text (see page 314) Copies data as text into the system clip board.
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The Compare window lets you compare acquired (input) data to data that has been saved in a 
reference buffer. The reference data has a colored background, and differences between between 
the input data and the reference data are highlighted.

The Compare window is accessed through the menu bar's Window>Compare. If you have Tabbed 
Windows (see page 313) turned on, you can also select a tab at the bottom of the window.

Except for the Compare window's ability to display the differences between captured data and 
reference data, and its inability display colorized data (from the Filter/Colorize tool), the Compare 
window is just like the Listing window.

See Also • Comparing Captured Data to Reference Data (see page 274)

• To copy data to the reference buffer (see page 274)

• To find differences in the compared data (see page 274)

• To compare only a range of samples (see page 275)

• To offset the reference data (see page 275)

• To run until a number of compare differences (see page 275)

• To set Compare window properties (see page 276)

• Analyzing Listing Data (see page 235)

Source Display Window
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The Source window lets you view the high-level source code that is associated with captured data.

The Source window is accessed through the menu bar's Window>Source command. If you have 
Tabbed Windows (see page 313) turned on, you can also select a tab at the bottom of the window.

The Source window has two panes: the top pane displays the high-level source code associated with 
the captured data, and the bottom pane is the same as a Listing window.

See Also • Viewing Source Code Associated with Captured Data (see page 277)

• To step through captured data by source lines (see page 277)

• To go to captured data associated with a source line (see page 278)

• To browse source files (see page 278)

• To search for text in source files (see page 279)

• To set a Quick Trigger in the Source window (see page 145)

•  To go to the source line associated with the listing center rectangle (see page 279)

• To edit the source code directory list (see page 279)

• To select the correlation bus (see page 280)

• Changing Source Window Properties (see page 281)

• Analyzing Listing Data (see page 235)

Protocol Viewer Display Window

You can use a Protocol Viewer window to display data captured by an Keysight instrument module 
such as the U4301A PCIe Gen3 Analyzer module. The following screen displays an instance of 
Protocol Viewer added to the U4301A module in the Logic Analyzer application to display the PCI 
Express data captured by the module. 
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On clicking the Show button on Protocol Viewer, the Protocol Viewer window is displayed with the 
captured data in the Logic Analyzer application.

Unlike the Listing window, the Protocol Viewer window lets you view summarized and detailed 
packet information at the same time within two panes.



Keysight Logic and Protocol Analyzer User Guide 415

Reference 13

The upper pane lists the captured packets. On selecting a packet in the upper pane, specific details 
of that packet are displayed in various tabs of the lower pane.

Adding a Protocol Viewer window instance

You can add an instance of the Protocol Viewer window to a module or a tool in the Overview tab of 
the Logic Analyzer application. To do this, right-click the module or tool, select New Window and 
then select Protocol Viewer.

If you are using the U4301A PCIe Gen3 Analyzer module, an instance of the Protocol Viewer window 
is automatically added to this module in the Overview tab of the Logic Analyzer application.

Upper pane of Protocol Viewer

The upper pane of Protocol Viewer provides a summarized listing of the captured packets. To know 
more about how to use the upper pane of Protocol Viewer, refer to the topic “Viewing the Packet 
Summary" on page 285.

Lower pane of Protocol Viewer

The lower pane displays the details of a packet that you selected in the upper pane. The packet 
details are organized in the following tabs.

Menu Description

Details This tab displays the details of a selected packet. You can also compare the details 
of a packet with another packet's details. To know how to use this tab, refer to the 
topic “To view and compare packet details" on page 294.

Header This tab displays the header information for a selected packet. To know how to use 
this tab, refer to the topic “To view a packet header" on page 297.

Payload This tab displays the payload information for a selected packet. To know how to use 
this tab, refer to the topic “To view a packet payload" on page 298.

Lanes This tab displays a vertical listing of a selected packet's data with respect to the 
logical lanes. To know how to use this tab, refer to the topic “To view a packet's 
lanes" on page 299.

Traffic Overview This tab provides an overview of the protocol traffic that is displayed in the upper 
pane of Protocol Viewer. You can use this tab to get a count of captured packets 
categorized on the basis of packet types. 
To know how to use this tab, refer to the topic Viewing the captured PCIe Traffic 
statistics in U4301A PCIe Gen3 Analyzer module online help.

LTSSM Overview This tab displays a sequential list of the LTSSM states and their transitions and the 
packets exchanged during each state. You can use the information displayed in this 
tab to in verify the link training process and find out reasons for any failure in this 
process. 
To know how to use this tab, refer to the topic Viewing LTSSM States and Transitions 
in the U4301A PCIe Gen3 Analyzer module online help.

Transaction Decode This tab allows you to compute and view transactions decoded from the captured 
PCIe traffic. This is a licensed feature.
To know how to use this tab, refer to the topic Viewing Decoded Transactions in the 
U4301A PCIe Gen3 Analyzer module online help.

PCIe Performance Overview This tab allows you to perform post processing on the captured PCIe traffic and 
generate an offline performance summary of bus utilization. This is a licensed 
feature.
To know how to use this tab, refer to the topic Viewing Offline Performance 
Summary in the U4301A PCIe Gen3 Analyzer module online help.
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ONFi Analysis Window

You can use the ONFi Analysis window to display and analyze a NAND Flash memory device's data 
captured by a Keysight logic analyzer module such as the U4154B or U4164A module.

Adding an ONFi Analysis Window Instance

You can add an instance of the ONFi Analysis window to any of the following modules/tools in the 
Logic and Protocol Analyzer GUI:

• A logic analyzer module such as U4164A, U4154B, or 16860 series

• A Data Import tool

To do this, right-click the module or tool in the Overview tab, select New Window and then select 
ONFi Analysis. An instance of the ONFi Analysis window is then automatically added to the module in 
the Overview tab of the Logic and Protocol Analyzer GUI.

The following screen displays an instance of the ONFi Analysis window added to the U4164A module 
in the Logic and Protocol Analyzer GUI.

NOTE
You can export the captured packet information to a specified .csv file using 
Protocol Viewer. You can either export all the data captured and displayed in 
Protocol Viewer or a specified time/marker based range of data. You do this 
using the  toolbar button in the Protocol Viewer window.

NOTE
You need the software license option B4661A-4FP Performance Analysis to get the full 
feature set and capabilities of the ONFi Analysis window. Without this license, it is possible to 
compute only limited number of NAND Flash memory transactions from the captured data. 

NOTE
You should NOT attach the ONFi Analysis window to a Filter tool. Filtering can impair some of 
the memory analysis features if some data such as clock speeds is filtered.
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On clicking the Show button on the ONFi Analysis instance, the ONFi Analysis window is displayed. In 
this window, you can initiate the compute process to allow the Logic and Protocol Analyzer software 
to computer the decoded NAND Flash memory transactions from the captured data.

A sample of the NAND Flash memory data as presented in the ONFi Analysis window is displayed 
below.

Upper Pane of ONFi Analysis

The upper pane lists the decoded ONFi transactions that the Logic and Protocol Analyzer software 
computed from the captured NAND Flash memory data.

To know more about how to use the upper pane, refer to the topic Computing and Viewing Decoded 
ONFi Transactions.

Lower Pane of ONFi Analysis

Besides displaying the decoded ONFi transactions in the upper pane, the ONFi Analysis window also 
provides various tabs in its lower pane.

These tabs provide statistical data and charts from the decoded transactions to help you analyze 
different aspects of your NAND Flash memory device.

The memory analysis details are organized in the following tabs of the lower pane.
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Overview Window

The Overview window lets you specify how the data is sent from the logic analyzer data acquisition 
module to post-processing tools and display windows.

The Overview window is accessed through the menu bar's Window>Overview command. If you have 
Tabbed Windows (see page 313) turned on, you can also select a tab at the bottom of the window.

Connection Rules There are a few rules that govern how you are able to add/connect tools and display data.

• Rule 1: Fan out to tools only occurs directly after modules.

Tab Description

Traffic Overview This tab provides a tabular as well as a graphical overview of the captured NAND Flash memory traffic. You 
can use this tab to get a count of ONFi commands categorized on the basis of command types.
To know how to use this tab, refer to the topic Analyzing ONFi Traffic Statistics in the ONFi Analysis 
Window User Guide.

Details  This tab displays the details of an ONFi transaction selected in the upper pane. You can also visualize an 
ONFi operation as a set of logically grouped commands in a sequence in this tab.
To know how to use this tab, refer to the topic Viewing Details of an ONFi Transaction in the ONFi Analysis 
Window User Guide.

Payload View This tab displays the payload for an ONFi transaction selected from the upper pane. To know how to use 
this tab, refer to the topic Viewing the Payload of an ONFi Transaction in the ONFi Analysis Window User 
Guide.
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• Rule 2: Fan in to tools occurs only directly after modules.

• Rule 3: Display windows cannot show two versions of the same bus/signal.

See Also • Analyzing the Same Data in Different Ways (Using the Overview Window) (see page 307)

• To open or display the Overview window (see page 307)

• To add, duplicate, or delete windows and tools (see page 307)

• To add new windows (see page 308)

• To delete windows (see page 308)

• To add new tools (see page 308)
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• To delete tools (see page 309)

• To duplicate windows (see page 309)

• To delete connections (see page 309)

• To add connections (see page 310)

• To edit window or tool properties (see page 310)

• To rename windows, tools, and modules (see page 311)

• To redraw the Overview window (see page 311)

• To delete the Overview window (see page 311)
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Dialogs

• Advanced Clocking Setup Dialog (see page 422)

• Advanced Trigger Dialog (see page 424)

• Keysight Logic Analyzer Upgrade Dialog (see page 425)

• Analyzer Setup Dialog (see page 426)

• Chat Dialog (see page 429)

• Chat Select Destination Dialog (see page 430)

• Choose a Protocol Family and Bus Dialog (see page 430)

• Create a New Configuration Dialog (see page 431)

• DDR Accumulate Dialog (see page 431)

• E-mail Dialog (see page 432)

• Event Editor Dialog (see page 433)

• Export Dialog (see page 434)

• Export File Selection Dialog (see page 435)

• External Application Setup Dialog (see page 436)

• External Trigger Dialog (see page 437)

• Find Dialog (see page 438)

• Frame/Module Information Dialog (see page 439)

• "General Purpose Probe Set Dialog" (in the online help)

• Instrument Details Dialog (see page 441)

• Import Dialog (see page 442)

• Import Setup Dialog (see page 442)

• Module Mapping Dialog (see page 444)

• Module Skew and System Trigger Dialog (see page 446)

• Netlist Import Dialog (see page 446)

• Offline Startup Options Dialog (see page 447)

• Options Dialog (see page 447)

• Pod Assignment Dialog (see page 450)

• Printing Data Dialog (see page 451)

• Properties Dialog (see page 452)

• Range Properties Dialog (see page 452)

• Recall Trigger Dialog (see page 453)

• Run Properties Dialog (see page 454)

• Search Dialog (see page 455)

• Select Symbol Dialog (see page 458)

• Select System to Use Dialog (see page 459)

• Software Licensing Dialog (see page 461)

• Source Viewer Properties Dialog (see page 466)

• Specify Mapping Dialog (see page 468)

• Status Dialog (see page 469)

• Symbols Dialog (see page 471)

• System Summary Dialog (see page 472)

• Target Control Port Dialog (see page 475)
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• TimingZoom Setup Dialog (see page 476)

Advanced Clocking Setup Dialog

The Advanced Clocking Setup dialog lets you specify more complex clock setups than you can with 
the normal clock edge and qualifier selections in the Sampling tab of the Setup dialog. This dialog 
box is available only when you are setting up multiple clocks. To know how to access this dialog box, 
refer to the topic To set up advanced clocking.

Some situations in which this dialog box is particularly useful:

• By default, the clock qualifiers available for multiple clocks are set with the AND conditional 
operator but you can use the Advanced clocking feature to set these qualifiers with either "AND" 
or  "OR" conditional operators.

Menu Description

Clock spec: A textual description of the clocking setup that you defined in this dialog box.

Edges Lets you choose from Don't Care, Rising Edge, Falling Edge, or Both Edges for each 
of the available clock inputs (on Pod 1, 2, 3, and 4).
Edges are set in an Ored combination.

Qualifiers Lets you turn Off clock qualifiers or select Low or High levels from the available clock 
inputs for each of the clock qualifier resources (Q1-Q4).

And/Or Lets you toggle the And/OR conditional operators for the two clock qualifiers used 
for a clock.
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• By default, the clock qualifiers that you set are used with all the clocks that you set but you can 
use the Advanced clocking feature to set different qualifiers for different clocks.

Multiple clocks with same clock qualifiers

Multiple clocks with different clock qualifiers

• By default, a clock channel can be used either as an edge or a qualifier in a multiple clock 
description but you can use the Advanced clocking feature to use a clock channel both as an 
edge and a qualifier in the same clock description.
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See Also • To set up advanced clocking (see page 127)

• Pod and Channel Naming Conventions (see page 361)

Advanced Trigger Dialog

The Advanced Trigger dialog lets you set up complex trigger specifications that cannot be set up with 
simple triggers (for example, you can trigger on a sequence of events in the device under test).

Menu Description

Trigger Functions Trigger functions are pre-defined trigger setups for common measurements. Trigger 
functions are drag-and-dropped into the Trigger Sequence area in the desired order; 
then, you fill-in the fields that specify the events to look for in the sampled data and 
the actions to take when the events are found.

Trigger Sequence The trigger sequence describes the steps to take when searching for a sequence of 
events that will trigger the logic analyzer.
Default storage specifies which samples to store unless there are overriding storage 
control actions within the trigger sequence steps.

Simple Trigger... Opens an information dialog that explains how to specify simple triggers (see 
page 146).



Keysight Logic and Protocol Analyzer User Guide 425

Reference 13

See Also • Specifying Advanced Triggers (see page 152)

• Trigger Functions (see page 478)

• Specifying Simple Triggers (see page 146)

• Storing and Recalling Triggers (see page 194)

Keysight Logic Analyzer Upgrade Dialog

Determine if a
Logic Analyzer is
Upgradeable Tab

This tab lists the logic analyzers and other cards in a frame and shows you whether they are 
upgradeable or if an upgrade is pending.

Store... Opens the Store Trigger dialog for saving a trigger sequence setup as a favorite or 
saving it to a file.

Recall... Opens the Recall Trigger dialog (see page 453) for recalling favorite, recently used, 
and stored trigger sequence setups.

Clear Clears the current trigger sequence and sets up a default trigger sequence.

Menu Description

NOTE
When installing licensed hardware upgrades, you must run the Hardware Update Utility program 
on the frame that contains the cards you want to upgrade. In other words:

• In a multiframe logic analysis system, you must run the Hardware Update Utility program on 
each frame that has cards to be upgraded.

• You cannot install module upgrades over a remote connection (including remote connections 
via Remote Desktop, NetOp, or RealVNC).
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Install a Logic
Analyzer Upgrade

Tab

See Also • Installing Licensed Hardware Upgrades (see page 139)

Analyzer Setup Dialog

The Analyzer Setup dialog is accessed through the main menu's Setup>(Logic Analyzer 
Module)>Bus/Signal... or Setup>(Logic Analyzer Module)>Timing/State (Sampling)... commands.

The dialog consists of the following two tabs.

• Buses/Signals - The Buses/Signals tab is used to map bus and signal names in the interface to 
the pod and channel connections of the probes. Also, you can set a pod threshold, and assign a 
default number base and polarity to the bus or signal. See Buses/Signals Tab (see page 426).

• Sampling - The Sampling tab is used to name the analyzer, and select and configure the 
acquisition mode. In the timing acquisition mode, you set the channel width and sampling rate. In 
the state acquisition mode you configure the state clocks and qualifiers. See Sampling Tab (see 
page 428).

Buses/Signals Tab

The Buses/Signals tab is used to map (assign) bus and signal names in the interface to the pod and 
channel connections of the probes. You also use the Buses/Signal tab to set up thresholds, polarity, 
default number base, and enter user comments.

Menu Description

Upgrade... Performs the pending upgrade for the selected card.
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The Buses/Signals tab is accessed through the menu bar's Setup>(Logic Analyzer 
Module)>Bus/Signal... command.

Through the Display button, you can select what bus/signal setup information is displayed.

The bus and signal icons in the Bus/Signal Name column are normally red, but they turn gray if the 
bus/signal is locked by an inverse assembler.

Read Only Options The following fields are read only and cannot be edited. The display of these items can be turned 
on/off under the Display button.

Menu Description

Width The Width column displays the number of assigned channels on each bus.

Activity The Activity row displays the type of signal activity on each channel.
• Low bar = A stable low level.
• High bar = A stable high level.
• Transition arrows = An active signal transition between low and high.

Channel Numbers The Channel Numbers row displays pod channel numbers

NOTE
In previous versions of the Keysight Logic Analyzer application, the Buses/Signals setup tab had a 
Define Probes... button; now, probes are defined differently (see "To define probes" (in the online 
help)).
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See Also • Defining Buses and Signals (see page 83)

• To add a new bus or signal (see page 84)

• To delete a bus or signal (see page 84)

• To rename a bus or signal (see page 85)

• To assign channels in the default bit order (see page 88)

• To assign channels, selecting the bit order (see page 89)

• To define buses and signals by importing netlist files (see page 90)

• To reorder bits by editing the Channels Assigned string (see page 91)

• To set the default number base (see page 93)

• To set polarity (see page 94)

• To add user comments (see page 94)

• To add a folder (see page 95)

• To alias a bus/signal name (see page 95)

• To sort bus/signal names (see page 95)

• Pod and Channel Naming Conventions (see page 361)

• Why Are Pods Missing? (see page 362)

• Logic Analyzer Notes (see page 536)

Sampling Tab

The Sampling tab is access through the menu bar's Setup>(Logic Analyzer Module)>Timing/State 
(Sampling)... command. The Sampling setup tab is used to select and configure the sampling mode.

NOTE
If you enable the Advanced Probe settings for U4154A/B logic analyzer, a button named APS is 
displayed in the Buses/Signals tab. You use this button to enable or disable the peaking for the 
probing system used for these logic analyzers. See “Changing Advanced Probe Settings for 
Logic Analyzers" on page 563.
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See Also • Choosing the Sampling Mode (see page 96)

• Logic Analyzer Notes (see page 536)

Chat Dialog

The Chat dialog lets you enter and send messages to other logic analysis system users.

Menu Description

Acquisition Lets you select the Timing or State acquisition mode (see Choosing the Sampling 
Mode (see page 96)).

Timing Options When the Timing acquisition mode is selected, you can specify its options (see 
Selecting the Timing Mode (Asynchronous Sampling) (see page 96)).

State Options When the State acquisition mode is selected, you can specify its options (see 
Selecting the State Mode (Synchronous Sampling) (see page 98)).

Options Lets you specify options that apply to both the Timing and State acquisition modes 
(see To specify the trigger position (see page 128) and To set acquisition memory 
depth (see page 129)).

TimingZoom Lets you turn the timing zoom feature on or off and specify its settings (see Using 
Timing Zoom (see page 129)).



13 Reference

430 Keysight Logic and Protocol Analyzer User Guide

See Also • Select System to Use Dialog (see page 459)

• Chat Select Destination Dialog (see page 430)

Chat Select Destination Dialog

The Chat Select Destination dialog lets you select either the person logged into or the person 
connected to the logic analysis system.

Clicking OK opens the Chat dialog (see page 429) where you can enter and send your message.

See Also • Select System to Use Dialog (see page 459)

Choose a Protocol Family and Bus Dialog

The Choose a Protocol Family and Bus dialog lets you select a protocol family and bus for the "Find a 
packet" trigger function.

Menu Description

Message to send Lets you enter a message to send.

Send Sends the message.

Close Closes the dialog and the chat session.
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See Also • Find a packet (see page 496) trigger function

• To specify packet events (in "Find a packet" trigger function) (see page 164)

Create a New Configuration Dialog

The Select Offline Hardware dialog appears when you are in offline mode and you choose the 
File>New command to create a new logic analyzer configuration file. This dialog lets you specify the 
type of logic analyzer hardware to model in the configuration file.

See Also • Offline Analysis (see page 217)

DDR Accumulate Dialog

This dialog is accessed by clicking the Setup button from the Compute Options groupbox in the 
DDR/LPDDR Memory Analysis Window.

Menu Description

Protocol Family Lets you select the protocol family.

Bus Lets you select the type of bus within the protocol family.

Menu Description

Type of Card Selects the type of logic analysis hardware to use in the new offline configuration 
file.

Number of Cards in Specifies the number of cards in the hardware module.

Starting Slot Selects the starting slot of the cards used in the new offline configuration file.
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When you select the Compute and Accumulate on Run compute option, the computed data from 
each consecutive run of logic analyzer is accumulated for the applicable tabs of the DDR/LPDDR 
Memory Analysis window. 

You use the DDR Accumulate dialog box to configure options for this accumulated data. 

See Also Computing Decoded Memory Transactions and Analysis Data (in the Memory Analysis Window User 
Guide)

E-mail Dialog

This dialog allows you to configure the e-mail settings that the Keysight Logic and Protocol analyzer 
application uses to compose e-mail messages for the specific situations for which you have 
configured the "send e-mail" feature. For instance, to send the specified e-mail message to the 
specified recipient when a trigger event occurs for which you have configured "send e-mail" as the 
trigger action. 

Option Description

Data To Accumulate  By default, the computed data from each consecutive run of logic analyzer 
can be accumulated only for the Traffic Overview, Memory Access Overview, 
and Performance Overview tabs of the DDR/LPDDR Memory Analysis 
window. If you do not want data to be accumulated for any of these tabs, you 
can deselect its checkbox.

Memory Access Options The options in this groupbox are applicable for data accumulation in the 
Memory Access Overview tab only. 
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You can access the E-mail dialog from the following dialogs that support the "send e-mail" feature. 

• Advanced Trigger dialog (See - To specify a trigger sequence step's goto or trigger action on 
page 166)

• Interval Properties dialog (See - To create a new time interval measurement on page 251)

• Interval Properties dialog (See - To create a new sample interval measurement on page 252)

• Value Properties dialog (See - To change a marker's position property on page 248)

• Compare Properties dialog (See - To run until a number of compare differences on page 275)

Event Editor Dialog

The Event Editor dialog lets you specify packet events in the "Find a packet" trigger function.

NOTE
Ensure that you have specified the SMTP mail server name and sender's 
email address in the Options dialog for the "send e-mail" feature to work. 
The Keysight Logic and Protocol Analyzer application communicates 
directly with this e-mail server to send the e-mail.

Menu Description

To Address(es) to which e-mail will be sent. You can specify multiple recipients by 
separating each e-mail address with a semicolon (;).

Subject Subject of the e-mail.

(message) Text of the message.
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See Also • Using the Packet Event Editor (see page 164)

• Find a packet (see page 496) trigger function

• To specify packet events (in "Find a packet" trigger function) (see page 164)

• To find packet patterns in the captured data (see page 267)

• "To specify packet patterns to filter" (in the online help)

Export Dialog

The Export dialog lets you export certain kinds of data into the Keysight Logic Analyzer application.

Menu Description

Events Hierarchically lists protocol event types that you can select.

(Fields) (On the right side of the dialog). Lets you enter, select, or clear ( ) packet field 
values.

Name Lets you enter or modify the name of the packet event.

Add to Favorites Adds the packet event to the favorites list.

Organize Favorites... Opens the Organize Favorites dialog for organizing the packet event favorites list 
(see To organize favorite packet events (see page 165)).

Clear Clears all packet field values.

View as Bits... Opens the View as Bits dialog for viewing the packet event in a format similar to 
specifications documents (see To view a packet event as bits (see page 165)).
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Export File Selection Dialog

The Export file selection dialog lets you select the file to which data is exported, the data source, the 
export options, the range of data samples, and the buses/signals to export.

Menu Description

Module CSV text file Lets you export module data only to a comma separated value (CSV) format text file. 
This file type is for post-processing tools (see “To export data to module CSV 
format files" on page 201).

Module binary file Lets you export module data only to a binary format file (see “To export data to 
module binary (ALB) format files" on page 203).

Standard CSV text file Lets you export data from modules, tools, or windows to a comma separated value 
(CSV) format text file (see “To export data to standard CSV format files" on 
page 199).

Menu Description

File name Lets you select the file to which data is exported.

Save as type The appropriate type is already selected, based on the file type selected in the 
previous Export dialog (see page 434).

Source Lets you select the data source. The list of sources you can select from is determined 
by the file type selected in the previous Export dialog (see page 434).

Options... Opens the File Export Options dialog where you can select the appropriate options 
for the file type selected in the previous Export dialog (see page 434).

All Data When checked, data from all samples and all buses/signals is exported.

Data Range... When All Data is not checked, this button opens a Range Properties dialog for 
selecting the range of data samples to export.

Bus Signal Selection... When All Data is not checked, this button opens a Range Properties dialog for 
selecting the buses/signals to be included in the export.
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See Also • To export data to standard CSV format files (see page 199)

• To export data to module CSV format files (see page 201)

• To export data to module binary (ALB) format files (see page 203)

• "Exporting Vector Sequences to CSV Format Files" (in the online help)

External Application Setup Dialog

The External Application Setup dialog lets you add, edit, arrange, or remove items from the 
Tools>External Applications> menu.

External Application Add/Edit Dialog

The Add/Edit Application dialog lets you enter or modify the parameters for an item in the 
Tools>External Applications> menu.

Menu Description

Add Application... Opens the Add Application dialog (see page 436) for specifying a new menu item's 
parameters.

Edit Application... Opens the Edit Application dialog (see page 436) for changing the selected menu 
item's parameters.

Delete Application Deletes the selected application from the menu item list.

Move Up Move Down Moves the selected application up or down within the menu item list.
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External Trigger Dialog

There are Trigger In and Trigger Out BNC connectors located on the 16850-series logic analysis 
system. These BNC connectors are used to connect the analyzer to an external instrument and either 
send or receive a trigger signal.

The External Trigger dialog is used for setting up triggers between the logic analyzer or logic analysis 
system and other, external instruments.

The 16850-series External Trigger dialog looks like:

Trigger In Lets you trigger the logic analyzer from another source. You can select whether a rising or falling 
edge indicates a trigger.

Trigger Out Sends a signal to another device when the logic analyzer triggers. You can select whether the trigger 
will appear as a rising or falling edge.

Menu Description

Executable file The name of the file to execute when the menu item is selected.

Application name The name that appears on the menu item.

Command line Command line options for the executable file.

Application directory The directory that contains the executable file.

Test Run For quick testing, this executes the application with the given parameters.

Input Signal Characteristic 16850-Series

Input signal level: Selectable, ±5 V Max.

Minimum signal amplitude: 200 mV
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The trigger out signal is designed to drive a 50 Ohm load. It is recommended that for good signal 
quality, the trigger out signal be terminated in 50 Ohms to ground.

With a 16850-series logic analysis system frame, you can:

• Enable or disable (3-state high-impedance) the output.

• Choose the polarity of the output.

• Choose whether the output mode is Pulsed or Feedthrough (for observing flag settings).

• Select the events that will cause a trigger signal to be output.

See Also • To trigger other instruments - trigger out (see page 191)

• To trigger analyzer from another instrument - trigger in (see page 192)

Find Dialog

The Find dialog lets you search for patterns in captured data. You can qualify your search by specific 
bits, data patterns, equality, and range operators. The search result is placed at the center of the 
display.

Output Signal Characteristic 16850-Series

VOH (output high level): >2.0 V (3.3 V avg.)

VOL (output low level): <0.5 V (0 V avg.)

Pulse width: Approx. 80-160 ns

Menu Description

Find N occurrences Specifies the number of occurrences to search for.

searching Specifies whether to search Forward or Backward.

from Specifies the starting location (Display Center, Beginning Of Data, End Of Data, 
Trigger, or a marker).
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See Also • To quickly find bus signal patterns (see page 264)

• To find bus/signal patterns in the captured data (see page 265)

• To find packet patterns in the captured data (see page 267)

• To find complex patterns in the captured data (see page 270)

• To store, recall, or delete favorite find patterns (see page 271)

• To specify "found" marker placement (see page 272)

Frame/Module Information Dialog

The Frame/Module Information dialog displays detailed information about a logic analysis system 
frame (see page 615).

(pattern event) Specifies the pattern event you wish to locate.
In addition to the usual pattern matching operators (=, !=, <, >, <=, >=, In Range, 
and Not In Range), there are three additional operators you can use:
• Entering — the first sample of one or more consecutive samples that match the 

pattern. (By comparison, the "=" equals operator considers every sample that 
matches the pattern as an occurrence.)

• Exiting — the sample after one or more consecutive samples that match the 
pattern.

• Transitioning — entering or exiting one or more consecutive samples that match 
the pattern.

When A find qualifier (which further qualifies the find criteria with a time duration or other 
operator):
• Present
• Not Present
• Present> (time duration)
• Present>= (time duration)
• Present< (time duration)
• Present<= (time duration)
• Present for Range (of time)
• Not Present for Range (of time)
• Entering
• Exiting
• Transitioning
The find qualifiers Present>, Present>=, Present<, Present<=, Present for Range, 
and Not Present for Range let you specify a time duration. This means the find event 
specified in the expression area will be found based upon the given time and 
operator.
The other qualifiers (Present, Not Present, Entering, Exiting, and Transitioning) do 
not allow a time duration.

Store Favorite Lets you store favorite find patterns.

Recall Favorite Lets you recall or delete favorite find patterns.

Clear Clears the current find pattern.

Options... Opens the Find Options dialog that lets you specify "found" marker placement.

Find Performs the find without closing the Find dialog.

Close Closes the Find dialog.

Menu Description
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Notes: • When no auto-connect is established, the Keysight Logic Analyzer application attempts to go 
online with the local frame or starts offline if there is no local frame.

• The auto-connect frame selection is stored on a per-user basis-so each logged on user can 
establish a different auto-connect frame.

Menu Description

System Details Displays the detailed information about the logic analysis system. This includes both 
information on the frame as a whole and information on each module.
If the frame is participating in a multiframe set (as is the case in the example above), 
frame and module details on each frame is shown. In the example above, the in-use 
icon shows a user is currently using the multiframe set.
If module depth or speed is upgradeable (via hardware licensing), module upgrade 
information is also provided.
Under the "Frame Details" category, you can find information about the frame's 
software version, host IP address, host name, whether or not the frame is password 
protected from remote-access, etc.

Set as Auto-Connect Selects the logic analysis system frame as the one to use when the Keysight Logic 
Analyzer application starts. The words "auto-connect" will show up next to the frame 
selected as an auto-connect in the Select System to Use dialog (see page 459). 
This button will change to "Clear Auto-Connect" if this frame is already set as an 
auto-connect.

Clear Auto-Connect When pressed, specifies that the logic analysis system frame not be automatically 
connected to when the Keysight Logic Analyzer application starts.
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• If you are running the Keysight Logic Analyzer application on a standalone instrument or you are 
running the Keysight Logic Analyzer application on your PC with hosted instruments attached to 
your PC, the Keysight Notification Center Icon will be present on the taskbar (lower, right-hand 
corner of your desktop). This icon can be right-clicked to open an instrument details dialog 
showing the same type of information as the above dialog—but only for the local hardware.

See Also • To view logic analysis system details (see page 64)

Instrument Details Dialog

To access this dialog, use the Keysight Notification Center icon present on the Windows taskbar 
(lower, right-hand corner of your desktop). 

The Instrument Details dialog box is displayed. This dialog box displays information on the modules 
currently installed in the chassis. 

If you have created a multi-card set by interconnecting modules (cards) using cables, the dialog box 
also displays information about the number of cards in each set and the chassis slots in which you 
have installed these cards. For instance, in the screen below, there are two U4164A multi-card sets 
and each set has two U4164A modules. To know more, refer to “Creating a Logic Analyzer Multi-card 
Set" on page 74.

Once a multi-card set is created, you can use the Partitioning button in this dialog box to reconfigure 
(repartition) this set by including/excluding the interconnected modules from the set without 
physically  connecting/disconnecting these modules. Refer to the topic “Repartitioning a U4164A 
Multi-card Set" on page 75 to know more.
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Import Dialog

The Import dialog lets you import certain kinds of data into the Agilent Logic Analyzer application.

Import Setup Dialog

The Import Setup dialog is accessed through the menu bar's Setup>(Data Import Module)>Bus/Signals....

The dialog consists of the following two tabs.

• Buses/Signals - The Buses/Signals tab is used to edit bus and signal names in the data import 
module. Also, you can assign a default number base and polarity to the bus or signal. See 
Buses/Signals Tab (see page 442).

• File Information - The File Information tab describes the contents of the file that has been imported. 
See File Information Tab (see page 443).

Buses/Signals Tab

The Buses/Signals tab is used to edit bus and signal names in the data import module. You also use 
the Buses/Signal tab to set the polarity, set the default number base, and enter user comments.

Menu Description

Module CSV text file Lets you import data from a CSV format text file into the logic analysis system using a 
data import module (see To create a data import module (see page 400)).

Module binary file Lets you import data from a module binary (ALB) format file into the logic analysis 
system using a data import module (see To create a data import module (see 
page 400)).
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The Buses/Signals tab is accessed through the menu bar's Setup>(Data Import Module)>Bus/Signals... 
command.

Through the Display button, you can select what bus/signal setup information is displayed.

The bus and signal icons in the Bus/Signal Name column are normally red, but they turn gray if the 
bus/signal is locked by an inverse assembler.

Read Only Options

The following fields are read only and cannot be edited. The display of these items can be turned 
on/off under the Display button.

See Also • To edit data import module bus/signal definitions (see page 213)

• Using Data Import Modules (see page 211)

File Information Tab

The File Information tab describes the contents of the file that has been imported.

Field Description

Width The Width column displays the number of assigned channels on each bus.

Activity The Activity row displays the type of signal activity on each channel.
- Low bar = A stable low level.
- High bar = A stable high level.
- Transition arrows = An active signal transition between low and high.

Channel Numbers The Channel Numbers row displays pod channel numbers
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The File Information tab is accessed through the menu bar's Setup>(Data Import Module)>File Info... 
command.

See Also • To view data import module file information (see page 215)

• Using Data Import Modules (see page 211)

Module Mapping Dialog

The Module Mapping dialog helps you map module setup information from the configuration file you 
are opening to the modules in the logic analysis system you are using.

If you are opening an ALA format configuration file, modules must be compatible in order to setup a 
module with information from the configuration file. If you are opening an XML format configuration 
file, you can use setup information from any module; however, because of module differences, some 
settings may not transfer.
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See Also • To transfer module setups to/from multi-module systems (see page 210)

Best-Fit Algorithm for Automatic Module Mapping

The best-fit algorithms differ slightly, depending on whether you're loading XML or ALA format 
configuration files.

When Loading XML
Format

Configuration Files:

For any given module in the configuration file:

1 Look for a module in the Overview window with the same name. If one is found, load the 
configuration into that module.

2 Look for the first module (based on the top to bottom order as shown in the Overview window) of 
the same specific type as the configuration file module. If one is found, load the configuration into 
that module.

3 Look for the first module of the same general type as the configuration file module.

4 If not found with any of the above, then:

a In online (either Local or Remote) mode, don't load the module.

b In offline mode, create the module.

When Loading ALA
Format

Configuration Files

For any given module in the configuration file:

1 Look for the first module (based on the top to bottom order as shown in the Overview window) of 
the same specific type as the configuration file module. If one is found, load the configuration into 
that module.

2 If not found, skip it.

See Also • Module Mapping Dialog (see page 444)

Menu Description

Best-fit algorithm (see 
page 445)

Automatically maps configuration file modules into the current frame.

Manually map The Specify Mapping... button opens the Specify Mapping dialog (see page 468) to 
specify how configuration file modules should be mapped into the current frame.

Offline mode Loads the configuration file as-is in the offline mode.

NOTE
In offline mode:

When loading an ALA format configuration file, there is always a "clear" performed in the Overview 
window. Therefore, no matching algorithm is needed.

When loading an XML format configuration file, the XML best-fit algorithm is used.
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Module Skew and System Trigger Dialog

This dialog is available when there are multiple modules (see page 616) in a logic analyzer or logic 
analysis system. It lets you:

• Specify which module is the system trigger (that is, which module's trigger reference point is 
Time=0).

• Specify the trigger reference point skew for modules that are not the system trigger.

When First module to trigger designates the System Trigger is checked, the first module to trigger 
after the next run is selected as the system trigger. Unchecking this option and checking it again 
causes the module that has currently triggered first to become the selected system trigger.

Disabled modules are grayed out.

See Also • Setting the System Trigger and Skew Between Modules (see page 312)

• To disable and enable modules (see page 72)

Netlist Import Dialog

The Netlist Import dialog lets you set up bus/signal names and assign them to logic analyzer 
channels by importing netlist files. Netlist files come from the Electronic Design Automation (EDA) 
tools used to design the device under test, and they contain information about the signals on the 
connectors built into the device under test for the logic analyzer probes.

NOTE
Before you can import bus/signal names from netlist files and assign them to logic analyzer 
channels, you must use the Define Probes dialog to identify the probes that are used with the logic 
analyzer.
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See Also • To define buses and signals by importing netlist files (see page 90)

Offline Startup Options Dialog

The Offline Startup Options dialog appears when you start the Keysight Logic Analyzer application 
and it wants to start in the offline mode (see page 217) (if this is unexpected, see If starting in offline 
mode is unexpected (see page 332)). This dialog presents options for the tasks you can perform in 
the offline mode.

See Also • If starting in offline mode is unexpected (see page 332)

Options Dialog

To change your system options, select Edit>Options... from the menu bar. System options are 
written in the Windows registry file and persist across sessions.

• System options (see page 448)

• Bus/Signal Naming options (see page 449)

• Advanced Settings options (see page 449)

• Email Settings options (see page 449)

• Message Dialogs/Event Logging options (see page 450)

Menu Description

Netlist File Lets you enter or browse for the name of the netlist file to import.

Trim Buses/Signals... Opens the Trim Bus/Signal Names dialog which lets you trim the bus/signal names 
imported from the netlist file.

Menu Description

Go Online... Opens the Select System to Use dialog (see page 459) for choosing a frame to 
connect the Keysight Logic Analyzer application to.

Open File... Lets you open a logic analyzer configuration file (see page 208).

Continue Offline... Opens the Create a New Configuration dialog (see page 431) for creating a new 
logic analyzer configuration file.
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System options
Menu Description

Trigger History Depth You can keep as many as 50 of the most recently used triggers. See To store a trigger 
(see page 194) for more information on re-using triggers. Trigger history is saved in 
the configuration files. The default is 10.

Recent File List Entries This sets how many recently-loaded configuration files are shown in the File menu. 
The default is 4.

Repetitive Run Delay Delay between repetitive measurements allows you to look at the captured data and 
decide whether to stop the measurement before the next run occurs.

Start Maximized Specifies whether the Keysight Logic Analyzer application's main window is 
maximized when the application is started.

Create Demo Data when 
offline

When you run the analyzer, fake data will be created. This mode is useful when 
learning how to use the logic analyzer software.
NOTE: The logic analyzer does not trigger with fake data. You can set the triggers, 
but will not get the same results you would with a real acquisition.

Go to Trigger on Run Specifies, when a logic analyzer measurement is run, whether display windows are 
automatically positioned around the data that triggered the analyzer.

Enable Numeric Grouping Numeric grouping adds spaces between every four hexadecimal and binary digits, 
spaces between every three octal digits, and commas between every three decimal 
digits (for example, FFFF FFFF, 1111 1111, 777 777, and 999,999).

Default Folders... Opens the Default Folders dialog for specifying the default folder locations for 
configuration files and export files.
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Bus/Signal Naming
options

When you have defined the same bus/signal name in more than one module:

Advanced Settings
options

Email Settings
options The Keysight Logic and Protocol Analyzer application supports the "send e-mail" feature in various 

dialogs of the application. For this feature to work, you need to specify the e-mail settings listed in 
the table below. The Keysight Logic and Protocol Analyzer application uses these settings to send 
e-mails for situations for which you have enabled the "send e-mail" feature. Some such situations 
are:

• when a trigger event occurs for which you have specified "send e-mail" as a trigger action. This is 
useful when you are waiting for a trigger event that may take a long time to occur and you want to 
do other things in the meantime.

• when markers in the logic analyzer meet certain measurement requirements (specified interval 
value) and you have configured "send e-mail" as an action. 

Menu Description

Short Bus/signal names are shown without the module name even if they are the same. In 
other words, it is possible to display two buses called "ADDR" that are not the same 
physical bus. (You can still see the module name in a tool tip by hovering over the 
bus/signal name.)

Unique Module names are pre-pended to identical bus/signal names, for example, 
"Module 1:ADDR" and "Module 2:ADDR".

Menu Description

Enable Advanced Probe 
Settings (ASP)

The Advanced Probe Settings are supported on U4154A/B logic analyzers and PCIe 
Gen3 analyzer.
Checking this option enables:
• the Probe Setup tab in the PCIe Gen3 analyzer's Setup dialog. The probe setup 

tab is used to adjust the analyzer's equalizing snoop probe (ESP) settings. See 
"Adjusting the Equalizing Snoop Probe (ESP) Settings" (in the online help).

• the APS button in the Buses/Signals tab of the U4154A/B logic analyzer's Setup 
dialog. The APS button is used to change the settings for the probes used with 
the U4154A/B logic analyzers. Probe settings include enabling peaking for the 
channels of these logic analyzers to compensate for the additional high 
frequency attenuation that some probing solutions provide on target signals. 
See“Changing Advanced Probe Settings for Logic Analyzers" on 
page 563.

Menu Description

SMTP Server Enter the name of your mail server that is running the Simple Mail Transfer Protocol (SMTP). The 
Keysight Logic and Protocol Analyzer application will communicate directly with this e-mail 
server to send the e-mail.
If you do not know your mail server name, ask your Network Administrator for it.

From Email ID Enter the e-mail address that the Keysight Logic and Protocol Analyzer application will use to 
send an e-mail message. It is a good idea to use your e-mail address in this field so you will 
receive an e-mail informing you if the e-mail was unable to be delivered. You can specify 
multiple e-mail addresses by separating each address with either a space or a semicolon.



13 Reference

450 Keysight Logic and Protocol Analyzer User Guide

Message
Dialogs/Event

Logging Options

As with any other program, the Keysight Logic Analyzer application generates messages about 
events. You can choose which messages are displayed. Check the appropriate box to indicate you 
wish the dialogs displayed.

Pod Assignment Dialog

The Pod Assignment dialog lets you reserve a pod (see page 616) or pod pair (see page 616) for time 
tag storage. If you choose the highest acquisition memory depth (see page 129) and there is a pod 
pair that has no buses or signals assigned to it, that pod pair is automatically reserved for time tag 
storage, and there is no need to use this dialog.

NOTE
You can specify the rest of the e-mail settings such as the e-mail 
address(es) to which e-mail will be sent, subject, and text of the e-mail in 
the E-mail dialog. This dialog can be accessed from within various dialogs 
in which the "send email" feature is available such as the Advanced Trigger 
dialog. The E-mail dialog help topic lists the dialogs in which the "send 
e-mail" feature is available. 

Menu Description

Show Information Dialogs Information dialogs offer tips such as the location of Simple Trigger, and do not 
indicate a failure.

Show Warning Dialogs Warning dialogs occur when some setting may affect your data, such as being 
offline.

Show Error Dialogs Error dialogs occur when an operation cannot be completed as specified.

Event Logging You can choose to have all events recorded in a log file. Event logging will slow down 
your logic analyzer. Event logs can be viewed by navigating to Documents > My 
Documents > Keysight Technologies > Logic Analyzer > Logic Files in your local 
system. Set the event logging level according to the directions of your Keysight 
Technologies support person. Be sure to turn off event logging when resuming 
normal use.
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See Also • Memory Depth and Channel Count Trade-offs (see page 363)

• Pod and Channel Naming Conventions (see page 361)

Printing Data Dialog

After choosing File>Print..., this dialog lets you print the current measurement data from a display 
window.

Menu Description

Pod/Pod Pair Indicates the pod or pod pair to be assigned or reserved.

(Module Selection) For each pod or pod pair, selects the module to which it is assigned or reserves it for 
time tag storage.

Master Pods Indicates that the pod or pod pair is on the master card.

NOTE
The first time you access the print dialog, you are asked to install a printer. Follow the directions in 
the printer install dialogs that appear.

Menu Description

Printer Lets you select the printer, change its properties, and preview the print out.

Print What Lets you select which display window to print from and specify printing options.
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See Also • Printing Captured Data (see page 314)

• To install a printer (see page 315)

• To connect a LAN (see page 315)

Properties Dialog

The Properties dialog is accessed through the menu bar's Window>Properties.... Use it to set up how 
the window and the displayed data appear.

• Changing Waveform Window Properties (see page 227)

• Changing Listing Window Properties (see page 238)

• To set Compare window properties (see page 276)

• Changing Source Window Properties (see page 281)

• Changing Marker Properties (see page 255)

Range Properties Dialog

Data Range Tab Specifies the range of data to export.

Scaling Lets you specify the number of pages to print per sheet.

Copies Lets you specify the number of copies to print.

Print range You can print All data, or print just a defined range between times, sample numbers, 
or marker locations. Data is printed from the smallest time/sample to the largest.

Menu Description
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Bus/Signal
Selection Tab

Specifies the buses/signals to export data from.

See Also • To export data to CSV format files (see page 199)

Recall Trigger Dialog

The Recall Trigger dialog lets you:

• Recall a previously-used trigger from: 

• The favorites list.

• The recently used list.

Menu Description

Time Lets you specify the range of data to export by time.

Marker Lets you specify the range of data to export by markers.

Menu Description

Select All Selects all buses/signals.

Select None De-selects all buses/signals.
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• An XML format trigger specification file.

• Move a recently used trigger to the favorites list.

• Rename the trigger.

• Clear triggers from the favorites or recently-used list.

• View trigger details.

See Also • To store a trigger (see page 194)

• To recall a trigger (see page 194)

• To set the trigger history depth (see page 195)

Run Properties Dialog

Displays the options for saving captured data after each run and stopping after a certain number of 
repetitive runs.

NOTE
The favorites list is saved with the logic analyzer configuration. If you load a new configuration file, 
the favorites list is overwritten.

Menu Description

Rename Lets you edit the name of the highlighted trigger.

Clear Clears the highlighted trigger from the list.

Clear All Clears all triggers from recall lists.

Details Shows complete definition of the highlighted trigger.

Open... Lets you recall a trigger that was previously saved to an XML format trigger 
specification file.
NOTE: When a trigger is stored to an XML format trigger specification file, trigger 
sequence steps are converted to advanced If/Then trigger functions. Therefore, the 
trigger may look different when you recall it from an XML format file; however, it is 
equivalent to the trigger that was saved.
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Save Options

Repetitive Options

See Also • Running/Stopping Measurements (see page 196)

Search Dialog

The Search dialog box lets you specify the search criteria for quickly searching a particular command 
of interest from the list of decoded transactions displayed in the upper pane of the Memory Analysis 
or ONFi Analysis window. 

Menu Description

Save after every acquisition Enables or disables saving captured data after every run. When enabled, you can 
specify additional options for naming the data files.

Increment file numbers 
between runs, starting with

Enables or disables saving to consecutively numbered files. When enabled, you can 
specify the base file name and type.

Base file name Lets you enter the base file name when saving to consecutively numbered files.

Save as type Lets you specify the file type to use when saving to consecutively numbered files. 
You can choose from:
• Logic Analyzer Configuration (*.ala)
• Transferable Configuration (*.xml)
• Module CSV text file (*.csv)
• Module binary file (*.alb)
• Standard CSV text file (*.csv)
For more information on these file types, see the topics under Saving Captured Data 
(and Logic Analyzer Setups) (see page 198).

Settings... Opens the Save As dialog (see page 198) for specifying the settings of individual 
data files; for example, you can select the data source and sample range.

Current Settings Shows the currently selected settings.

Menu Description

Stop running after Lets you stop repetitive runs after a certain number of acquisitions. When enabled, 
you can enter the number of acquisitions.



13 Reference

456 Keysight Logic and Protocol Analyzer User Guide

You access this dialog box by clicking the Setup button from the Search section of the Memory Analysis 
or ONFi Analysis windows.

1 Click Setup in the Search section to define your search criteria.

The Search dialog box is displayed.

2 In the left pane of Search, the Command listbox contains a list of commands supported by the 
Memory Analysis / ONFi Analysis window. Select the required command to be searched.

On selecting a command, the right pane displays the fields relevant for that command. These 
fields help you refine and narrow down your search criteria for the selected command.

3 Select the checkbox displayed with each field that you want to include in the search criteria. Then 
specify the value of these fields. You can also select the R checkbox with the fields to define the 
range of field.

4 Click Next to begin the search based on the specified criteria.

If a command matching the search criteria is found in the list of decoded transactions, then the 
first occurrence of that command is highlighted in the upper pane of the Memory Analysis / ONFi 
Analysis window. A "Found" marker is also placed at this occurrence.

If a command matching the search criteria is not found in the list of decoded transactions, then a 
Not Found error message is displayed.
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5 Traverse to the next occurrences of the command matching the search criteria using the Next 
button in the Search dialog box. Click Prev to move to the previous occurrence of the command in 
the decoded transactions.

6 Click OK to close the Search dialog box with the search criteria defined in it and then you can 
search based on this criteria using the Next and Previous buttons displayed in the Search section.

See Also Chapter 9, “Analyzing ONFi Data using the ONFi Analysis Window”

Analyzing Memory Data using the Memory Analysis Window 

NOTE
You can save the search criteria that you defined in the Search dialog box for later use. You 
use the Save As option under Favorite Setups to save the search criteria in a Search Setup 
file.

You can access a previously saved search setup using the Open option under Favorite 
Setups. Also, the recently used search setup files are displayed as a list under Favorite 
Setups. You may choose to display these recently used setup files as only filenames or as 
complete path and filenames in the list using the Show Names as option under Favorite 
Setups.
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Select Symbol Dialog

Use the Select Symbol dialog to choose a symbol to use when the numeric base (see page 241) is set 
to Symbols.

The Select Symbol dialog becomes available when you use the Symbols number base in the 
following dialogs:

• Find (see page 265)

• "Filter/Colorize" (in the online help)

• Specifying Simple Triggers (see page 146)

• Advanced Trigger Dialog (see page 424)

In the Select Symbol dialog:

Menu Description

Symbol Name to find Filter the list of symbols by typing characters in this field. You can also use the 
wildcard characters:
• * (asterisk) to represent zero or more characters.
• ? (question mark) to represent a single character.
You can sort on any column in the symbol list by clicking the column header.

Name Lists the symbol names defined or loaded for the bus (see Setting Up Symbols (see 
page 132)).

Type Lists the symbol types (for example, section, variable, function, etc.). When sorting 
on this column, the symbols associated with each type are sorted by name.

Value Lists the symbol values.

Base Shows the number base for the symbol value.
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See Also • Setting Up Symbols (see page 132)

• Symbols Dialog (see page 471)

Select System to Use Dialog

The Select System to Use dialog lets you select a logic analysis system frame (see page 615) to 
connect to, and it lets you manage the list of frames.

A local system is a frame connected to the machine that runs the Keysight Logic Analyzer 
application. Remote systems are frames connected to machines elsewhere on your network. The 
remote system list can be managed any way you wish. The list of remote systems is stored on a 
per-user basis (each user has their own customizable list of remote systems).

The information in the dialog can be sorted by any of the columns by clicking on the column header.

You can right-click on any row in the dialog to get quick access to a menu of system-specific actions.

File Shows the high-level source file that the symbol is from. When sorting on this 
column, the symbols associated with each file are sorted by value.

Select When there is a range of values associated with the selected symbol, you can choose 
the Start Value of the range, the End Value of the range, and if you are selecting a 
symbol for a range setting, the Start and End Values of the range.

Add Offset (Hex) Lets you add an offset to the selected symbol value, for example, in the case where 
code is relocated.
Note that when you use offsets, the system stores the "real" value, not the fact that it 
is a symbol plus an offset. This can cause the display of the symbol+offset to be 
different than what you entered. For example, for:
•

Symbol Value
------------ ------
RangeSymbol1 00..10
RangeSymbol2 11..20
Symbol3 21
Symbol4 22
Symbol5 FF

• If you enter "Symbol3 + 1", the system interprets this as 22, which is also 
Symbol4. So, even though you entered "Symbol3 + 1", the system displays 
"Symbol4".

• If you enter "RangeSymbol2(end value) + 1", it will be displayed as "Symbol3".
• If you enter "RangeSymbol1(start value) + 12", it will be displayed as 

"RangeSymbol2+1".
• Symbol values can "wrap", such as "Symbol5 + 1" where the result is 00. In this 

case, the you enter "Symbol5 + 1" and the resulting symbol is "RangeSymbol1".

Menu Description
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Menu Description

System Displays the hostname or IP address of a frame in the list. A green, yellow, or red 
indicator indicates whether you can connect to or obtain information from this frame 
(green), the frame hardware is initializing (yellow), or some other problem (red)—
such as the host not having any frames, the host is offline, or the software on the 
target machine is incompatible.

Current Status Displays whether a frame is available, offline (that is, powered down), currently in 
use, or has an incompatible remote service (that is, its software needs to be 
upgraded to match the version of software installed on the machine displaying this 
dialog).

Analyzer Description Displays the type of logic analyzer frame.

In Use Comment Displays the "system in use" comments set by the user currently using the frame.

Connect Connects to the selected logic analysis system (either local or remote). You can 
connect to a frame even if it is in use. You will be warned if you elect to connect to a 
frame that is already in-use before bumping the other user offline. Taking a user 
offline by connecting to an in-use frame will result in the other user losing any 
unsaved acquisition data (included in the warning message). For this reason, it is 
always preferable to contact the user (perhaps using the chat feature) and ask them 
to gracefully take themselves offline—saving any important data. If the user is not 
reachable—this ability to claim the system remotely is a powerful feature.

Add Lets you enter the hostname or IP address of a remote system to be added to the list.

Delete Removes the selected system from the system list.

Refresh Forces an immediate refresh of all information in this dialog. This dialog is 
auto-updating—so you should not need to push this button. It is provided as a 
fail-safe only.

More >> Less << Shows or hides the bottom row of buttons.

Set My Comments Opens a dialog that lets you enter some in-use comments. If another Keysight Logic 
Analyzer application attempts to connect to the system that you are currently 
connected to, your "system in-use" comments will be displayed. These comments 
can be used to explain why you are using a particular system, give your contact 
information, etc. These comments can be changed before going online with a frame 
or while online with a frame. The changes will take effect immediately.
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Notes: • If the systems in this dialog are slow to update, try removing any machines in the list that are 
unresponsive (red) or not used.

• Slow network conditions can also slow the update rate of this dialog.

• This dialog is auto-updating—so it is not necessary to push the refresh button to see status 
changes. The refresh button is provided as a fail-safe only.

See Also • Connecting to a Logic Analysis System (see page 59)

Software Licensing Dialog

The Software Licensing dialog is used to manage the software licenses used by a logic analysis 
system. This dialog has four tabs:

• Summary Tab (see page 461)

• Activation Tab (see page 463)

• Floating License Servers Tab (see page 464)

• Borrow Tab (see page 465)

See Also • Managing Software Licenses (see page 321)

Summary Tab

The Software Licensing dialog's Summary tab lists the licenses that you have checked out from the 
license server for use in the logic analysis system. (You can add a license server using the Floating 
License Servers tab of this dialog box.) A license is checked out from a license server for use only if 
the license is currently available on this server. 

Set Local Password Opens the Remote Access Password Utility dialog for establishing a remote-connect 
password (see page 68). The icon next to a remote system will have a padlock 
superimposed on it if a password is required to connect to that machine. A 
remote-access password forces remote users to enter this password before 
connecting to any local instrument. The local system icon will never have a padlock 
on it because a remote-access password is never required for the local client. This 
button will change to "Clear Local Password" if a remote-access password is already 
set. Only Windows users with administrative credentials will have the ability to set or 
clear remote-access passwords.

Set as Auto-Connect Selects the logic analysis system frame as the one to use when the Keysight Logic 
Analyzer application starts. The words "auto-connect" will show up next to the frame 
selected as an auto-connect. This button will change to "Clear Auto-Connect" if this 
frame is already set as an auto-connect.

Details... Opens the Frame/Module Information dialog (see page 439) which displays 
detailed information about the selected logic analysis system. If the selected frame is 
a member of a multiframe set, frame and module information on all frames in the set 
is presented in this dialog.

Chat Opens the Chat Select Destination dialog (see page 430) for communicating with 
someone on the selected system. You have the option of opening a two-way, 
interactive chat with any person logged on to the selected system or the user that is 
currently using the selected frame (if different).

Close Closes the dialog without connecting to a local or remote system.

Menu Description
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Red check marks in the Checked-out Licenses list indicate floating licenses that are checked out and 
are currently in use. A red "X" next to a folder in this list indicates a floating license that has been 
checked out but the software associated to this license has not been installed.

Menu Description

Show Details... Opens a dialog that displays detailed information about the selected license.

Copy to Clipboard Copies software licensing summary information to the clip board.

Check License Availability Displays the current availability status of floating licenses on the license server. A 
sample screen is displayed below. 
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To know how to install and manage these licenses, refer to the Keysight License Manager (KLM) help. 
KLM is installed when you install the Keysight Logic and Protocol Analyzer software. It lets you easily 
manage right-to-use licenses for software and hardware capabilities on Keysight host systems. 

See Also • To view active software license information (see page 322)

Activation Tab

The Software Licensing dialog's Activation tab contains the Licensing Host ID which is needed to 
activate software licenses.
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See Also • To activate software licenses (see page 323)

Floating License Servers Tab

The Software Licensing dialog's Floating License Servers tab lets you add / delete and order the 
license server(s) from where floating licenses can be checked out for use.

NOTE: If you have currently checked out license(s) from a license server, then the Add Server, Delete 
Server buttons in this tab are disabled indicating that you cannot add or delete a server while its 
licenses are in use.

When licenses need to be checked out, the list of License Servers is searched in order, and the 
license is checked out from the first server having an available license.

Menu Description

Licensing Host ID This ID is used when obtaining license files for software tools.
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See Also • To access floating license servers (see page 324)

Borrow Tab

The Software Licensing dialog's Borrow tab lets you borrow floating licenses from a server for a 
period of time, for example, if you're taking a logic analyzer (or a computer running the Keysight 
Logic Analyzer application) out of the office (or just off the network). When a borrowed license's time 
expires, the license is automatically returned to the server. However, you can also use the Borrow tab 
to return licenses early.

Menu Description

Add Server... Opens a dialog for entering the computer name and port number of the floating 
license server.

 Only enter names of computers (or logic analyzers) that are floating 
license servers. Otherwise, the license manager interface hangs up for many 
minutes trying to determine if the computer is really a floating license server.

Delete Server Removes the selected server from the list.

Move Up Raises the selected server in the search order.

Move Down Lowers the selected server in the search order.

Refresh Updates the green or red server availability indicators. This is only a check of 
whether the computer is on the network, not of whether the license server software 
is running on that computer.

Apply License server changes must be applied before you can go to the Summary or 
Borrow tabs.

Menu Description

Borrow Licenses Lets you enter the amount of time you want to borrow a license for and borrow the 
license. The default time is seven days. The minimum time is ten minutes. See also 
Messages in the Borrow Licenses Area (see page 466).

Return Borrowed Licenses Lets you return borrowed licenses early. All borrowed licenses must be returned at 
the same time. You are not able to return borrowed licenses while any licenses are 
checked out. See also Messages in the Return Borrowed Licenses Area (see 
page 466).
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See Also • To borrow floating licenses and return them early (see page 326)

Messages in the Borrow Licenses Area

These messages can appear in the Software Licensing dialog's Borrow tab.

Borrowing is not supported while in Demo Center Mode.

Licenses cannot be borrowed while using the Demo Center feature.

This configuration is not using any licenses. There is nothing to borrow.

No licenses are currently in use, so there is nothing to borrow.

This configuration is not using any floating licenses. There is nothing to borrow.

If all licenses being used are node-locked, there are no licenses that can be borrowed.

The licenses for this configuration cannot be borrowed because some are node-locked.

You cannot borrow licenses when floating licenses and node-locked licenses are in use at the 
same time.

Click on the Borrow button to borrow licenses used by this configuration.

When this message is displayed, you can borrow the licenses used by the current configuration.

Click on the Borrow button to borrow additional licenses used by this configuration.

When this message is displayed, some licenses are already borrowed, and you can borrow the 
additional licenses used by the current configuration.

All licenses needed by this configuration are already borrowed.

When this message is displayed, all licenses in use are already borrowed. To borrow additional 
licenses, open the feature that requires the license, and return to the Software Licensing dialog's 
Borrow tab.

Messages in the Return Borrowed Licenses Area

These messages can appear in the Software Licensing dialog's Borrow tab.

The following licenses cannot be returned while some servers are not configured.

If a license was checked out from a server that is not currently configured, licenses cannot be 
returned early.

The following licenses cannot be returned while licenses are still checked out.

If any licenses are checked out (and not borrowed), borrowed licenses cannot be returned early.

The following licenses are currently borrowed for exclusive use on this system.

When this message is displayed, borrowed licenses can be returned early.

Source Viewer Properties Dialog

• Source Properties Tab (see page 467)
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• Source Code Directories Tab (see page 467)

• Correlation Bus Tab (see page 468)

The Listing Properties, Column Properties, and Marker Properties tabs are the same as in the Listing 
window.

See Also • Changing Listing Window Properties (see page 238)

• Changing Bus/Signal Column Properties (see page 240)

Source Properties Tab

The Source Viewer Properties dialog's Source Properties tab lets you set the background color and 
font size as well as display options like the number of spaces to use for tabs and whether or not to 
display line numbers.

See Also • Changing Source Window Properties (see page 281)

• Source Viewer Properties Dialog (see page 466)

Source Code Directories Tab

The Source Viewer Properties dialog's Source Code Directories tab lets you specify the directories 
where the source code is located. This is necessary because source file paths specified in the symbol 
file may not be valid if you compile on one computer and debug on another. You can specify multiple 
directories and change their order. Directories are searched in order, and you can specify whether 
subdirectories are searched.
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See Also • To edit the source code directory list (see page 279)

• Source Viewer Properties Dialog (see page 466)

Correlation Bus Tab

The Source Viewer Properties dialog's Correlation Bus tab lets you specify the bus whose line 
number symbols will be used for source correlation. Typically, you will select the "software address" 
bus generated by an inverse assembler tool or another address bus.

See Also • To select the correlation bus (see page 280)

• Source Viewer Properties Dialog (see page 466)

Specify Mapping Dialog

The Specify Mapping dialog lets you manually map modules from a configuration file to modules in 
the logic analysis system.
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The top of the Specify Mapping dialog lists the module configurations in the file being loaded. The 
bottom part of the dialog lists modules in the logic analysis system. The Nothing selection says not to 
use any of the module configurations being loaded.

See Also • Module Mapping Dialog (see page 444)

• To transfer module setups to/from multi-module systems (see page 210)

• ALA vs. XML, When to Use Each Format (see page 380)

Status Dialog

System Status Tab Displays the logic analysis system status.

NOTE
If you cannot load setup information from an ALA format configuration file into a particular module, 
the modules are not compatible, and you need to use an XML format configuration file to transfer 
the module setup information (see If an ALA format configuration file won't open (see page 333)).
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You can copy a module, tool, or window's status to the clip board by right-clicking and choosing 
Copy from the popup menu.

Menu Description

Select Columns... For logic analyzer modules, opens the Select Status Columns dialog for selecting the 
columns to be displayed.

Default Columns Resets the columns displayed in the System Status tab to the default set.

Details... Displays details for the selected module, tool, or window.

For example, module details include: graphical trigger overview, occurrence counter, 
global counter, flags, and timer status.

Cancel Cancels processing for the selected module, tool, or window.

Resume Resumes canceled processing for the selected module, tool, or window.
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Status Log Tab Displays the logic analysis system status log.

You can select the types of log messages to display, and you can clear the log.

See Also • Options Dialog (see page 447)

Symbols Dialog

The Symbols dialog lets you to define, copy, and edit symbols for the entire system.

User-defined symbols are indicated by .

Symbols files are indicated by . Symbol files can be either compiler-generated object files 
containing symbols or general-purpose ASCII (GPA) format symbol files.

Menu Description

Load... If a bus/signal is selected, this opens the Select Symbol File dialog for loading 
symbols from a compiler-generated object file or a general-purpose ASCII (GPA) 
format symbol file.
If symbol file is selected, it is reloaded.

Add... Adds a user-defined symbol to the selected bus/signal. To know more, see “To 
create and edit user-defined symbols" on page 132.
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See Also • Setting Up Symbols (see page 132)

• Displaying Names (Symbols) for Bus/Signal Values (see page 243)

System Summary Dialog

The System Summary dialog is used to see summary information about all modules in the system 
including a physical view of the cards in the system (Slot Summary (see page 472)), a list of all of the 
modules and their trigger times (Module Summary (see page 474)), and a list of how to connect all of 
the probes (Probe Summary (see page 474)).

• Slot Summary Tab (see page 472)

• Module Summary Tab (see page 474)

• Probe Summary Tab (see page 474)

See Also • Analyzer Setup Dialog (see page 426)

Slot Summary Tab

For the selected frame (see page 615) (if there are multiple frames), the Slot Summary tab shows: 
the slots (see page 618), cards (see page 614), and modules (see page 616) in the logic analysis 
system frame, or the cards (see page 614) and modules (see page 616) in the standalone logic 
analyzer.

Edit... Edits the selected user-defined symbol. To know more, see “To create and edit 
user-defined symbols" on page 132.

Delete / Delete All Removes the selected user-defined symbol or symbol file (or all symbols if a 
bus/signal is selected) from the list.

Move Up Move Down Moves the selected user-defined symbol or symbol file up or down within the list. 
When the system looks for a symbol that corresponds to a bus/signal value, the first 
match is used. (More than one symbol can match a given value.)

Menu Description
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U4154A/B Logic Analyzer Slot Summary

If you are using U4154A/B Logic Analyzer, the Slot Summary tab displays a graphical view of the 
slots of the AXIe chassis in which you installed the U4154A/B Logic Analyzer. If you are using a 
two-slot chassis, then the placement of the U4154A/B cards in these two slots is displayed. If you are 
using a 5-slot chassis, then all the five slots are displayed. You can also view which U4154A/B card in 
a multi-card set is considered as the master card.
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See Also • System Summary Dialog (see page 472)

Module Summary Tab

For each module (see page 616) in the logic analysis system, the Module Summary tab shows the 
frame (see page 615) in which the module resides, the cards (see page 614) that make up the 
module, the slots (see page 618) in which these cards reside, and the time that a trigger occurred.

See Also • System Summary Dialog (see page 472)

Probe Summary Tab

The Probe Summary tab shows logic analyzer pods and channels, probe types, and the connectors or 
signals in the device under test to which the pods and channels should be connected.

Probe types can be defined by themselves, in XML configuration files, or while importing netlists (see 
page 90) (to assign bus/signal names to logic analyzer channels). If you haven't defined probe types, 
the flying-lead probe type is assumed.

NOTE
When connecting differential probe channel pin/pad/lead pairs to single-ended signals, make sure 
the negative pin/pad/lead is connected to ground and the positive pin/pad/lead is connected to 
the single-ended signal.
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See Also • "To define probes" (in the online help)

• System Summary Dialog (see page 472)

• "Connecting Probes Using the Probe Summary" (in the online help)

Target Control Port Dialog

The 16850-series logic analysis system frames (see page 615) have a target control port, an 8-bit, 
3.3V port that can be used to send signals to a device under test. The target control port does not 
function like a pattern generator, but more like a remote control for switches in the device under test.

For the selected frame (if there are multiple frames), the Target Control Port dialog lets you set the 
output signal levels on the port.
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See Also • To control signals in the device under test (see page 58)

TimingZoom Setup Dialog

Timing zoom collects additional high-speed timing data around the trigger of the logic analyzer.

Menu Description

Signal Identifies the target control port signal.

Enabled Lets you enable or disable an output signal on the target control port. When 
disabled, the signal has a tri-state high-impedance output. When enabled, the signal 
outputs a standard 3.3V logic level with 1 high and 0 low.

Write Gives you two buttons, 0 and 1, for changing the signal output value to a standard 
3.3V logic low or high, respectively.

Observed Value Displays the signal value observed on the target control port signal.

Toggle Flips the settings of the signal and leaves them that way. For example, if your signal 
is set to 1 and you click Toggle, the setting changes to 0.

Pulse Flips the settings for one clock cycle, which is at least 16 ms. The pulse may last 
longer. You cannot specify the duration of the pulse.
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See Also • Using Timing Zoom (see page 129)

• Logic Analyzer Notes, Timing Zoom (see page 536)

Menu Description

Sampling Period Displays the timing zoom sampling period. With some logic analyzers (see Logic 
Analyzer Notes, Timing Zoom (see page 536)), you can change the sampling period 
to see more or less sampling resolution around the trigger.

Trigger Position Lets you position the timing zoom acquisition memory around the event that triggers 
the logic analyzer.
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Trigger Functions

The trigger functions available in the Advanced Trigger dialog give you pre-configured trigger setups 
for common measurements. If the trigger function you need is not available, start with a trigger 
function that is close, convert the trigger sequence step to advanced If/Then trigger functions, and 
edit the If/Then trigger functions.

• Timing Mode Trigger Functions (see page 478)

• State Mode Trigger Functions (see page 490)

See Also • To show a trigger sequence step as Advanced If/Then trigger functions (see page 182)

• To convert a trigger sequence step to Advanced If/Then trigger functions (see page 183)

• Triggering From, and Sending Triggers To, Other Modules/Instruments (see page 186)

Timing Mode Trigger Functions

The following trigger setup examples are available as Trigger Functions in the Advanced Trigger 
dialog when in the timing acquisition mode. To see these trigger setups in the context of an example 
measurement refer to Making a timing analyzer measurement (see page 50).

Edge • Edge (see page 479)

• "N" number of edges (see page 479)

• Edge and Pattern (see page 480)

• Edge followed by edge (see page 480)

• Edges too far apart (see page 481)

• Edge followed by pattern (see page 481)

• Pattern too late after edge (see page 482)

Bus Pattern • Pattern (see page 482)

• Edge and Pattern (see page 480)

• Pattern present for > "T" time (see page 483)

• Pattern present for < "T" time (see page 483)

• Pattern absent for > "T" time (see page 484)

• Pattern absent for < "T" time (see page 484)

• Edge followed by pattern (see page 481)

• Pattern too late after edge (see page 482)

Other • Find anything "N" times (see page 484)

• Width violation on pattern or pulse (see page 485)

• Wait "T" seconds (see page 485)

• Run until user stop (see page 486)

• Wait for external arm (see page 486)

• Wait for arm from another module (see page 487)

Advanced • Advanced If/Then (see page 487)

• Advanced 2-Way Branch (see page 488)

• Advanced 3-Way Branch (see page 488)

• Advanced 4-Way Branch (see page 489)

• Pattern "AND" Pattern (see page 489)

• Pattern "OR" Pattern (see page 490)
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See Also • To replace or insert trigger functions into trigger sequence steps (see page 158)

• State Mode Trigger Functions (see page 490)

• To store a trigger (see page 194)

• To recall a trigger (see page 194)

Edge

This trigger function is available when the acquisition mode is set to Timing - Asynchronous. The 
analyzer triggers when a user-defined edge occurs.

To edit this
function

• Specifying Advanced Triggers (see page 152)

"N" number of edges

This trigger function is available when the acquisition mode is set to Timing - Asynchronous. The 
analyzer triggers when the "Nth" occurrence of a user-defined edge occurs.

To edit this
function

• Specifying Advanced Triggers (see page 152)
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Edge and Pattern

This trigger function is available when the acquisition mode is set to Timing - Asynchronous. The 
analyzer triggers when both a user-defined edge and bus pattern occur at the same time.

To edit this
function

• Specifying Advanced Triggers (see page 152)

Edge followed by edge

This trigger function is available when the acquisition mode is set to Timing - Asynchronous. The 
analyzer triggers when edge 2 occurs within a specified time period after edge 1.

To edit this
function

• Specifying Advanced Triggers (see page 152)
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Edges too far apart

This trigger function is available when the acquisition mode is set to Timing - Asynchronous. The 
analyzer triggers when edge 2 does not occur within a specified time period after edge 1.

To edit this
function

• Specifying Advanced Triggers (see page 152)

Edge followed by pattern

This trigger function is available when the acquisition mode is set to Timing - Asynchronous. The 
analyzer triggers when a bus pattern occurs within a specified time period after an edge.

To edit this
function

• Specifying Advanced Triggers (see page 152)



13 Reference

482 Keysight Logic and Protocol Analyzer User Guide

Pattern too late after edge

This trigger function is available when the acquisition mode is set to Timing - Asynchronous. The 
analyzer triggers when a specified bus pattern does not occur within a specified time period after an 
edge.

To edit this
function

• Specifying Advanced Triggers (see page 152)

Pattern

This trigger function is available when the acquisition mode is set to Timing - Asynchronous. The 
analyzer triggers when a designated bus pattern occurs.

To edit this
function

• Specifying Advanced Triggers (see page 152)
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Pattern present for > "T" time

This trigger function is available when the acquisition mode is set to Timing - Asynchronous. The 
analyzer triggers when a user-defined bus pattern is present greater than a specified time period.

To edit this
function

• Specifying Advanced Triggers (see page 152)

Pattern present for < "T" time

This trigger function is available when the acquisition mode is set to Timing - Asynchronous. The 
analyzer triggers when a user-defined bus pattern is present less than a specified time period.

To edit this
function

• Specifying Advanced Triggers (see page 152)
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Pattern absent for > "T" time

This trigger function is available when the acquisition mode is set to Timing - Asynchronous. The 
analyzer triggers when a user-defined bus pattern is absent greater than a specified time period.

To edit this
function

• Specifying Advanced Triggers (see page 152)

Pattern absent for < "T" time

This trigger function is available when the acquisition mode is set to Timing - Asynchronous. The 
analyzer triggers when a user-defined bus pattern is absent less than a specified time period.

To edit this
function

• Specifying Advanced Triggers (see page 152)

Find anything "N" times (timing)
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This trigger function is available when the acquisition mode is set to Timing - Asynchronous. The 
analyzer triggers when it sees any data (Anything) for the Nth time.

To edit this
function

• Specifying Advanced Triggers (see page 152)

Width violation on pattern or pulse

This trigger function is available when the acquisition mode is set to Timing - Asynchronous. The 
analyzer triggers when a pulse or bus pattern is found that is either too narrow or too wide.

To edit this
function

• Specifying Advanced Triggers (see page 152)

Wait "T" seconds

This trigger function is available when the acquisition mode is set to Timing - Asynchronous. The 
analyzer triggers after the specified time period expires.

The maximum amount of time you can enter is based on the logic analyzer's sampling period. If you 
need to wait longer than the maximum time allowed, you can use a timer (see page 153) instead.
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To edit this
function

• Specifying Advanced Triggers (see page 152)

Run until user stop (timing)

This trigger function is available when the acquisition mode is set to Timing - Asynchronous. This 
trigger function sets up to never trigger. You must select the stop button to view the captured data.

To edit this
function

• Specifying Advanced Triggers (see page 152)

Wait for external arm (timing)

This trigger function is available when the acquisition mode is set to Timing - Asynchronous. The 
analyzer triggers when an external arming signal appears through the external Trigger In port (see 
Triggering From, and Sending Triggers To, Other Modules/Instruments (see page 186)). The Trigger 
In BNC connector is located on the front panel of the U4154A/B Logic Analyzers.

To edit this
function

• Specifying Advanced Triggers (see page 152)
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Wait for arm from another module (timing)

This trigger function is available when the acquisition mode is set to Timing - Asynchronous. The 
analyzer triggers when an arming signal from another module occurs (see Triggering From, and 
Sending Triggers To, Other Modules/Instruments (see page 186)).

To edit this
function

• Specifying Advanced Triggers (see page 152)

Advanced If/Then (timing)

This trigger function is available when the acquisition mode is set to Timing - Asynchronous. The 
analyzer triggers when the "If" clause becomes true.

To edit this
function

• Specifying Advanced Triggers (see page 152)
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Advanced 2-Way Branch (timing)

This trigger function is available when the acquisition mode is set to Timing - Asynchronous. The 
two-way branch is evaluated true when either of two patterns (if or Else if) are found. Depending on 
which pattern is found true, the appropriate "Then" action is executed.

To edit this
function

• Specifying Advanced Triggers (see page 152)

Advanced 3-Way Branch (timing)

This trigger function is available when the acquisition mode is set to Timing - Asynchronous. The 
three-way branch is evaluated true when either of three patterns (If or Else if) are found. Depending 
on which pattern is found true, the appropriate "Then" action is executed.

To edit this
function

• Specifying Advanced Triggers (see page 152)
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Advanced 4-Way Branch (timing)

This trigger function is available when the acquisition mode is set to Timing - Asynchronous. The 
four-way branch is evaluated true when either of four patterns (If or Else if) are found. Depending on 
which pattern is found true, the appropriate "Then" action is executed.

To edit this
function

• Specifying Advanced Triggers (see page 152)

Pattern "AND" Pattern (timing)

This trigger function is available when the acquisition mode is set to Timing - Asynchronous. The 
analyzer triggers when both pattern1 "AND" pattern2 occur at the same time, and for the specified 
numbers of samples (occurs).
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To edit this
function

• Specifying Advanced Triggers (see page 152)

Pattern "OR" Pattern (timing)

This trigger function is available when the acquisition mode is set to Timing - Asynchronous. The 
analyzer triggers when either pattern1 "OR" pattern2 occurs for the specified numbers of samples 
(occurs).

To edit this
function

• Specifying Advanced Triggers (see page 152)

State Mode Trigger Functions

The following trigger setup examples are available as Trigger Functions in the Advanced Trigger 
dialog when in the state acquisition mode. To see these trigger setups in the context of an example 
measurement refer to Making a state analyzer measurement (see page 51).

Patterns • Pattern "N" times (see page 491)

• "N" consecutive samples with Pattern1 (see page 491)

• Pattern1 followed by Pattern2 (see page 492)

• Pattern1 immediately followed by Pattern2 (see page 492)

• Pattern1 followed by Pattern2 before Pattern3 (see page 493)

• Too few states between Pattern1 and Pattern2 (see page 494)

• Too many states between Pattern1 and Pattern2 (see page 494)

• Pattern2 occurring too soon after Pattern1 (see page 495)

• Pattern2 occurring too late after Pattern1 (see page 496)

• Find a packet (see page 496)

Other • Reset and start timer (see page 497)

• Find anything "N" times (see page 497)

• Run until user stop (see page 498)

• Wait for external arm (see page 498)

• Wait for arm from another module (see page 499)

• Wait "N" external clock states (see page 499)
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Advanced • Advanced If/Then (see page 500)

• Advanced 2-Way Branch (see page 500)

• Advanced 3-Way Branch (see page 501)

• Advanced 4-Way Branch (see page 501)

• Pattern "AND" Pattern (see page 502)

• Pattern "OR" Pattern (see page 503)

See Also • To replace or insert trigger functions into trigger sequence steps (see page 158)

• Timing Mode Trigger Functions (see page 478)

• To specify default storage (see page 167)

• To store a trigger (see page 194)

• To recall a trigger (see page 194)

Pattern "N" times

This trigger function is available when the acquisition mode is set to State - Synchronous. It will 
trigger the logic analyzer when it finds the nth occurrence of a bus pattern as shown below.

To edit this
function

• Specifying Advanced Triggers (see page 152)

"N" consecutive samples with Pattern1
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This trigger function is available when the acquisition mode is set to State - Synchronous. It will 
trigger the logic analyzer when a bus pattern occurs a specified number times.

To edit this
function

• Specifying Advanced Triggers (see page 152)

Pattern1 followed by Pattern2

This trigger function is available when the acquisition mode is set to State - Synchronous. It will 
trigger the logic analyzer when pattern2 occurs eventually after pattern 1.

To edit this
function

• Specifying Advanced Triggers (see page 152)

Pattern1 immediately followed by Pattern2
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This trigger function is available when the acquisition mode is set to State - Synchronous. It will 
trigger the logic analyzer when pattern 2 is found immediately after exiting pattern 1.

To edit this
function

• Specifying Advanced Triggers (see page 152)

Pattern1 followed by Pattern2 before Pattern3

This trigger function is available when the acquisition mode is set to State - Synchronous. It will 
trigger the logic analyzer when pattern2 occurs eventually after pattern1, for a specified number of 
times, without pattern3 occurring in between.

To edit this
function

• Specifying Advanced Triggers (see page 152)
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Too few states between Pattern1 and Pattern2

This trigger function is available when the acquisition mode is set to State - Synchronous. It will 
trigger the logic analyzer when pattern1 is followed by pattern2 with fewer than "N" specified states 
in between.

To edit this
function

• Specifying Advanced Triggers (see page 152)

Too many states between Pattern1 and Pattern2

This trigger function is available when the acquisition mode is set to State - Synchronous. It will 
trigger the logic analyzer when pattern1 is followed by pattern2 with more than "N" specified states 
in between.
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To edit this
function

• Specifying Advanced Triggers (see page 152)

Pattern2 occurring too soon after Pattern1

This trigger function is available when the acquisition mode is set to State - Synchronous. It will 
trigger the logic analyzer when pattern2 occurs within a specified time period after pattern1.

To edit this
function

• Specifying Advanced Triggers (see page 152)
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Pattern2 occurring too late after Pattern1

This trigger function is available when the acquisition mode is set to State - Synchronous. It will 
trigger the logic analyzer when pattern2 does not occur within a specified time period after pattern1.

To edit this
function

• Specifying Advanced Triggers (see page 152)

Find a packet

This trigger function is available when the acquisition mode is set to State - Synchronous. It will 
trigger the logic analyzer when the selected packet and occurrence is found.
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To edit this
function

• Specifying Advanced Triggers (see page 152)

Reset and start timer (state)

This trigger function is available when the acquisition mode is set to State - Synchronous. This 
trigger function resets a timer, then starts the timer for a specified period of time. This trigger 
function requires that the timer value be set in either the same trigger step, or another trigger step 
that follows. When the timer stops, the analyzer triggers. For more information refer to "To configure 
a timer (see page 153)".

To edit this
function

• Specifying Advanced Triggers (see page 152)

Find anything "N" times (state)

This trigger function is available when the acquisition mode is set to State - Synchronous. It will 
trigger the logic analyzer when any data (Anything) is seen for the Nth time. It is commonly used to 
create an immediate trigger, or a trigger after a user-defined delay.
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To edit this
function

• Specifying Advanced Triggers (see page 152)

Run until user stop (state)

This trigger function is available when the acquisition mode is set to State - Synchronous. This 
trigger function sets up to never trigger. You must select the stop button to view the captured data.

To edit this
function

• Specifying Advanced Triggers (see page 152)

Wait for external arm (state)

This trigger function is available when the acquisition mode is set to State - Synchronous. The 
analyzer triggers when an external arming signal appears through the external Trigger In port (see 
Triggering From, and Sending Triggers To, Other Modules/Instruments (see page 186)). The Trigger 
In BNC connector is located on the front panel of the U4154A/B Logic Analyzers.

To edit this
function

• Specifying Advanced Triggers (see page 152)
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Wait for arm from another module (state)

This trigger function is available when the acquisition mode is set to State - Synchronous. The 
analyzer triggers when an arming signal from another module occurs (see Triggering From, and 
Sending Triggers To, Other Modules/Instruments (see page 186)).

To edit this
function

• Specifying Advanced Triggers (see page 152)

Wait "N" external clock states

This trigger function is available when the acquisition mode is set to State - Synchronous. The 
analyzer triggers on the "Nth" occurrence of the external clock signal (plus any user-defined clock 
qualification) from the device under test.

To edit this
function

• Specifying Advanced Triggers (see page 152)
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Advanced If/Then (state)

This trigger function is available when the acquisition mode is set to State - Synchronous. The 
analyzer triggers when the "If" clause becomes true.

To edit this
function

• Specifying Advanced Triggers (see page 152)

Advanced 2-Way Branch (state)

This trigger function is available when the acquisition mode is set to State - Synchronous. The 
two-way branch is evaluated true when either of two patterns (if or Else if) are found. Depending on 
which pattern is found true, the appropriate "Then" action is executed.



Keysight Logic and Protocol Analyzer User Guide 501

Reference 13

To edit this
function

• Specifying Advanced Triggers (see page 152)

Advanced 3-Way Branch (state)

This trigger function is available when the acquisition mode is set to State - Synchronous. The 
three-way branch is evaluated true when either of three patterns (If or Else if) are found. Depending 
on which pattern is found true, the appropriate "Then" action is executed.

To edit this
function

• Specifying Advanced Triggers (see page 152)

Advanced 4-Way Branch (state)
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This trigger function is available when the acquisition mode is set to State - Synchronous. The 
four-way branch is evaluated true when either of four patterns (If or Else if) are found. Depending on 
which pattern is found true, the appropriate "Then" action is executed.

To edit this
function

• Specifying Advanced Triggers (see page 152)

Pattern "AND" Pattern (state)

This trigger function is available when the acquisition mode is set to State - Synchronous. The 
analyzer triggers when both pattern1 "AND" pattern2 occur at the same time, and for the specified 
numbers of samples (occurs).

To edit this
function

• Specifying Advanced Triggers (see page 152)
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Pattern "OR" Pattern (state)

This trigger function is available when the acquisition mode is set to State - Synchronous. The 
analyzer triggers when either pattern1 "OR" pattern2 occurs for the specified numbers of samples 
(occurs).

To edit this
function

• Specifying Advanced Triggers (see page 152)
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Data Formats

Configuration File
Formats

• ALA Format (see page 504)

• "XML Format" (in the online help)

Data Export
Formats

• Standard CSV Format (see page 504)

• Module CSV Format (see page 504)

• Module Binary (ALB) Format (see page 511)

ALA Format

The Keysight Logic Analyzer (ALA) format is the default format for saving configuration files. The ALA 
format is proprietary; ALA format configuration files are not intended to be read by programs other 
than the Keysight Logic Analyzer application.

ALA format configuration files contain everything that is needed to restore a session (in other words, 
the information necessary to reconstruct the display appearance, instrument settings, and optionally, 
captured data).

Configuration files are saved (see page 198) and opened (see page 208) through the File menu (see 
page 386).

Standard CSV Format

You can export captured data to CSV (Comma-Separated Values) format files which can then be 
imported by other applications like Excel.

Output is standard CSV format where the first row is the headings for the columns you have chosen 
to export (for example, buses/signal names, sample number, or time), and each successive row 
contains data for those columns, in the range specified, separated by commas (or other specified 
separation characters). For example:

"Sample Number","My Bus 1","My Signal 1","Time"
-10,FE,1,-13 ns
-9,FE,1,-10.5 ns
-8,FE,1,-8 ns
-7,FE,1,-5.5 ns
-6,FE,1,-3 ns
-5,FE,1,-500 ps
-4,FE,1,2 ns
-3,FE,1,4.5 ns
-2,FE,1,7 ns
-1,FE,1,9.5 ns
0,FF,1,12 ns
1,FF,1,14.5 ns
2,FF,1,17 ns
3,FF,1,19.5 ns
4,FF,1,22 ns
5,FF,1,24.5 ns
6,FF,1,27 ns
7,FF,1,29.5 ns
8,FF,1,32 ns
9,FF,1,34.5 ns
10,FF,1,37 ns

Module CSV Format
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You can export captured data to module CSV (Comma-Separated Values) format files which can 
then be post-processed.

Module CSV format files contain a header section (see page 505) followed by comma separated 
values. For example:

KEYSIGHT_CSV_DATA
HEADER_BEGIN
#
# -------------------------------------------------
# Created: Dec 5, 2005 15:38:38
# By: Keysight Logic Analyzer
# -------------------------------------------------
#
VALUE_SEPARATOR=","
VALUE_FILL_IN=ZEROS # ZEROS, ONES, PREVIOUS, or ERROR
TRIGGER_CORRELATION_OFFSET=0.000000000000000e+000
TRIGGER_ROW=524288
NUM_ROWS=1048576
TIME_SOURCE PERIOD=2.000000000000000e-009
COLUMN "Sample Number" SAMPLE_NUMBER INTEGER
COLUMN "My Bus 1" VALUE UNSIGNED_INTEGER HEX WIDTH_BITS=8
COLUMN "My Bus 2" VALUE UNSIGNED_INTEGER HEX WIDTH_BITS=16
COLUMN "My Bus 3" VALUE UNSIGNED_INTEGER HEX WIDTH_BITS=32
COLUMN "My Signal 1" VALUE UNSIGNED_INTEGER HEX WIDTH_BITS=1
COLUMN "My Signal 2" VALUE UNSIGNED_INTEGER HEX WIDTH_BITS=1
COLUMN "Time" TIME FLOAT EXPONENT=-12 ABSOLUTE
HEADER_END
-524288,53,FFF0,004103E7,1,1,-1048576000
-524287,53,FFF0,004103E7,1,1,-1048574000
-524286,53,FFF0,004103E7,1,1,-1048572000
-524285,53,FFF0,004103E7,1,1,-1048570000
.
.
.

See Also • Module CSV and Module Binary File Header Format (see page 505)

• Module CSV Format File Characteristics (see page 510)

Module CSV and Module Binary File Header Format

The header section comes at the beginning of the module CSV or module binary (ALB) file. The 
header definition is slightly different in the two cases.

KEYSIGHT_CSV_DATA KEYSIGHT_BINARY_DATA

REQUIRED: Key word tag to confirm the file type. The first is for module CSV text files. The 
second is for module binary (ALB) files. This tag must be the first characters 16 (or 19) characters 
in the file.

#

CAUTION
Do not modify module CSV files with Microsoft Excel.
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OPTIONAL: Comment character. All text following a # is ignored to the end of the line. Any line 
(except the first) may be a comment, except in module binary (ALB) files, where comments are 
only allowed in the header.

HEADER_BEGIN

REQUIRED: Key word tag to delimit the beginning of the header.

TABLE_BEGIN "<name>" <TableType>

A table represents data sampled at a specified timebase and sampling depth. A table can only 
represent a single timebase and sample depth.

OPTIONAL: If only one timebase and sample depth is needed, this keyword is not needed.

REQUIRED: If multiple timebases and sampling depths are needed, this keyword is needed to 
delimit the beginning of a table. The name may contain most printable characters, including 
embedded quote marks single or double), provided they are escaped with a backslash. For 
example, TABLE_BEGIN "my \"perfect\" table" . . .

Generally, each analog waveform channel has its own table, and there is only one table for digital 
channels.

When multiple tables are used, the binary data associated with each table is concatenated after 
the header.

<TableType>:

• ANALOG

• DIGITAL

An identifier is needed to explicitly determine what the table contains. There are specific fields 
that are required depending on the type of table. Analog requires the X/Y_INC/ORG/REF.

TIME_SOURCE PERIOD = <n.nnne-nn>

TIME_SOURCE FREQUENCY = <n.nnne+nn>

TIME_SOURCE COLUMN = "<columnName>"

OPTIONAL: How to assign a time tag to each sample row. PERIOD gives the sampling period; 
FREQUENCY gives the sample rate. COLUMN indicates which time column contains the time tags 
to use (ignored if PERIOD or FREQUENCY is given).

TRIGGER_ROW = <nnnn>

OPTIONAL: Row number containing the trigger sample, relative to the first data row in the file, 
which is row 0. The trigger row may be outside the range of rows in a file with a time line defined 
by a period or frequency, in which case it will be negative (trigger occurred before the first data 
row) or positive and greater than or equal to the number of data rows in the file (trigger occurred 
after the last data row in the file).

TRIGGER_CORRELATION_OFFSET = <n.nnne-nn>
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OPTIONAL: Time offset in seconds (positive or negative) to apply to trigger (that is, to the T=0 
reference) when correlating with data from other modules. If not given, 0.0 is assumed. The offset 
is rounded to the nearest picosecond.

NUM_ROWS = <nnn>

REQUIRED: If TABLE_BEGIN is present. Indicates the total number of data rows that will be read 
in from the file.

OPTIONAL: The expected number of data rows in the file. A warning is given if the number given 
does not match the actual number of rows in the file. This is provided as an optional sanity check 
to detect file truncation.

X_INC = <nnn.nnn>

OPTIONAL: Used for oscilloscope data processing.

X_ORG = <nnn.nnn>

OPTIONAL: Used for oscilloscope data processing.

X_REF = <nnn>

OPTIONAL: Used for oscilloscope data processing.

Y_INC = <nnn.nnn>

OPTIONAL: Used for oscilloscope data processing.

Y_ORG = <nnn.nnn>

OPTIONAL: Used for oscilloscope data processing.

Y_REF = <nnn>

OPTIONAL: Used for oscilloscope data processing.

Y_MIN = <nnn.nnn>

OPTIONAL: Used for oscilloscope data processing--the minimum voltage value represented in 
the data.

Y_MAX = <nnn.nnn>

OPTIONAL: Used for oscilloscope data processing--the maximum voltage value represented in 
the data.

VALUE_SEPARATOR = "<ccc>"

OPTIONAL, Module CSV only: One or more characters to be used as the separation character(s) 
between values in each row. If not given, the comma character is used. If the value for a column is 
missing (for example, two consecutive commas), its value is determined by the VALUE_FILL_IN 
property. The separation string may contain any printable character, and/or the blank and tab 
characters, except the following ambiguous characters: 

• '#' — the comment character.

• '-', '+' — sign characters (signed decimal, also known as two's complement, and floats).

• '.' — the period, used in floating point.
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• a-f, A-F — hex.

• 0-9 — digits.

VALUE_FILL_IN = PREVIOUS | ZEROS | ONES | ERROR

OPTIONAL, Module CSV only: The value to be used for a skipped cell in a row. This attribute is 
optional. The default is ZEROS. PREVIOUS is consistent with the VCD file format and means "use 
the value from the cell above". ERROR indicates that any missing value should be treated as an 
error. This setting applies to all columns except TIME. Any missing time tag is an error.

BYTE_ORDER = LITTLE_ENDIAN | BIG_ENDIAN

OPTIONAL, Module binary (ALB) only: The order of bytes in a multi-byte value. An 
Intel-compatible system uses little endian as its internal format. This applies to both integer and 
floating point values. The default is LITTLE_ENDIAN.

LABEL "<name>" CHANNELS = "<ChannelDescription>" [HEX | 
DECIMAL | OCTAL | BINARY | SYMBOL]

OPTIONAL: As described below, a COLUMN represents a pod. If there are no LABELs defined, a 
LABEL is created by default which has the same characteristics as the COLUMN. If a LABEL is 
defined, it represents a subset of the data defined by the COLUMN. Another way to look at it is 
that a COLUMN defines the physical data that was exported and a LABEL is an interpretation of 
the data. The "<name>" may contain most printable characters, including embedded quote 
marks (single or double), provided they are escaped with a backslash. For example, LABEL "my 
\"perfect\" label". It is required that LABEL names be unique. If a duplicated name is 
found, only the first instance of the LABEL definition will be processed. There is an optional base 
which, if specified, will be the default label base. The default is HEX.

<ChannelDescription>

A channel description consists of the following format: <COLUMN_NAME>[bit position] with 
multiple channel descriptions separated by a comma. A <COLUMN_NAME> corresponds to the 
COLUMN name attribute. If there are multiple COLUMNs by the same name, the first one will be 
used. The bit position list is enclosed in [ ] and is order dependent. The MSB is on the left-hand 
side and the LSB is on the right-hand side For example, [7:0] represents bits 0-7 and 
[7,4,3,1] represents individual bits. 1, 3, 4, and 7. Bit patterns that are not monotonically 
increasing from right to left are considered reordered. For example, [1,3,4,7] represents bits 7 
as the LSB and bit 1 as the MSB.

SYMBOL "<name>" LABEL = "<label or column name>" VALUE = 
"<value> | <value..value>" [HEX | DECIMAL | OCTAL | 
BINARY]

TABLE_END

REQUIRED: If TABLE_BEGIN is used.

HEADER_END

REQUIRED: The explicit end of the header. Information obtained from the header is evaluated at 
this point to determine if the file makes sense (for example, that a time base and one or more 
columns were defined).
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Each line of a module CSV file (including sample rows following the header) are processed by first 
stripping the comment character and all characters following it, and then removing all leading 
whitespace (except blanks or tabs if a blank or tab is part of the delimiter string). If the resulting line 
is then empty, it is silently skipped. Otherwise, each data row is parsed using the definitions provided 
by the COLUMN definitions in the header, defined below.

COLUMN Syntax One or more COLUMN definitions are required. The order of definitions in the header corresponds to 
the order of the columns in the data section. At least one of these must define a VALUE column. 
COLUMN syntax is more complicated than the other statements, so it is given in pieces:

COLUMN "<name>" <CSVcolumnType> | <ALBcolumnType>

These are the major parts of a COLUMN definition. The details are different for module CSV versus 
module binary (ALB) files. The name may contain most printable characters, including embedded 
quote marks (single or double), provided they are escaped with a backslash. For example, 
COLUMN "my \"perfect\" data" . . .

<CSVcolumnType>:

• VALUE <CSVformat> WIDTH_BITS = <nnn>

• TIME <CSVformat> <timeUnit> ABSOLUTE | RELATIVE

• LINE_NUMBER <CSVformat>

• SAMPLE_NUMBER <CSVformat>

• IGNORE

The column type gives the purpose of the values in the column.

Line numbers begin at 0 on the first row and increase by 1 for each subsequent row.

Sample numbers begin at 0 on the trigger row, decreasing by one for each row above the trigger 
row and increasing by one for each row after it.

Time columns give the time position for the sample. Absolute time positions are referenced to T=0 
on the trigger row. Relative time positions give the amount of time elapsed from the arrival of the 
previous sample to the arrival of the sample on the row with the time tag.

Value columns contain data samples to be displayed in viewers in the application. The width in 
bits of a value is the width assigned to the pod which represents this column in the Bus/Signal 
setup page. Values are truncated (or expanded) to fit the width. Signed values are sign extended. 
Floating point values are converted to integers of the appropriate size (after applying the scale 
factor, if given).

<ALBcolumnType>:

• VALUE NBYTES = <nnn> <ALBformat> WIDTH_BITS = <nnn>

• TIME NBYTES = <nnn> <ALBformat> <timeUnit> ABSOLUTE | RELATIVE

• LINE_NUMBER NBYTES = <nnn> <ALBformat>

• SAMPLE_NUMBER NBYTES = <nnn> <ALBformat>

• IGNORE NBYTES = <nnn>

This is the same as <CSVcolumnType>, with the addition of an NBYTES attribute that gives the 
number of bytes in the binary data that are assigned to the column.

<CSVformat>:

• INTEGER [HEX | DECIMAL | OCTAL | BINARY]

• UNSIGNED_INTEGER [HEX | DECIMAL | OCTAL | BINARY]

• FLOAT [SCALE = <nnn.nnn>]
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The column format describes the way the value is represented in the file. The base is optional, 
and defaults to hex if not given. SCALE is also optional, and defaults to 1.0. The final value 
loaded is the value in the column, multiplied by the scale factor, rounded to the nearest integer 
(except for time values, which are rounded to the nearest 10-24 sec). All values are checked for 
overflow with respect to the field's WIDTH_BITS. Line numbers and sample numbers are treated 
as 32-bit quantities.

<ALBformat>:

• INTEGER

• UNSIGNED_INTEGER

• FLOAT [SCALE = <nnn.nnn>]

The same as <CSVformat>, except there is no numeric base. Floating point values must be in 
IEEE Standard 754, and so must be either four bytes or eight bytes wide.

<timeUnit>:

• EXPONENT = <nnn>

• EXPONENT = -<nnn>

The unit to apply to time tag values (in addition to the scale factor, if used with floating point 
values). For example, EXPONENT = -12 is equivalent to picosecond time ticks.

Header Example KEYSIGHT_CSV_DATA
#
# ---------------------------- #
# Created: 2008 Sep 21 21:18 #
# By: Keysight Logic Analyzer #
# ---------------------------- #
#
HEADER BEGIN
TIME COLUMN="tSample"
TRIGGER_ROW=100
TRIGGER_CORRELATION_OFFSET=1.24e-9
COLUMN "Sample" SAMPLE_NUMBER INTEGER DECIMAL
COLUMN "Address" VALUE INTEGER HEX WIDTH_BITS=24
COLUMN "Data" VALUE INTEGER HEX WIDTH_BITS=16
COLUMN "Status" VALUE INTEGER BIN WIDTH_BITS=8
COLUMN "DigRF" VALUE FLOAT SCALE=16.0e+3 WIDTH_BITS=16
COLUMN "tSample" TIME INTEGER DECIMAL EXPONENT=-12 RELATIVE
VALUE_SEPARATOR ","
VALUE_FILL_IN PREVIOUS
HEADER END
# Start data
0afc38,ff98,01000110,0.114,5000
0afc3c,055a,,,2500
# embedded comment
0afc38,ff98,01010001,0.116,2500

Module CSV Format File Characteristics

The file must define a time line so that each sample can be associated with a time tag. To do this, a 
periodic rate, or a time column with absolute or relative time tags, is required (see the 
TIME_SOURCE property in the file header). Time tags in the file are verified to be monotonically 
increasing. The specification of a periodic rate overrides the presence of time tag columns, if any.
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The file must have one or more data value columns. Data value columns have the data to load. Other 
columns, such as line numbers, sample numbers, and time tags, annotate that data, but are not 
loaded as data.

Data rows in the file are indexed beginning with row 0 first, then 1, and so on. Row numbers are 
file-centric. They are not the same as the sample numbers in the module's listing. Sample numbers 
are always relative to the location of the trigger row, not the first row in the file.

The file header has a property, TRIGGER_ROW, giving the row number, in the file, associated with 
logic analyzer trigger. The trigger row is defined as the time origin, and contains T=0.

In a multi-module logic analyzer, only one module's trigger is at T=0. All the others are offset by 
hardware delays associated with the propagation of the trigger signal from the originating module to 
the receiving modules. The time delay is indicated by the TRIGGER_CORRELATION_OFFSET 
property. This is the amount of time that must be added to the time of each sample in the file to 
correctly position each sample on a time line with samples from another module in the system.

An interesting case arises if the trigger sample is not included in the export range. This can 
legitimately occur if the time source is periodic. In this case, the TRIGGER_ROW value will indicate a 
row not in the file. For example, if the first data row in the file is the first sample after the trigger in 
the module, then TRIGGER_ROW=-1. Conversely, if the trigger was the first sample after the last row 
in the exported data, TRIGGER_ROW is equal to the number of rows in the file. If the trigger was two 
samples after the last row, TRIGGER_ROW is the number of rows in the file plus one, and so on. 
Sample numbers are handled in a similar manner, with sample 0 on the trigger row. If the trigger row 
is not in the file, sample 0 is not in the file either.

These statements about the contents of a module CSV file will always be true:

• The first data row in the file is row 0. The next is 1, then 2, and so on.

• The TRIGGER_ROW is always relative to the first row in the file (row 0). The trigger row may or may 
not be in the file.

• The time associated with the TRIGGER_ROW is always 0. The TRIGGER_CORRELATION_OFFSET 
property allows correct correlation to other data sets.

• The sample number on the TRIGGER_ROW (if a sample number column is present) is always 0. 
Sample numbers increase by one for each row after the trigger row; they decrease by one for each 
row before the trigger. Sample numbers are not the same as row numbers.

• Line numbers, if exported to the file, always begin at 0 on row 0, then increase by one for each row 
thereafter: lineNumber = rowNumber.

Inconsistencies between a T=0 time tag, sample numbers and the TRIGGER_ROW property are 
resolved in this order:

1 The data row containing an absolute time tag of 0 is the trigger row and sample numbers are 
re-aligned if necessary to begin at zero on that row.

2 If the time line is defined by a period or frequency, and a sample number column is given, then 
the data row with sample number 0 is the trigger row. (This may or may not be within the span of 
the file itself).

3 Finally, the TRIGGER_ROW property is used. If time tags (relative or absolute) are used, the 
trigger row will be moved if it is not within the file.

See Also • Module CSV and Module Binary File Header Format (see page 505)

Module Binary (ALB) Format

You can export captured data to module binary files.

Module binary format files contain a header section (see page 505) followed by binary data. For 
example:
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KEYSIGHT_BINARY_DATA
HEADER_BEGIN
#
# -------------------------------------------------
# Created: Dec 5, 2005 16:14:36
# By: Keysight Logic Analyzer
# -------------------------------------------------
#
BYTE_ORDER=LITTLE_ENDIAN
TRIGGER_CORRELATION_OFFSET=0.000000000000000e+000
TRIGGER_ROW=524288
NUM_ROWS=1048576
TIME_SOURCE PERIOD=2.000000000000000e-009
COLUMN "Sample Number" SAMPLE_NUMBER NBYTES=4 INTEGER
COLUMN "My Bus 1" VALUE NBYTES=1 UNSIGNED_INTEGER WIDTH_BITS=8
COLUMN "My Bus 2" VALUE NBYTES=2 UNSIGNED_INTEGER WIDTH_BITS=16
COLUMN "My Bus 3" VALUE NBYTES=4 UNSIGNED_INTEGER WIDTH_BITS=32
COLUMN "My Signal 1" VALUE NBYTES=1 UNSIGNED_INTEGER WIDTH_BITS=1
COLUMN "My Signal 2" VALUE NBYTES=1 UNSIGNED_INTEGER WIDTH_BITS=1
COLUMN "Time" TIME NBYTES=8 FLOAT EXPONENT=-12 ABSOLUTE
HEADER_END
<binary data>

The binary data section of the file contains only binary data. Binary data is organized by rows, where 
there are a fixed number of columns within a row (the number of COLUMN definitions in the header) 
and a fixed number of bytes per column (1, 2, 4, 8, or 16 as specified by NBYTES in the COLUMN 
definition). This simplifies reading the data, because these sizes match the native C language sizes of 
char, short, long, and long long (__int64). Values of 16 bytes contain 128 bits which is the 
widest bus supported in the logic analysis system. By restricting exported sizes to these values, an 
ALB file with no header and only one bus/signal becomes a simple dump of an array of integers.

See Also • Module CSV and Module Binary File Header Format (see page 505)
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Object File Formats Supported by the Symbol Reader

The logic analysis system can read symbol files in the following formats:

• OMF96

• OMFx86

• IEEE-695

• ELF/DWARF

• ELF/stabs

• TI COFF

For ELF/DWARF1, ELF/stabs, and ELF/stabs/Mdebug files, C++ symbols are demangled so that they 
can be displayed in the original C++ notation. To improve performance for these ELF symbol files, 
type information is not associated with variables. Hence, some variables (typically a few local static 
variables) may not have the proper size associated with them. They may show a size of 1 byte and not 
the correct size of 4 bytes or even more. All other information function ranges, line numbers, global 
variables and filenames will be accurate. These behaviors may be changed by editing the readers.ini 
(see page 136) file.

See Also • To load symbols from a file (see page 134)

• To change symbol reader options (see page 136)

• To create an ASCII symbol file (see page 135)
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General-Purpose ASCII (GPA) Symbol File Format

General-purpose ASCII (GPA) format files are loaded into a logic analyzer just like other object files.

If your compiler does not produce object files in a supported format, or if you want to define symbols 
that are not included in the object file, you can create an ASCII format symbol file.

Typically, ASCII format symbol files are created using text processing tools that convert the symbol 
table information from a compiler or linker map output file.

Different types of symbols are defined in different records in the GPA file. Record headers are 
enclosed in square brackets, for example, [USER]. For a summary of GPA file records and associated 
symbol definition syntax, refer to the General-Purpose ASCII (GPA) Record Format Summary (see 
page 514).

Each entry in the symbol file must consist of a symbol name followed by an address or address 
range.

The address or address range must be a hexadecimal number. It must appear on the same line as the 
symbol name, and it must be separated from the symbol name by one or more blank spaces or tabs. 
Address ranges must be in the following format:

beginning address..ending address

The following example defines two symbols that correspond to address ranges and one symbol that 
corresponds to a single address.

main 00001000..00001009
test 00001010..0000101F
var1 00001E22 #this is a variable

For more detailed descriptions of GPA file records and associated symbol definition syntax, refer to 
the following topics:

• SECTIONS (see page 515)

• FUNCTIONS (see page 516)

• USER (see page 516)

• VARIABLES (see page 518)

• SOURCE LINES (see page 518)

• START ADDRESS (see page 519)

• Comments (see page 519)

General-Purpose ASCII (GPA) Record Format Summary

Format [SECTIONS (see page 515)]
section_name start..end attribute

[FUNCTIONS (see page 516)]
func_name start..end

[USER (see page 516)]
sym_name value base
sym_name start_value [size] base
sym_name start_value..end_value base

[VARIABLES (see page 518)]
var_name start [size]
var_name start..end
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[SOURCE LINES (see page 518)]
File: file_name
line# address

[START ADDRESS (see page 519)]
address

#comment text (see page 519)

Lines without a preceding header are assumed to be symbol definitions in one of the [USER] formats.

Example This is an example GPA file that contains several different kinds of records.

[SECTIONS]
prog 00001000..0000101F
data 40002000..40009FFF
common FFFF0000..FFFF1000

[FUNCTIONS]
main 00001000..00001009
test 00001010..0000101F

[USER]
bdontcare 00x1 binary
hvalue 00EF hex
drange 0..99 decimal
srange -23 20 signed decimal # The 20 is a decimal value for s
ize.

[VARIABLES]
total 40002000 4
value 40008000 4

[SOURCE LINES]
File: main.c
10 00001000
11 00001002
14 0000100A
22 0000101E

File: test.c
5 00001010
7 00001012
11 0000101A

SECTIONS

Use SECTIONS to define symbols for regions of memory, such as sections, segments, or classes.

NOTE
To enable section relocation, section definitions must appear before any other definitions in the 
file.
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Format [SECTIONS]
section_name start..end attribute

Example [SECTIONS]
prog 00001000..00001FFF
data 00002000..00003FFF
display_io 00008000..0000801F NONRELOC
sect3 00003000..00003FFF AddReloc 1000
sect4 00005000..00005FFF SetReloc 0000F000

FUNCTIONS

Use FUNCTIONS to define symbols for program functions, procedures or subroutines.

Format [FUNCTIONS]
func_name start..end

Example [FUNCTIONS]
main 00001000..00001009
test 00001010..0000101F

USER

Under the [USER] record header, you can create symbols with don't care values, and you can use 
value number bases other than hex.

NOTE
If you use section definitions in a GPA symbol file, any subsequent function or variable definitions 
must be within the address ranges of one of the defined sections. Functions and variables that are 
not within the range are ignored.

Menu Description

section_name A symbol representing the name of the section.

start The first address of the section, in hexadecimal.

end The last address of the section, in hexadecimal.

attribute (optional) Attribute may be one of the following:
NORMAL (default) - The section is a normal, relocatable section, such as code or 
data.
NONRELOC - The section contains variables or code that cannot be relocated. 
In other words, this is an absolute segment.
AddReloc reloc_offset - Lets you specify an offset value (up to 
32-bit) for a relocated section.
SetReloc reloc_value - Lets you specify a new base value (up to 
32-bit) for a relocated section.

Menu Description

func_name A symbol representing the function name.

start The first address of the function, in hexadecimal.

end The last address of the function, in hexadecimal.
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USER is the default record type; this means symbols defined without any record header ([USER], 
[VARIABLE], etc.) are assumed to be USER symbols.

USER symbol definitions can have 128-bit values; symbol definitions in all other record types are 
limited to 32-bit values.

Format [USER]
sym_name value base
sym_name start_value [size] base
sym_name start_value..end_value base

* use quotes(") around names or values with spaces.

Example [USER]
bdontcare 00x1 binary
bvalue 0011 binary
brange 0000..0011 binary
brange2 0011 9 binary # The 9 is a decimal value for size
.
odontcare 00x7 octal
ovalue 0077 octal
orange 0000..0077 octal
orange2 0000 99 octal # The 99 is a decimal value for siz
e.
hdontcare 00xF hex
hvalue 00EF hex
hrange 0000..00FF hex
hrange3 0000 99 hex # The 99 is a decimal value for siz
e.
dvalue 1090 decimal
drange 0..99 decimal
drange2 0 100 decimal # The 100 is a decimal value for
size.
svalue -23 signed decimal
srange -23..-5 signed decimal
srange -23 20 signed decimal # The 20 is a decimal value
for size.
"hvalue with space" "01XX FFFF" hex

Menu Description

sym_name A symbol name.

value The value of the symbol.

base The number base of the value(s); can be:

• binary
• octal
• hex (or hexadecimal or blank)

• decimal
• signed decimal (two's complement)

start_value The low value of the range.

end_value The high value of the range.

size The size of the range of values, in decimal.
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"hrange with space" "0100 FFFF".."0400 FFFF" hex # Applies to other bas
es also.

VARIABLES

You can specify symbols for variables using:

• The address of the variable.

• The address and the size of the variable.

• The range of addresses occupied by the variable.

If you specify only the address of a variable, the size is assumed to be 1 byte.

Format [VARIABLES]
var_name start [size]
var_name start..end

Example [VARIABLES]
subtotal 40002000 4
total 40002004 4
data_array 40003000..4000302F
status_char 40002345

SOURCE LINES

Use SOURCE LINES to associate addresses with lines in your source files.

Format [SOURCE LINES]
File: file_name
line# address

Example [SOURCE LINES]
File: main.c
10 00001000
11 00001002
14 0000100A
22 0000101E

Menu Description

var_name A symbol representing the variable name.

start The first address of the variable, in hexadecimal.

end The last address of the variable, in hexadecimal.

size (optional) The size of the variable, in bytes, in decimal.

Menu Description

file_name The name of a file.

line# The number of a line in the file, in decimal.

address The address of the source line, in hexadecimal.
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See Also • Viewing Source Code Associated with Captured Data (see page 277)

START ADDRESS

Format [START ADDRESS]
address

Example [START ADDRESS]
00001000

Comments

Use the # character to include comments in a file. Any text following the # character is ignored. You 
can put comments on a line alone or on the same line following a symbol entry.

Format #comment text

Example #This is a comment

Menu Description

address The address of the program entry point, in hexadecimal.



13 Reference

520 Keysight Logic and Protocol Analyzer User Guide

Product Overviews

• U4164A Logic Analyzer Product Overview (see page 520)

• U4154A Logic Analyzer Product Overview (see page 522)

• U4154B Logic Analyzer Product Overview (see page 523)

• 16850-Series Logic Analyzer Product Overview (see page 524)

• 16860-Series Logic Analyzer Product Overview (see page 528)

• Keysight Logic and Protocol Analyzer Application Product Overview (see page 532)

See Also • Tutorial - Getting to know your logic analyzer (see page 40)

U4164A Logic Analyzer Product Overview

The Keysight U4164A logic analyzer is a 136 channel AXIe based high speed state and timing logic 
analyzer with new features such as:

• DDR4 and LPDDR4 probing for data rates over 2.5 Gb/s using the new Quad sampling state mode 
and single touch probing

• deeper memory

• ¼ channel 10GHz Timing mode 

• deskew of timing traces by individual channels

The module can be used as a general purpose logic analysis system as well as for debug, validation 
and analysis of DDR and LPDDR memory systems. It allows maximum DQ visibility with simultaneous 
Read and Write traffic capture for DDR4 and LPDDR4 without overloading the system under test. It 
supports up to 4 Gb/s State Mode and 10 GHz Timing Mode.

U4164A comes as an instrument module that you can install in one of the slots of the Keysight AXIe 
chassis. This chassis is a modular instrument chassis that supports complex and high density testing. 
The chassis provides slots for installing multiple instrument modules such as the U4164A Logic 
Analyzer module.

You can install a single U4164A module or multiple U4164A modules in slots of an AXIe chassis to 
increase the channel count. You can connect upto three U4164A modules in an AXIe chassis to form 
a three-card set with 408 channels in Full Channel mode.

You can configure, control, and use the U4164A Logic Analyzer module through the Keysight Logic 
and Protocol Analyzer application (version 6.2 and above). You can install this application on a host 
PC (a laptop or a desktop with a PCIe interface or the Keysight M9536A Embedded Controller 
Module). The laptop or desktop host PC connects to the U4164A module through the PCIe x8 
interface of the AXIe chassis.

The following figure displays a U4164A Logic Analyzer module installed in a 2-slot AXIe chassis and 
connected to a DUT via W4641A BGA interposer and U4208A and U4209A probe cables.
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To know more about the hardware components of the U4164A Logic Analyzer module and how to set 
up this module in AXIe chassis, refer to the   AXIe Based Logic Analysis and Protocol Test Modules 
Installation Guide.

Supplied Accessories

• Flex cables for connecting multiple U4164A modules in different slots of an AXIe chassis

• Accessory pouch

• Pod connector cables for connecting Logic Analyzer pods to probes.

Optional Accessories

• Interposers, Probes and cables 

Refer to the U4164A Data Sheet (5992-1057EN) on www.keysight.com to get a list of supported 
interposers, probes, and cables for U4164A. Details of these interposers, probes, and cables are in 
their respective user guides available on www.keysight.com. 

See Also Tutorial - Getting to know your logic analyzer (see page 40)

CAUTION
You must power down the AXIe chassis before inserting, replacing, or removing the U4164A Logic 
Analyzer module. The enclosure surface of the U4164A module may become hot during use. If you 
need to remove the module, first power down the AXIe chassis, wait for at least five minutes to 
allow the module to cool, and then pull the module out of the chassis.

www.keysight.com
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U4154A Logic Analyzer Product Overview

The Keysight U4154A logic analyzer is a 136 channel AXIe based high speed state and timing logic 
analyzer. It provides reliable data capture with powerful analysis and validation tools for high data 
rate memory based products. It helps you to perform functional validation and characterization of 
your memory based products. 

U4154A comes as an instrument module that you can install in one of the slots of the Keysight AXIe 
chassis. The Keysight AXIe chassis is a modular instrument chassis that supports complex and high 
density testing. The chassis provides slots for installing multiple instrument modules such as the 
U4154A Logic Analyzer module.

You can configure, control, and use the U4154A Logic Analyzer module through the Keysight Logic 
Analyzer application (version 5.0 and above). You can install this application on a host PC (a laptop or 
a desktop with a PCIe interface or the Keysight M9536A Embedded Controller Module). The laptop or 
desktop host PC connects to the U4154A module through the PCIe x8 interface of the AXIe chassis.

The following figure displays a sample setup of the U4154A Logic Analyzer module in one of the slots 
of the Keysight AXIe chassis. 
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You can install a single U4154A module or multiple U4154A modules in slots of an AXIe chassis to 
increase the channel count. You can connect two U4154A modules in an AXIe chassis to form a 
two-card set with 272 channels.

To know more about the hardware components of the U4154A Logic Analyzer module and how to set 
up this module in AXIe chassis, refer to the  AXIe Based Logic Analysis and Protocol Test 
Modules Installation Guide.

Supplied
Accessories

• Flex cables for connecting multiple U4154A modules in different slots of an AXIe chassis

• Accessory pouch

• Pod connector cables for connecting Logic Analyzer pods to probes.

Optional
Accessories

• Probes.

See Also • Tutorial - Getting to know your logic analyzer (see page 40)

• U4154A Logic Analyzer Specifications and Characteristics (see page 592)

U4154B Logic Analyzer Product Overview

The Keysight U4154B logic analyzer is a 136 channel AXIe based high speed state and timing logic 
analyzer. It provides reliable data capture with powerful analysis and validation tools for high data 
rate memory based products. It helps you to perform functional validation and characterization of 
your memory based products. 

U4154B comes as an instrument module that you can install in one of the slots of the Keysight AXIe 
chassis. This chassis is a modular instrument chassis that supports complex and high density testing. 
The chassis provides slots for installing multiple instrument modules such as the U4154B Logic 
Analyzer module. 

You can install a single U4154B module or multiple U4154B modules in slots of an AXIe chassis to 
increase the channel count. You can connect upto three U4154B modules in an AXIe chassis to form 
a three-card set with 408 channels in Full Channel mode and 204 channels in Half Channel mode. 

You can configure, control, and use the U4154B Logic Analyzer module through the Keysight Logic 
and Protocol Analyzer application (version 6.0 and above). You can install this application on a host 
PC (a laptop or a desktop with a PCIe interface or the Keysight M9536A Embedded Controller 
Module). The laptop or desktop host PC connects to the U4154B module through the PCIe x8 
interface of the AXIe chassis. 

The following figure displays a U4154B Logic Analyzer module. 

CAUTION
You must power down the AXIe chassis before inserting, replacing, or removing 
the U4154A Logic Analyzer module. The enclosure surface of the U4154A 
module may become hot during use. If you need to remove the module, first 
power down the AXIe chassis, wait for at least five minutes to allow the module 
to cool, and then pull the module out of the chassis.
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To know more about the hardware components of the U4154B Logic Analyzer module and how to set 
up this module in AXIe chassis, refer to the  AXIe Based Logic Analysis and Protocol Test 
Modules Installation Guide.

Supplied
Accessories

• Flex cables for connecting multiple U4154B modules in different slots of an AXIe chassis

• Accessory pouch

• Pod connector cables for connecting Logic Analyzer pods to probes.

Optional
Accessories

• Probes.

See Also • Tutorial - Getting to know your logic analyzer (see page 40)

• U4154B Logic Analyzer Specifications and Characteristics (see page 596)

16850-Series Logic Analyzer Product Overview

The Keysight Technologies 16850-series logic analyzers are standalone benchtop logic analyzers 
that range from 34 to 136 logic acquisition channels, depending on the model.

Model Comparison

Features, Logic
Acquisition

• 2 M to 128 M memory depth per channel (depending on memory option), software upgradeable.

• 350 MHz or 700 MHz maximum state data rate (depending on state speed option), software 
upgradeable. 

• Full Channel Timing Mode at 2.5 GHz sampling with 12.5 GHz Timing Zoom.

• Half Channel Timing Mode at 5.0 GHz sampling with 12.5 GHz Timing Zoom.

CAUTION
You must power down the AXIe chassis before inserting, replacing, or removing 
the U4154B Logic Analyzer module. The enclosure surface of the U4154B 
module may become hot during use. If you need to remove the module, first 
power down the AXIe chassis, wait for at least five minutes to allow the module 
to cool, and then pull the module out of the chassis.

Keysight model number: 16851A 16852A 16853A 16854A

Logic 
acquisition 
channels:

34 68 102 136
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• Automated threshold and sample position setup.

• 12.5 GHz timing zoom with 256 K samples.

Features,
Mainframe

• Built-in 15 inch TFT color LCD display, 1,024 x 768 (XGA) resolution. Touch screen with Option 
103. See Tips for Using the Touch Screen (see page 525).

• Front panel knob and buttons. See 16850 Series Front Panel Operation (see page 527).

• 500 GB hard disk drive (or external hard drive option).

• 10Base-T, 100Base-T, 1000Base-T LAN port.

• USB 2.0 ports (six total, two on front, four on back).

• One PCI expansion slot.

• One PCI Express x1 expansion slot.

• Windows 7 operating system. 

• Keysight Logic and Protocol Analyzer application which takes the complexity out of making logic 
analyzer measurements. You can perform all operations directly from one window.

Supplied
Accessories

• PS/2 mouse

• PS/2 mini keyboard

• Accessory pouch

• Power cord

Optional
Accessories

• Probes

See Also • Tutorial - Getting to know your logic analyzer (see page 40)

• 16850-Series Logic Analyzer Specifications and Characteristics (see page 600)

Tips for Using the Touch Screen

The 16850-series logic analyzer frames with Option 103 have a touch screen. Here are some tips for 
using the touch screen:

Use firm, even pressure on the touch screen.

You may prefer to use a stylus.

Use the front panel marker knobs to place markers. Placing markers is hard to do accurately using 
the touch screen. (Any marker can be selected using the Marker Choose button.)

For trees, the touchable area around the +/- buttons is expanded.

For option selections, both the option and the caption are active.

To open a keyboard
dialog

Inside the Keysight Logic Analyzer application:

• Press the  keyboard button in any edit field. This opens a dialog for entering field values.

CAUTION
When powering off the 16850-series logic analyzer, wait until the fans stop turning (about 15 
seconds) before turning the logic analyzer back on. This ensures that internal circuitry restarts in a 
known state. (For more information on powering off the logic analyzer, see the "16850-Series 
Logic Analyzer Installation/Quick Start Guide".)



13 Reference

526 Keysight Logic and Protocol Analyzer User Guide

Outside the Keysight Logic Analyzer application:

• Press the front panel Keyboard button. This opens the Microsoft On-Screen Keyboard and the 
touch screen Event Selector.

(You can also choose Start>All Programs>Accessories>Accessibility>On-Screen Keyboard.)

To access right
mouse button

behavior

Inside the Keysight Logic Analyzer application, most right mouse button behavior is accessible just 
by touching the screen.

Outside the Keysight Logic Analyzer application:

• Press down on the touch screen until a full circle is drawn around your finger; then, a right-click 
occurs.

• Or, you can choose Start>All Programs>Keysight Logic Analyzer>Utilities>Touch Screen>Event 
Selector to open the window:
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Touching inside this window causes your next touch to act as a right-click.

To recalibrate the
touch screen

• If the touch screen needs to be recalibrated, choose Start>All Programs>Keysight Logic 
Analyzer>Utilities>Touch Screen>Calibrate.

16850-Series Front Panel Operation

The front panel interface consists of a knob and buttons that you use to set up and run 
measurements. There are also shortcut buttons that quickly access commonly used dialogs in the 
interface. When a front panel action is not valid, an audible "beep" will sound.

All functions available with the front panel knobs and buttons can also be performed in the graphical 
user interface (GUI).

• Run/Stop Buttons 

• General Purpose Knob 

• Touch Off Button 

Run/Stop Buttons

General Purpose
Knob

NOTE
When multiple instances of the Keysight Logic and Protocol Analyzer application are running on 
the logic analyzer, the front panel knobs and buttons only work for the application that is 
connected to the local acquisition hardware.

Item Description

Run Single Runs a single acquisition (see page 196). The Run Single button turns green 
indicating when a Run action is valid. While the analyzer is running, the light goes 
out.

Run Rep. (Repetitive) Runs a repetitive acquisition (see page 196). The Run Repetitive button turns green 
indicating when a Run Repetitive action is valid. While the analyzer is running, the 
light goes out.

Stop Stops (see page 196) the current acquisition. The Stop button turns red during a 
Run cycle indicating when the Stop action is valid.
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The general purpose knob acts on the field that has the current focus. Fields that have the current 
focus have the blue background. The general purpose knob is typically used to increase/decrease 
numeric values such as waveform scale and delay.

Touch Off Button

See Also • Tips for Using the Touch Screen (see page 525)

16860-Series Logic Analyzer Product Overview

The 16860-series logic analyzers are standalone benchtop state and timing logic analyzers that 
range from 34 to 136 logic acquisition channels, depending on the model.

The 16860-series models provide features such as:

• deeper memory

• ¼ channel 10GHz Timing mode

• deskew of timing traces by individual channels

• single as well as multiple clocks support

• advanced clocking capabilities

• clock hysteresis 

• various clock modes such as Master, Dual Sample, Master/Slave, and Demultiplex.

This series of logic analyzers can be used:

• at a higher speed (700MHz to 12.5 MSps) for debug, validation, and analysis of DDR and LPDDR 
memory systems.

• at a lower speed (350MHz to 0 MSps) as a medium to high performance general purpose logic 
analyzer.

These logic analyzers allow the maximum DQ visibility with simultaneous Read and Write traffic 
capture for DDR3 and LPDDR3 without overloading the system under test. 

Item Description

Touch Off Turns off the touch screen so that accidental touches don't affect the instrument.
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You can configure, control, and use the 16860-series Logic Analyzers through the Keysight Logic and 
Protocol Analyzer application (version 6.3 and above). 

To know more about how to set up, use, and update your 16860 series logic analyzer, refer to the 
16860 Series Portable Logic Analyzers Installation/Quick Start Guide shipped with your logic 
analyzer.

Features, Logic
Acquisition

• 2 M to 400 M memory depth per channel (depending on memory option), software upgradeable.

• 350 MHz or 700 MHz maximum state data rate (depending on state speed option), software 
upgradeable.

• Full Channel Timing Mode at 2.5 GHz sampling with 12.5 GHz Timing Zoom.

• Half Channel Timing Mode at 5.0 GHz sampling with 12.5 GHz Timing Zoom.

• Automated threshold and sample position setup.

• 12.5 GHz timing zoom with 256 K samples.

Features,
Mainframe

• Built-in 15 inch TFT color LCD display with 1,024 x 768 (XGA) resolution. Touch screen with 
Option 103. See Tips for Using the Touch Screen.

• Front panel knob and buttons. See 16860 Series Front Panel Operation.

• 500 GB hard disk drive (or external hard drive option).

• 10Base-T, 100Base-T, 1000Base-T LAN port.

• USB 2.0 ports (six total, two on front, four on back).

• One PCI expansion slot.

• One PCI Express x1 expansion slot.

• Windows 7 operating system.

• Keysight Logic and Protocol Analyzer application which takes the complexity out of making logic 
analyzer measurements. You can perform all operations directly from one window.

Supplied
Accessories

• PS/2 mouse

• PS/2 mini keyboard

• Accessory pouch

• Power cord

Optional
Accessories

• Interposers, Probes, and Cables

Refer to the 16860-Series Logic Analyzer - Probing Selection Card (16860-97002) which is shipped 
with your logic analyzer or refer to its electronic version on www.keysight.com to get a list of 
supported interposers, probes, and cables for 16860-series. In addition, details of these interposers, 
probes, and cables are in their respective user guides available on www.keysight.com.

See Also • Tutorial - Getting to know your logic analyzer (see page 40)

• 16860-Series Logic Analyzer Specifications and Characteristics (see page 600)

Tips for Using the Touch Screen

The 16860-series logic analyzer frames have a touch screen. Here are some tips for using the touch 
screen:

Use firm, even pressure on the touch screen.

You may prefer to use a stylus.

Use the front panel marker knobs to place markers. Placing markers is hard to do accurately using 
the touch screen. (Any marker can be selected using the Marker Choose button.)
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For trees, the touchable area around the +/- buttons is expanded.

For option selections, both the option and the caption are active.

To open a keyboard
dialog

Inside the Keysight Logic Analyzer application:

• Press the  keyboard button in any edit field. This opens a dialog for entering field values.

Outside the Keysight Logic Analyzer application:

• Press the front panel Keyboard button. This opens the Microsoft On-Screen Keyboard and the 
touch screen Event Selector.

(You can also choose Start>All Programs>Accessories>Accessibility>On-Screen Keyboard.)

To access right
mouse button

behavior

Inside the Keysight Logic Analyzer application, most right mouse button behavior is accessible just 
by touching the screen.

Outside the Keysight Logic Analyzer application:

• Press down on the touch screen until a full circle is drawn around your finger; then, a right-click 
occurs.
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• Or, you can choose Start>All Programs>Keysight Logic Analyzer>Utilities>Touch Screen>Event 
Selector to open the window:

Touching inside this window causes your next touch to act as a right-click.

To recalibrate the
touch screen

• If the touch screen needs to be recalibrated, choose Start>All Programs>Keysight Logic 
Analyzer>Utilities>Touch Screen>Calibrate.

16860-Series Front Panel Operation

The front panel interface consists of a knob and buttons that you use to set up and run 
measurements. There are also shortcut buttons that quickly access commonly used dialogs in the 
interface. When a front panel action is not valid, an audible "beep" will sound.

All functions available with the front panel knobs and buttons can also be performed in the graphical 
user interface (GUI).

• Run/Stop Buttons 

• General Purpose Knob 

• Touch Off Button 

Run/Stop Buttons

NOTE
When multiple instances of the Keysight Logic and Protocol Analyzer application are running on 
the logic analyzer, the front panel knobs and buttons only work for the application that is 
connected to the local acquisition hardware.
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General Purpose
Knob

The general purpose knob acts on the field that has the current focus. Fields that have the current 
focus have the blue background. The general purpose knob is typically used to increase/decrease 
numeric values such as waveform scale and delay.

Touch Off Button

See Also • Tips for Using the Touch Screen (see page 525)

Keysight Logic and Protocol Analyzer Application Product Overview

The Keysight Logic Analyzer application is a familiar Windows-based user interface which takes the 
complexity out of making logic analyzer measurements. You can perform all operations directly from 
one window.

Keysight's Simple, Quick and Advanced Trigger functions take the complexity out of triggering. Use 
Simple Trigger's pull down menus to define events in terms of edges and patterns. With Quick 
Trigger you can see if a suspect event ever reoccurs by just drawing a box around the event in the 
display. Quick trigger will do the rest! Use Advanced Trigger's drag and drop graphical icons with 
sentence-like structures to customize complex trigger scenarios.

• Keyboard Commands (see page 532)

Keyboard Commands

• Access Menus (see page 533)

• File Operations (see page 533)

• Edit Operations (see page 533)

• Search Operations (see page 533)

• View operations (see page 534)

• Run/Stop Operations (see page 534)

Item Description

Run Single Runs a single acquisition (see page 196). The Run Single button turns green 
indicating when a Run action is valid. While the analyzer is running, the light goes 
out.

Run Rep. (Repetitive) Runs a repetitive acquisition (see page 196). The Run Repetitive button turns green 
indicating when a Run Repetitive action is valid. While the analyzer is running, the 
light goes out.

Stop Stops (see page 196) the current acquisition. The Stop button turns red during a 
Run cycle indicating when the Stop action is valid.

Item Description

Touch Off Turns off the touch screen so that accidental touches don't affect the instrument.
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• Compare Operations (see page 534)

• Listing Operations (see page 534)

• Waveform Operations (see page 535)

• Window Operations (see page 535)

• Help Operations (see page 535)

• Miscellaneous (see page 535)

Access Menus

File Operations The following operations are located under File in the menu bar.

Edit Operations The following operations are located under Edit in the menu bar.

Search Operations The following operations are located under Edit in the menu bar.

Menu Description

Alt+F Access to File menu

Alt+E Access to Edit menu

Alt+V Access to View menu

Alt+S Access to Setup menu

Alt+T Access to Tools menu

Alt+M Access to Markers menu

Alt+R Access to Run/Stop menu

Alt+W Access to Window menu

Alt+H Access to Help menu

Menu Description

Ctrl+N File - New

Ctrl+O File - Open

Ctrl+F4 File - Close

Ctrl+S File - Save

Shift+E File - Export

Ctrl+P File - Print

Menu Description

Ctrl+Z Edit - Undo

Ctrl+X Edit - Cut

Ctrl+C Edit - Copy

Ctrl+V Edit - Paste

Alt+I Edit - Insert Bus/Signal into Window

Alt+P Edit - Current Window Properties
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View Operations The following operations are located under View in the menu bar.

Run/Stop
Operations

The following operations are located under Run/Stop in the menu bar.

Compare
Operations

The following operations are located under Compare in the menu bar.

Listing Operations The following operations are located under Listing in the menu bar.

Menu Description

Ctrl+F Edit - Find

Shift+F3 Edit - Find Previous

F3 Edit - Find Next

Ctrl+B Edit - Go To Beginning

Ctrl+T Edit - Go To Trigger

Ctrl+E Edit - Go To End

Ctrl+G Edit - Go To

Menu Description

Shift+F View - Zoom Out Full

Shift+O View - Zoom Out

Shift+I View - Zoom In

F9 View - Full Screen

F11 View - Toggle Tabbed Windows

F12 View - Toggle Status Bar

Menu Description

F5 Run/Stop - Run

Ctrl+F5 Run/Stop - Run Repetitive

F8 Run/Stop - Stop

Shift+F8 Run/Stop - Cancel

Shift+Ctrl+F8 Run/Stop - Resume

Menu Description

Alt+P Compare - Properties

Menu Description

Alt+P Listing - Properties
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Waveform
Operations

The following operations are located under Waveform in the menu bar.

Window
Operations

The following operations are located under Window in the menu bar.

Help Operations The following operations are located under Help in the menu bar.

Miscellaneous The following operations are located throughout the interface.

Menu Description

Alt+P Waveform - Properties

Menu Description

F6 Window - Toggle to Next

Shift+F6 Window - Toggle to Previous

Menu Description

F1 Help - Help Topics

Menu Description

Ctrl+esc Shows Windows Start bar
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Logic Analyzer Notes

• Channels and Memory Depth (see page 536)

• Timing Mode Sampling Options (see page 536)

• State Mode Sampling Options (see page 536)

• Timing Zoom (see page 536)

Channels and
Memory Depth

• U4164A Logic Analyzer Notes, Channels and Memory Depth (see page 537)

• U4154A Logic Analyzer Notes, Channels and Memory Depth (see page 545)

• U4154B Logic Analyzer Notes, Channels and Memory Depth (see page 549)

• 16850-Series Logic Analyzer Notes, Channels and Memory Depth (see page 553)

• 16860-Series Logic Analyzer Notes, Channels and Memory Depth (see page 555)

Timing Mode
Sampling

Options/Period

The timing mode sampling options let you choose between Full Channel Timing Mode (default), Half 
Channel Timing Mode (faster sampling), or Transitional / Store Qualified Timing Mode (greater 
measurement length). For notes on these modes in a particular logic analyzer, see:

• U4164A Logic Analyzer Notes, Timing Mode Sampling Options/Period (see page 538)

• U4154A Logic Analyzer Notes, Timing Mode Sampling Options/Period (see page 545)

• U4154B Logic Analyzer Notes, Timing Mode Sampling Options/Period (see page 545)

• 16850-Series Logic Analyzer Notes, Timing Mode Sampling Options/Period (see page 553)

• 16860-Series Logic Analyzer Notes, Timing Mode Sampling Options/Period (see page 555)

State Mode
Sampling Options

The state mode sampling options let you choose between Single Clock or Multiple Clocks options. 
For notes on these options in a particular logic analyzer, see:

• U4164A Logic Analyzer Notes, State Mode Sampling Options (see page 540)

• U4154A Logic Analyzer Notes, State Mode Sampling Options (see page 546)

• U4154B Logic Analyzer Notes, State Mode Sampling Options (see page 546)

• 16850-Series Logic Analyzer Notes, State Mode Sampling Options (see page 553)

• 16860-Series Logic Analyzer Notes, State Mode Sampling Options (see page 555)

Timing Zoom • U4164A Logic Analyzer Notes, Timing Zoom (see page 542)

• U4154A Logic Analyzer Notes, Timing Zoom (see page 546)

• U4154B Logic Analyzer Notes, Timing Zoom (see page 546)

• 16850-Series Logic Analyzer Notes, Timing Zoom (see page 553)

• 16860-Series Logic Analyzer Notes, Timing Zoom (see page 555)

U4164A Logic Analyzer Notes

• Differences from Other Logic Analyzers (see page 536)

• Channels and Memory Depth (see page 537)

• Timing Mode Sampling Options/Period (see page 538)

• State Mode Sampling (see page 540)

• Timing Zoom (see page 542)

Differences from
Other Logic

Analyzers

Compared to other Keysight logic analyzers supported in earlier releases, the U4164A logic analyzer 
differs in the following ways:

• Supports two state sampling options - Single Clock and Multiple Clocks. 
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• The Single Clock option provides a single master clock and supports the state mode sampling 
speed ranging from 12.5 Mega samples per second to 2.5 GHz (with "02G" state speed license 
option). 

• The Multiple Clocks mode provides up to four clocks and is a low speed option more suitable 
for general-purpose logic analysis with state mode sampling speed ranging from 0 Mega 
samples per second to 700 MHz.

To know more about these two state sampling options, refer to the topic Selecting the State 
Sampling Option for a U4164A Logic Analyzer.

• You can connect three U4164A modules to form a three-module set in an AXIe chassis. U4164A 
modules cannot merge into module sets with U4154A or U4154B modules.

• In a U4164A setup, you can load a .xml Logic Analyzer configuration file that you 
created/previously saved in a U4154A or U4154B setup. You cannot, however load a Standard 
configuration (.ala) file that you created/previously saved in a U4154A or U4154B setup.

• U4164A supports four state speeds. The maximum state speed supported is 4 Gb/s. The "02G" 
license sets it to 4 Gb/s (2.5 GHz). These license options do not however control and set the 
timing speed of the U4164A module.

• Supports Master, Master/Slave/Demux, Dual Sample, and Quad Sample clock modes. The 
availability of these clock modes depend on the state sampling option (Single Clock or Multiple 
clocks) that you have selected for your logic analyzer. 

• Supports high speed data capture with a new State sampling clock mode - Quad Sample that 
allows four samples per clock edge. It allows you to capture separate rising and falling edge 
samples of both read and write DDR/LPDDR DQ signals for data rates up to 4 Gb/s from a single 
probe point. 02G license of U4164A is required for this clock mode. Refer to the topic “To set up 
the quad sample sampling clock mode" on page 119 to know more.

• Supports the Dual Sample clock mode with two thresholds that can be assigned as separate 
offsets to capture two samples per clock edge with different thresholds. Refer to the topic “To set 
up the dual sample sampling clock mode" on page 116mode to know more about how dual 
sampling functions in the U4164A module. 

• Supports a new Timing (Asynchronous) sampling option - Quarter Channel Timing Mode. 01G or 
02G license of U4164A is required for this timing mode.

• Allows you to set the sampling positions for all Timing (Asynchronous) sampling options using a 
new tool named the Signal Deskew tool. 

• U4164A provides a new setting called Clock hysteresis for the state sampling clock on Pod1 of the 
U4164A module. Using this setting, you can set a value (in milliVolts) between 0 and 1 volts 
around the clock threshold. This allows you to avoid false sampling on noisy clock inputs where a 
differential clock input turns off and floats to zero volts. Refer to the topic  Setting Clock 
Hysteresis for the U4164A State Sampling Clock to know more. 

Channels and
Memory Depth

136 channels per U4164A module (This includes 128 data channels and 8 clock channels)

You can install and connect a maximum of three U4164A modules in an AXIe chassis to form a 
3-card set with 408 channels. Refer to the table below for the number of channels available for each 
of the supported sampling modes.
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Timing Mode
Sampling

Options/Period

U4164A Sampling 
Modes

For State (Synchronous) Sampling Modes For Timing (Asynchronous) Sampling Modes

Conventional State 
Sampling

Dual Sample State 
Sampling

Quad Sample State 
Sampling

Full Channel Half Channel Quarter Channel

Number of Channels 
Available in one 
U4164A module

136 68 34 136 68 34

Number of Channels 
Available in a two 
U4164A modules set

272 136 68 272 136 68

Number of Channels 
Available in a three 
U4164A modules set

408 204 102 408 204 102

U4164A Memory 
depth

For State 
(Synchronous) 
Sampling Modes

For Timing (Asynchronous) Sampling Modes

Full Channel Half Channel Quarter Channel

Standard memory 2 M 2 M 4 M 8 M

Option 004 4 M 4 M 8 M 16 M

Option 008 8 M 8 M 16 M 32 M

Option 016 16 M 16 M 32 M 64 M

Option 032 32 M 32 M 64 M 128 M

Option 064 64 M 64 M 128 M 200 M

Option 128 128 M 128 M 200 M 400 M

Option 200 200 M 200 M 400 M 800 M

Option 400 400 M 400 M 800 M 1.6 G
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Timing Mode Sampling 
Option

Description

Full channel, 2.5 GHz 
(Full Channel Timing 
Mode)

Maximum acquisition rate supported in this option - 2.5 GHz.
With this timing mode sampling option:
• You can use the full memory depth of your U4164A logic analyzer module.
• Data sampling period ranging from 400 ps to 10 ns. You can set the sample period using the Sample 

Period field.
• All the eight pods of U4164A are available.
• Eight clock channels are available per U4164A module.

Half channel, 5.0 GHz 
(Half Channel Timing 
Mode)

Maximum acquisition rate supported in this option - 5.0 GHz.
With this timing mode sampling option:
• The memory depth is doubled the available depth (refer to the table above).
• Data is sampled and stored every 200 ps; this rate cannot be changed.
• Only odd pod of each pod pair is available that is, Pod 1, 3, 5, and 7.
• Channels assigned to the unavailable even pods are ignored. 
• Four clock channels are available per U4164A module.

Quarter channel, 10 
GHz 
(Quarter Channel 
Timing Mode)

Maximum acquisition rate supported in this option - 10.0 GHz.
This timing mode sampling option is available only if you have installed the 01G or 02G Speed license 
option of the U4164A module.
With this timing sampling option:
• The memory depth is four times the available depth (refer to the table above). 
• Data is sampled and stored every 100 ps; this rate cannot be changed.
• Only odd pod of each pod pair is available that is, Pod 1, 3, 5, and 7.
• Only even channels (0, 2, 4, 6, 8, 10, 12, 14) for each odd pod are available.
• Two clock channels are available per U4164A module.

Transitional / Store 
Qualified Timing Modes

This timing mode sampling option provides maximum duration of acquisition because data is only stored 
when a change from the last value is detected. Data is sampled at regular intervals but stored only when 
there is a signal transition across the threshold voltage level. See transitional timing. Three sampling 
options are available in this mode:
• Transitional / Store qualified, (Full channel mode), 2.5 GHz
• Transitional / Store qualified, (Half channel mode), 5.0 GHz
• Transitional / Store qualified, (Quarter channel mode), 10.0 GHz - Available only when you have 

installed 01G or 02G license of the U4164A module.

NOTE
For the U4164A module, you can set the sampling positions for the Timing mode sampling options 
as well. You use the Signal Deskew Tool to accomplish this. Refer to the online help available with 
this tool's GUI to know more. 
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State Mode
Sampling Option

The U4164A logic analyzer supports the following four state speeds. Based on the state speed 
license option that you have purchased for your logic analyzer, the maximum available state speed of 
your logic analyzer is automatically set.

State Sampling
Clock Modes

The state sampling clock mode specifies how the clock inputs are used for sampling. The clock 
modes available for a U4164A logic analyzer depends on the state sampling option (Single clock or 
Multiple Clocks) that you selected. 

State Sampling Option Description

Single Clock Faster state mode sampling speeds are supported, but some triggering 
features, multiple clocks, and advanced clocking are not available.
Refer to the table below to know about the maximum acquisition rate 
available in the Single Clock sampling option.

Multiple Clocks Advanced clocking capabilities and multiple clocks are supported, but at a 
slower state sampling speed.
Refer to the table below to know about the maximum acquisition rate 
available in the Multiple Clocks sampling option.

Refer to the topic Selecting the State Sampling Option for a U4164A Logic Analyzer to get a comparison between these two sampling 
options and to know how these options are used in the context of a U4164A Logic Analyzer.

U4164A State Speed License Option Maximum Acquisition Rate 

In Single Clock State Sampling Option  In Multiple Clock State Sampling Option

Standard (Default) State Speed
350 MHz (700 Mb/s)

700 Mb/s on 136 channels per U4164A, clocking on both 
edges of the clock
350 Mb/s on 136 channels per U4164A, clocking on 
either edge of the clock
700 Mb/s on 68 channels per U4164A, clocking on either 
or both edges of the clock 

 Captures a 350MHz signal on rising, falling, or both edges of 
the clock up to 350 MSp/s 

Option 700
700 MHz (1.4 Gb/s)

1.4 Gb/s on 136 channels per U4164A, clocking on both 
edges of the clock
700 Mb/s on 136 channels per U4164A, clocking on 
either edge of the clock
1.4 Gb/s on 68 channels per U4164A, clocking on either 
or both edges of the clock 

 Captures a 700MHz signal on rising, falling, or both edges of 
the clock up to 700 MSp/s 

Option 01G
2.8 Gb/s (1.4 GHz)

2.5 Gb/s on 136 channels per U4164A, clocking on both 
edges of clock
1.4 Gb/s on 136 channels per U4164A, clocking on either 
edge of the clock
2.8 Gb/s on 68 channels per U4164A, clocking on either 
or both edges of the clock

 Not allowed

Option 02G
4 Gb/s (2.5 GHz)

2.5 Gb/s on 136 channels per U4164A, clocking on either 
or both edges of clock 
4.0 Gb/s on 68 channels per U4164A, clocking on either 
edge of the clock 

 Not allowed
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State Sampling
Clock(s)

The U4164A logic analyzers support both Single and Multiple clocks sampling options. Therefore, 
you can set up a single or multiple state sampling clocks. 

• In case of a single clock, the state sampling clock input is always from Pod1 of the logic analyzer. 
In a multi-module set, the clock is allowed only on Pod1 of the master card (clocking module). 
The master card is the middle U4164A module in a three-module set and the bottom U4164A 
module in a two-module set. 

• In case of multiple clocks, the state sampling clock input can be from multiple Pods (Pod 1, 2, 3, 
or 4) of the logic analyzer in an Ored combination.  

To know how to set up a single or multiple clocks, refer to the topic To set up the state sampling 
clock.

When setting up multiple clocks, you can also use the Advanced Clocking feature to define complex 
clock descriptions. 

State Sampling
Clock Qualifiers

For a Single Clock

The clock qualifiers can take clock signal inputs from the following pods of logic analyzer. You cannot 
use the signals from the other pods clock inputs as the sampling clock qualifiers.

The following are some points to remember when using the clock qualifier on Pod 7:

• This qualifier is only available when other clock qualifier(s) are used as OR qualifiers.

Clock Modes Available for the Single Clock Sampling Option  Clock Modes Available for the Multiple Clocks Sampling 
Option

 Master
Dual Sample
Quad Sample

Master
Master/Slave/Demux 

For a detailed description of these clock modes, refer to the topics:
• Master
• Dual Sample
• Quad Sample
• Master/Slave
• Demux

For information on how to set up these clock modes, see:
• To set up the master only sampling clock mode
• To set up the dual sample sampling clock mode
• To set up the quad sample sampling clock mode
• To set up the master/slave sampling clock mode
• To set up the demultiplex sampling clock mode

Clock qualifier Pod input Usage

 Pod 2  Can be used as AND or OR clock qualifier

Pod 3  Can be used as AND or OR clock qualifier

Pod 4 Can be used as AND or OR clock qualifier

Pod 5 Can be used as AND or OR clock qualifier

Pod 7 The RESET clock qualifier input on pod 7 is available as an AND input only when other 
clock qualifiers are set up as OR inputs. One situation in which this clock qualifier is 
particularly useful is to capture RESET when the other clock qualifiers are looking for 
CKE. This qualifier allows you to create OR qualification of upto 4 DDR memory CKE 
clock qualifiers along with an AND qualified with RESET.
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• This qualifier is only an AND qualifier. The Clock Description equation therefore, always adds the 
Ck7 as an AND condition. For example:   Ck1^ AND (Ck4=0 OR Ck5=1) AND Ck7=1

• Setup and hold of Pod 7 qualifier will be larger than other clock qualifiers.

For multiple clocks

• The clock qualifiers can take clock signal inputs from the following pods of logic analyzer. You 
cannot use the signals from the other pods clock inputs as the sampling clock qualifiers.

Clock Qualifiers in Multiple Clocks

• Up to two clock qualifiers (Pod 1, 2, 3, 4) 

• Though three clock qualifiers are displayed for use, you can set up to 2 clock qualifiers for a clock.

Determining
Optimal Sample

Positions and
Thresholds

In the state sampling acquisition mode, you need to adjust the sampling positions on U4164A 
channels relative to the sampling clock to make sure data is sampled when it is valid.

You can use the eye scan feature of the U4164A Logic Analyzer to automatically determine and set 
the optimal sample positions and thresholds for the individual signals. Clicking the Eye scan: Sample 
Positions and Threshold button in the Sampling tab displays the Eye Scan - Sample Positions and 
Threshold Settings dialog box where you can set up and run the eye scan measurement for U4164A 
channels. Refer to the topic Setting up and Running Eyescans in Logic Analyzer to learn more.

Timing Zoom Timing zoom collects additional high-speed timing data around the trigger of the logic analyzer. It 
uses a 256+K-depth, 12.5 GHz timing analyzer to sample data every 80 ps on all channels. Timing 
zoom is available for all acquisition modes.

Setting up the State Sampling Options for a U4164A Logic Analyzer

The state sampling option that you select specifies the speed up to which the state mode sampling 
clock will match input clock edges from the device under test. 

The following table describes and compares the state sampling options that you can set for a 
U4164A logic analyzer. 
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 State Sampling Options Single Clock, Full Channel, 2.5GHz to 12.5 MSps Multiple Clocks, Full channel, 700 MSps to 0 MSps

Usage Default Option
Faster state mode sampling speeds are supported, but some 
triggering and advanced clocking features are not available.
More suitable for DDR/LPDDR data captures with high data 
rates.

Supports slower state sampling speeds but allows advanced 
clocking capabilities and multiple clocks.
More suitable for general-purpose logic analysis.

State Sampling Speeds 
Supported

2.5 GHz to 12.5 MHz (with state speed option 02G)
1.4 GHz to 12.5 MHz (with state speed option 01G)
700 MHz to 12.5 MHz (with state speed option 700)
350 MHz to 12.5 MHz (with standard state speed)
Note: An error message is displayed if the input clock edges from 
the DUT are outside the lowest and highest speed range allowed 
in this option. In such a situation, measurements are not 
collected. 

700 MSps to 0 MSps
(This sampling speed will not change with state speed license 
options of U4164A)
Note: A warning message is displayed if the input clock edges 
from the DUT are faster than the highest speed allowed in this 
option. In such a situation, measurements are still available but 
there is a risk of some missing data. You can use the Single 
Clock option in such a situation.

Maximum Acquisition Rate At the 2.5 GHz state sampling speed:
2.5 Gb/s on 136 channels per U4164A, clocking on either or 
both edges of clock 
4.0 Gb/s on 68 channels per U4164A, clocking on either edge of 
the clock 

At the 1.4 GHz state sampling speed:
2.5 Gb/s on 136 channels per U4164A, clocking on both edges 
of clock
1.4 Gb/s on 136 channels per U4164A, clocking on either edge 
of the clock
2.8 Gb/s on 68 channels per U4164A, clocking on either or both 
edges of the clock

At the 700 MHz state sampling speed:
1.4 Gb/s on 136 channels per U4164A, clocking on both edges 
of the clock
700 Mb/s on 136 channels per U4164A, clocking on either edge 
of the clock
1.4 Gb/s on 68 channels per U4164A, clocking on either or both 
edges of the clock 

At the 350 MHz state sampling speed:
700 Mb/s on 136 channels per U4164A, clocking on both edges 
of the clock
350 Mb/s on 136 channels per U4164A, clocking on either edge 
of the clock
700 Mb/s on 68 channels per U4164A, clocking on either or both 
edges of the clock 

At the 350MHz state sampling speed:
Captures a 350MHz signal on rising, falling, or both edges of 
the clock up to 350 MSp/s 

At the 700MHz state sampling speed:
Captures a 700MHz signal on rising, falling, or both edges of 
the clock up to 700 MSp/s 

Number of Clocks Supported Single clock (Always on Pod1 of the logic analyzer) Up to 4 clocks (in an Ored combination). 
Master and slave clocks are counted separately. 
Refer to the topic To set up the state sampling clock to know 
about setting multiple clocks.

State Sampling Clock Modes 
Supported

Master
Dual Sample

Master
Master/Slave
Demux

Advanced Clocking 
Capabilities

Not supported
A clock channel can be used either as an edge or as a qualifier 
but not both. The clock channel on Pod 1 can only be used as an 
edge.

Supported
You can specify complex clock setups with the available clock 
channels used both as an edge and a qualifier in the same 
clock description. 
Refer to the topic Advanced Clocking Setup dialog to know 
more.
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See Also • To set up the state sampling clock

• U4164A Logic Analyzer Notes - State Mode Sampling

U4154A Logic Analyzer Notes

• Differences from Other Logic Analyzers (see page 544)

• Channels and Memory Depth (see page 545)

• Timing Mode Sampling Options/Period (see page 545)

• State Mode Sampling (see page 546)

• Timing Zoom (see page 546)

Differences from
Other Logic

Analyzers

Compared to other Keysight logic analyzers supported in earlier releases, the U4154A logic analyzer 
differs in the following ways:

• There is no quarter channel timing mode.

• U4154A supports two license based state speeds. A "01G" license sets the maximum state speed 
of U4154A to 1.4Gbs. A "02G license sets it to 2.5Gbs. These license options do not however 
control and set the timing speed of the U4154A module.

• There is a single state sampling clock with four qualifiers. The clock qualifiers allow you to sample 
only when qualifying signal is active so that you can view more system activity. The state sampling 
clock input is always from Pod1 on the master card in a multi-card set. (The master card is the 
lower-middle card of a multi-card set). You cannot use the signals from the other pods clock 
inputs as the sampling clock inputs. For more information, refer to the topic “Setting up the State 
Sampling Options in U4154A Logic Analyzer" on page 547.

• Advanced probe settings are enabled for U4154A logic analyzers. You can enable or disable the 
peaking at the channel/pod/module level for the probing system used for these logic analyzers. 
For more information, refer to “Changing Advanced Probe Settings for Logic Analyzers" on 
page 563.

• Memory depth controls and licensing is different in U4154A Logic Analyzer compared to previous 
Keysight logic analyzers. Unlike previous logic analyzers, the density of data samples stored in 
U4154A memory varies with the acquisition mode. The amount of U4154A memory available is 
fixed based on the memory license that you have purchased. However, there is a variation in the 
maximum number of samples that you can store in the fixed memory based on the selected 
acquisition mode. 

• You cannot logically split a U4154A logic analyzer module. 

• The U4154A module is installed in one of the slots of the Keysight AXIe chassis. It connects to the 
host PC through the PCIe interface of the AXIe chassis. You can connect two U4154A modules to 
form a two-card set in an AXIe chassis.

Clock Qualifiers Maximum of five clock qualifiers (Pod 2, 3, 4, 5, 7) Maximum of two clock qualifiers (Pod1, 2, 3, 4).

Note: Though there are three clock qualifiers displayed, you 
can use a maximum of only two qualifiers for a clock. The third 
qualifier is automatically set to "Don't Care" and can be used 
only as an Ored clock in the clock description.

Triggering Capabilities 
Differences

Number of trigger sequences - 8
Burst patterns supported - Yes
Number of timers - 1
Global counters supported - No
Event counters supported - Yes

 Number of trigger sequences - 16
Burst patterns supported - No
Number of timers - 3
Global counters supported - 2
Event counters supported - No

The logic analysis features that are not included in this table work the same in Single clock and Multiple Clocks options. 

 State Sampling Options Single Clock, Full Channel, 2.5GHz to 12.5 MSps Multiple Clocks, Full channel, 700 MSps to 0 MSps
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• Colorized Eyescan on all signals is supported to quickly set accurate sample positions and 
threshold voltages as per the optimal values suggested by the eye scan run. You can also export 
the eyescan data to a specified .csv file. For more information, refer to “Setting up and Running 
Eyescans in Logic Analyzers" on page 567.

• Trigger expansions with more levels and deeper bursts. Burst levels increased from 4 to 8. Faster 
trigger sequencer rate (with triggers on sequential events upto 2.5 Gb/s). New event counter 
added for specifying the trigger action. 

• The DDR Setup Assistant tool has been enhanced to support the set up of the U4154A Logic 
Analyzer module using this tool. The automated setup steps now also include automatically 
determining and setting the optimal acquisition sample position at the center of the eye on 
individual channels of U4154A. You can now use this tool to automatically set the sampling 
positions for command, address, read and write data signals separately while setting up DDR 
measurement setup with U4154A logic analyzer. The eye scan feature of the U4154A Logic 
Analyzer is used to accomplish this. To learn more, refer to the DDR Setup Assistant online help 
integrated with this help.

Channels and
Memory Depth

Timing Mode
Sampling

Options/Period

• Full channel 2.5 GHz = Full Channel Timing Mode

With this timing mode sampling option, you can use the full memory depth of your U4154A logic 
analyzer module, with data sampling period ranging from 400 ps to 10 ns. You can set the sample 
period using the Sample Period field.

• Half channel 5.0 GHz = Half Channel Timing Mode

With this timing mode sampling option, only one pod of each pod pair is available, and the 
memory depth is doubled. Channels assigned to unavailable pods are ignored. You can specify 
which pod to use in the Buses/Signals tab of the Analyzer Setup dialog by clicking the Pod 
button and selecting the desired pod. 

Data is sampled and stored every 200 ps; this rate cannot be changed.

• The Quarter channel timing mode is not supported.

• Transitional / Store Qualified Timing Mode

This timing mode sampling option provides maximum duration of acquisition because data is only 
stored when a change from the last value is detected. See transitional timing on page 365. Two 
sampling options are available in this mode: 

• Transitional / Store qualified, (Full channel mode), 2.5 GHz - With this sampling option, you 
can use the full memory depth of your U4154A logic analyzer module, with data being 
sampled at regular intervals but stored only when there is a signal transition across the 
threshold voltage level. You can set the sampling period from 400 ps to 10 ns for this mode. 

U4154A 
Memory 
depth

Option 002 Option 
004

Option 
008

Option 
016

Option 
032

Option 
064

Option 
128

Option 
200

2 M 4 M 8 M 16 M 32 M 64 M 128 M 200 M

Channels 136 channels per U4154A module (This includes 128 data channels and 8 clock channels)
In a multi-card set:
136 channels * number of U4154A modules installed in slots of an Keysight AXIe chassis
You can install and connect two U4154A modules in an AXIe chassis to form a 2-card set with 272 channels.
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• Transitional / Store qualified, (Half channel mode), 5.0 GHz - With this sampling option, only 
one pod of each pod pair is available, and the memory depth is doubled. Channels assigned to 
unavailable pods are ignored. You can specify which pod to use in the Buses/Signals tab of the 
Analyzer Setup dialog by clicking the Pod button and selecting the desired pod. Data is 
sampled at regular intervals but stored only when there is a signal transition across the 
threshold voltage level. The sampling period is 200 ps for this mode and cannot be changed. 

State Mode
Sampling

• U4154A has two license based state speeds. A "01G" license sets the maximum state speed of 
U4154A to 1.4Gbs. A "02G license sets it to 2.5Gbs. Based on the license option that you have 
purchased for U4154A, the maximum available state speed of U4154A is automatically set. If the 
licensed speed is 1.4Gbs (01G option) and while acquiring data, the clock frequency is found to 
exceed the maximum state speed available as per the 01G license, an error message is displayed 
and the data is discarded.

• There is a single state sampling clock with four qualifiers. In a multi-card set, the sampling clock 
signals can come only from Pod 1 of the master card in the set. The qualifiers can take clock 
signal inputs only from the pods 2 to 5 on the master card in the set. The clock can be used as a 
rising, falling, or both edge clock.

• U4154A supports Full channel (Master) and Dual sample clock modes. In both these modes, the 
sampling option is as per the state speed license acquired for U4154A.

Timing Zoom Timing zoom collects additional high-speed timing data around the trigger of the logic analyzer. 
It uses a 256K-depth, 12.5 GHz timing analyzer to sample data every 80 ps on all channels. 
Timing zoom is available for all acquisition modes.

See Also • “Setting up the State Sampling Options in U4154A Logic Analyzer

• “Changing Advanced Probe Settings for Logic Analyzers

• “Setting up and Running Eyescans in Logic Analyzers

• “U4154A Logic Analyzer Specifications and Characteristics

• “Pod and Channel Naming Conventions in Logic Analyzer 
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Setting up the State Sampling Options in U4154A Logic Analyzer

The U4154A state sampling speed matches your device under test's clock rate, from 100 Mb/s up to 
2.5 Gb/s.

The state sampling clock inputs let signals from the device under test specify when data should be 
captured.

U4154A provides the following two license options for state mode speeds (2.5Gb/s and 1.4Gb/s) at 
which the state sampling clock matches input clock edges from the device under test. 

• 2.5 Gb/s speed - If you have the 02G license for U4154A module, then the maximum available 
state speed of U4154A is automatically set to 2.5Gb/s.

• 1.4 Gb/s speed - If you have the 01G license for U4154A module, then the maximum available 
state speed of U4154A is automatically set to 1.4Gb/s. If, while acquiring data, the clock 
frequency is found to exceed the maximum state speed available as per the 01G license, an error 
message is displayed and the data is discarded.

State Sampling Clock Mode

The state sampling clock mode specifies how the clock inputs are used for sampling. There are two 
state sampling clock modes to choose from:

• Master — all pods sampled on one master clock. 

• Dual Sample — one pod in the pod pair sampled on one master clock but with different delays. 
When you enable this clock mode, the next step is to set up the pod pairs that you want to be 
dual sampled in the Busses/Signals tab of the Analyzer Setup dialog box (see “To set up the dual 
sample sampling clock mode" on page 116). Data on the active pod in a dual sampled pod pair is 
sampled twice (as master sample and second sample).
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The pods for which you select the dual sample mode have their associated clock bit also dual 
sampled. The active clock bit of the pods in a dual sampled pod pair is the clock bit of the selected 
active pod in that pod pair. notice that in the following screen, the clock channels of the dual sample 
pod pair (pod 1.3 and pod 1.4) are also dual sampled. These dual sampled clocks are represented as 
13 M or C3M and 13 S or C3S (C3 Master Sample and C3 Second Sample).

For instructions on setting up these state sampling clock modes, see:

• “To set up the master only sampling clock mode" on page 114

• “To set up the dual sample sampling clock mode" on page 116

State Sampling Clock and Qualifiers

In U4154A, only one state sampling clock is provided. The state sampling clock is the clock of Pod 1 
of the master card (the lower middle level card in the set). To know which card is the master card in 
the set, click System Summary button in the Buses/Signals tab of the Analyzer Setup dialog box.

You can choose the sampling to occur on rising, falling, or both edges of the input clock signal. 

There are four qualifiers available for the state clock. The clock inputs of pods 2 to 5 are used as the 
state clock qualifiers. In a multi card set, the clock inputs of pods 2 to 5 of the master card in the set 
are used as the state clock qualifiers.

You cannot use the signals from the other pods clock inputs as the sampling clock inputs or its 
qualifiers. 

In the following screen, the clock channel (Clk1) of pod 1 of the master card (first card from bottom in 
the set of two cards) is used as the sampling clock. Clk2, Clk3, Clk4, and Clk5 are the state clock 
qualifiers. 
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You can use the "AND"/ "OR" conditional operators with the state clock qualifiers to add conditions 
and completely describe the clock as a combination of edges and highs or lows. 

Determining Optimal Sample Positions and Thresholds

In the state sampling acquisition mode, you need to adjust the sampling positions on each U4154A 
channel relative to the sampling clock to make sure data is sampled when it is valid.

You can use the eye scan feature of the U4154A Logic Analyzer to automatically determine and set 
the optimal sample positions and thresholds for the individual signals. Clicking the Eye scan: Sample 
Positions and Threshold button in the Sampling tab displays the Eye Scan - Sample Positions and 
Threshold Settings dialog box where you can set up and run the eye scan measurement for U4154A 
channels. Refer to the topic Setting up and Running Eyescans in U4154A Logic Analyzer to learn 
more.

U4154B Logic Analyzer Notes

• Differences from Other Logic Analyzers (see page 549)

• Channels and Memory Depth (see page 549)

• Timing Mode Sampling Options/Period (see page 550)

• State Mode Sampling (see page 550)

• Timing Zoom (see page 551)

Differences from
Other Logic

Analyzers

Compared to other Keysight logic analyzers supported in earlier releases, the U4154B logic analyzer 
differs in the following ways:

• U4154B supports two state speeds. By default, it supports the maximum state speed of 2.8 Gb/s. 
A "02G" license sets it to 4 Gb/s (2.5 GHz). These license options do not however control and set 
the timing speed of the U4154B module.

• The state sampling clock input is always from Pod1 of the U4154B module. In a multi-card set, 
the clock is allowed only on Pod1 of the master card. The master card is the middle U4154B 
module in a three-card set and the bottom U4154B module in a two-card set. You cannot use the 
signals from the other pods clock inputs as the sampling clock inputs. For more information, refer 
to the topic “Setting up the State Sampling Options in U4154B Logic Analyzer" on page 551.

• U4154B has improved clock qualifiers to capture traces out of reset. U4154B has Pod 7, Pod 5, 
Pod 4, Pod 3 and Pod 2 clock qualifiers on the clocking module. U4154B provides an additional 
new clock enable on Pod 7 of the clocking module to allow 'OR' qualification of upto 4 DDR 
memory CKE clock qualifiers AND qualified with RESET. 

• You cannot logically split a U4154B logic analyzer module. 

• The U4154B module is installed in one of the slots of the Keysight AXIe chassis. It connects to the 
host PC through the PCIe or USB interface of the AXIe chassis. You can connect three U4154B 
modules to form a three-card set in an AXIe chassis.

• The three U4154B modules support in a multi-card set in the AXIe chassis enables DDR4 
interposers to perform full data capture at speeds >2.5 Gb/s.

• U4154B modules cannot merge into module sets with U4154A/B modules.

• There is no quarter channel timing mode.

Channels and
Memory Depth U4154B Memory 

depth
Option 004 Option 008 Option 016 Option 032 Option 

064
Option 128 Option 

200

4 M 8 M 16 M 32 M 64 M 128 M 200 M

Channels 136 channels per U4154A module (This includes 128 data channels and 8 clock channels)
In a multi-card set:
136 channels * number of U4154A modules installed in slots of an Keysight AXIe chassis
You can install and connect two U4154A modules in an AXIe chassis to form a 2-card set with 272 channels.
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Timing Mode
Sampling

Options/Period

• Full channel 2.5 GHz = Full Channel Timing Mode

With this timing mode sampling option, you can use the full memory depth of your U4154B logic 
analyzer module, with data sampling period ranging from 400 ps to 10 ns. You can set the sample 
period using the Sample Period field.

• Half channel 5.0 GHz = Half Channel Timing Mode

With this timing mode sampling option, only one pod of each pod pair is available, and the 
memory depth is doubled. Channels assigned to unavailable pods are ignored. You can specify 
which pod to use in the Buses/Signals tab of the Analyzer Setup dialog by clicking the Pod 
button and selecting the desired pod. 

Data is sampled and stored every 200 ps; this rate cannot be changed.

• The Quarter channel timing mode is not supported.

• Transitional / Store Qualified Timing Mode

This timing mode sampling option provides maximum duration of acquisition because data is only 
stored when a change from the last value is detected. See transitional timing on page 365. Two 
sampling options are available in this mode: 

• Transitional / Store qualified, (Full channel mode), 2.5 GHz - With this sampling option, you 
can use the full memory depth of your U4154B logic analyzer module, with data being 
sampled at regular intervals but stored only when there is a signal transition across the 
threshold voltage level. You can set the sampling period from 400 ps to 10 ns for this mode. 

• Transitional / Store qualified, (Half channel mode), 5.0 GHz - With this sampling option, only 
one pod of each pod pair is available, and the memory depth is doubled. Channels assigned to 
unavailable pods are ignored. You can specify which pod to use in the Buses/Signals tab of the 
Analyzer Setup dialog by clicking the Pod button and selecting the desired pod. Data is 
sampled at regular intervals but stored only when there is a signal transition across the 
threshold voltage level. The sampling period is 200 ps for this mode and cannot be changed. 

State Mode
Sampling

• U4154B supports two state speeds. By default, it supports the maximum state speed of 2.8 Gb/s. 
A "02G" license sets it to 4 Gb/s (2.5 GHz). These license options do not however control and set 
the timing speed of the U4154B module.

• Based on the license option that you have purchased for U4154B, the maximum available state 
speed of U4154B is automatically set. If the licensed speed is 2.8 Gb/s (default) and while 
acquiring data, the clock frequency is found to exceed the maximum state speed available, an 
error message is displayed and the data is discarded.

• The state sampling clock input is always from Pod1 of the U4154B module. In a multi-card set, 
the clock is allowed only on Pod1 of the master card. The master card is the middle U4154B 
module in a three-card set and the bottom U4154B module in a two-card set. You cannot use the 
signals from other pods clock inputs as the sampling clock inputs. The qualifiers can take clock 
signal inputs from the Pod 7, Pod 5, Pod 4, Pod 3 and Pod 2 on the clocking module. The clock 
can be used as a rising, falling, or both edge clock.

• U4154B supports Full channel (Master) and Dual sample clock modes. In both these modes, the 
sampling option is as per the state speed license acquired for U4154B.
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Timing Zoom Timing zoom collects additional high-speed timing data around the trigger of the logic analyzer. 
It uses a 256K-depth, 12.5 GHz timing analyzer to sample data every 80 ps on all channels. 
Timing zoom is available for all acquisition modes.

See Also • “Setting up the State Sampling Options in U4154B Logic Analyzer

• “Changing Advanced Probe Settings for Logic Analyzers

• “Setting up and Running Eyescans in Logic Analyzers

• “U4154B Logic Analyzer Specifications and Characteristics

• “Pod and Channel Naming Conventions in Logic Analyzer 

Setting up the State Sampling Options in U4154B Logic Analyzer

The U4154B state sampling speed matches your device under test's clock rate, from 100 Mb/s up to 
4 Gb/s.

The state sampling clock inputs let signals from the device under test specify when data should be 
captured.

U4154B provides the following two options for state mode speeds (2.8 Gb/s and 4 Gb/s) at which the 
state sampling clock matches input clock edges from the device under test.

• 2.8 Gb/s speed - This is the default state speed of U4154B. If, while acquiring data, the clock 
frequency is found to exceed this maximum available state speed, an error message is displayed 
and the data is discarded.

• 4 Gb/s speed - If you have the 02G license for U4154B module, then the maximum available state 
speed of U4154B is automatically set to 4 Gb/s.
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State Sampling Clock Mode

The state sampling clock mode specifies how the clock inputs are used for sampling. There are two 
state sampling clock modes to choose from:

• Master — all pods sampled on one master clock. 

• Dual Sample — one pod in the pod pair sampled on one master clock but with different delays. 
When you enable this clock mode, the next step is to set up the pod pairs that you want to be 
dual sampled in the Busses/Signals tab of the Analyzer Setup dialog box (see “To set up the dual 
sample sampling clock mode" on page 116). Data on the active pod in a dual sampled pod pair is 
sampled twice (as master sample and second sample).

The pods for which you select the dual sample mode have their associated clock bit also dual 
sampled. The active clock bit of the pods in a dual sampled pod pair is the clock bit of the selected 
active pod in that pod pair. Notice that in the following screen, the clock channels of the dual sample 
pod pair (pod 1.3 and pod 1.4) are also dual sampled. These dual sampled clocks are represented as 
13 M or C3M and 13 S or C3S (C3 Master Sample and C3 Second Sample).

For instructions on setting up these state sampling clock modes, see:

• “To set up the master only sampling clock mode" on page 114

• “To set up the dual sample sampling clock mode" on page 116

State Sampling Clock and Qualifiers

In U4154B, only one state sampling clock is provided. The state sampling clock is the clock of Pod 1 
of the U4154B module. In a multi-card set, the clock is allowed only on Pod1 of the master card. The 
master card is the middle U4154B module in a three-card set and the bottom U4154B module in a 
two-card set. You cannot use the signals from the other pods clock inputs as the sampling clock 
inputs. To know which card is the master card in the set, click System Summary button in the 
Busses/Signals tab of the Analyzer Setup dialog box.

You can choose the sampling to occur on rising, falling, or both edges of the input clock signal. 

There are following five qualifiers available for the state clock. You cannot use the signals from the 
other pods clock inputs as the sampling clock qualifiers. You can use the "AND"/ "OR" conditional 
operators with these state clock qualifiers to add conditions and completely describe the clock as a 
combination of edges and highs or lows.
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The following are some points to remember when using the clock qualifier to Pod 7:

• This qualifier is only available when other clock qualifier(s) are used as “OR” qualifiers.

• This qualifier is only an “AND” qualifier. The Clock Description equation therefore, always adds the 
Ck7 as an AND condition. For example:   Ck1^ AND (Ck4=0 OR Ck5=1) AND Ck7=1.

• Setup and hold of Pod 7 qualifier will be larger than other clock qualifiers.

In the following screen, the clock channel (Clk1) of pod 1 of the master card is used as the sampling 
clock. Clk2 and Clk3 are used as the OR'ed qualifiers along with Clk7 as the AND qualifier. 

Determining Optimal Sample Positions and Thresholds

In the state sampling acquisition mode, you need to adjust the sampling positions on each U4154B 
channel relative to the sampling clock to make sure data is sampled when it is valid.

You can use the eye scan feature of the U4154B Logic Analyzer to automatically determine and set 
the optimal sample positions and thresholds for the individual signals. Clicking the Eye scan: Sample 
Positions and Threshold button in the Sampling tab displays the Eye Scan - Sample Positions and 
Threshold Settings dialog box where you can set up and run the eye scan measurement for U4154B 
channels. Refer to the topic “Setting up and Running Eyescans in Logic Analyzers" on page 567 to 
learn more.

See Also • To set up the state sampling clock

• “Pod and Channel Naming Conventions in Logic Analyzer" on page 561

16850-Series Logic Analyzer Notes

• Channels and Memory Depth 

• Maximum State Sampling Speed 

• Timing Mode Sampling Options/Period 

• State Mode Sampling Options 

• Timing Zoom

Clock qualifier Pod input Description

Pod 2 Can be used as “AND” or “OR” clock qualifiers

Pod 3 Can be used as “AND” or “OR” clock qualifiers

Pod 4 Can be used as “AND” or “OR” clock qualifiers

Pod 5 Can be used as “AND” or “OR” clock qualifiers

Pod 7 The “RESET” clock qualifier input on pod 7 is available as an “AND” input only when other 
clock qualifiers are set up as “OR” inputs. One situation in which this clock qualifier is 
particularly useful is to capture “RESET” when the other clock qualifiers are looking for CKE. 
This qualifier allows you to create OR qualification of upto 4 DDR memory CKE clock 
qualifiers along with an AND qualified with RESET.
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Channels and
Memory Depth

See also Memory Depth and Channel Count Trade-offs (see page 363).

Maximum State
Sampling Speed

Timing Mode
Sampling

Options/Period

• Full channel, 2.5 GHz = Full Channel Timing Mode

With this sampling option, you can use the full memory depth of your logic analyzer, with data 
sampling period on all channels as 400 ps to 10 ns. You can set the sample rate to go slower with 
the Sample Period field.

• Half channel, 5 GHz = Half Channel Timing Mode

With this sampling option, only one pod of each pod pair is available, and the memory depth is 
doubled. Channels assigned to unavailable pods are ignored. You can specify which pod to use in 
the Buses/Signals tab of the Analyzer Setup dialog by clicking the Pod button and selecting the 
desired pod.

Data sampling period is 200 ps and is fixed.

• Transitional / Store qualified, Full channel 2.5 GHz / Half channel 5.0 GHz  = Transitional / Store 
Qualified Timing Modes

At the 2.5 GHz sample rate, one pod pair (34 channels) must be reserved for time tag storage. At 
slower sample rates, you can get full channels by using 1/2 (or less) of a module's acquisition 
memory depth (for more information, see Memory Depth and Channel Count Trade-offs (see 
page 363)).

Transitional / Store Qualified Timing mode provides maximum duration of acquisition because 
data is only stored when a change from the last value is detected. The sampling period ranges 
from 10 ns to 400 ps for full channel mode and is fixed at 200 ps for half channel mode. (see 
page 365).

Timing Zoom Timing zoom collects additional high-speed timing data around the trigger of the logic analyzer. It 
uses a 256 K-sample, 12.5 GHz timing analysis sample rate to sample data at a sampling period of 
80 ps.

See Also • 16850 Series Logic Analyzer Specifications and Characteristics (see page 600)

Default Option 004 Option 008 Option 016 Option 032 Option 064 Option 128

Memory depth 2 M 4 M 8 M 16 M 32 M 64 M 128 M

Channels *Memory depth upgrades for the 16850 Series logic analyzers can be ordered by appending the relevant 
memory option number to the following upgrade model numbers:
16851AU, 16852AU, 16853AU, 16854AU
For instance, 16851AU-008 to upgrade to 8M samples.
(See also Installing Licensed Hardware Upgrades.)

16851A 16852A 16853A 16854A

Channels 34 68 102 136

Default Option 700*

Max. state clock rate 350 MHz 700 MHz

Max. state data rate 700 Mb/s 1400 Mb/s 

*State sampling speed upgrade for the 16850 Series logic analyzers can be ordered by appending the -700 option number to the 
following upgrade model numbers:
16851AU, 16852AU, 16853AU, 16854AU
(See also Installing Licensed Hardware Upgrades (see page 139).)



Keysight Logic and Protocol Analyzer User Guide 555

Reference 13

16860-Series Logic Analyzer Notes

• Differences from Other Logic Analyzers

• Channels and Memory Depth

• Timing Mode Sampling Options/Period

• State Mode Sampling Options

• State Sampling Clock Modes

• State Sampling Clock(s)

• State Sampling Clock Qualifiers

• Timing Zoom

Differences from
Other Logic

Analyzers

Compared to other Keysight logic analyzers supported in earlier releases, the 16860-series logic 
analyzers differ in the following ways:

• Supports two state sampling options - Single Clock and Multiple Clocks. 

• The Single Clock option provides a single master clock and supports the state mode sampling 
speed ranging from 12.5 Mega samples per second to 700 MHz (with "700" state speed license 
option). 

• The Multiple Clocks mode provides up to four clocks and is a low speed option more suitable for 
general-purpose logic analysis with state mode sampling speed ranging from 0 Mega samples 
per second to 350 MHz.

To know more about these two state sampling options, refer to the topic Selecting the State 
Sampling Option for a 16860-Series Logic Analyzer.

• Supports two state speeds. The default state speed is 350 MHz. The maximum state speed 
supported is 700 MHz (1.4 GSa/s). The "700" license sets it to 700 MHz. This license option does 
not however control and set the timing speed of the 16860-series logic analyzer.

• Supports the Master, Master/Slave/Demux, and Dual Sample clock modes. The availability of 
these clock modes depend on the state sampling option (Single Clock or Multiple clocks) that you 
have selected for your logic analyzer. 

• Supports a new 10 GHz Timing (Asynchronous) sampling option - Quarter Channel Timing Mode. This 
option is only available on 16862A (68 channels) and !6864A (136 channels) models in the 
16860-series of logic analyzers. Also, the "T10" license of 16860-series logic analyzer is required 
for this timing mode.

• Allows you to set the sampling positions for all Timing (Asynchronous) sampling options using the 
Signal Deskew tool.

• Supports Clock hysteresis for the state sampling clock on Pod1 of the 16860-series logic analyzers. 
Using this feature, you can set a value (in milliVolts) between 0 and 1 volts around the clock 
threshold. This allows you to avoid false sampling on noisy clock inputs where a differential clock 
input turns off and floats to zero volts. Refer to the topic  Setting Clock Hysteresis for the State 
Sampling Clock to know more.

• Does not support multiframe capabilities. 

• In a 16860 setup, you can load a .xml Logic Analyzer configuration file that you created/previously 
saved in a 16850-series, U4154A, or U4154B setup. You cannot, however load a Standard 
configuration (.ala) file that you created/previously saved in a 16850-series, U4154A, or U4154B 
setup.

Channels and
Memory Depth

Four models of the 16860-series logic analyzers are available. The number of channels available in 
each of these models is given below.



13 Reference

556 Keysight Logic and Protocol Analyzer User Guide

Timing Mode
Sampling

Options/Period

16861A 16862A 16863A 16864A

Channels 34
(32 data channels  and 2 
clock channels)

68
(64 data channels and 4 
clock channels)

102
(96 data channels and 6 
clock channels)

136
(128 data channels and 8 
clock channels)

The number of channels and pods available are also impacted by the Timing mode sampling option that you select or on selecting the Dual Sample clock mode.

16860-Series Memory Depth 
License Options

For State (Synchronous) 
Sampling Modes

For Timing (Asynchronous) Sampling Modes

Full Channel Half Channel Quarter Channel

Standard memory 2 M 2 M 4 M 8 M

Option 004* 4 M 4 M 8 M 16 M

Option 008* 8 M 8 M  16 M 32 M

Option 016* 16 M 16 M 32 M 64 M

Option 032* 32 M 32 M 64 M 128 M

Option 064* 64 M 64 M 128 M 256 M

Option 128* 128 M 128 M 256 M 512 M

Option 200*
(Available only in the Single 
Clock State Sampling option)

200 M 200 M 400 M 800 M

Option 400*
(Available only in the Single 
Clock State Sampling option)

400 M 400 M 800 M 1.6 G

* You can order Memory depth upgrades for the 16860-series logic analyzers by appending the relevant memory option number to the following upgrade model 
numbers:
16851AU, 16852AU, 16853AU, 16854AU
For instance, 16851AU-008 to upgrade to 8M samples.
(See also Installing Licensed Hardware Upgrades.)
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Timing Mode Sampling Option Description

Full channel, 2.5 GHz
(Full Channel Timing Mode)

Maximum acquisition rate supported in this option - 2.5 GHz.
With this timing mode sampling option:
• You can use the full memory depth of your logic analyzer.
• Data sampling period ranging from 400 ps to 10 ns. You can set the sample period using the Sample Period field.
• All the pods of the logic analyzer are available.
• All the clock channels are available.

Half channel, 5.0 GHz
(Half Channel Timing Mode)

Maximum acquisition rate supported in this option - 5.0 GHz.
With this timing mode sampling option:
• The memory depth is double the available depth (refer to the Memory Depth table above).
• Data is sampled and stored every 200 ps; this rate cannot be changed.
• Only odd pod of a pod pair is available that is, Pod 1, 3, 5, and 7.
• Channels assigned to the unavailable even pods are ignored.
• Clock channels are reduced to half of the total available clock channels and are for only odd pod of each pod 

pair.

Quarter channel, 10 GHz
(Quarter Channel Timing Mode)

Maximum acquisition rate supported in this option - 10.0 GHz.
This timing mode sampling option is only available:
• If you have the 16862A or 16864A model of logic analyzer.
• if you have installed the T10 Speed license option of the 16860-series logic analyzer.
With this timing sampling option:
• The memory depth is four times the available depth (refer to the Memory Depth table above).
• Data is sampled and stored every 100 ps; this rate cannot be changed.
• Only odd pod of a pod pair is available that is, Pod 1, 3, 5, and 7.
• Only even channels (0, 2, 4, 6, 8, 10, 12, 14) for each odd pod are available.
• Clock channels are reduced to one-fourth of the total available clock channels and are for only odd pod of each 

pod pair.

Transitional / Store Qualified Timing Mode This timing mode sampling option provides the maximum duration of acquisition because data is only stored when a 
change from the last value is detected. Data is sampled at regular intervals but stored only when there is a signal 
transition across the threshold voltage level. See transitional timing. Three sampling options are available in this 
mode:
• Transitional / Store qualified, (Full channel mode), 2.5 GHz
• Transitional / Store qualified, (Half channel mode), 5.0 GHz
• Transitional / Store qualified, (Quarter channel mode), 10.0 GHz - Available only when you have installed the T10 

timing speed license and the logic analyzer model is either 16862A or 16864A.

NOTE
For the 16860-series logic analyzers, you can set the sampling positions for the Timing mode 
sampling options as well. You use the Signal Deskew Tool to accomplish this. Refer to the 
online help available with this tool's GUI to know more.
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State Mode
Sampling Option

16860-series logic analyzers support the following two state speeds. Based on the state speed 
license option that you have purchased for your logic analyzer, the maximum available state speed of 
your logic analyzer is automatically set.

State Sampling
Clock Modes

The state sampling clock mode specifies how the clock inputs are used for sampling. The clock 
modes available for a 16860-series logic analyzer depends on the state sampling option (Single clock 
or Multiple Clocks) that you selected. 

State Sampling Option Description

Single Clock Faster state mode sampling speeds are supported, but some triggering and advanced clocking features 
are not available.
Refer to the table below to know about the maximum acquisition rate available in the Single Clock 
sampling option.

Multiple Clocks Advanced clocking capabilities and multiple clocks are supported, but at a slower state sampling speed.
Refer to the table below to know about the maximum acquisition rate available in the Multiple Clocks 
sampling option.

Refer to the topic Selecting the State Sampling Option for a 16860-Series Logic Analyzer to get a comparison between these two sampling options and 
to know how these options are used in the context of a 16860-Series Logic Analyzer.

State Speed License Option Maximum Acquisition Rate

In Single Clock State Sampling Option In Multiple Clock State Sampling Option

Standard (Default) State Speed
350 MHz (700 Mb/s)

Captures a 350MHz signal on either edge of the clock  up 
to 350 MSp/s 
Captures a 350MHz signal on both edges of the clock up 
to 700 MSp/s 

Captures a 350MHz signal on either edge of the clock up to 350 
MSp/s 
Captures a 350MHz signal on both edges of the clock up to 700 
MSp/s 

Option 700*
700 MHz (1.4 Gb/s)

Captures a 700MHz signal on either edge of the clock up 
to 700 MSp/s 
Captures a 700MHz signal on both edges of the clock up 
to 1400 MSp/s 

Captures a 350MHz signal on either edge of the clock up to 350 
MSp/s 
Captures a 350MHz signal on both edges of the clock up to 700 
MSp/s 

*State sampling speed upgrade for the 16860 Series logic analyzers can be ordered by appending the -700 option number to the following upgrade model numbers:
16861AU, 16862AU, 16863AU, 16864AU
(See also Installing Licensed Hardware Upgrades.)

Clock Modes Available for the Single Clock 
Sampling Option

Clock Modes Available for the Multiple Clocks 
Sampling Option

Master
Dual Sample

Master
Master/Slave/Demux 

For a detailed description of these clock modes, refer to the topics:
• Master
• Dual Sample
• Master/Slave
• Demux
For information on how to set up these clock modes, see:
• To set up the master only sampling clock mode
• To set up the dual sample sampling clock mode
• To set up the master/slave sampling clock mode
• To set up the demultiplex sampling clock mode
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State Sampling
Clock(s)

The 16860-series logic analyzers support both Single and Multiple clocks sampling options. 
Therefore, you can set up a single or multiple state sampling clocks. 

• In case of a single clock, the state sampling clock input is always from Pod1 of the logic analyzer. 

• In case of multiple clocks, the state sampling clock input can be from multiple Pods (Pod1, 2, 3, 
and 4) of the logic analyzer in an Ored combination.  

To know how to set up a single or multiple clocks, refer to the topic To set up the state sampling 
clock.

When setting up multiple clocks, you can also use the Advanced Clocking feature to define complex 
clock descriptions. 

State Sampling
Clock Qualifiers

For a Single Clock

The clock qualifiers can take clock signal inputs from the following pods of logic analyzer.

The following are some points to remember when using the clock qualifier on Pod 7:

• This qualifier is only available when other clock qualifier(s) are used as OR qualifiers.

• This qualifier is only an AND qualifier. The Clock Description equation therefore, always adds the 
Ck7 as an AND condition. For example:   Ck1^ AND (Ck4=0 OR Ck5=1) AND Ck7=1

• Setup and hold of Pod 7 qualifier will be larger than other clock qualifiers.

For multiple clocks

The clock qualifiers can take clock signal inputs from the following pods of logic analyzer.

16861A  16862A/16863A 16864A

One clock qualifier (Pod 2)  Three clock qualifiers (Pod 2, 3, 4) Five clock qualifiers (Pods 2, 3, 4, 5, and 7)

You cannot use the signals from the other pods clock inputs as the sampling clock qualifiers.

Clock qualifier Pod input Usage

Pod 2 Can be used as AND or OR clock qualifier

Pod 3 Can be used as AND or OR clock qualifier

Pod 4 Can be used as AND or OR clock qualifier

Pod 5 Can be used as AND or OR clock qualifier

Pod 7 The RESET clock qualifier input on pod 7 is available as an AND input only when other clock qualifiers are set up as OR 
inputs. One situation in which this clock qualifier is particularly useful is to capture RESET when the other clock qualifiers 
are looking for CKE. This qualifier allows you to create OR qualification of upto 4 DDR memory CKE clock qualifiers along 
with an AND qualified with RESET.

16861A  16862A,/16863A/16864A

One clock qualifier (Pod 1 or 2) Up to two clock qualifiers (Pod 1, 2, 3, 4) 
Though three clock qualifiers are displayed for use, you can set up to 2 clock qualifiers for a clock.

You cannot use the signals from the other pods clock inputs as the sampling clock qualifiers.
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Determining
Optimal Sample

Positions and
Thresholds

In the state sampling acquisition mode, you need to adjust the sampling positions on 16860 channels 
relative to the sampling clock to make sure data is sampled when it is valid.

You can use the eye scan feature of the 16860 Logic Analyzer to automatically determine and set the 
optimal sample positions and thresholds for the individual signals. Clicking the Eye scan: Sample 
Positions and Threshold button in the Sampling tab displays the Eye Scan - Sample Positions and 
Threshold Settings dialog box where you can set up and run the eye scan measurement for 16860 
channels. Refer to the topic Setting up and Running Eyescans in Logic Analyzer to learn more.

Timing Zoom Timing zoom collects additional high-speed timing data around the trigger of the logic analyzer. It 
uses a 256 K-sample, 12.5 GHz timing analysis sample rate to sample data at a sampling period of 
80 ps.

Selecting the State Sampling Option for a 16860-Series Logic Analyzer

The state sampling option that you select specifies the speed up to which the state mode sampling 
clock will match input clock edges from the device under test. 

The following table describes and compares the state sampling options that you can set for a 
16860-series logic analyzer. 

 State Sampling Options Single Clock, Full Channel, 700MHz to 12.5 MSps Multiple Clocks, Full channel, 350MHz to 0 MSps

Usage Faster state mode sampling speeds are supported, but some 
triggering and advanced clocking features are not available.
More suitable for DDR/LPDDR data captures with high data 
rates.

Default option
Supports slower state sampling speeds but allows advanced 
clocking capabilities and multiple clocks.
More suitable for general-purpose logic analysis.

State Sampling Speeds 
Supported

700MHz to 12.5 MSps (if state speed option 700 is installed)
350MHz to 12.5 MSps (if state speed option 700 is NOT installed)
Note: An error message is displayed if the input clock edges from 
the DUT are outside the lowest and highest speed range allowed 
in this option. In such a situation, measurements are not 
collected. 

350 MHz to 0 MSps (with or without the state speed option 700 
installed)
Note: A warning message is displayed if the input clock edges 
from the DUT are faster than the highest speed allowed in this 
option. In such a situation, measurements are still available but 
there is a risk of some missing data. You can use the Single 
Clock option in such a situation.

Maximum Acquisition Rate At the 350MHz state sampling speed:
Captures a 350MHz signal on either edge of the clock up to 350 
MSp/s 
Captures a 350MHz signal on both edges of the clock up to 700 
MSp/s 
At the 700MHz state sampling speed:
Captures a 700MHz signal on either edge of the clock up to 700 
MSp/s 
Captures a 700MHz signal on both edges of the clock up to 1400 
MSp/s 

At the 350MHz state sampling speed:
Captures a 350MHz signal on either edge of the clock up to 350 
MSp/s 
Captures a 350MHz signal on both edges of the clock up to 700 
MSp/s 
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Pod and Channel Naming Conventions in Logic Analyzer

In U4154A/B Logic Analyzer module:

• Slots are named "1" through "5" in the Keysight AXIe chassis starting with the bottom slot.

• A U4154A/B module installed in a slot has eight pods. These pods are named "1" to "8".

• A U4154A/B pod is represented as <Slot_number_of_module><Pod_number>. For instance, Slot 
1 Pod 2 represents the Pod 2 of the U4154A/B module that you installed in slot 1 of chassis. This 
pod is also referred to as Pod 1.2 in Logic Analyzer GUI.

• Each pod has 16 data channels named "0" through "15". Pod 2.8[11] represents the channel 11 of 
the Pod 8 of the module installed in slot 2.

Number of Clocks Supported Single clock (Always on Pod1 of the logic analyzer) Up to 2 clocks (in an Ored combination)  for a 16861A logic 
analyzer.
Up to 4 clocks (in an Ored combination) for a 16862A/3A/4A 
logic analyzer. Master and slave clocks are counted separately. 
Refer to the topic To set up the state sampling clock to know 
about setting multiple clocks.

State Sampling Clock Modes 
Supported

Master
Dual Sample

Master
Master/Slave
Demux

Advanced Clocking 
Capabilities

Not supported Supported
You can specify complex clock setups with the available clock 
channels used both as an edge and a qualifier in the same 
clock description. 
Refer to the topic Advanced Clocking Setup dialog to know 
more.

Clock Qualifiers Maximum of five clock qualifiers (Pod 2, 3, 4, 5, 7) for the 16864A 
model. 
Maximum of three clock qualifiers (Pod 2, 3, 4) for the 
16862A/3A models.
Maximum of one clock qualifier (Pod 2) for the 16861A model.

Maximum of two clock qualifiers (Pod 1, 2, 3, 4) for the 
16862A/3A/4A models.
Note: Though there are three clock qualifiers displayed, you 
can use a maximum of only two qualifiers for a clock. The third 
qualifier is automatically set to "Don't Care" and can be used 
only as an Ored clock in the clock description.
Maximum of one clock qualifier for the 16861A model.

Triggering Capabilities 
Differences

Number of trigger sequences - 8
Burst patterns supported - Yes
Number of timers - 1
Global counters supported - No
Event counters supported - Yes

Number of trigger sequences - 16
Burst patterns supported - No
Number of timers - 3
Global counters supported - 2
Event counters supported - No

The logic analysis features that are not included in this table work the same in Single clock and Multiple Clocks options. 

 State Sampling Options Single Clock, Full Channel, 700MHz to 12.5 MSps Multiple Clocks, Full channel, 350MHz to 0 MSps
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• Each pod has one clock channel making it a total of eight clock channels for a U4154A/B module. 
These clock channels are named C1 through C8. If you have installed multiple U4154A/B module 
in an AXIe chassis, then the clock channels of the next U4154A module are named C9 through 
C16 and so on for the rest of the modules in the set. The following is an example of the clock 
channels naming convention in U4154A/B.

The clock channel of Pod 8 of the U4154A/B module installed in slot 1 is represented as:

• 18  

• Clk8 

• C8

Similarly, the clock channel of Pod 4 of the U4154A/B module installed in slot 2 is represented as:

• 24  
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• Clk12 

• C12

The input from the clock channel of Pod 1 is used as the state sampling clock input. If you have 
installed multiple U4154A/B cards in chassis, then the clock of Pod 1 of the master card in the set 
is used as the state sampling clock. For instance, if there are five cards in the set, then the third 
card from the bottom is the master card. The clock of Pod 1 of this card is the state sampling 
clock. 

Changing Advanced Probe Settings for Logic Analyzers

You can change the settings for the probes used with the logic analyzers. You can enable peaking for 
channels of these logic analyzers to compensate for the additional high frequency attenuation that 
some probing solutions provide on target signals. Enabling the peaking can improve the capture 
window of the input signals by peaking the edges of the input signals. This is particularly useful in 
situations when the additional attenuation on target signals becomes significant at high frequencies 
and DDR3 edge rates.

When you enable peaking with the DDR3 Eyefinder tool, it can increase the capture window for the 
data signals therefore providing increased accuracy for capturing the data. (The DDR3 Eyefinder tool 
helps you set the appropriate sampling positions for read and write data signals to capture DDR 
data. it is specifically designed to find DDR3 data signal eyes.)

It is recommended that you run the DDR3 Eyefinder tool on the high-speed target systems with the 
peaking enabled and then disabled to determine the setting that best suits the target system.

To change probe settings, you must first enable the probe settings and then adjust these settings. 
These procedures are described below.

To enable Advanced Probe Settings (APS) for the Logic Analyzer Module

1 From the menu bar, select Edit > Options.

2 In the Options dialog, select the Enable Advanced Probe Settings (APS) checkbox.

3 Click OK.

CAUTION
Changing the peaking settings can improve or reduce the performance of the probing system. For 
instance, if the DDR BGA Interposer probe is used at speeds of DDR3-1600 or higher, enabling the 
peaking results in improving the capture window.

NOTE
The advanced probe settings feature is supported for U4154A/B, U4164A, and 16850-series logic 
analyzers.
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On enabling the advanced probe settings in the Options dialog, the APS button is added to the 
Buses/Signals tab of the Analyzer Setup dialog of the logic analyzer module. You can use this button 
to view and change the advanced probe settings.
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To change the Advanced Probe Settings for the Logic Analyzer Module

1 From the menu bar, select Setup > Bus/Signal.

2 In the Buses/Signals tab of the Analyzer Setup dialog, click the APS button.

The Advanced Probe Settings dialog is displayed. All the logic analyzer cards that you installed 
in different slots of the chassis to make up the logical module are displayed. On expanding a slot, 
the pods available for that logic analyzer card are displayed. Each pod further expands to the 
supported channels per pod. The following screen displays the advanced probe settings dialog 
for the U4154A/B logic analyzer. In this screen, the logical module comprises of two U4154A/B 
modules installed in slot A and B of the AXIe chassis. For each U4154A/B, there are eight pods 
available. Each of these pods expands to 16 data channels and 1 clock channel. 
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3 You can choose to enable the peaking at the channel/pod/slot/logical module level by selecting 
the checkbox displayed with these options. By default, peaking is disabled at all these levels.

4 Click OK.

Setting Clock Hysteresis for the U4164A State Sampling Clock

You can set the Clock hysteresis feature On or Off for the state sampling clock on Pod1 of the 
U4164A module. Using this setting, you can set a value (in milliVolts) between 0 and 1 volts around 
the state sampling clock threshold. This allows you to avoid false sampling on noisy clock inputs 
where a differential clock input turns off and floats to zero volts. 

If you set Hysteresis to On, then in the event of your clock input going to zero volts, the problems 
related to the false clock signals due to noise on the clock and clock edges being too close together 
are eliminated. With the Hysteresis feature set to On, the Analyzer recognizes the clock signals only 
when the clock differentially exceeds the Hysteresis value that you specified thereby avoiding false 
clock signals. 
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1 Click the Clock Thresholds button displayed in the Buses/Signals tab of the Analyzer Setup 
dialog box.

2 The Threshold Settings for Clock Channels dialog box is displayed. You can set the Hysteresis 
feature On or Off using the Hysteresis On checkbox displayed for the state sampling clock, that is, 
the clock on Pod1.

3 Specify a value for Clock Hysteresis in the field next to the Hysteresis On checkbox. You can set a 
value between 0 to 1 V. 

4 Click Done.

Setting up and Running Eyescans in Logic Analyzers

NOTE
The Clock hysteresis feature is available only for the U4164A and 16860-series logic analyzers. 
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The U4154A/B logic analyzer allows you to set up and run eyescans for automatically adjusting the 
state mode sampling positions and threshold voltages of address and control signals so that data is 
sampled when it is valid. This topic describes how you can set up and run the eyescan measurements 
when using the U4154A/B Logic Analyzer.

For U4154A/B, you can set the sampling positions and threshold voltages for signals in an eyescan 
measurement and then run the measurement to allow U4154A/B logic analyzer to find out and 
suggest optimal sample positions and threshold voltages for these signals. You can then choose to 
set the sampling position and threshold voltages suggested in the eyescan run or manually adjust 
these settings based on the suggested values.

When you run an eyescan measurement, logic analyzer determines the threshold voltage that results 
in the widest possible data valid window by examining the signals from the DUT. Then logic analyzer 
determines the location of the data valid window in relation to the sampling clock, and suggests the 
ideal threshold voltage and sampling position. 

Eyescan sets the sample position on individual channels of U4154A/B and therefore, is an easy way 
to get the smallest possible logic analyzer setup/hold window to accurately capture data.

You use the Eye Scan - Sample Position and Threshold Settings dialog box to set up and run 
eyescan measurements for U4154A/B channels. The following screen displays this dialog box with 
five predefined eyescan measurements - Clock, Chip Select, Command and Address, Data Read, and 
Data Write. The eyescan results of the Command and Address eye scan measurement is shown. The 
eyescan diagram is displayed for channel 1 of pod 1.1 mapped to a signal named COMMAND.
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Creating an eyescan measurement 

In an eyescan measurement, you:

• select buses/signals on which you want to run the eyescan measurement. For these 
buses/signals, you can select either all or specific U4154A/B channels mapped to these 
buses/signals.

• set the sample positions and thresholds for the selected signals.

• select the eyescan parameters including the type of eyescan run.

Before creating an eyescan measurement

Ensure that you have:

1 Connected the U4154A/B logic analyzer channels to the appropriate signals on the DUT to probe 
the DUT.

2 Assigned bus/signal names and mapped the names to the U4154A/B channels that you used in 
step1. You use the Buses/Signals tab of the Analyzer setup dialog box to do this.

3 If you already set the threshold voltages for channels in the Buses/Signals tab, then these 
settings will be displayed as the current threshold settings in the eyescan setup.
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4 Selected the state (synchronous sampling) mode.

5 Set the state sampling clock options. (see Setting State Sampling Options in U4154A/B)

To create an eyescan measurement

1 Click the Eye Scan: Sample Positions and Thresholds button in the Sampling tab of the Analyzer 
setup dialog box.

The Eye Scan - Sample Position and Threshold Settings dialog box is displayed. 

2 A Default Measurement is displayed with the currently mapped buses/signals and channels. For 
each channel, the current threshold voltage and sample position is displayed. You can either 
rename this measurement by right-clicking this measurement and selecting Rename. Or you can 
create a new measurement by clicking the  Add New Measurement toolbar button.

3 Click the tab of the new measurement that you created.

4 Assign signals/buses to this measurement so that eyescan is run on the assigned signals only. To 
do this:

a Click  Assign Buses / Signals to Measurements toolbar button. 

b All the buses/signals that you created in the Analyzer setup dialog box are displayed. You can 
expand these to display the mapped U41554A channels. 

c Select the checkbox displayed with a bus/signal on which you want to run the eyescan. This 
selects all the channels that are a part of the bus/signal. Alternatively, you can select 
individual channels from the different buses/signal names by selecting the checkbox displayed 
with a channel.

d Click OK.

5 All the signals that you selected are now displayed in the measurement tab. The current 
threshold type, threshold voltage, and sample position settings are also displayed for each of 
these signals. These settings are editable. If needed, you can edit these settings. 

6 Click Edit to customize the eyescan run options. 
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7 Select the appropriate scan options and click OK.

After you have created an eyescan measurement, you can edit the measurement to customize how 
you want the U4154A/B Logic Analyzer to run the eyescan measurement. You do this by clicking Edit 
Current Measurement button in the Eye Scan - Sample Position and Threshold Settings dialog box. 
Refer to the topic Customizing an Eyescan Measurement to know more.

Creating multiple eyescan measurements

You can also create multiple eyescan measurements to use different eye scan parameters for 
different signals. For instance, you can create a measurement for control signals to perform a simple 
time scan and another one for data read and write signals to do a full time and voltage scan. 

NOTE
If you need to create multiple eye scan measurements, you can include a signal 
in only one of these measurements for setting the signal’s sample position. This 
ensures that you get the eye scan results for a signal in only that measurement. 
If you assign a signal that already exists in a measurement to another 
measurement, then the signal is automatically removed from the earlier 
assigned measurement. 
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Customizing an Eyescan Measurement

Once you have created an eyescan measurement, you can configure various settings in the Eye Scan 
- Sample Position and Threshold Settings dialog box to customize how you want the U4154A/B 
Logic Analyzer to run the eyescan measurement. For instance, you can set eyescan parameters such 
as the type of eyescan run or the eyescan resolution.

To customize an eyescan measurement, you edit the measurement by clicking Edit Current 
Measurement toolbar button  in the Eye Scan - Sample Position and Threshold Settings dialog 
box. On clicking this button, the following dialog box is displayed with various configurable eyescan 
options organized in different tabs.

Based on the combination of edit options that you select to customize the eye scan, an explanation 
of the expected eyescan results is displayed in the Eye Scan - Sample Position and Threshold 
Settings dialog box as follows. 

This topic describes some of the configurable options for eyescan.

Types of eyescans:

• Time scan only - This eyescan option performs a full time scan at the middle threshold voltage 
and suggests the optimal sample position. It sets the threshold voltage and sample positions 
based on the optimal values depending on whether or not you selected to lock the current 
threshold and sample position settings.
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• Time and voltage scan - This eyescan option finds the signal activity envelop and adjusts the 
threshold voltage to determine the optimal threshold voltage. Then it performs a full time scan at 
that threshold to suggest the optimal sample position. It sets the threshold voltage and sample 
positions based on the optimal values depending on whether or not you selected to lock the 
current threshold and sample position settings.

Locking the current settings

At times, you may want to run the eyescan to view the suggested optimal settings but do not want 
logic analyzer to automatically adjust your current settings based on the eyescan results. In such a 
situation, you can lock your current threshold and sample position settings to ensure that the 
eyescan run suggestions do not automatically alter your current settings. By locking the settings, you 
lock these for manual adjustments as well. If you do not lock these settings, then eye scan run 
automatically adjusts the current settings as per the suggested optimal settings. You can later 
choose to retain these adjusted settings or modify manually. The following screen displays these lock 
settings that are available in Edit Measurement dialog box.

Setting eyescan resolution

You can select the eyescan resolution that you want for the resulting scans. If you have the 02G 
license option for U4154A/B module, then you can select either Normal or High resolution for the 
scans. However, if you have the 01G license option for the U4154A/B module, then only the Normal 
resolution option is available. The High resolution option is disabled for 01G license. 

If you select the Normal option, you get a time resolution of 20 ps in scans. With the High resolution 
option, you get a time resolution of 4.8 ps in scans. 

The following screen displays these two resolution options.
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Configuring Unit Interval (UI) settings

There may be a situation when the eyes in which you want to set the sampling positions are outside 
of the adjustment range in the eyescan. In such a situation, you can configure the unit interval 
settings to move the signals left or right (in relation to the zero time) by Unit Interval (clock cycle) 
amounts. You can use the left and right arrow keys displayed in the Unit Interface Controls section to 
adjust the window on which the eyescan will be performed. The currently applicable scan window is 
represented by the green shaded area. Each mark to the left represents a whole clock cycle. Moving 
the slider to the left results in the data eyes moving left in the display after rerunning a scan. 

After configuring the unit interval settings, you must rescan and then set the sampling positions 
again.
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Running an Eyescan

After you have created an eyescan measurement and customized it to suit your specific 
requirements, you can run the eyescan measurement. This allows U4154A/B logic analyzer to 
determine and suggest optimal values for sample positions and thresholds. 

If you created multiple eyescan measurements, you can either run these measurements separately or 
as a sequential batch. In a sequential batch, the measurements are run in the same order in which 
these are displayed in the tabbed list. 

To run an eyescan measurement

1 Click the tab of the eyescan measurement that you want to run in the Eye Scan - Sample 
Position and Threshold Settings dialog box.

2 Click Run this measurement.

To run multiple eyescan measurements

1 Click Run All Sample Position Measurements in the Eye Scan - Sample Position and Threshold 
Settings dialog box.

Interpreting the eyescan results and eye diagrams

By performing full time and voltage scans, U4154A/B is able to give you a map of transitions 
detected in small windows of time and voltage. These scans are called eyescans. 

The eyescan results show:

• Suggested sampling positions and threshold voltages (green triangles).
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• The current sampling positions (vertical blue lines in stable regions, red lines in transitioning 
regions) and threshold voltages (horizontal blue lines in stable regions, red lines in transitioning 
regions).

• A digital "eye" diagram that represents many samples of data captured in relation to the sampling 
clock. The transitioning edges measured before and after the sampling clock result in a picture 
that is eye-shaped. Eye diagrams are used to display the measurement data. 

The following screen displays the results of a time and voltage eye scan run on the data read signals. 
The current settings have been automatically adjusted by the eye scan based on the optimal settings 
determined during the eye scan.

Adjusting sample positions and thresholds

Setting sample positions for all signals to their suggested positions

You can set the sample positions for all the signals included in a measurement to their suggested 
sample positions displayed in the eyescan results in a single click. To accomplish this, right-click the 
measurement and select the Set sample position only to suggested option. 
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You can also set the thresholds to their suggested threshold values by clicking the Set threshold only 
to suggested option. The Set to suggested option sets both the sample positions and thresholds to 
their suggested values. 

Adjusting/moving the sample positions manually

After viewing the eyescan results, if needed, you can mark the ideal sample position for each signal 
by manually moving the sample position markers in the eyescan. You do this:

• either by dragging and dropping the sample position markers to the required positions. 

• or by clicking on the required position. This automatically moves the marker to the clicked 
position. For this, you need to select the Click to move markers checkbox. By default, this 
checkbox is deselected.

While adjusting the sample positions, you may want to deselect the Snap marker to eye center 
checkbox to get greater control over the sample position placements. On deselecting this checkbox, 
the sample position markers are set exactly at the same position at which you dropped the marker or 
clicked. When this checkbox is selected, the sample position marker is set at the center of the eye 
irrespective of where you clicked or dropped the marker while moving it. 

If the eyes in which you want to set the sampling positions are outside of the adjustment range in the 
eyescan, you can configure the unit interval settings to move the signals left or right (in relation to 
the zero time) by Unit Interval (clock cycle) amounts. You can use the left and right arrow keys 
displayed in the Unit Interface Controls section to adjust the window on which the eyescan will be 
performed. The currently applicable scan window is represented by the green shaded area. Each 
mark to the left represents a whole clock cycle. Moving the slider to the left results in the data eyes 
moving left in the display after rerunning a scan. 

After configuring the unit interval settings, you must rescan and then set the sampling positions 
again.
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Scaling voltage axis for a signal or an entire bus

After you have run the eyescan measurement and acquired the eyescan data, you can scale the 
voltage axis for individual signals or an entire bus in that eyescan. When you scale the voltage axis 
for a bus, each child signal in that bus is scaled to the same value that you select.

Note: The scaling options are available only on a full time/voltage eyescan diagram. On a Time Only 
eyescan diagram, these options are not displayed as the eyescan data is time-only. Further, if you 
generated a full time/voltage eyescan diagram from a time-only scan, the scaling options will be 
displayed for use but not meaningful as the data is still time-only. Scaling provides meaningful 
results on a full time/voltage eyescan diagram that has been acquired by running a full time and 
voltage scan. 

To scale the voltage axis

1 In the displayed eyescan diagram, navigate to the signal or the bus for which you want to scale 
the voltage axis.

2 Right-click the signal or the bus. A context menu is displayed.
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3 To scale an entire bus, select the Scale voltage axis for entire bus to option. To scale an 
individual signal, select the Scale voltage axis for this signal to option.

4 A submenu is displayed with three scaling options that represent the value to be used to scale 
the signal(s). Select a menu option that suits your scaling requirement. You can select from:

• Current base threshold setting - Selecting this option scales the signal(s) using the base 
threshold voltage setting with which you run the eyescan measurement. This threshold setting 
is displayed in the Threshold column on the right of the diagram.

• Current data - Selecting this option scales the signal(s) using the voltage setting currently 
displayed in the acquired eyescan data.

• Custom setting - Selecting this option scales the signal(s) using the minimum and maximum 
voltage values that you specify when you select this menu option. 

The selected signal or the signals in the entire bus are then scaled to the selected value.

Exporting eyescan data to a .CSV file

After you have run the eyescan measurement, you can export the displayed eyescan data to a 
specified .csv file. 

To export eyescan data to a .csv file

1 Click the  Export Measurement Data to CSV File toolbar button in the Eye Scan - Sample 
Position and Threshold Settings dialog box. 

The Save As dialog box is displayed.

2 Specify the name and location of the .csv file to which you want to export the displayed eyescan 
data and then click Save.

Contents of the .csv file

In the CSV file, the eyescan data is exported for each signal that you included in the eyescan 
measurement. The following screen displays a sample .csv file in Excel with eyescan data for the 
MyBus1[0] signal.
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As displayed in the above screen, the .csv file contains information in the following two sections for 
each of the mapped bus/signal and channel that you included in the eyescan measurement.

• General information on signal and scan - This section displays:

• Signal_Info - The name of the signal and mapped channel followed by the name of the parent 
bus name, the numerical index of the signal within the bus, the U4154A/B pod which contains 
the signal, and the bit index within that pod.

• Scan_start_date - The date at which the eye scan was started.

• Scan_start_time - The time at which the eye scan was started.

• Threshold_scan - Displays True if a full time/voltage scan was performed and False if only a 
time scan was performed.

• tMin, tMax, and tRes - Represent the minimum time, maximum time, and time resolution (step 
size).

• vMin, vMax, and vRes - Represent the minimum voltage, maximum voltage, and voltage 
resolution.

• nCols and nRows - The number of columns and rows of eyescan data displayed in the .csv file 
for the signal.

• Eyescan data (eye_scan_data) - In this section, the eyescan data for the signal is displayed for 
various voltage/time points. Rows in this section represent voltage points and columns represent 
time points in the scan. The first row in this section shows the scan data for the minimum voltage 
in the scan. The last row shows the scan data for the maximum voltage in the scan. The first cell in 
each of these rows is the earliest time in the scan. 

Each cell in the eyescan data section has a value that represents a hit probability (signal activity) 
for the time/voltage point that the row and column combination of the cell represents. The cells 
can have the following values:

• 0 - This value indicates that there was no signal activity at that voltage and time combination.

• -1 - This value indicates that no scan data was taken at that voltage and therefore all other 
values displayed in that row should be ignored. In the .csv file generated for a full eye scan, 
none of the rows in the eyescan data section start with -1 because all voltage values have 
been measured. 

• 1 - This value indicates that there was a hit (signal activity) at every clock (a rare situation).
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You can determine the voltage of a row in the eyescan data section by using the following 
formula:

vRow = vMin + (rowNum * vRes)

where rowNum is the 0-based index of the row.

You can determine the time for a column in the eyescan data section by using the following 
formula:

tCol = tMin + (colNum * tRes)

Modifying General or Target-specific Scan Qualification

You use the Scan Qualification tab in the Edit Measurement dialog box invoked from the Eye Scan - 
Sample Positions and Threshold Settings dialog box to modify the scan qualification for general as 
well as target-specific scans such as DDR scans. This tab displays different fields based on whether 
you are modifying scan qualification for a general or a target-specific scan. This topic describes how 
to use this tab to modify general or target-specific scan qualification.

General Scan Qualification

For generating general trigger specifications when using the U4154 module, the Scan Qualification 
tab displays only the Scan Qualification... button as displayed below.

When you click the Scan Qualification button, the Eyescan Trigger dialog box is displayed. Using this 
dialog box, you can specify a sequence of trigger conditions for a generalized eyescan measurement. 
These trigger conditions allow you to control when U4154A/B logic analyzer takes samples that are 
used in that eyescan for determining the optimal threshold and sample positions.



13 Reference

582 Keysight Logic and Protocol Analyzer User Guide

The eyescan trigger feature in U4154A/B is similar to the general trigger function of logic analyzer 
(for specifying when to capture data from DUT). However, an eyescan trigger has only one type of 
action (Goto <trigger step>) when the trigger condition is met.

DDR/LPDDR-specific Scan Qualification

Once you have created an initial DDR/LPDDR setup and set the initial sample positions using the 
DDR Setup Assistant tool, there may be situations when you want to modify the 
DDR/LPDDR-specific scan qualification parameters before running subsequent eyescans for 
DDR/LPDDR signals. In such situations, you use the Scan Qualification tab of the Edit Measurement 
dialog box invoked from the Eye Scan - Sample Positions and Threshold Settings dialog box. 

In a general eyescan usage scenario, the Scan Qualification tab displays a single button to modify a 
general trigger condition for scan qualification. However, when you load a DDR/LPDDR specific 
configuration file or an already saved DDR setup .ala file in the Logic Analyzer GUI, this tab displays 
DDR/LPDDR-specific scan qualification fields. By default, these fields display the values that you set 
while creating the initial DDR setup using the DDR Setup Assistant tool. You can modify these 
default values using this tab.

When you confirm and save the DDR-specific scan qualification settings, these settings are used to 
create a DDR trigger specification. The eyescan feature of the U4154A/B module then uses this 
trigger specification while performing subsequent eyescan runs to find DDR data signal eyes and set 
sample positions for DDR signals.

NOTE
The Scan Qualification tab is used to set/modify the scan qualification only when 
you are using the U4154A/B module for capturing DDR data.
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To modify the DDR-specific scan qualification

1 In the Keysight Logic Analyzer GUI, load the required DDR/LPDDR-specific configuration file for 
U4154A/B. (The default DDR/LPDDR configuration files are available if you have installed the 
DDR packages, Keysight Bus Decoder for DDR2 and DDR3 and Keysight Bus Decoder for LPDDR 
and LPDDR2. Also, you should have the appropriate software license to use these software 
packages.) 

OR

Open the Logic Analyzer configuration (.ala) file in which you saved the DDR setup (probes, 
module, tools, and windows) that you created using the DDR Setup Assistant tool.

2 Click the Sampling Setup link of the module displayed in the DDR setup.

The Sampling tab is displayed.

3 Ensure that the State - Synchronous sampling option is selected in the Sampling tab.

4 Click the Eye Scan: Sample Positions and Thresholds... button.

5 In the Eye Scan - Sample Position and Threshold Settings dialog box, select the tab for Chip 
Select, Command and Address, Data Read or Data Write to modify the scan qualification for the 
appropriate signals.

6 Click the Edit Current Measurement toolbar button.

7 Click the Scan Qualification tab.

8 Based on the signals tab you selected in step 5, the options are displayed in the Scan 
qualification interface listbox. Select one of the following options from this listbox:

• DDR/LPDDR Chip Select option - to modify the scan qualification for chip select signals.

• DDR/LPDDR Command and Address option - to modify the scan qualification for command 
and address signals.

• DDR Data Read option - to modify the scan qualification for data read signals.

• DDR Data Write option - to modify the scan qualification for data write signals.

On selecting the DDR/LPDDR Chip Select option in the previous step, the following fields are 
displayed for chip select scan qualification:
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9 For the DDR/LPDDR Chip Select signals, make the appropriate selections based on the active 
clock enable signals. 

On selecting the DDR/LPDDR Command and Address option in the step 8, the following fields 
are displayed for scan qualification:

10 For the DDR/LPDDR Command and Address signals, make the appropriate Memory 
Configuration selections based on the chip selects used in the DUT. 

On selecting the DDR/LPDDR Data Read or Data Write interface in step 8, the following fields are 
displayed for scan qualification:
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11 For DDR Data Read or Write signals:

a The DUT's Total Read / Write Latency value that you set up in the initial DDR setup is 
displayed. If needed, modify this value. To find an appropriate value of Total Read/Write 
Latency, you can set up the Mode Register Settings (MRS) trigger, take a trace, and scan it for 
latency values. Refer to the DDR Setup Assistant online help to know more on how to find 
latency values.

b In the Memory Configuration section, choose the appropriate Chip Select(s) for the memory 
path being traced.

c In the Burst Length field, specify the number of words read or written for each read/write 
command. To find appropriate value of Burst Length for the DUT, you can set up the Mode 
Register Settings (MRS) trigger, take a trace, and scan it for burst length. Refer to the DDR 
Setup Assistant online help to know how to find burst length.

d Select the appropriate scan mode:

• Eye Overlay Mode - Use this mode when setting sample positions for DDR data signals. In 
this mode, the eyescan feature of U4154A/B overlays the eyes for each bit in a burst in 
order to show a composite eye, without tri-state or noise, that helps you locate the best 
sample position.

NOTE
The latency values specified here represent the total latency for your system and therefore should 
include parameters that affect total latency. For instance, if your system has Additive Latency (AL), 
then you must include it in the Total Latency values. Similarly, if tDQSS or tDQSCK parameters are 
greater than one full clock cycle, then you must add these values (rounded to the nearest integer) 
in the Total Latency values.
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• Signal Trace Mode - Use this mode for viewing signal swing vs. time. Although sample 
positions can be checked and modified in this mode, it is generally not recommended. In 
this mode, the eyescan feature of U4154A/B overlays complete bursts in order to provide 
additional qualitative insight into the signal integrity on the DDR system at the logic 
analyzer probe location. In this mode, you can view how the bits in a complete burst 
compare to one another. When you select the Signal Trace Mode, the following three 
options are provided to you to select the data burst area to view:

• Beginning — Scans are made at the beginning of a data burst.

• Middle — Scans are made at the middle of a data burst.

• End — Scans are made at the end of a data burst.

12 Select the Capture and store all memory bursts radio button to capture and store back to back 
memory bursts.

13 Select the Do not store back-to-back memory bursts radio button to eliminate the "double eye" 
effect in scan results.

14 Click OK to confirm the settings.

You can save the modified scan qualification settings in the Logic Analyzer .ala or .xml 
configuration file.
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Specifications and Characteristics

Describes the specifications, characteristics, and requirements of supported logic analyzers and 
logic analysis systems.

• U4164A Logic Analyzer Specifications and Characteristics (see page 587)

• U4154A Logic Analyzer Specifications and Characteristics (see page 592)

• U4154B Logic Analyzer Specifications and Characteristics (see page 596)

• 16850-Series Logic Analyzer Specifications and Characteristics (see page 600)

• 16860-Series Logic Analyzer Specifications and Characteristics (see page 604)

See Also • What is a Specification (see page 611)

• What is a Characteristic (see page 611)

U4164A Logic Analyzer Specifications and Characteristics

Describes the specifications and characteristics of the U4164A logic analyzer.

• Module Channel Counts (see page 588)

• State (Synchronous) Analysis Mode (see page 588)

• Timing (Asynchronous) Analysis Modes (see page 590)

• Timing Zoom (Asynchronous) Analysis Modes (see page 590)

• Trigger Characteristics (see page 590)
• General (see page 591)

• Logic and Protocol Analyzer Software Compatibility (see page 592)

• Power Requirements (see page 592)

• Chassis Compatibility (see page 591)

• Environmental Characteristics (see page 592)

NOTE
Complete and up-to-date specifications and characteristics of the U4164A logic analyzer are 
available in the  U4164A Logic Analyzer Data Sheet (5992-1057EN) on the Keysight web site.

NOTE
Specification (spec): Represents warranted performance of a calibrated instrument that has been 
stored for a minimum of 2 hours within the operating temperature range, unless otherwise stated, 
and after a 45 minute warm-up period. The specifications include measurement uncertainty.

Typical (typ): Represents characteristic performance, which 80% of the instruments manufactured 
will meet. This data is not warranted, does not include measurement uncertainty, and is valid only 
at room temperature (approximately 25 °C).

Nominal (nom): The expected mean or average performance, or an attribute whose performance is 
by design, such as the 50 O connector. This data is not warranted and is measured at room 
temperature (approximately 25 °C).

Measured (meas): An attribute measured during the design phase for purposes of communicating 
expected performance, such as amplitude drift vs. time. This data is not warranted and is measured 
at room temperature (approximately 25 °C).
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Module Channel
Counts

State
(Synchronous)
Analysis Mode

Feature Description

Number of Channels (nom) 136 in one U4164A 
272 in two U4164As 
408 in three U4164As 

Maximum channels on 
single time base and trigger:

408

Feature For Single Cock For Multiple Clocks

Maximum state data rate 
Option 02G, 2.5 GHz state 
mode (spec)

2.5 Gb/s on 136 channels per U4164A, clocking on either or both 
edges of clock (spec)
4.0 Gb/s on 68 channels per U4164A, clocking on either edge of 
the clock (typ)
Suitable for DDR/LPDDR memory systems running up to 4.0Gb/s

Not Supported

Maximum state data rate 
standard -01G, 1.4 GHz 
state mode (spec)

2.5 Gb/s on 136 channels per U4164A, clocking on both edges of 
clock (spec)
1.4 Gb/s on 136 channels per U4164A, clocking on either edge of 
the clock (spec)
2.8 Gb/s on 68 channels per U4164A, clocking on either or both 
edges of the clock (typ)
Suitable for DDR/LPDDR memory systems running up to 2.5Gb/s

Not Supported

Maximum state data rate 
Option -700, 700 MHz state 
mode (spec)

1.4 Gb/s on 136 channels per U4164A, clocking on both edges of 
the clock (spec)
700 Mb/s on 136 channels per U4164A, clocking on either edge 
of the clock (spec)
1.4 Gb/s on 68 channels per U4164A, clocking on either or both 
edges of the clock (typ)
Suitable for DDR/LPDDR memory systems running up to 1.4Gb/s

Captures a 350MHz signal on either edge of the clock up to 
350 MSp/s (spec)
Captures a 350MHz signal on both edges of the clock up to 
700 MSp/s (spec)

Maximum state data rate 
Option -350, 350 MHz state 
mode (spec)

700 Mb/s on 136 channels per U4164A, clocking on both edges of 
the clock (spec)
350 Mb/s on 136 channels per U4164A, clocking on either edge 
of the clock (spec)
700 Mb/s on 68 channels per U4164A, clocking on either or both 
edges of the clock (typ)
Suitable for DDR/LPDDR memory systems running up to 700Mb/s

Captures a 350MHz signal on either edge of the clock up to 
350 MSp/s (spec)
Captures a 350MHz signal on both edges of the clock up to 
700 MSp/s (spec)

Maximum state clock 
frequency (typ)

2.5 GHz Option -02G
1.4 GHz -01G
700 MHz Option -700
350 MHz standard (base)

350 MHz

Minimum state clock 
frequency (typ)*

12.5 MHz (single edge)
6.25 MHz (both edges)

0 MSps

Sample position adjustment 
resolution (typ)

5 ps or 20 ps 80 ps typical

Sample position adjustment 
accuracy (typ)

± 150 ps

Minimum data valid window 
(typ)

100 ps 500 ps

Minimum setup time (typ) 50 ps 250 ps
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Minimum hold time (typ) 50 ps 250 ps

Minimum eye height (typ) 100 mV

Sample position adjustment 
range (typ)

7 ns 12 ns (typical)

Minimum state clock pulse 
width (typ)

200 ps Single edge: 250 ps

Number of clocks (nom) 1 Up to 4 clocks (in an Ored combination). 
Master and slave clocks are counted separately.

Minimum time between 
active clock edges (typ)*

400 ps 2.86 ns (for 350 MHz state speed) 
1.43 ns (for 700 MHz state speed)

Maximum time between 
active clock edges (typ)*

80 ns

Number of clock qualifiers 4 (pods 2, 3, 4 and 5 on clocking module) Up to two clock qualifiers (Pod 1, 2, 3)

Note: Though there are three clock qualifiers displayed, you 
can use a maximum of only two qualifiers for a clock. The third 
qualifier is automatically set to "Don't Care" and can be used 
only as an Ored clock in the clock description.

Clock qualifier setup time 150 ps 250 ps

Clock qualifier hold time 150 ps 250 ps

Number of “RESET” clock 
qualifiers

1 (pod 7 of clocking module) 0

“RESET” clock qualifier 
setup time

2 ns N/A

“RESET” clock qualifier hold 
time

0 ps N/A

Minimum slave to master 
clock time 

 N/A  350 ps

Minimum master to slave 
clock time 

N/A 150 ps

Minimum slave to slave 
clock time 

N/A 1.43 ns

Time tag resolution (typ) 80 ps 80 ps

Maximum time count 
between stored states (typ)

66 days 66 days

* Clock can pause for up to 66 days once every 8 or more edges

Feature For Single Cock For Multiple Clocks
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Timing
(Asynchronous)
Analysis Modes

Timing Zoom
(Asynchronous)
sampling mode

Trigger
Characteristics

Feature Description

Full-channel Mode Half-channel Mode Quarter-channel Mode

Maximum time 
between transitions 
(nom)

66 Days

Minimum data pulse 
width (typ)

1 sample period + 200 ps

Time interval accuracy 
(typ)

± (1 sample period + 400 ps + 0.01% of time interval reading)

Maximum sample rate 
(nom)

2.5 GHz 5 GHz 10 GHz

Minimum sample 
period (nom)

400 ps 200 ps 100 ps

Pod usage (nom) 1 
pod from each

All pods Odd from each odd/even pod 
pair

Even signal inputs (0, 2, 4, 6, 8) 
from odd pod of each odd/even 
pair plus clock input

Feature Description

Timing Zoom sampling rate 
(nom)

12.5 GHz

Timing Zoom memory depth 
(nom)

256 K samples

Feature For State (Single Clock) and Timing Modes For State (Multiple Clocks)

Maximum trigger sequence 
speed (typ)

2500 MHz (400 ps) Option -02G
1400 MHz (714 ps) Option -01G
700 MHz (1.428 ns) Option -700
350 MHz (2.856 ns) standard (base) module

350 MHz (for 350 MHz state speed option) 

700 MHz (for 700 MHz state speed option)

Trigger resources (nom) 16 patterns evaluated as =, ! =, >, > =, <, < =
8 double-bounded ranges evaluated as in range, not in range
4 to 8 burst detectors
4 edge detectors in timing, 3 in transitional timing
1 occurrence counter persequence level
1 timer
4 flags
1 arm in
Global counter not supported
Event counter supported

16 patterns evaluated as =, ! =, >, > =, <, < =
8 double-bounded ranges evaluated as in range, not in range
Burst patterns not supported
4 edge detectors in timing, 3 in transitional timing
1 occurrence counter persequence level
3 timers
4 flags
1 arm in
Global counters -2
Event counter not supported

Trigger resource Boolean 
conditions (nom)

Arbitrary Boolean combinations

Trigger actions (nom) Goto
Trigger and fill memory
Trigger and Goto
Trigger, send e-mail, and fill memory
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General

Chassis
Compatibility

Keysight AXIe M9502A 2-slot or M9505A 5-slot chassis

Store qualification actions 
(nom)

Default (global) and per sequence level
Store/don’t store sample
Turn on/off default storing

Timer actions Start from reset
Stop and reset
Pause
Resume

Flag actions Set
Clear
Pulse set
Pulse clear

Maximum trigger sequence 
levels (nom)

8 16

Trigger sequence level 
branching (nom)

Arbitrary 4-way if/then/else

Trigger position (nom) Start, center, end, or user-defined

Maximum occurrence 
counter (nom)

999,999,999

Maximum pattern width 
(nom)

128 bits – single label
408 bits – AND of multiple labels across three-card set

Maximum range width (nom) 64 bits

Timer range (nom) 100 ns to 27 hours (in timing modes)
200 * state clock period to 27 hours (in state mode)

Timer resolution (nom) 5 ns

Timer accuracy (typ) ± (5 ns +0.01%) (in timing modes)
± (8 * state clock period +2 ns +0.01%) (in state mode)

Timer reset latency (nom) 40 ns (in timing modes)
80 * state clock period (in state mode)

Feature For State (Single Clock) and Timing Modes For State (Multiple Clocks)

Feature Description

Input signal amplitude 
Vamptd (typ)

 => 350 mV

Supported signal types Single-ended and differential

Voltage threshold (typ) -5 V to 5 V –4 V to +4 V when in dual sample or quad sample state modes

Threshold accuracy (typ) ± (30 mV + 1% of setting)

Minimum threshold 
resolution (typ)

2 mV

Threshold setting granularity By channel
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Logic and Protocol
Analyzer Software

Compatibility

Version 6.2 or greater

Power
Requirements

All necessary power is supplied by the backplane connector of the Keysight AXIe chassis.

Environmental
Characteristics

Indoor use only.

Operating
Environment

Non-operating
Environment

Weight 2.34 kg

See Also • What is a Specification (see page 611)

• What is a Characteristic (see page 611)

U4154A Logic Analyzer Specifications and Characteristics

Describes the specifications and characteristics of the U4154A logic analyzer.

• Module Channel Counts (see page 593)

• State (Synchronous) Analysis Mode (see page 593)

• Timing (Asynchronous) Analysis Modes (see page 593)

Feature Description

Temperature (nom) 0°C to 40°C (+32°F to 104°F)

Humidity (nom) 0 to 80% relative humidity at 40°C (+104°F)

Altitude 0 to 3,000 m (10,000 ft)

Vibration Random vibration 5-500 Hz, 10 minutes per axis, approximately 0.2 g rms

Feature Description

Temperature (nom) -40°C to +75°C (-40°F to +167°F).

Humidity (nom) 0 to 90% relative humidity at 65°C (149°F)

Altitude 0 to 15,300 m (50,000 ft)

Vibration (in shipping carton) Random vibration 5 to 500 Hz, 10 minutes per axis, approximately 2.41 g rms; and 
swept sine resonant search, 5 to 500 Hz, 0.50 g (0-peak), 5-minute resonant dwell at 
4 resonances per axis.

NOTE
Complete specifications and characteristics of the U4154A logic analyzer are available in the    
U4154A Logic Analyzer Data Sheet (5990-7513EN) on the Keysight web site.

NOTE
Items marked with an asterisk (*) are specifications. All others are characteristics.

"Typical" represents the average or median value of the parameter based on measurements from a 
significant number of units.
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• Trigger Characteristics (see page 594)
• Other (see page 595)

• Power Requirements (see page 595)

• Chassis Compatibility (see page 595)

• Environmental Characteristics (see page 595)

Module Channel
Counts

State
(Synchronous)
Analysis Mode

Timing
(Asynchronous)
Analysis Modes

Menu Description

Channels per U4154A 
module (unused clock and 
clock ready inputs can be 
used as data channels)::

136 channels
State analysis: 128 data channels + 8 clock channels
Timing (Full channel): 128 data channels + 8 clock channels
Timing (Half channel): 64 data channels + 4 clock channels

Maximum channels on 
single time base and trigger:

272

Number of AXie chassis slots 
per card::

1

Number of U4154A modules 
that can be connected in an 
AXIe chassis to form a 
multi-card set

2

Menu Description

2.5 Gb/s State data rate with 02G license option
1.4 Gb/s State data rate with 01G license option

Setup/hold window 1 500 ps (350 ps typ)

S/H adjustment resolution 5 ps

Sample range -3 ns to + 3 ns

Minimum state clock pulse 
width

200 ps

Number of clocks 1

Number of qualifiers 4

Time tag resolution 80 ps

Maximum time count 
between stored states 

66 days

* Items marked with an asterisk (*) are specifications. All others are characteristics. "Typical" represents the average or 
median value of the parameter based on measurements from a significant number of units.
1 Dependant on probing system

Menu Description

Sample rate on all channels 2500 MHz

Sample rate in 1/2 channel 
mode

5000 MHz

Sample period  (full channel) 400 ps to 10 ns
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Trigger
Characteristics

Sample period  (half 
channel) 

200 ps

Maximum time between 
transitions 

66 days

Minimum data pulse width 1 sample period + 200 ps

Time interval accuracy ± (1 sample period + 400 ps + 0.01% of time interval reading)

* Items marked with an asterisk (*) are specifications. All others are characteristics. "Typical" represents the average or 
median value of the parameter based on measurements from a significant number of units.

Menu Description

Menu Description

Sample rate on all channels 2500 MHz

Sample rate in 1/2 channel 
mode

5000 MHz

Sample period  (full channel) 400 ps

Sample period  (half 
channel) 

200 ps

Maximum trigger sequence 
speed 

2500 MHz

Maximum trigger sequence 
levels 

8

Trigger sequence level 
branching 

Arbitrary 4-way if/then/else

Trigger position Start, center, end, or user-defined

Trigger resources 16 patterns evaluated as =, !=, >, >=, <, <=
8 double-bounded ranges evaluated as in range, not in range
1 timer
3 flags
1 occurrence counter per sequence level

Trigger resource conditions Arbitrary Boolean combinations

Trigger actions Go To
Trigger, send e-mail, and fill memory
Trigger and Go To
Trigger and fill memory

Store qualification actions Default (global) and per sequence level
Store/don’t store sample
Turn on/off default storing

Maximum global counter N/A

Maximum occurrence 
counter 

999,999,999

Maximum pattern width 128 bits – single label
272 bits – AND of multiple labels across two-card set

Maximum range width4 64 bits
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Other

Chassis
Compatibility

Keysight AXIe 2-slot or 5-slot chassis with software revision 5.0 or greater.

Power
Requirements

All necessary power is supplied by the backplane connector of the Keysight AXIe chassis.

Environmental
Characteristics

Indoor use only.

Operating
Environment

Non-operating
Environment

Timers range 100 ns to 27 hours (in timing modes)
200 * state clock period to 27 hours (in state mode)

Timer resolution 5 ns

Timer accuracy ± (5 ns +0.01%) (in timing modes)
± (8 * state clock period +2ns
+0.01%) (in state mode)

Timer reset latency 40 ns (in timing modes)
80 * state clock period (in state mode)

* Items marked with an asterisk (*) are specifications. All others are characteristics. "Typical" represents the average or 
median value of the parameter based on measurements from a significant number of units.

Menu Description

Menu Description

Supported signal types: Single-ended and differential

Probe compatibility: 90-pin cable connector

Voltage threshold: -5 V to 5 V 

Threshold accuracy: ±(30 mV + 1% of setting)

Threshold setting 
granularity:

By channel

Menu Description

Temperature: 0°C to 40°C (+32°F to 104°F). Reliability is enhanced when operating within the 
range +20°C to +35°C (+68°F to +95°F).

Humidity: 0 to 80% relative humidity at 40°C (+104°F). Reliability is enhanced when operating 
within the range 20% to 80% non-condensing.

Altitude: 0 to 3,000 m (10,000 ft)

Vibration: Random vibration 5-500 Hz, 10 minutes per axis, approximately 0.2 g rms

Menu Description

Temperature: -40°C to +75°C (-40°F to +167°F). Protect the instrument from temperature 
extremes which cause condensation on the instrument.
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See Also • What is a Specification (see page 611)

• What is a Characteristic (see page 611)

U4154B Logic Analyzer Specifications and Characteristics

Describes the specifications and characteristics of the U4154B logic analyzer.

Module Channel
Counts

Humidity: 0 to 90% relative humidity at 65°C (149°F)

Altitude: 0 to 15,300 m (50,000 ft)

Vibration (in shipping 
carton):

Random vibration 5 to 500 Hz, 10 minutes per axis, approximately 2.41 g rms; and 
swept sine resonant search, 5 to 500 Hz, 0.50 g (0-peak), 5-minute resonant dwell 
at 4 resonances per axis.

Menu Description

NOTE
Complete specifications and characteristics of the U4154B logic analyzer are available in the    
U4154B Logic Analyzer Data Sheet (5992-0108EN) on the Keysight web site.

NOTE
Items marked with an asterisk (*) are specifications. All others are characteristics.

Typical (typ): Represents characteristic performance, which 80% of the instruments manufactured 
will meet. This data is not warranted, does not include measurement uncertainty, and is valid only 
at room temperature (approximately 25 °C). 

Nominal (nom): The expected mean or average performance, or an attribute whose performance is 
by design, such as the 50 O connector. This data is not warranted and is measured at room 
temperature (approximately 25 °C). 

Measured (meas): An attribute measured during the design phase for purposes of communicating 
expected performance, such as amplitude drift vs. time. This data is not warranted and is measured 
at room temperature (approximately 25°C).

Feature Description

Number of Channels (nom) 136 in one U4154B
272 in two U4154Bs combined
408 with three U4154B combined

Maximum channels on 
single time base and trigger 
(nom)

408
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State
(Synchronous)
Analysis Mode

Feature Description

Maximum state data rate 
Option 2.5 GHz state mode 
(spec) 

2.5 Gb/s on 136 channels per U4154B, using either or both edges of clock (spec)
4 Gb/s on 68 channels per U4154B, clocking on either edge of the clock (typ)

Maximum state data rate 
standard -01G 1.4 GHz state 
mode (spec)

 1.4 Gb/s on 136 channels per U4154B, using either or both edges of clock (spec)
2.8 Gb/s on 68 channels per U4154B, clocking on either edge of the clock (typ)

Maximum state clock 
frequency (typ) 

2.5 GHz Option -02G
1.4 GHz standard

Minimum data valid window 
(typ)

100 ps Option -02G
160 ps standard -01G

Sample position adjustment 
accuracy (typ)

± 150 ps

Sample position adjustment 
resolution (typ) 

5 ps or 20 ps Option -02G
20 ps standard

Minimum state clock 
frequency 1 (typ) 

12.5 MHz (single edge)
6.25 MHz (both edges)

Minimum setup time (typ) 50 ps

Minimum hold time (typ)  50 ps

Minimum eye height (typ) 100 mV Option -02G
160 mV standard

Sample position adjustment 
range (typ)

7 ns

Minimum state clock pulse 
width (typ)

200 ps

Number of clocks (nom) 1

Minimum time between 
active clock edges (typ) 

400 ps

Maximum time between 
active clock edges 1 (typ)

80 ns

Number of clock qualifiers 4 (pods 2, 3, 4 and 5 on clocking module)

Clock qualifier setup time 150 ps

Clock qualifier hold time  150 ps

Number of "RESET" clock 
qualifiers

1 (pod 7 of clocking module)

"RESET" clock qualifier 
setup time

2 ns

"RESET" clock qualifier hold 
time

0 ps

Time tag resolution (typ) 80 ps

Maximum time count 
between stored states (typ)

66 days

1  Clock can pause for up to 66 days once every 8 or more edges
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Timing
(Asynchronous)
Analysis Modes

Trigger
Characteristics

Feature Half Channel Mode Full Channel Mode

Maximum sample rate (nom) 5 GHz 
2.5 GHz

Minimum sample period (nom) 200 ps 400 ps

Pod usage (nom) 1 pod from each 1 pod from each odd/even pod pair, 
user selectable

All pods

Timing Zoom sampling rate (nom) 12.5 GHz

Timing Zoom memory depth (nom) 256 K samples

Maximum time between transitions 
(nom)

66 days

Minimum data pulse width (typ) 1 sample period + 200 ps

Time interval accuracy (typ) ± (1 sample period + 400 ps + 0.01% of 
time interval reading)

Menu Description

Maximum trigger sequence 
speed

2500 MHz (400 ps) Option -02G
1400 MHz (714 ps) Option -01G

Maximum trigger sequence 
levels (nom)

8

Trigger sequence level 
branching (nom)

Arbitrary 4-way if/then/else
Trigger position (nom)
Start, center, end, or user-defined

Trigger resources 16 patterns evaluated as =, ! =, >, > =, <, < =
8 double-bounded ranges evaluated as in range, not in range
4 to 8 burst detectors
4 edge detectors in timing, 3 in transitional timing
1 occurrence counter per sequence level
1 timer
3 flags
1 arm in

Trigger resource Boolean 
conditions (nom)

 Arbitrary Boolean combinations

Trigger actions Goto
Trigger and fill memory
Trigger and Goto
Trigger, send e-mail, and fill memory

Store qualification actions Default (global) and per sequence level
Store/don't store sample
Turn on/off default storing
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Other

Chassis
Compatibility

Keysight AXIe 2-slot or 5-slot chassis with Logic and Protocol Analyzer software version 6.0 or 
greater.

Power
Requirements

All necessary power is supplied by the backplane connector of the Keysight AXIe chassis.

Environmental
Characteristics

Indoor use only.

Timer actions Start from reset
Stop and reset
Pause
Resume
Flag actions
Set
Clear
Pulse set
Pulse clear

Maximum occurrence 
counter (nom)

999,999,999

Maximum pattern width 
(nom)

128 bits - single label
408 bits - AND of multiple labels across three-card set

Maximum range width (nom) 64 bits

Timers range (nom) 100 ns to 27 hours (in timing modes)
200 * state clock period to 27 hours (in state mode)

Timer resolution (nom) 5 ns

Timer accuracy (typ) ± (5 ns +0.01%) (in timing modes)
± (8 * state clock period +2 ns +0.01%) (in state mode)

Timer reset latency (nom) 40 ns (in timing modes)
80 * state clock period (in state mode)

Menu Description

Menu Description

Input signal amplitude 

Vamptd (typ)
 => 350 mV

Supported signal types Single-ended and differential

Probe compatibility 90-pin cable connector

Voltage threshold (typ) -5 V to 5 V

Threshold accuracy (typ) ±(30 mV + 1% of setting)

Minimum threshold 
resolution (typ) 

2 mV Option -02G
20 mV standard

Threshold setting granularity By channel
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Operating
Environment

Non-operating
Environment

Weight 2.34 Kg

See Also • What is a Specification (see page 611)

• What is a Characteristic (see page 611)

16850-Series Logic Analyzer Specifications and Characteristics

This topic describes the specifications and characteristics of the 16850-series logic analyzers.

• Channel Count per Measurement Mode (see page 600)

• Probes (see page 601)

• Timing Zoom (see page 601)

• State (Synchronous) Analysis Mode (see page 601)

• Timing (Asynchronous) Analysis Mode (see page 602)

• Other (see page 603)

• General Information (see page 603)

• Environmental Characteristics (see page 604)

Channel Count per
Measurement

Mode

Menu Description

Temperature: 0°C to 40°C (+32°F to 104°F). 

Humidity: 0 to 80% relative humidity at 40°C (+104°F). 

Altitude: 0 to 3,000 m (10,000 ft)

Vibration: Random vibration 5-500 Hz, 10 minutes per axis, approximately 0.2 g rms

Menu Description

Temperature: -40°C to +75°C (-40°F to +167°F). Protect the instrument from temperature 
extremes which cause condensation on the instrument.

Humidity: 0 to 90% relative humidity at 65°C (149°F)

Altitude: 0 to 15,300 m (50,000 ft)

Vibration (in shipping 
carton):

Random vibration 5 to 500 Hz, 10 minutes per axis, approximately 2.41 g rms; and 
swept sine resonant search, 5 to 500 Hz, 0.50 g (0-peak), 5-minute resonant dwell 
at 4 resonances per axis.

NOTE
"Typical" represents the average or median value of the parameter based on measurements from a 
significant number of units.

16851A 16852A 16853A 16854A

34 (includes 1 clock + 1 
clock qualifier)

68 ( includes 1 clock + 3 
clock qualifiers)

102 (includes 1 clock + 3 
clock qualifiers)

136 (includes 1 clock + 3 clock 
qualifiers)

Unused clock channels can be used as data channels.
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Probes A probe must be used to connect the logic analyzer to your device under test. For specifications and 
characteristics of a particular probe, see the documentation that is supplied with your probe or 
search for the probe's model number at "www.keysight.com".

Timing Zoom

State
(Synchronous)
Analysis Mode

Menu Description

Timing analysis sample rate: 12.5 GHz (80 ps sample resolution)

Timing interval accuracy: Within a 16 channel block
+/-(80 ps + 130ps + 0.01% of time interval reading)

Between 16 channel blocks
+/-80 ps + 400ps + 0.01% of time interval reading)

Memory depth: 256 K samples

Trigger position: Start, center, end, or user-defined

Minimum data pulse width: 1 sample period + 200 ps

Default Option 700

Minimum setup time (typical) 80 ps

Minimum hold time (typical) 80 ps

Minimum data valid window 160 ps 

Sample position adjustment range 7 ns typical 

Sample position adjustment resolution 20 ps typical

Maximum state data rate on each channel 700 Mb/s 1400 Mb/s 

Maximum state clock frequency single edge clocking 350 MHz  single edge clocking 700 MHz

Minimum state clock frequency 12.5 MHz (single edge)
6.25 MHz (both edges)

Number of clocks 1
Clock on Pod1 of the master card

Number of clock qualifiers  For 16851A - 1
For 16852A, 3A, 4A models - 3

Minimum time between active clock edges 1429 ps 714 ps

Minimum state clock pulse width Single edge: 200 ps

Clock qualifier setup time 200 ps

Clock qualifier hold time 200 ps

Time tag resolution 80 ps

Maximum time count between stored 
states

66 days

Maximum trigger sequence speed 700 MHz 1.4 GHz

Maximum trigger sequence steps 8

Trigger sequence step branching  Arbitrary 4-way if/then/else

http://www.keysight.com/
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Timing
(Asynchronous)
Analysis Mode

Trigger position Start, center, end, or user-defined

Trigger resources •  16 patterns evaluated as =, !=, >, >=, <, <=
• 8 double-bounded ranges evaluated as in range, not in range
• 4 edge detectors in timing, 3 in transitional timing
• 1 occurrence counter per sequence level 
• 1 timer
• 3 flags
• 1 arm in

Trigger resource conditions  Arbitrary Boolean combinations

Trigger actions • Go To
• Trigger and fill memory
• Trigger and Go To
• Trigger, send e-mail, and fill memory
• Occurrence counter reset
• Store qualification
• Default (global) and per sequence level
• Store/don’t store sample
• Turn on/off default storing

Maximum occurrence counter 999,999,999

Maximum pattern width 128 bits –single label

Maximum range width 64 bits

Timer value range 200 * sample clock period to 27 hours

Timer resolution 5 ns

Timer accuracy +/- (8 * sample clock period + 2ns + 0.01%) 

Timer reset latency  80 * sample clock period

Default Option 700

Conventional and Transitional Timing

Maximum Sample rate on all 
channels

 2.5 GHz

Maximum Sample rate in 
half channel mode

5 GHz

Sample period (half channel) 200 ps

Sample period (full channel) 400 ps to 10 ns

Minimum data pulse width 1 sample period + 200 ps

Time interval accuracy  Within a 16 channel pod

+/- (1 sample period + 130ps + 0.01% of time interval reading)1

Across 16 channel pods 

+/- (1 sample period + 400ps + 0.01% of time interval reading)2

Memory depth in full 
channel mode

Up to 128M depth

Memory depth in half 
channel mode

Up to 256 M depth
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Others

General
Information

Power:

100-120VAC 50/60/400Hz & 100-240VAC 50/60 mains capable of supplying 325 watts 

Maximum trigger sequence 
speed

2.5 GHz

Maximum trigger sequence 
steps

8

Trigger sequence step 
branching

Arbitrary 4-way if/then/else

Trigger position Start, center, end, or user-defined

Trigger resources • 16 patterns evaluated as =, !=, >, >=, <, <=
• 8 double-bounded ranges evaluated as in range, not in range
• 4 edge detectors in timing, 3 in transitional timing
• 1 occurrence counter per sequence level 
• 1 timer
• 3 flags
• 1 arm in

Trigger resource conditions  Arbitrary Boolean combinations

Trigger actions • Go To
• Trigger and fill memory
• Trigger and Go To
• Trigger, send e-mail, and fill memory
• Occurrence counter reset

Flag actions • Set
• Clear
• Pulse Set
• Pulse Clear

Maximum occurrence 
counter

999,999,999

Maximum range width  64 bits

Maximum pattern width 128 bits –single label

Timer range 200 * sample clock period to 27 hours

Timer resolution 5 ns

Timer accuracy +/- (8 * sample clock period + 2ns + 0.01%) 

Timer reset latency  80 * sample clock period

Conventional and Transitional Timing

Supported signal types Single-ended, differential

Automated 
threshold/sample position

Yes

Simultaneous eye diagrams, 
all channels

Yes
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Weight:

Operating System:

Microsoft Windows 7 Embedded (64-bit)

Printers:

Can print to any local or network printer supported by the installed operating system (Windows 
7).

Environmental
Characteristics

• Intended for use in an indoor lab environment 

• Pollution degree 2

• Installation category II

See individual probe Specifications and Characteristics for probe environmental characteristics.

• Operating Environment

Operating
Environment

See Also • What is a Specification (see page 611)

• What is a Characteristic (see page 611)

16860-series Logic Analyzer Specifications and Characteristics

Describes the specifications and characteristics of the 16860-series logic analyzer.

CAUTION
This instrument has auto-ranging line voltage input, be sure the supply voltage is within the 
specified range and voltage fluctuations do not to exceed 10 percent of the nominal supply 
voltage.

Max Net Max Shipping

14.6 kg (32.2 lbs) 21.7 kg (48 lbs)

Attribute Description

Temperature: 5°C to 40°C

Humidity: 90% to temperatures up to 31ºC decreasing linearly to 50% rH at 40ºC; 

/// max 90% rh, non-condensing. 
Type tested at 95% RH, +40 degrees C (non-condensing)

Altitude: 4000 m 

NOTE
Complete and up-to-date specifications and characteristics of the 16860-series logic analyzer are 
available in the 16860-series Logic Analyzer Data Sheet on the Keysight web site.
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• Channel Counts (see page 605)

• State (Synchronous) Analysis Mode (see page 605)

• Timing (Asynchronous) Analysis Modes (see page 608)

• Timing Zoom (see page 610)

• Probes (see page 610)
• Others (see page 610)

• General Information (see page 610)

• Environmental Characteristics (see page 610)

• Operating Environment (see page 611)

Channel Counts

State
(Synchronous)
Analysis Mode

NOTE
Specification (spec): Represents warranted performance of a calibrated instrument that has been 
stored for a minimum of 2 hours within the operating temperature range, unless otherwise stated, 
and after a 45 minute warm-up period. The specifications include measurement uncertainty. 

Typical (typ): Represents characteristic performance, which 80% of the instruments manufactured 
will meet. This data is not warranted, does not include measurement uncertainty, and is valid only 
at room temperature (approximately 25 °C).

Nominal (nom): The expected mean or average performance, or an attribute whose performance is 
by design, such as the 50 O connector. This data is not warranted and is measured at room 
temperature (approximately 25 °C).

Measured (meas): An attribute measured during the design phase for purposes of communicating 
expected performance, such as amplitude drift vs. time. This data is not warranted and is measured 
at room temperature (approximately 25 °C).

16861A 16862A 16863A 16864A

Channels 34
(32 data channels  and 2 
clock channels)

 68
(64 data channels and 4 
clock channels)

102
(96 data channels and 6 
clock channels)

136
(128 data channels and 8 
clock channels)

Unused clock channels can be used as data channels.

Feature For Single Clock For Multiple Clocks

Maximum state data rate for 
the 350 MHz option (spec)

 Captures a 350MHz signal on either edge of the 
clock  up to 350 MSp/s (spec)
Captures a 350MHz signal on both edges of the 
clock up to 700 MSp/s (spec)

 Captures a 350MHz signal on either edge of 
the clock  up to 350 MSp/s (spec)
Captures a 350MHz signal on both edges of 
the clock up to 700 MSp/s (spec)

Maximum state data rate for 
the 700 MHz option (spec)

 Captures a 700MHz signal on either edge of the 
clock up to 700 MSp/s (spec)
Captures a 700MHz signal on both edges of the 
clock up to 1400 MSp/s (spec)

Captures a 350MHz signal on either edge of 
the clock  up to 350 MSp/s (spec)
Captures a 350MHz signal on both edges of 
the clock up to 700 MSp/s (spec)

Maximum state clock 
frequency 

700 MHz (Option -700)
350 MHz standard (base)

 350MHz

Minimum state clock 
frequency

12.5 MHz (single edge)
6.25 MHz (both edges)

0 MSps

Minimum setup time 
(typical)

 80 ps 250 ps
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Minimum hold time (typical) 80 ps 250 ps

Minimum data valid window 160 ps 500 ps

Sample position adjustment 
range

7 ns typical 12 ns typical

Sample position adjustment 
resolution

20 ps typical 80 ps typical

Number of clocks

 

 1
(Clock on Pod1)

For 16861A - Up to 2 clocks (in an Ored 
combination) 

For 16862A/3A/4A - Up to 4 clocks (in an 
Ored combination). Master and slave clocks 
are counted separately

Number of clock qualifiers

 

For 16864A - Up to five clock qualifiers (Pod 2, 3, 
4, 5, 7).

For 16862A/3A - Up to three clock qualifiers (Pod 
2, 3, 4)

For 16861A - One clock qualifier (Pod 2)

For 16862A/3A/4A  - Up to two clock 
qualifiers (Pod 1, 2, 3, 4)

Note: Though there are three clock 
qualifiers displayed, you can use a 
maximum of only two qualifiers for a clock. 
The third qualifier is automatically set to 
"Don't Care" and can be used only as an 
Ored clock in the clock description.

For 16861A - One clock qualifier (Pod 1 or 
2)

Minimum time between 
active clock edges

1430 ps (for 350 MHz state speed)
715 ps (for 700 MHz state speed)

2.86 ns (for 350 MHz state speed) 
1.43 ns (for 700 MHz state speed)

Minimum state clock pulse 
width

 Single edge: 200 ps Single edge: 250 ps

Clock qualifier setup time 200 ps 250 ps

Clock qualifier hold time 200 ps 250 ps

Number of RESET clock 
qualifiers

1 (pod 7 of clocking module) 0

RESET clock qualifier setup 
time

2 ns N/A

RESET clock qualifier hold 
time

0 ps N/A

Minimum slave to master 
clock time 

N/A 350 ps

Minimum master to slave 
clock time 

N/A 150 ps

Minimum slave to slave 
clock time 

 N/A 1.43 ns

Time tag resolution 80 ps 80 ps

Maximum time count 
between stored states

66 days 66 days

Maximum trigger sequence 
speed

700 MHz (for 350 MHz state speed option)
1.4 GHz  (for 700 MHz state speed option)

350 MHz (for 350 MHz state speed option) 
700 MHz (for 700 MHz state speed option)

Feature For Single Clock For Multiple Clocks



Keysight Logic and Protocol Analyzer User Guide 607

Reference 13

Timing
(Asynchronous)
Analysis Modes

Maximum trigger sequence 
steps

 8 16

Trigger sequence step 
branching

 Arbitrary 4-way if/then/else

Trigger position  Start, center, end, or user-defined

Trigger resources 16 patterns evaluated as =, !=, >, >=, <, <=
8 double-bounded ranges evaluated as in range, 
not in range
4 edge detectors in timing, 3 in transitional timing
1 occurrence counter per sequence level
1 timer
4 flags
1 arm in
Burst patterns feature 
Event counters - 2
Global counters - Not supported

16 patterns evaluated as =, !=, >, >=, <, <=
8 double-bounded ranges evaluated as in 
range, not in range
4 edge detectors in timing, 3 in transitional 
timing
1 occurrence counter per sequence level
3 timers
4 flags
1 arm in
Number of timers - 3
Global counters - 2
Event counters - Not supported
Burst patterns - Not supported

Trigger resource conditions  Arbitrary Boolean combinations

Trigger actions Go To
Trigger and fill memory
Trigger and Go To
Trigger, send e-mail, and fill memory
Occurrence counter reset

Store qualification Default (global) and per sequence level
Store/do not store sample
Turn on/off default storing

Maximum occurrence 
counter

999,999,999

Maximum pattern width 128 bits single label

Maximum range width 64 bits

Timer value range 200 * sample clock period to 27 hours

Timer resolution 5 ns

Timer accuracy +/- (8 * sample clock period + 2ns + 0.01%)

Timer reset latency 80 * sample clock period

Feature For Single Clock For Multiple Clocks

Feature Conventional and Transitional Timing

Maximum Sample rate on all 
channels

2.5 GHz

Maximum Sample rate in 
half channel mode

5 GHz

Sample period (half 
channel)

200 ps

Sample period (full channel) 400 ps to 10 ns

Minimum data pulse width 1 sample period + 200 ps
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Time interval accuracy Within a 16 channel pod +/- (1 sample period + 130ps + 0.01% of time interval reading)1
Across 16 channel pods +/- (1 sample period + 400ps + 0.01% of time interval reading)2

Memory depth in full 
channel mode

 Up to 128M depth

Memory depth in half 
channel mode

Up to 256 M depth

Maximum trigger sequence 
speed

2.5 GHz

Maximum trigger sequence 
steps

8

Trigger sequence step 
branching

Arbitrary 4-way if/then/else

Trigger position Start, center, end, or user-defined

Trigger resources 16 patterns evaluated as =, !=, >, >=, <, <=
8 double-bounded ranges evaluated as in range, not in range
4 edge detectors in timing, 3 in transitional timing
1 occurrence counter per sequence level
1 timer
4 flags
1 arm in
Burst trigger
2 Event counters

Trigger resource conditions Arbitrary Boolean combinations

Trigger actions Go To
Trigger and fill memory
Trigger and Go To
Trigger, send e-mail, and fill memory
Occurrence counter reset

Flag actions Set
Clear
Pulse Set
Pulse Clear

Maximum occurrence 
counter

 999,999,999

Maximum range width 64 bits

Maximum pattern width 128 bits –single label

Timer range 200 * sample clock period to 27 hours

Timer resolution 5 ns

Timer accuracy +/- (8 * sample clock period + 2ns + 0.01%)

Timer reset latency 80 * sample clock period

Feature Conventional and Transitional Timing
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Timing Zoom
(Asynchronous)
sampling mode

Probes For specifications and characteristics of a particular probe, see the documentation that is supplied 
with your probe or search for the probe's model number at www.keysight.com.

Others

General
Information

Environmental
Characteristics

Intended for use in an indoor lab environment

Pollution degree 2

Installation category II

Feature Description

Timing analysis sample rate  12.5 GHz (80 ps sample resolution)

Timing interval accuracy Within a 16 channel block
+/-(80 ps + 130ps + 0.01% of time interval reading)
Between 16 channel blocks
+/-80 ps + 400ps + 0.01% of time interval reading)

Memory depth 256 K samples

Trigger position Start, center, end, or user-defined

Minimum data pulse width 1 sample period + 200 ps

Feature Description

Supported signal types  Single-ended, differential

Automated 
threshold/sample position

Yes

Simultaneous eye diagrams, 
all channels

Yes

Feature Description

Power 100 to 120 VAC ± 10% 50/60/400 Hz
100 to 240 VAC ± 10% 50/60 Hz
Maximum input power 325 W

This instrument has auto-ranging line voltage input, be sure the supply voltage is 
within the specified range and voltage fluctuations do not to exceed 10 percent of 
the nominal supply voltage.

Weight Max Net
12.5 kg (28 lbs) 
Max Shipping
23.3 kg (51 lbs)

Operating system Microsoft Windows 7 Embedded (64-bit)

Printers Can print to any local or network printer supported by the installed operating system 
(Windows 7).

Logic and Protocol Analyzer 
Software Compatibility

Version 6.3 or greater

CAUTION
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See individual probe Specifications and Characteristics for probe environmental characteristics

Operating
Environment

See Also • What is a Specification (see page 611)

• What is a Characteristic (see page 611)

What is a Specification?

A specification is a numeric value, or range of values, that bounds the performance of a product 
parameter. The product warranty covers the performance of parameters described by specifications. 
Products shipped from the factory meet all specifications. Additionally, products sent to Keysight 
Customer Service Centers for calibration, and returned, meet all specifications. Specifications are 
verified by calibration procedures.

What is a
Calibration
Procedure?

Calibration procedures verify that products or systems operate within the specifications. Parameters 
covered by specifications have a corresponding calibration procedure. Calibration procedures 
include both performance tests and system verification procedure. Calibration procedures are 
traceable and must specify adequate calibration standards.

Calibration procedures verify products meet the specifications by comparing measured parameters 
against a pass-fail limit. The pass-fail limit is the specification less any required guardband.

The term "calibration" refers to the process of measuring parameters and referencing the 
measurement to a calibration standard rather than the process of adjusting products for optimal 
performance.

See Also • What is a Characteristic (see page 611)

What is a Characteristic?

Characteristics describe product performance that is useful in the application of the product, but 
that is not covered by the product warranty. Characteristics describe performance that is typical of 
the majority of a given product, but not subject to the same rigor associated with specifications. 
Characteristics are verified by function tests.

What is a Function
Test?

Function tests are quick tests designed to verify basic operation of a product. Function tests include 
operator's checks and operation verification procedures. An operator's check is normally a fast test 
used to verify basic operation of a product. An operation verification procedure verifies some, but not 
all, specifications, and often at a lower confidence level than a calibration procedure.

Feature Description

Temperature  +5 to +40°C (Operating) 
-40 to +65°C (Non-operating)

Humidity Up to 90% relative humidity (non-condensing) at +40°C (Operating) 
Up to 90% relative humidity (non-condensing) at +65°C (Non-operating)
Type tested at 95% RH, +40 degrees C (non-condensing)

Altitude Operating up to 4,000 meters (13,000 feet)
Non-operating up to 15,300 meters (50,000 feet)

NOTE
Self-tests are not a substitute for calibration.
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See Also • What is a Specification (see page 611)
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Keysight Logic and Protocol Analyzer 

User Guide

Glossary

A

acquisition

Denotes one complete cycle of data gathering by a measurement module. For example, if you are 
using an analyzer with 200K memory depth, one complete acquisition will capture and store 200K 
states in acquisition memory.

acquisition depth

The acquisition depth is the amount of memory that is filled with data on an acquisition. The choices 
available depend on the maximum memory depth available in the analyzer that is being used.

action

Actions are things that the analyzer does as a part of triggering, for example "Then Trigger and Fill 
Memory" or "Start Timer."

activity indicator

Symbols next to logic analyzer channels that indicate whether a signal is a logic-high, or logic-low, 
or whether the signal is changing between highs and lows.

advanced trigger

Advanced triggers provide more power than simple triggers, but are more complex.

analysis probe

A probe connected to a microprocessor or standard bus in the device under test. An analysis probe 
provides an interface between the signals of the microprocessor or standard bus and the inputs of 
the logic analyzer.

arming

Typically, instruments are armed immediately when Run or Run Repetitive is selected. For example, 
logic analyzers are commonly used to arm oscilloscopes.

asynchronous sampling

When the logic analyzer acquires samples from the device under test asynchronously, that is, at 
regular intervals, such as every 100 ns. Also known as timing mode.

B

beginning of acquisition

The beginning of the acquisition is the point in time where the collection of data begins.

bits

A bit is a single signal in a bus. Numbering of bits begins with 0.

bus

A bus is a group of associated signals, such as ADDR or DATA.
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C

captured data

Signal values that have been sampled by the logic analyzer and stored in its memory.

card

A logic analyzer that can be inserted into a slot (see page 618) in a frame (see page 615). Cards can 
be combined with others to increase the channel count available in a single time domain.

channel

A single line of input to the logic analyzer. Each channel corresponds to a lead that is connected to 
the device under test. Each channel is used to acquire one and only one signal from the device under 
test.

chassis

A chassis is a modular instrument chassis that supports complex and high density testing. The 
Keysight AXIe chassis provides slots for installing multiple instrument modules such as the U4154A 
module. 

clock channel

A special logic analyzer input channel that can be used to determine the analyzer's sampling. Clock 
channels are identified on a pod by CLK.

CLOCK IN BNC

This input is for a 10 MHz reference clock used to synchronize the logic analysis system with other 
external instruments.

Do not confuse this BNC input with logic analyzer clock inputs (which are present on the logic 
analyzer pod cables).

D

data channel

A channel that carries data. Data channels cannot be used to clock logic analyzers. Data channels 
are numbered as opposed to clock channels which are labeled CLK.

default storage

Default storage means "unless sequence step storage specifies otherwise, this is what should be 
stored". Sequence step storage always overrides default storage.

delay

Delay is the horizontal position of the waveform on the screen for the timing analyzer. Delay time is 
measured from the trigger point in seconds.

device under test

The system under development whose digital signals are captured by the logic analyzer.

don't care

A "don't care" means that the state of the signal (high or low) is not relevant to the measurement. 
The analyzer ignores the state of this signal when determining whether a match occurs on an input 
bus/signal.

double-click

When using a mouse as a pointing device, to double-click an item, position the cursor over the item, 
and then quickly press and release the left mouse button twice.



Keysight Logic and Protocol Analyzer User Guide 615

Glossary 14

drag and drop

Position the cursor over the item, and then press and hold the left mouse button. While holding the 
left mouse button down, move the mouse to drag the item to a new location. When the item is 
positioned where you want it, release the mouse button.

E

edge

Logic analyzer trigger resources that allow detection of transitions on a signal. An edge term can be 
set to detect a rising edge, falling edge, or either edge.

event

Events are the things you are looking for in your device under test, for example ADDR=0 or ADDR=5.

external trigger

A signal outside the logic analyzer that is used to synchronize measurements between instruments. 
For example, the logic analyzer can be armed (activated) by a signal that comes from another 
instrument. Logic analyzers are commonly used to trigger oscilloscopes through a BNC connection.

F

frame

A modular logic analysis system that has slot (see page 618)s in the back for the insertion of logic 
analyzer card (see page 614)s. Multiple frames can be connected together to form a multiframe logic 
analysis system.

I

inverse assembler

A tool that displays the assembly language instructions for captured machine code.

L

logic analyzer

An instrument that captures and displays digital signal values. A logic analyzer is like an oscilloscope, 
except that it only displays two voltage levels (a logic high or 1, and a logic low or 0) instead of many 
voltage levels. Because a logic analyzer only captures 1s and 0s, its sample rate can be slower than 
an oscilloscope that needs to capture move voltage detail. Consequently, a logic analyzer can 
capture a greater amount of overall execution time.

M

macro

• In COM/DCOM, "macros" (in the online help) are Sub procedures that can be run from the user 
interface to automate an application.

• In previous Keysight logic analysis systems, macros, or trigger macros, were what are now called 
trigger function (see page 620)s: preprogrammed components that are used to build trigger 
sequences.

marker

A relocatable reference point in the data display. Markers can be used to measure time intervals or 
sample intervals. Markers are assigned to patterns in order to find patterns or track sequences of 
state in the data.

menu bar
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The menu bar is located at the top of all windows. Use it to select drop down menus that contain tool 
or system options.

module

A logical collection of logic analyzer card (see page 614)s that are connected together. This gives you 
the flexibility to increase channel count by using more than one card. A module can be a single card 
or several cards. By definition, a module consists of a single time domain. While a module can consist 
of a single card, a module is not a physical entity.

O

occurrence

Occurrence is used in triggering to define how many times something happens during the 
acquisition.

offline analysis

Analyzing previously captured and saved logic analysis data without data acquisition hardware. In 
other words, you can use the Keysight Logic Analyzer application by itself on a Windows XP/Vista 
computer to analyze data in the waveform, listing, and compare windows.

P

pattern

Logic analyzer resources that represent single states to be found on buses/signals; for example, an 
address on the address bus or a status on the status lines.

pod

A physical collection of logic analyzer channels within a card (see page 614). Pods are numbered 
relative to cards only. Pods are used to physically connect data and clock signals from the device 
under test to the analyzer.

pod index

A logical number for a pod (see page 616). If a module (see page 616) has 20 pods, the pod indexes 
are 1 through 20 with no renumbering at card boundaries. In a multi-card module, numbering begins 
with the master card then continues from the bottom card up. Pod indexes can be used without 
considering how many pods are on each card (see page 614), or in which slot (see page 618)s the 
cards are located.

pod pair

A group of two pods containing 16 data channels and 1 clock channel each. Pod pairs are used to 
physically connect data and clock signals from the device under test to the analyzer. Pods are 
assigned by pairs in the analyzer interface. The number of pod pairs available is determined by the 
channel width of the instrument.

pod truncation

This occurs when opening a configuration file that was saved from a logic analyzer module that had 
more pods. Because the current module has fewer pods, truncation occurs. Any buses/signals 
assigned to truncated pods are unusable.

point

To point to an item, move the mouse cursor over the item.

polarity

Positive polarity is when an incoming low voltage is shown with a high waveform and a logical value 
of 1. Negative polarity is when an incoming high voltage is shown with a low waveform and a logical 
value of 0. Polarity affects the display of values and waveforms, and does not affect the trigger.
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preprocessor

See analysis probe (see page 613).

probe

A device to connect the various instruments of the logic analysis system to the device under test. 
There are many types of probes and the one you should use depends on the instrument and your 
data requirements. As a verb, "to probe" means to attach a probe to the device under test.

protocol

An agreed-upon format for transmitting data between two devices. The protocol determines: the 
type of error checking, data compression, encoding, how sending devices indicate they have finished 
sending a message, and how receiving devices indicate they have received a message.

Q

quick trigger

Quick trigger allows you to quickly set up a simple trigger within the waveform and listing displays, 
by drawing a rectangle in the display area with the mouse. After a simple trigger has been defined, 
and the analyzer is run, the trigger is stored and can be recalled at any time.

R

range pattern

Logic analyzer resources which let you set up patterns that represent a range of values, such as 
"ADDR in range 1000 to 2000". Most logic analyzers support a "not in range" operator as well as the 
"in range" operator. Range patterns are a convenient shortcut that can be used instead of AND'ing or 
OR'ing two patterns, such as "ADDR >= 1000 and ADDR <= 2000".

repetitive measurement

A measurement in which the logic analyzer's trigger condition is searched for, and data storage is 
filled, repetitively.

right-click

When using a mouse for a pointing device, to right-click an item, position the cursor over the item, 
and then quickly press and release the right mouse button.

run

The single run measurement will save captured data to trace memory one time. The amount of data 
stored during a single run is equal to the amount of trace memory allotted.

run repetitive

The run repetitive measurement will save the captured data to trace memory repetitively. The 
amount of data stored in a repetitive run is the same as a single run. During a repetitive run once the 
trace memory is full the system clears the trace memory and begins to refill with new data. This cycle 
will continue until the run is stopped.

S

sample

A data sample is a single measurement. When an instrument samples the device under test, it takes 
a single measurement as part of its data acquisition cycle. The number of samples acquired is equal 
to the logic analyzers memory depth.

sample period
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The sample period is the period of time between samples. The sample period can be based on an 
internal sampling clock (also known as timing analysis or asynchronous sampling). Or, the sampling 
can be based on a signal in the device under test (also known as state analysis, or synchronous 
sampling).

sampled data

Signal values that are sampled by the logic analyzer (not necessarily stored).

sampling

The process by which the logic analyzer looks at digital signals.

search

Searches through the acquired data for specified data pattern or value, time value, sample number, 
or marker. Search criteria can range from specific bits to multiple events, depending on which search 
option you choose.

simple trigger

Simple triggers include triggers such as edges and bus patterns.

single measurement

A measurement in which the logic analyzer's trigger condition is searched for, and data storage is 
filled, once.

skew

Skew is the difference in channel delays between measurement channels.

slot

An opening in the back of a frame (see page 615) where card (see page 614)s can be inserted. The 
slots are lettered from A to F with A being the topmost slot. Slots are physical entities and are always 
referred to by slot letter.

snap to edge markers

Snap to edge markers enable easy placement of markers on waveform edges. When a marker is 
moved in the data display area, the cursor changes to a green "direction arrow" indicating the 
direction of the next valid edge. A red "valid edge" bar is placed on the next edge that the marker will 
be placed on.

state analyzer

A logic analyzer that samples based on a clock signal in the device under test.

state measurement

In a state measurement, the logic analyzer is clocked by a signal from the system under test. Each 
time the clock signal becomes valid, the analyzer samples data from the system under test. Since the 
analyzer is clocked by the system, state measurements are synchronous with the test system.

state mode

When the logic analyzer acquires samples from the device under test synchronously, in other words, 
when a signal or signals from the device under test indicates when to acquire a sample. For example, 
the logic analyzer might take a sample whenever there is a rising edge on a signal from the device 
under test. Typically, the signal used to set up the sampling is a state machine clock signal or 
microprocessor clock signal. Also know as synchronous sampling.

stop

Stops the measurement currently in progress.

storage qualification
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Storage qualification is only available in a state measurement, not timing measurements. Store 
qualification allows you to specify the type of data (all samples, no samples, or selected states) to be 
stored in memory. Use store qualification to prevent memory from being filled with unwanted activity 
such as wait-loops. Storage qualification lets you filter out specific types of data as the acquisition is 
running, which saves memory. In contrast filters can hide data after it has been collected.

symbols

Names assigned to particular bus or signal values. Symbols in a display of captured data values are 
easy to read. Also, symbols make it easy to set up triggers on particular values. For example, in a 
communication protocol you could display the value FF as "end of file."

synchronous sampling

When the logic analyzer acquires samples from the device under test synchronously, in other words, 
when a signal or signals from the device under test indicates when to acquire a sample. For example, 
the logic analyzer might take a sample whenever there is a rising edge on a signal from the device 
under test. Typically, the signal used to set up the sampling is a state machine clock signal or 
microprocessor clock signal. Also know as state mode.

T

target system

See device under test (see page 614).

threshold voltage

The voltage level that the signal must cross before the logic analyzer recognizes a change in voltage 
levels. A high voltage level is indicated by a "1" and a low voltage level is indicated by a "0." TTL and 
ECL are two examples of voltage levels that the signal must cross.

time/division

Time/division controls the "zooming" of a waveform display. Increasing the time/division zooms out, 
while decreasing the time/division zooms in.

timer

Timers are used to create either a user-defined delay or a time standard which valid data duration is 
evaluated against.

timing analyzer

A logic analyzer that samples at regular intervals based on an internal clock signal.

timing measurement

In a timing measurement, the logic analyzer samples data at regular intervals according to a clock 
signal internal to the timing analyzer. Since the analyzer is clocked by a signal that is not related to 
the device under test, timing measurements capture traces of electrical activity over time. These 
measurements are asynchronous with the device under test.

timing mode

When the logic analyzer samples from the device under test asynchronously, that is, at regular 
intervals, such as every 100 ns. Also known as asynchronous sampling.

tool tip

Small information display (text readout) that appears during mouse operations such as hovering over 
a waveform or bus/signal name, moving markers, or drawing a rectangle in data. Use them as 
comments (see page 94) or to read current positions, waveform transition widths, or trigger 
specifications (when setting up quick triggers (see page 143) with mouse).

trace
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See acquisition (see page 613).

transitional timing

When the logic analyzer is in transitional timing mode, the timing analyzer samples data at regular 
intervals, but only stores data when there is a threshold level transition (high-to-low transition, or 
low-to-high transition). Each time a level transition occurs on any of the bits, data on all channels is 
stored. A time tag is stored with each stored data sample so the measurement can be reconstructed 
and displayed later.

trigger

The event about which acquired data is stored; in other words, the event that you are looking for. For 
example, you may want to trigger on an edge in order to see the events that lead up to it and the 
events that happen after it. The event that triggers the logic analyzer becomes a reference point in 
the data display.

trigger function

Trigger functions are preprogrammed components that are used to build trigger sequences.

trigger history

Each time you set up a new trigger and run the measurement, the trigger setup is saved in the 
configuration file. Each saved trigger can be retrieved and reused. The default number of triggers 
saved is 10.

trigger position

The location of the trigger event in trace memory. If you want to view data after, about, or before the 
trigger event, you set the trigger position to the start, center, or end of trace memory, respectively.

trigger sequence

A trigger sequence is a sequence of events that you specify. The logic analyzer compares this 
sequence with the samples it is collecting to determine when to trigger.

V

value at measurement

The value at measurement measures the value of a bus or a single signal at a specified marker 
location in data. Measurement results are displayed in the marker measurement display bar.
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Z

zooming

To expand and contract the waveform along the time base by varying the value in the time/div field. 
This action allows you to view specific portions of a particular waveform.
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Index

Symbols
!= operator, pattern trigger, 147, 159
< operator, pattern trigger, 147, 159
<= operator, pattern trigger, 147, 159
= operator, pattern trigger, 147, 159
> operator, pattern trigger, 147, 159
>= operator, pattern trigger, 147, 159

Numerics
01G license, 547
02G license, 547
16850-series logic analyzer front panel 

operation, 527
16850-series logic analyzer notes, 553
16850-series logic analyzer 

specifications and 
characteristics, 600

16860, 520, 528
16860-series logic analyzer notes, 555
8b, 299

A
abbreviated marker name, 246, 254
about, help, 397
absolute time, 241
accumulate waveforms, 229
acquiring data, 141
acquisition, 613
acquisition depth, 613
acquisition errors, 334
acquisition memory depth, 128, 129, 

139, 428, 545, 549, 553, 600
acquisition memory depth and channel 

count trade-offs, 363
acquisition mode, 428
acquisition mode, choosing, 96
acquisition mode, setting, 43
acquisition mode, state, 98
acquisition mode, timing, 96, 97
acquisition time, transitional 

timing, 365
action, 613
action statements, 153, 154, 157
action statements, reading, 153
action, counter, 180
action, flag, 180
action, reset occurrence counter, 154, 

180
action, storage control, 181
action, timer, 179

actions and events, trigger, 152
actions in trigger sequence, 371, 424
actions, inserting or deleting, 179
activation, software licenses, 323, 463
active software licenses, 322, 461
activity (bus/signal), 83
activity indicator, 613
activity indicators, 426
activity indicators in Listing 

window, 237
activity indicators in Waveform 

window, 226
Add Application dialog, 436
add external scope, 389
add icons to toolbar, 402
add logic analysis system, 459
Add or Remove Logic Analyzer 

Software tool, 327
add software, 327
adding a bus or signal, 84
adding a folder, 95
adding connections, 307
adding display windows, 307, 313
adding system to use list, 61
adding tools, 307
address alignment, trigger in Source 

window, 467
adjustable delay on state sampling 

clock input, 367
advanced 2-way branch trigger 

function, state mode, 500
advanced 2-way branch trigger 

function, timing mode, 488
advanced 3-way branch trigger 

function, state mode, 501
advanced 3-way branch trigger 

function, timing mode, 488
advanced 4-way branch trigger 

function, state mode, 501
advanced 4-way branch trigger 

function, timing mode, 489
advanced clocking, 127
Advanced Clocking Setup dialog, 422
advanced if/then trigger function, 

state mode, 500
advanced if/then trigger function, 

timing mode, 487
advanced If/Then trigger 

functions, 478
advanced setup, 389
advanced trigger, 141, 152, 389, 399, 

613
Advanced Trigger dialog, 424
advanced trigger example, 359

advanced trigger functions, state 
mode, 490

advanced trigger functions, timing 
mode, 478

agLogicSvc.exe service, 348
agSymbolBuild.exe, 135
agSymbolQuery.exe, 135
ALA format, 504
ALA format configuration files, 198, 

208, 210
ALA format configuration files, 

automatic module mapping, 445
ALA format configuration files, offline 

analysis, 218
ALA format configuration files, won't 

open, 333
ALA vs. XML format, when to use, 380
ALB module binary file format, 203, 511
ALB module binary file header 

format, 505
alias bus/signal name, 95
align trigger with, timing zoom, 476
aligning reference data, 275
alignment, bus/signal column, 241
alignment, packet column, 305
alignment, Set Quick Trigger, 282
all reference data, 276
altitude, 595, 600
analog properties, 234
analog signal row properties, 233
analog signal, Voltage number base in 

Listing, 241
analog signals, overlaying, 223
analog signals, voltage markers 

for, 257
analogy, conveyor belt, 369
analysis probe, 57, 613
analyzer, 72
Analyzer Setup dialog, 426
Analyzer Setup toolbar, 399
analyzer triggering, 

understanding, 369
analyzing captured data, 207
analyzing listing data, 235
analyzing waveform data, 220
AND events, 168
AND'ed find events, 270
anything event, 168
application (external), adding to Tools 

menu, 436
arm from another module, 186
arm from another module, wait 

for, 487, 499
arm in from event, 168, 170
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arming, 613
arrange icons, 396
ASCII format symbol file, 514
Ascii number base, 159, 232, 241
ASCII symbol file, creating, 135
ASCII text file, print to, 314
Assign Names dialog, 86
asynchronous sampling, 96, 613
asynchronous sampling mode, 428
auto-connect at application 

startup, 439
auto-connect, selecting logic analysis 

system for, 66
automatically mapping modules, 444
autosize columns, 241
available status, 63
AXIe chassis slots per card, 593

B
B4661A, 317
background color, Listing 

window, 238, 239
background color, marker, 246, 256
background color, Source window, 282
background color, timing zoom 

listing, 239
background color, timing zoom 

waveforms, 229
background color, Waveform 

window, 227, 228
base, number, 93, 232, 241
base, symbol, 458
beginning of acquisition, 613
beginning of data, 222
Beginning of Data marker, 312
beginning of data, go to, 249
beginning of data, go to in Listing 

window, 236
best-fit algorithm, module 

mapping, 445
big endian, 91
Binary number base, 159, 232, 241
bit order, 89
bit reordering, 91
bits, 613
block boundary addresses, 282
BNC connectors, trigger in/out, 186
boolean expressions, 372
boolean expressions in trigger 

sequence, 371
boolean expressions, setting 

parentheses, 177
boolean expressions, triggering 

capability, 370
borrow floating licenses, 326, 465
borrow licenses messages, 466
branch expression too complex, 337
branches, 373
browsing source files, 278
buffer, reference, copying data to, 274
burst patterns, 170

burst triggering, 170
bus, 613
bus analysis tools, new, 390
bus clock, data valid relative to, 367
bus pattern trigger functions, timing 

mode, 478
bus pattern triggers, 147, 159
bus width, 83
bus, group signals into, 227
bus, renaming the bits, 86
bus, source code correlation, 

selecting, 280
bus, source correlation, 468
bus/signal column alignment, 241
bus/signal column properties, 240
bus/signal column width in Listing 

window, 241
bus/signal column, finding a, 237
bus/signal columns, re-arranging, 237
bus/signal data color, Listing 

window, 240
bus/signal data to export, 199
bus/signal errors, 334
bus/signal event, 168
bus/signal folders, adding, 95
bus/signal name, alias, 95
bus/signal names, setting up, 42
bus/signal names, sorting, 95
bus/signal naming, short or 

unique, 447
bus/signal number base, 232, 241
bus/signal patterns, finding, 264, 265
bus/signal patterns, finding 

complex, 270
bus/signal row properties, 230
bus/signal row, finding a, 224
bus/signal setup, 83, 389, 399
bus/signal values displayed as 

symbols, 243
bus/signal values, symbolic, 138
bus/signal, adding a new, 84
bus/signal, assigning channels in 

default bit order, 88
bus/signal, assigning channels in 

selected bit order, 89
bus/signal, deleting a, 84
bus/signal, renaming a, 85
buses, expanding/collapsing, 227
buses/signals in data import 

module, 213, 442
Buses/Signals tab, 426
buses/signals, define by importing 

netlist, 446
buses/signals, exporting data from 

selected, 452
buses/signals, inserting/deleting in 

Listing window, 238
buses/signals, inserting/deleting in 

Waveform window, 227
buses/signals, load warning, 339
bus-specific probes, 57

buttons, 16800-series logic 
analyzers, 527

C
calibration, 611
calibration failed, 337
calibration procedure, 611
cancel, 392
cancel operation, 401
cancel processing, 

module/tool/window, 469
captured data, 141, 614
captured data, analyzing, 207
captured data, comparing, 274
captured data, exporting to module 

binary (ALB) files, 203
captured data, exporting to module 

CSV files, 201
captured data, printing, 314
captured data, saving, 198
card, 614
card, logic analyzer, 431
cards (logic analyzer), combining, 72
cards in frame, 472
cards in module, 474
cascade windows, 396, 398
center about edges, 221
center about marker pair, 249, 391, 400
center alignment, bus/signal 

columns, 241
center rectangle, go to source line 

of, 279
center rectangle, showing/hiding, 239
center screen, placing marker at, 247
changing the display scale, 221
changing the time/division, 221
channel, 614
channel and pod connections, 474
channel count and memory depth 

trade-offs, 363
channel counts, 588, 593, 596, 600, 605
channel naming conventions, 361
channel numbers, 426
channel numbers (bus/signal), 83
channel order selection, enable, 89
channel order, reverse, 91
channel reordering, 91
channel width, 97
channels, 545, 549, 553, 588, 593, 596, 

600, 605
channels (directions), packet 

column, 305
channels assigned (bus/signal), 83, 89
channels assigned (bus/signal), 

reordering, 91
channels on a single time base and 

trigger, 593, 600
channels per module, 593
channels, assigning in default bit 

order, 88
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channels, assigning in selected bit 
order, 89

channels, data on unassigned, 
transitional timing, 365

character names, 299
characteristics, 587, 611
characteristics, 16800-series logic 

analyzer, 600
chart, viewing Waveform bus data 

as, 224
chassis, 614
Chat dialog, 429
chat messages, 67
Chat Select Destination dialog, 430
Choose a Protocol Family and Bus 

dialog, 430
clear favorite/recently used 

triggers, 453
clear flag, 157
clear flag action, 180
clear trigger sequence, 185
clearing a remote access password, 68
clearing the trigger sequence, 424
clip board, copying 

module/tool/window status to, 469
clip board, copying screens to, 315
clip board, copying text to, 314
clipped (show) analog property, 234
clock channel, 88, 89, 614
CLOCK IN BNC, 614
clock mode (state sampling), 

Demultiplex, 103, 115
clock mode (state sampling), Dual 

Sample, 106
clock mode (state sampling), Master 

Only, 100, 114
clock mode (state sampling), 

Master/Slave, 101, 114
clock mode (state sampling), 

selecting, 99
clock pod/channel naming, 361
clock qualifier hold time, 600
clock qualifier setup time, 600
clock qualifiers, 600
clock setup, state mode, 334
clock threshold voltage, 77
clock, slow or missing, 339
clock, state mode sampling, 358, 359
clock, state mode sampling, setting 

up, 124
clock, timing mode sampling, 356
clocks, 600
clocks pod, 89
Coff/Stabs symbol files, 136
collapse a bus, 227
color, difference 

foreground/background, 276
color, filtered data in Waveform 

window, 229
color, Listing window background, 239
color, overlaid waveform, 228
color, reference data background, 276

color, selected packet box, 303
color, Source window background, 282
color, Source window text, 282
color, waveform, 231
color, Waveform window 

background, 227
colorize symbols, 133
colorize/filter tool, 390
column alignment in Listing 

window, 241
column autosize, 241
column base in Listing window, 237
column channels (directions), 

protocol, 288
column headings in Waveform 

window, 226
column properties, bus/signal, 240
column properties, packet 

summary, 304
COM automation, use of XML 

format, 380
COM/DCOM, extending capture 

capabilities, 206
combining logic analyzer cards, 72
commands, keyboard, 532
comma-separated value files, 199, 504
comments, 94
comments, bus/signal, 83, 426
comments, General-Purpose ASCII 

symbol file format, 519
comments, If clause, 

displaying/hiding, 183
comments, marker, 257
comments, system in use, 63, 65, 459
communication timeout, floating 

license server, 342
compare differences, run until a 

number, 275
Compare menu, 394
compare operation keyboard 

commands, 532
Compare Overview bar, 274
compare packets, 294
Compare window, 411
Compare window properties, 276
Compare window, new, 396
compared data, finding 

differences, 274
comparing a range of samples, 275
comparing captured data, 274
compatible modules, 380
complex bus/signal patterns, 

finding, 270
complex triggers, setting up, 378
concepts, 317, 353
conclusions, understanding logic 

analyzer triggering, 379
conditions in trigger sequence, 371
configuration file header 

information, 208
configuration file, ALA format, 504

configuration file, creating new after 
offline startup, 447

configuration file, mapping modules 
from, 468

configuration file, new/open/save, 398
configuration file, offline creation 

of, 431
configuration file, opening, 208
configuration file, opening after offline 

startup, 447
configuration file, recently-used, 210
configuration file, saving, 198
configuration files, default folders, 447
configuration files, loading/saving, 46
configuration files, 

new/open/save, 386
configuration files, trigger setup, 194
configuration files, won't open, 333
configuring counters, 154
configuring timers, 153
connect samples analog property, 234
connect samples in chart, 224
connect to logic analysis system, 459
connecting multiple frames, 381
connecting to a LAN, 315
connection attributes, external 

oscilloscope, 399
connection rules, 418
connections to device under test, 474
connections, deleting/adding, 307
connectivity, 315
connectorless probing, Soft Touch, 57
consecutive files, storing repetitive run 

data, 206
contact information, 351
content information, configuration 

file, 208
convert trigger step to if/then, 183
conveyor belt analogy, 369
copy data to Compare reference 

buffer, 394
copy to clip board, 387, 398
copying data to reference buffer, 274
copying module/tool/window status to 

clip board, 469
copying screens to clip board, 315
copying text to clip board, 314
copyright information, 397
correlated source line, showing, 279
Correlation Bus tab, 468
correlation bus, selecting, 280
counter action, 179, 180
counter event, 168, 169, 337
counter event check without increment 

action, 339
counter in trigger sequence, 337
counters, 152
counters, triggering capability, 370
counters, using, 154
counters, using in triggers, 373
creating new markers, 246
CSV file (module) header format, 505
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CSV format, 199, 504
CSV format files, offline analysis in 

Excel, 218
CSV module file format, 201, 504, 510
custom default storage, 167
customizing toolbars, 402
cut to clip board, 387, 398
cutting trigger sequence steps, 182

D
data and setup, loading, 208
data channel, 614
data formats, 504
data import module setup, 442
data import module, 

buses/signals, 442
data import module, file 

information, 215, 443
data import modules, 211
Data Import toolbar, 400
data on unassigned channels, 

transitional timing, 365
data storage, transitional timing, 365
data valid window, 367
data values in waveform, 

showing/hiding, 232
data, buses/signals to export, 452
data, comparing captured to 

reference, 274
data, copying to reference buffer, 274
data, exporting to module binary (ALB) 

files, 203
data, exporting to module CSV 

files, 201
data, finding bus/signal patterns 

in, 264, 265
data, finding compare differences, 274
data, loading saved, 208
data, print to file, 314
data, printing, 314, 451
data, range to export, 452
data, reference, offset, 275
data, saving, 198
data, viewing saved, 380
date information, configuration 

file, 208
Decimal number base, 159, 232, 241
default base, 93
default base (bus/signal), 83
default bit order, assigning 

channels, 88
default bit order, resetting to, 89, 91
default folders, 447
default number base, 426
default storage, 152, 167, 375, 424, 614
default storage, action to turn 

on/off, 181
default trigger sequence, 424
defining probes, 474
delay, 614

delay from trigger in waveform 
display, 222

delay, adjustable, on state sampling 
clock input, 367

delay, repetitive run, 447
delete Compare window, 394
delete event, 168
delete external scope, 389
Delete Find Event, 270
delete Listing window, 393
delete logic analysis system, 459
delete marker, 391
delete Overview window, 393
delete Source window, 395
delete Waveform window, 394
delete, Overview window, 311
deleting a bus or signal, 84
deleting actions, 179
deleting buses/signals from Listing 

window, 238
deleting buses/signals from Waveform 

window, 227
deleting connections, 307
deleting display windows, 307, 313
deleting favorite find patterns, 271
deleting markers, 250
deleting system from use list, 61
deleting tools, 307
deleting trigger sequence steps, 182
demangled symbols, 513
Demo Center, 55
demo data, creating when offline, 447
Demultiplex state sampling clock 

mode, 103, 115
depth, acquisition memory, 128, 129, 

139, 428, 545, 549, 553, 600
description information, configuration 

file, 208
description, configuration file, 198
details, module/tool/window, 469
details, trigger, 453
details, viewing system, 64
device under test, 614
device under test connection, 474
device under test, connecting, 41
device under test, controlling signals 

in, 58
device under test, loading in the, 334
device under test, probing, 57
device under test, remote control for 

switches, 475
dialogs, 421
difference foreground/background 

color, 276
difference pair reference data, 276
differences in compared data, 

finding, 274
differential probes and single-ended 

signals, 474
differential threshold voltage level, 77
directories, source file, 277, 467
directory list, source file, 279

disabling module, 72, 389
disk space, freeing, 328
display center rectangle Listing 

window, 239
display line numbers, 282
display scale, changing the, 221
display window properties, 

editing, 310
display windows, 404
display windows, adding/deleting, 313
display windows, 

adding/deleting/duplicating, 307
display windows, lock scrolling, 229, 

239
display windows, renaming, 311
display windows, using, 313
displaying symbols, 243
displaying the Overview window, 307
documenting trigger sequences, 378
don't care, 614
don't store sample action, 181
Dont Care signal pattern value, 159
double-click, 614
drag and drop, 615
drag and drop markers, 247
draw box triggers, 143
draw rectangle in data, 221
Dual Sample state sampling clock 

mode, 106
dual sample state sampling clock 

mode, 106, 116
duplicate Compare window, 394
duplicate Listing window, 393
duplicate Source window, 395
duplicate Waveform window, 394
duplicating display windows, 307
duration counts, 178
duration of storage, transitional 

timing, 365
dynamic triggers, 206

E
early return of borrowed floating 

licenses, 326, 465
edge, 615
edge and pattern trigger function, 480
edge followed by edge trigger 

function, 480
edge followed by pattern trigger 

function, 481
edge operator, pattern trigger, 159
edge resources, 337
edge trigger, 146, 357
edge trigger function, 479
edge trigger functions, timing 

mode, 478
edge, triggering on signal, 148
edges on a bus, triggering on, 147
edges too far apart trigger 

function, 481
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edges, center waveform display 
about, 221

edges, state clock, too close, 334
edges, triggering capability, 370
edges, triggering on, 373
Edit Application dialog, 436
Edit menu, 387
edit operation keyboard 

commands, 532
editing window/tool properties, 310
Either Edge signal edge value, 159
either edge, triggering on, 373
elastomeric probe adapter, 57
ELF/DWARF object file format, 513
ELF/stabs object file format, 513
ELF/Stabs symbol files, 136
else if branches, 373, 488, 489, 500, 501, 

502
E-mail dialog, 432
e-mail on trigger, 166
e-mail, send on compare 

differences, 275
e-mail, send on interval marker 

statistic, 251, 252
e-mail, send when marker value 

found, 247
enable channel order selection, 89
enable module, 389
enabling modules, 72
end of data, 222
End of Data marker, 312
end of data, go to, 249
end of data, go to in Listing 

window, 236
end value of symbol, 458
endian, 91
English online help, 397
Entering, find qualifier, 265
equal to operator, pattern trigger, 147, 

159
error dialogs, showing/hiding, 447
error messages, 334
error messages in the status log, 469
evaluation order of events, 177
evaluation order of find events, 270
event, 615
event checks without action, 339
Event Editor dialog, 433
event logging, 447
event statements, 153, 154, 157
event statements, reading, 153
event, arm in from, 170
event, counter, 169
event, flag, 170
event, timer, 169
events (advanced trigger), 

grouping, 177
events and actions, trigger, 152
events in trigger sequence, 424
events, duration or occurrence counts 

in timing mode, 178
events, inserting or deleting, 168

events, negating, 177
excluding bus/signal transitions, 167
Exiting, find qualifier, 265
expand a bus, 227
expand bus into signal waveforms, 224
experienced users, tips for, 39
export bus/signal data to CSV file, 199
export CSV files, 386
Export dialog, 434
Export file selection dialog, 435
export files, default folders, 447
exporting a range of data, 452
exporting data, 199
exporting data from selected 

buses/signals, 452
exporting data to module binary (ALB) 

files, 203
exporting data to module CSV 

files, 201
expressions, boolean, 372
External Application Setup dialog, 436
external arm, wait for, 486, 498
external instrument, trigger in 

from, 192
external instrument, triggering, 437
external instruments, trigger out 

to, 191
External Oscilloscope Setup 

toolbar, 399
external scope, add/delete, 389
external trigger, 170, 186, 389, 615
External Trigger dialog, 437
extra data channels, 88, 89

F
Falling Edge signal edge value, 159
falling edge, triggering on, 373
fan out/in to tools in Overview 

window, 418
Fast Zoom In option for Waveform 

windows, 230
favorite find pattern, 271
favorite packet events, organizing, 165
favorite packet events, saving, 165
favorite trigger, 194, 195, 453
feedthrough mode, external 

trigger, 437
field decode, 299
field patterns (packet), finding, 267
file errors, 336
file format, 218, 504
file format, module binary (ALB), 203, 

511
file format, module CSV, 201, 504, 510
file format, netlist, 90
file information in data import 

module, 443
File menu, 386
file operation keyboard 

commands, 532
file, print to, 314

file, symbol, 458
files (configuration), opening, 208
files (configuration), 

recently-used, 210
files (configuration), saving, 198
files (configuration), translating 167xG 

and 16700-series, 198
files (configuration), won't open, 333
files, source, browsing, 278
files, symbol, 471
fill memory action, 166
fill memory storage qualifiers, 167
filling memory after trigger, 340
filter/colorize tool, 390
filtered data color, Waveform 

window, 229
find, 387, 390
find a packet trigger function, 496
find anything N times trigger function, 

state mode, 497
find anything N times trigger function, 

timing mode, 484
Find Bus/Signal dialog, 224, 237
find data, 398
Find dialog, 438
find events, 270
Find Options dialog, 272
find patterns, favorites, 271
find qualifiers, 265
find symbol name, 458
find, quick, 264
FindEdges macro, 391
finding bus/signal patterns, 264, 265
finding complex bus/signal 

patterns, 270
finding differences in compared 

data, 274
fixed unit for time column, Listing 

window, 242
fixed unit for time column, Protocol 

Viewer window, 306
flag action, 179, 180
flag action delay, 170
flag event, 168, 170
flag line used for arming in multiframe 

systems, 381
flags, 152, 373
flags status, 469
flags, using, 157
FLEXlm License Finder dialog, 461
floating license server communication 

timeout, 342
floating license servers, 324, 464
floating licenses, 321
flying lead probe type, 474
folder (bus/signal), adding, 95
folders, default, 447
font size, Listing window, 238, 239
font size, Protocol Viewer, 303
font size, Source window, 282
font size, waveform, 229
font size, Waveform window, 227
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footers when printing, 314
force prestore, 128
foreground color, marker, 246, 256
format, netlist file, 90
formats, data, 504
Found marker placement, 272
frame, 615
Frame Module Information dialog, 439
frame that module is in, 474
frame, connecting to, 459
frame, slots/cards/modules in, 472
frequency of changes in time 

interval, 251
front panel operation, 16880-series 

logic analyzers, 527
full channel timing mode, 97, 545, 550, 

553
full screen, 388
full screen display, 398
function names, 132
function tests, 611
FUNCTIONS, General-Purpose ASCII 

symbol file format, 516

G
general purpose knob, 16800-series 

logic analyzer, 527, 531
general purpose probing, 57
general state mode, 98, 553
General-Purpose ASCII (GPA) symbol 

file, 135, 471, 514
General-Purpose ASCII (GPA) symbol 

file format, 514
generic text only printer, 314
getting started, 39
glitch drawing, 147, 148
Glitch signal edge value, 159
glitch, triggering on signal, 148
glitches on a bus, triggering on, 147
global counter, 155
global counter status, 469
global counters, 373
global counters, transitional 

timing, 365
glossary, 613
go offline, 386
go online, 386
go to action, 371
go to beginning/end/trigger, 387, 398
go to here (in markers overview 

bar), 245
go to locations in displayed packet 

data, 286
go to locations in Listing window, 236
go to locations in Waveform 

window, 222
go to marker, 391, 400
Go To Marker dialog, 249
go to trigger on run, 196, 447
goto actions, 166

GPA (General-Purpose ASCII) symbol 
file, 135, 471

GPA (General-Purpose ASCII) symbol 
file format, 514

gray bus and signal icons, 83, 84
greater than duration, 600
greater than operator, pattern 

trigger, 147, 159
greater than or equal to operator, 

pattern trigger, 147, 159
grid style/color analog property, 234
group events (advanced trigger), 177
group signals into bus, 227
grouping, numeric, 447

H
half channel timing mode, 97, 545, 550, 

553
hardware errors, 337
Hardware Update Utility program, 425
hardware upgrades, installing, 139
hardware_log.txt file, 336
hardware, selecting offline, 431
header (packet), viewing, 297
header format in module CSV and 

module binary files, 505
headers when printing, 314
height, waveform row, 232
help, 40
help file errors, 337
Help menu, 397
help operation keyboard 

commands, 532
help, Japanese, accessing on Windows 

XP, 345
Hex number base, 159, 232, 241
hide marker measurement display 

bar, 400
hide measurements list, 391
hiding markers, 256
hiding source file line numbers, 282
hiding/showing data values in 

waveforms, 232
High signal pattern value, 159
high-level source code, viewing, 277
history depth, trigger, 194, 195
host offline status, 63
hostname, logic analysis system 

frame, 61, 459
humidity, 595, 600

I
I/O channel error, 337
IEEE 1394 interface card/cable, 332
IEEE-695 object file format, 513
If clause comments, 

displaying/hiding, 183
if/then, show trigger step as, 376
Import dialog, 442

import module setup, 442
import module toolbar, 400
import module, buses/signals, 442
import module, file information, 443
import netlist, 90
import netlist to define 

buses/signals, 446
Import Setup dialog, 442
in range operator, pattern trigger, 147, 

159
in use status, 63
incompatible remote service, 332
incompatible remote service version 

status, 63
increment counter action, 180
independent analyzers, 600
information messages in the status 

log, 469
informational dialogs, 

showing/hiding, 447
informational messages, 340
input only reference data, 276
insert action after, 179
insert action before, 179
insert bus/signal into window, 387
insert event after (AND/OR), 168
insert event before (AND/OR), 168
Insert Find Event After (AND/OR), 270
Insert Find Event Before 

(AND/OR), 270
inserting buses/signals into Listing 

window, 238
inserting buses/signals into Waveform 

window, 227
inserting trigger functions into trigger 

sequence steps, 158
installation guides, 351
installing a printer, 315
installing on to LAN, 315
interactive self tests, 343
interpreting error messages, 334
intersecting Y-Axis and time 

markers, 259
interval marker statistics, 251, 252
interval measurement, 403
inverse assembler, 615
inverse assembler tool, 277
inverse assembler tool, Software 

Address bus, 280
inverse assembler, locked 

bus/signals, 83
inverse assembly tools, new, 390
IP address, logic analysis system 

frame, 61, 459

J
Japanese help, accessing on Windows 

XP, 345
Japanese online help, 397
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K
keyboard commands, 532
keyboard, on-screen, 198, 208
knob, 16800-series logic analyzer, 527, 

531

L
LAN, connecting to, 315
lanes (packet), viewing, 299
lanes associated with packet, 

viewing, 299
language options, Windows XP, 345
language, help, 397
latency, timer reset, 153
left alignment, bus/signal 

columns, 241
less than duration, 600
less than operator, pattern 

trigger, 147, 159
less than or equal to operator, pattern 

trigger, 147, 159
level, triggering on signal, 148
license activation wizard, 323, 463
license file, 139
license not available, 342
license problems, 342
license server communication 

timeout, 342
license servers, 321
licensed hardware upgrades, 

installing, 139
licenses (software), activation, 323, 463
licenses (software), borrow 

floating, 326, 465
licenses (software), floating license 

servers, 324, 464
licenses (software), summary, 322, 461
Licensing dialog, 461
licensing host ID, 323, 463
licensing, software, 397
limits in chart, 224
line number symbols, 277, 280
line number symbols, source 

correlation bus, 468
line numbers in Source window, 467
line numbers, source file, 

showing/hiding, 282
listing center rectangle, go to source 

line, 279
Listing menu, 393
listing operation keyboard 

commands, 532
Listing window, 409
Listing window, analyzing data, 235
Listing window, background color, 239
Listing window, bus/signal column 

properties, 240
Listing window, bus/signal data 

color, 240
Listing window, center rectangle, 239

Listing window, column width, 241
Listing window, font size, 239
Listing window, go to locations in, 236
Listing window, inserting/deleting 

buses/signals, 238
Listing window, lock scrolling, 239
Listing window, marker-relative 

times, 242
Listing window, new, 396
Listing window, properties, 238
Listing window, Quick Trigger in, 144
Listing window, re-arranging 

bus/signal columns, 237
Listing window, showing/hiding parts 

of, 237
Listing window, timing zoom 

background color, 239
little endian, 91
loading in the device under test, 334
loading saved data and setups, 208
local area network, 315
Local online mode, 59
local printer, 315
local session, 332
locate bus/signal patterns, 264
lock chart limits to setup, 224
lock display window scrolling, 227, 238
lock in viewer, marker property, 256
lock scrolling, 229, 239
lock to relative marker, 257
locked bus/signal, 83, 84, 334, 426
lockstep, 293
lockstep window, Protocol Viewer, 303
log, status, 469
logic analysis system details, 439
logic analysis system self tests, 343
logic analysis system, adding, 61
logic analysis system, deleting, 62
logic analysis system, going 

online, 459
logic analysis systems, refresh list, 63
logic analyzer, 615
logic analyzer basics, 40
logic analyzer cards, combining, 72
logic analyzer memory, 369
logic analyzer notes, 536
logic analyzer pod and channel 

connections, 474
logic analyzer triggering, 

understanding, 369
Logic Analyzer Upgrade utility, 425
logic analyzer, setting up, 71
logic analyzer, turning on, 40
logic analyzer, what is, 356
logic analyzer, when should I use, 355
logic analyzers, offline analysis on, 217
long marker name, 246, 254
Low signal pattern value, 159
LTSSM States and Transitions, 300

M
macro, 615
macro (Visual Basic), 401
macro, COM/DCOM, 390
mail applications, 432
manage releases, 328
manually mapping modules, 444
mapping modules, 210, 444
mapping modules from configuration 

file, 468
margins when printing, 314
marker, 615
marker background color, 246, 256
marker comments, 257
marker display bar, 246, 254
marker for system trigger, 312
marker foreground color, 246, 256
marker lock in viewer setting, 256
marker measurement display bar, 403
marker measurements, sample 

interval, 252
marker measurements, time 

interval, 251
marker pair, center about, 249
marker position, 246
marker properties, comments, 257
marker properties, lock to relative, 257
marker properties, position, 247
marker properties, snap to edge, 247, 

250
marker quick measurements, 47
marker tool tip, 246, 254, 257
marker, Found, 272
marker, go to in Waveform 

window, 222
marker-relative times in Listing 

window, 241, 242
marker-relative times, Protocol 

Viewer, 306
markers, 245
markers display bar, 407
markers display bar in Waveform 

window, 226
markers display bar, reading, 245
markers display in Listing window, 237
Markers menu, 391
markers overview bar, 408
markers overview bar, reading, 245
Markers toolbar, 400
markers, abbreviated name, 246
markers, creating new, 246
markers, deleting, 250
markers, go to, 249
markers, go to in Listing window, 236
markers, hiding/showing, 256
markers, long name, 246
markers, placing in data, 247
markers, placing where data is 

found, 272
markers, properties, 255
markers, renaming, 254
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markers, sending to back, 254
markers, using, 44
markers, value at measurements, 253
master clock, 100, 101, 103, 106, 114, 

115, 116
master frame, 381
Master Only state sampling clock 

mode, 100, 114
master pods, 450
Master/Slave state sampling clock 

mode, 101, 114, 127
maximized, starting, 447
maximum 128 channels per bus, 334
maximum channels on a single time 

base and trigger, 593, 600
maximum global counter, 600
maximum occurrence counter, 600
maximum pattern width, 600
maximum range width, 600
maximum state clock speed, 334
maximum state data rate on each 

channel, 600
maximum state sampling speed, 553
maximum time count between stored 

states, 600
maximum transitions stored, 365
maximum trigger sequence steps, 600
measure time, 245
measurement data, printing, 451
measurement examples, 50, 51
memory depth, 128, 129, 139, 428, 553, 

600
memory depth and channel count 

trade-offs, 363
memory depth in full channel 

mode, 600
memory depth in half channel 

mode, 600
memory, logic analyzer, 369
menu (Tools), adding external 

applications, 436
menu access keyboard 

commands, 532
menu bar, 615
menu, File, 386
menus, 386
message dialog options, 447
messages, borrow licenses, 466
messages, error, 334
messages, return borrowed 

licenses, 466
minimum data pulse width, 600
minimum detectable glitch, 148
minimum master-to-slave clock 

time, 600
minimum PC requirements for offline 

analysis, 218
minimum slave-to-master clock 

time, 600
minimum slave-to-slave clock 

time, 600
minimum state clock pulse width, 600

minimum time between active clock 
edges, 600

minimum transitions stored, 365
miscellaneous keyboard 

commands, 532
missing or slow clock, 339
missing pods, 362
module, 616
module binary (ALB) file format, 203, 

511
module binary and module CSV file 

header format, 505
Module binary file, 442
module binary file, 435
module CSV file format, 201, 504, 510
Module CSV text file, 442
module CSV text file, 435
module details, 469
module mapping, 210
Module Mapping dialog, 444
module setup information, 

transferring, 380
module setup, mapping from 

configuration file, 468
module setups, transferring, 210
Module Skew and System Trigger 

dialog, 446
Module Summary tab, 474
module upgrade, 397
module, cancel processing, 469
module, disable/enable/rename, 389
module, number of cards in, 431
module, resume canceled 

processing, 469
module, splitting, 72
modules in frame, 472
modules only, loading, 208
modules, configuring, 72
modules, disabling/enabling, 72
modules, renaming, 311
mouse cursor, placing marker at, 247
mouse shortcuts, 49
moving markers, 247
MSB ordering in bus waveform, 224
multiframe, 381
multiframe cable, 381
multiframe logic analysis system, 

flags, 157
multiframe remote access 

passwords, 68
multi-module systems, transferring 

setups, 210
multiple clocks, 99, 125, 154, 158
multiple conditions, testing in trigger 

sequence, 373
multiple frames, 381

N
N consecutive samples with pattern1 

trigger function, 491

N number of edges trigger 
function, 479

name, symbol, 458
negating events, 177
negative logic, 94
netlist file format, 90
Netlist Import dialog, 446
Netlist Import folder, 90
netlist, importing, 90
network, 315
network printer, 315
network troubleshooting, 348
new Compare window, 396
new configuration file, 386, 398
new Listing window, 396
new marker, 391, 400
new sample interval 

measurement, 391, 400
new Source window, 396
new time interval measurement, 391, 

400
new toolbar, creating, 402
new value at measurement, 391, 400
new Waveform window, 396
next data for source line, 278
next difference, 274
next difference in Compare 

window, 394
next source line, 277
next window, 396, 398
no hardware found, 139
no matching symbol found, 279
node-locked licenses, 321
not equal to operator, pattern 

trigger, 147, 159
not in range operator, pattern 

trigger, 147, 159
not in range, triggering on, 373
Not Present for Range, find 

qualifier, 265
Not Present, find qualifier, 265
notes, 16800-series logic 

analyzer, 553
notes, 16962 logic analyzer, 544, 549
notes, logic analyzer, 536
nothing event, 168
number base, 93, 159, 232, 241
number base, default (bus/signal), 83
number base, packet column, 306
numeric data values, 

showing/hiding, 232
numeric grouping, 447

O
object file formats supported by 

symbol reader, 513
object file symbols, 132
object file symbols, converting to 

ASCII, 135
observed value on target control port 

signals, 475
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occurrence, 616
occurrence counter status, 469
occurrence counter, reset action, 179, 

180
occurrence counters, 154, 178, 373
Octal number base, 159, 232, 241
offline analysis, 208, 217, 218, 616
offline analysis warnings, 339
offline file formats, 218
offline hardware, selecting, 431
offline mode, 444
offline mode unexpected, 332
Offline Startup Options dialog, 447
offline, creating demo data when, 447
offline, go, 386
offset in Compare window, 394
offset, adding to symbol value, 458
offset, reference data, 275
OMF96 object file format, 513
OMFx86 object file format, 513
ONFi Analysis window, 416
online analysis, 59
online help, 397, 398
online, go, 386
online, going after offline startup, 447
on-screen keyboard, 198, 208
open configuration file, 386, 398
opening configuration files, 208, 333
opening the Overview window, 307
option attributes, external 

oscilloscope, 399
options, 387
options, symbol reader, 136
OR events, 168
or trigger, 186
OR'ed find events, 270
order, channel selection, 89
oscilloscope, when should I use, 354
other trigger functions, state 

mode, 490
other trigger functions, timing 

mode, 478
overlaid waveform color, 228
overlaying waveforms, 223
overview, 40
Overview menu, 393
Overview window, 307, 390, 418
Overview window and multiframe 

systems, 381
Overview window, delete, 311
Overview window, open/display, 307, 

396, 398
Overview window, redraw, 311
owner information, configuration 

file, 208
owner, configuration file, 198

P
packet column, width, 305
packet columns, inserting or 

deleting, 288

packet columns, re-arranging, 287
packet data, analyzing, 283
packet decode column, alignment, 305
packet decode column, channels 

(directions), 305
packet decode column, number 

base, 306
packet details, viewing and 

comparing, 294
packet event editor, 164
packet event, save as favorite, 165
packet event, view as bits, 165
packet events, organizing 

favorites, 165
packet events, specifying, 164
packet header, viewing, 297
packet information, viewing, 293
packet lanes, 299
packet lanes, viewing, 299
packet patterns, finding, 267
packet payload, viewing, 298
packet summary, 285
packet summary event colors, 301
packet summary, column 

properties, 304
packet summary, showing/hiding parts 

of the display, 292
packet, viewing selected, 293
page headers/footers/margins when 

printing, 314
parentheses in boolean 

expressions, 177
partial logic analyzer setup, 

transferring, 380
passwords for remote access, 68
paste from clip board, 387, 398
pattern, 616
pattern absent for greater than time 

trigger function, 484
pattern absent for less than time 

trigger function, 484
pattern and pattern trigger function, 

state mode, 502
pattern and pattern trigger function, 

timing mode, 489
pattern N times trigger function, 491
pattern or pattern trigger function, 

state mode, 503
pattern or pattern trigger function, 

timing mode, 490
pattern present for greater than time 

trigger function, 483
pattern present for less than time 

trigger function, 483
pattern resources, 337
pattern too late after edge trigger 

function, 482
pattern trigger, 147, 159, 357
pattern trigger function, 482
pattern1 followed by pattern2 before 

pattern3 trigger function, 493

pattern1 followed by pattern2 trigger 
function, 492

pattern1 immediately followed by 
pattern2 trigger function, 492

pattern2 occurring too late after 
pattern1 trigger function, 496

pattern2 occurring too soon after 
pattern1 trigger function, 495

patterns trigger functions, state 
mode, 490

patterns, finding bus/signal, 264, 265
patterns, finding complex 

bus/signal, 270
pause timer action, 179
payload (packet), viewing, 298
PC requirements, minimum for offline 

analysis, 218
personal computers, offline analysis 

on, 218
physical view of cards in system, 472
pin mapping details, 90
place marker on screen, 391, 400
place on edge markers, 250
placing markers in data, 247
placing markers with find, 272
pod, 616
pod and channel connections, 426, 474
pod assignment, 389
Pod Assignment dialog, 450
pod index, 616
pod naming conventions, 361
pod pair, 616
pod pair, reserving for time tag 

storage, 363
pod truncation, 208, 616
pods, missing, 362
point, 616
polarity, 83, 94, 426, 616
polarity, external trigger, 437
position marker property, 247
position, marker, 246
position, trigger, 369
poststore, 128
preprocessor, 57, 617
Present for Range, find qualifier, 265
Present greater than or equal to, find 

qualifier, 265
Present greater than, find qualifier, 265
Present less than or equal to, find 

qualifier, 265
Present less than, find qualifier, 265
Present, find qualifier, 265
prestore, 128
previous data for source line, 278
previous difference, 274
previous difference in Compare 

window, 394
previous source line, 277
previous window, 396, 398
print data, 386, 398
print to file, 314
printer, installing, 315
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printing captured data, 314
Printing Data dialog, 451
probe, 617
probe compatibility, 595
probe grounding, 334
Probe Summary tab, 474
probes, 600
Probes toolbar, 400
probing, 57
probing documentation, 351
probing options, 57
problems, solving, 331
procedure names, 132
processing, module/tool/window, 

canceling or resuming, 469
processor-specific probes, 57
product information web sites, 351
product overviews, 520
project information, configuration 

file, 208
project, configuration file, 198
Properties dialog, 452
properties, Compare window, 394
properties, editing window/tool, 310
properties, Listing window, 238, 393
properties, marker, 255, 391, 400
properties, Source window, 281, 395, 

466
properties, Waveform window, 227, 

394
properties, window, 387
properties, Y-Axis marker, 262
protocol, 617
protocol column channels 

(directions), 288
Protocol Viewer, 413
Protocol Viewer menu, 395
Protocol Viewer panes, 

showing/hiding, 301
Protocol Viewer, window 

properties, 302
pulse clear flag action, 157, 180
pulse set flag action, 157, 180
pulse target control port signals, 475
pulse width in waveform tool tip, 230
pulse width, flag pulse set/clear, 180
pulsed mode, external trigger, 437

Q
QFP package probing, 57
qualifier, state sampling clock, 124
quick find, 264
quick start for 16700-series users, 39
quick start guides, 351
quick trigger, 617
Quick Trigger alignment, setting, 282
Quick Trigger in Listing window, 144
Quick Trigger in Source window, 145
Quick Trigger in Waveform 

window, 143
quick triggers, 141, 143

R
range and offset in Compare 

window, 394
range of data to export, 199
range of samples, comparing, 275
range operator, pattern trigger, 53, 

147, 159
range pattern, 617
Range Properties dialog, 452
ranges, triggering capability, 370
ranges, triggering on, 373
RDP (Remote Desktop Protocol), 350
reader, symbol, 136
readers.ini file, 136
reading markers display and overview 

bars, 245
readme information, 331
re-arranging bus/signal columns, 237
re-arranging waveforms, 223
re-assign pods to split analyzers, 450
recall recently-used configuration 

file, 210
recall trigger, 46, 194, 389
Recall Trigger dialog, 453
recalling favorite find patterns, 271
recalling triggers, 424
recent configuration files, 386
recent file list entries, 447
recently used bus/signal names, 159
recently-used configuration file, 

recalling, 210
recently-used trigger, 194, 195, 453
redraw, Overview window, 311, 393
reference, 385
reference buffer, copy data to, 274, 394
reference buffer, range compare, 275
reference data background color, 276
reference data offset, 275
reference data, comparing to, 274
reference data, display options, 276
refresh logic analysis system, 459
refreshing system to use list, 63
regional and language options, 

Windows XP, 345
re-group events (advanced 

trigger), 177
relative marker, lock to, 257
relative time, 241
remote access passwords, 68
remote control for switches in 

DUT, 475
Remote Desktop Protocol (RDP), 350
Remote Desktop, setting up, 350
Remote online mode, 59
remote session, 332
remove bus/signal from window, 387
remove icons to toolbar, 402
remove software, 328
rename bits of a bus, 86
rename Compare window, 394
rename Listing window, 393

rename module, 389
rename Source window, 395
rename trigger, 453
rename Waveform window, 394
renaming a bus or signal, 85
renaming markers, 254
renaming 

windows/tools/modules, 311
reorder bits, 91
reordering symbols, 132
repetitive measurement, 617
repetitive run, 196, 392, 401
repetitive run delay, 447
repetitive run, go to trigger 

behavior, 196
repetitive run, stop on compare 

differences, 275
repetitive run, stop on interval marker 

statistic, 251, 252
repetitive run, stop when marker value 

found, 247
repetitive run, storing data to 

consecutive files, 206
RepetitiveSaveToFile macro, 391
replacement failed, 337
replacing trigger functions in trigger 

sequence steps, 158
reporting level, self tests, 343
requirements, minimum PC for offline 

analysis, 218
reset and start timer trigger 

function, 497
reset counter action, 180
reset occurrence counter action, 154, 

179, 180, 337
reset toolbar, 402
resume, 392
resume canceled operation, 401
resume canceled processing, 

module/tool/window, 469
resume timer action, 179
return borrowed floating licenses 

early, 326, 465
return borrowed licenses 

messages, 466
reverse channel order, 91
right alignment, bus/signal 

columns, 241
right-click, 617
Rising Edge signal edge value, 159
rising edge, triggering on, 373
row height, 232
row properties, analog signal, 233
row properties, bus/signal 

waveform, 230
rules, Overview window 

connection, 418
run, 617
Run Properties dialog, 454
run repetitive, 617
run status, 196, 469
Run toolbar, 401
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run until a number of compare 
differences, 275

run until user stop trigger function, 
state mode, 498

run until user stop trigger function, 
timing mode, 486

run, go to trigger on, 196, 447
run, repetitive, storing data to 

consecutive files, 206
Run/Stop menu, 392
run/stop operation keyboard 

commands, 532
running self tests repetitively, 343
running the analyzer, 196

S
sample, 617
sample interval measurement, 252, 403
sample interval measurement, 

new, 391, 400
sample period, 600, 617
sample period, timing zoom, 131
sample rate in half channel mode, 600
sample rate on all channels, 600
sample, go to in Listing window, 236
sample, go to in Waveform 

window, 222
sample, position marker by, 246, 247
sampled data, 618
samples, comparing range of, 275
samples, how they are stored in 

memory, 369
samples, storage qualification, 375
sampling, 618
sampling mode, state, 98
sampling options, 97
sampling options, memory depth and 

channel count trade-offs, 363
sampling options, state, 98
sampling period, 96, 98, 356
sampling period, timing zoom, 476
sampling period, transitional timing 

mode, 363
sampling positions, state mode, 

understanding, 367
sampling setup, 389, 399, 428
Sampling tab, 428
save configuration file, 386, 398
saved data and setups, loading, 208
saving captured data, 198
saving configuration files, 198
saving trigger sequences, 378
saving trigger setups, 46
scale of waveform display, 249
scaling analog property, 234
screen, copy to clip board, 387
screens, copying to clip board, 315
scroll lock on display windows, 227, 

238
search, 618
search for symbol name, 458

search operation keyboard 
commands, 532

search order of source file 
directories, 467

search, quick, 264
searching data, 48
searching for bus/signal patterns, 264
searching for text in Source 

window, 279
SECTIONS, General-Purpose ASCII 

symbol file format, 515
Select Offline Hardware dialog, 431
Select Symbol dialog, 458
Select System to Use dialog, 459
selected bit order, assigning 

channels, 89
selected packet box color, 303
selected source line, go to data 

for, 278
self test, 343, 397
send e-mail on trigger, 166
sending markers to the back, 254
SendToExcel macro, 391
separator rows in Waveform 

window, 227
sequence step branching, transitional 

timing, 365
sequence step storage, 167, 375
sequence steps, trigger, 337, 371, 372, 

373
sessions, saving and loading, 380
set flag action, 157, 180
Set Quick Trigger alignment, 282
Setup menu, 389
setup only, loading, 208
setup/hold time, logic analyzer, 334
setup/hold window, logic analyzer, 367
setups, loading saved, 208
short bus/signal names, 447
show axis in chart, 224
show clipped analog property, 234
show correlated source line, 279
show marker measurement display 

bar, 400
show measurements list, 391
show trigger step as if/then, 182, 376
show values in waveform tool tip, 230
showing markers, 256
showing source file line numbers, 282
showing/hiding data values in 

waveforms, 232
signal activity envelope, 367
signal names, 83
signal, grouping into a bus, 227
signal/bus column alignment, 241
signal/bus column properties, 240
signal/bus column width in Listing 

window, 241
signal/bus data color, Listing 

window, 240
signal/bus errors, 334
signal/bus folders, adding, 95

signal/bus name, alias, 95
signal/bus names, sorting, 95
signal/bus naming, short or 

unique, 447
signal/bus patterns, finding, 264, 265
signal/bus patterns, finding 

complex, 270
signal/bus row properties, 230
signal/bus values displayed as 

symbols, 243
signal/bus, adding a new, 84
signal/bus, assigning channels in 

default bit order, 88
signal/bus, assigning channels in 

selected bit order, 89
signal/bus, deleting a, 84
signal/bus, renaming a, 85
signals/buses, define by importing 

netlist, 446
signals/buses, exporting data from 

selected, 452
signals/buses, inserting/deleting in 

Listing window, 238
signals/buses, inserting/deleting in 

Waveform window, 227
signals/buses, load warning, 339
Signed Decimal number base, 159, 

232, 241
simple trigger, 141, 146, 389, 618
simple trigger example, 359
simple trigger in Listing window, 237
simple trigger in Waveform 

window, 226
simple trigger, setting up, 43
single clock, 99, 124
single measurement, 618
single run, 196
single-ended signals and differential 

probes, 474
skew, 618
skew and system trigger, 389
skew and system trigger, setting, 312
skew, module, 446
slave clock, 101, 103, 114, 115, 127
slave frame, 381
slot, 618
slot naming, 361
Slot Summary tab, 472
slot, starting, 431
slots of cards in module, 474
slow or missing clock, 339
snap to edge markers, 247, 250, 618
Soft Touch connectorless probing, 57
Software Address bus, 280, 468
software licenses, activation, 323, 463
software licenses, borrow floating, 326, 

465
software licenses, floating license 

servers, 324, 464
software licenses, summary, 322, 461
software licensing, 397
software, updating, 327
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solving problems, 331
sorting bus/signal names, 95
source code correlation bus, 

selecting, 280
Source Code Directories tab, 467
source code directory list, 279
source code, viewing, 277
source correlation, 468
Source display window, 412
source file line numbers, 132
source files, browsing, 278
source line numbers, 

showing/hiding, 282
source line symbol values, 

adjusting, 282
source line, go to data for, 278
source line, showing correlated, 279
SOURCE LINES, General-Purpose 

ASCII symbol file format, 518
source lines, step by, 277
Source menu, 395
source of data export, 199
Source Properties tab, 467
Source Viewer Properties dialog, 466
Source window background color, 282
Source window font size, 282
Source window properties, 281
Source window tab width, 282
Source window text color, 282
Source window, new, 396
Source window, Quick Trigger in, 145
Source window, text search, 279
specifications, 587, 611
specifications, 16800-series logic 

analyzer, 600
Specify Mapping dialog, 468
split analyzer, 72, 389
spreadsheet, importing CSV files, 198, 

199, 386
spreadsheet, pasting into from clip 

board, 314
standard CSV text file, 435
standard threshold voltage level, 77
Standard toolbar, 398
START ADDRESS, General-Purpose 

ASCII symbol file format, 519
start from reset timer action, 179
start maximized, 447
start value of symbol, 458
startup options, offline, 447
state acquisition mode, 428
state analyzer, 356, 618
state analyzer, triggering, 359
state clock edges too close, 334
state measurement, 618
state mode, 51, 96, 141, 359, 490, 618
state mode sampling positions, 

understanding, 367
state mode, default storage, 167
state mode, selecting, 98
state sampling clock, 124

state sampling clock mode, 
Demultiplex, 103, 115

state sampling clock mode, Dual 
Sample, 106

state sampling clock mode, Master 
Only, 100, 114

state sampling clock mode, 
Master/Slave, 101, 114

state sampling clock mode, 
selecting, 99

state sampling mode, 98
state sampling mode, memory depth 

and channel count trade-offs, 363
state sampling options, 98
state sampling setup, 399
state speed, 139
statistics, interval marker, 251, 252
status bar, 388
Status dialog, 469
status, system, 392
step to next/previous source lines, 277
steps in trigger sequence, cutting, 182
steps in trigger sequence, 

deleting, 182
steps, trigger sequence, 152, 337, 371
stop, 618
stop and reset timer action, 179
stop button, 16800-series logic 

analyzers, 527, 531
stop measurement, 392, 401
stopping self tests on fail, 343
stopping the analyzer, 196
storage control action, 152, 167, 179, 

181, 424
storage qualification, 167, 375, 618
storage qualification, triggering 

capability, 370
storage qualifier when filling 

memory, 166
store action, 337, 375
store qualification, 600
store qualified (transitional) timing 

mode, 97, 545, 550, 553
store qualified (transitional) timing 

mode, default storage, 167
store sample action, 181
store trigger, 194, 389
storing favorite find patterns, 271
storing triggers, 424
strategies for setting up triggers, 376
subdirectories, searching for source 

files, 467
summary of triggering capabilities, 370
summary, module, 474
summary, system, 472
supported signal types, 595
switch endian, 91
symbol decode, 299
symbol file, ASCII format, 514
symbol file, creating ASCII, 135
symbol information, XML format, 380
symbol lookup, 132

Symbol number base, 159, 232, 241
symbol reader options, changing, 136
symbol reader, object file formats 

supported, 513
symbol reader, running outside the 

application, 135
symbol search, 458
symbol selection, 458
symbolic bus/signal values, 138
symbols, 132, 387, 389, 458, 619
Symbols dialog, 471
symbols with same name, 132
symbols, displaying for bus/signal 

values, 243
symbols, line number, 277, 280
symbols, loading from file, 134
symbols, user-defined, 132
synchronous sampling, 98, 428, 619
system clock failure, 337
system details, 439
system details, viewing, 64
system in use comments, 63, 65, 459
system options, 447
system summary, 393
System Summary dialog, 472
system to use list, adding frame, 61
system to use list, deleting frame, 62
system trigger, 446
system trigger and skew, 389
system trigger and skew, setting, 312

T
tab width in Source window, 282, 467
tabbed windows, 220, 235, 313, 388
target connector probing, 57
target control port, 58, 389
Target Control Port dialog, 475
target system, 619
temperature, 595, 600
terminating slave frame, 381
testing the logic analyzer, 343
text color, Source window, 282
text data, copying to clip board, 314
text file, print to, 314
text search in Source window, 279
third party tools, 390
tHold, 600
threshold (bus/signal), 83
threshold accuracy, 595
threshold level, trigger in/out, 437
Threshold Settings dialog, 77
threshold value, 334
threshold voltage, 77, 426, 619
TI COFF object file format, 513
Ticoff symbol files, 136
tile windows horizontally, 396, 398
tile windows vertically, 396, 398
time axis in Waveform window, 226
time duration in find qualifiers, 265
time interval accuracy, 600
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time interval measurement, 251, 391, 
400, 403

time measured, transitional 
timing, 365

time tag resolution, 600
time tag storage, memory 

requirements, 363
time tag storage, reserve pod pair 

for, 450
time tag storage, transitional 

timing, 365
time trigger occurred, 474
time, absolute, 241
time, go to in Listing window, 236
time, go to in Waveform window, 222
time, marker-relative, 242
time, position marker by, 246, 247
time, relative marker, 241
time, relative previous, 241
time/division, 221, 619
timeout, floating license server 

communication, 342
timer, 619
timer accuracy, 600
timer action, 179
timer event, 168, 169
timer event check without start 

action, 339
timer in trigger sequence, 337
timer reset latency, 153, 600
timer resolution, 600
timer status, 469
timer value range, 600
timers, 152, 374
timers, number available, 363
timers, triggering capability, 370
timers, using, 153
timing acquisition mode, 428
timing analysis sample rate, 600
timing analyzer, 356, 619
timing analyzer, triggering, 357
timing interval accuracy, 600
timing measurement, 619
timing mode, 50, 96, 141, 356, 619
timing mode sampling period, 98
timing mode trigger functions, 478
timing mode, duration or occurrence 

counts for events, 178
timing mode, selecting, 96
timing sampling mode, 97
timing sampling options, 97
timing zoom, 129, 553
timing zoom background color, Listing 

window, 239
timing zoom background color, 

Waveform window, 229
timing zoom sample period, 131
timing zoom trigger position, 131
timing zoom, turning on or off, 131
timing/state sampling setup, 399
timing/state setup, 389
TimingZoom Setup dialog, 476

tips for experienced users, 39
toggle target control port signals, 475
too few states between pattern1 and 

pattern2 trigger function, 494
too many states between pattern1 and 

pattern2 trigger function, 494
tool details, 469
tool properties, editing, 310
tool tip, 619
tool tip display, Waveform 

window, 230
tool tip, marker, 246, 254, 257
tool tips, 49, 94
tool tips, Waveform window, 227
tool, cancel processing, 469
tool, resume canceled processing, 469
toolbars, 388, 398
toolbars and mouse shortcuts, 49
toolbars, customizing, 402
Tools menu, 390
Tools menu, adding external 

applications, 436
tools, adding/deleting, 307
tools, help on, 397
tools, renaming, 311
tools/viewers, loading, 208
topics, help, 397
trace, 619
trace memory, 196
transferring setups to/from 

multi-module systems, 210
transition width in waveform tool 

tip, 230
transitional default storage, 167
transitional timing, 97, 365, 620
transitional timing mode, counters 

in, 154
transitional timing sampling mode, 

memory depth and channel count 
trade-offs, 363

Transitioning, find qualifier, 265
trigger, 146, 152, 194, 620
trigger actions, 166, 371, 600
trigger analyzer from another 

instrument, 192
trigger and fill memory action, 166
trigger and goto action, 166
trigger attributes, external 

oscilloscope, 399
trigger errors, 337
trigger function, 424, 620
trigger functions, 152, 478
trigger functions, converting to 

if/then, 183
trigger functions, replacing or 

inserting, 158
trigger functions, state mode, 490
trigger functions, timing mode, 478
trigger functions, understanding 

triggering, 376
trigger history, 620
trigger history depth, 194, 195, 447

trigger in, 186, 437
trigger in from external 

instrument, 192
Trigger In/Out and multiframe 

systems, 381
trigger inhibited during prestore, 340
trigger other instruments, 191
trigger out, 186, 437
trigger out to external 

instruments, 191
trigger point, 222, 369
trigger position, 128, 369, 428, 600, 620
trigger position, timing zoom, 131, 476
trigger position, transitional 

timing, 365
trigger reference point skew, 446
trigger resource conditions, 600
trigger resources, 595, 600
trigger sequence, 424, 620
trigger sequence step branching, 600
trigger sequence step, show as 

if/then, 182
trigger sequence steps, 152, 337, 371
trigger sequence steps, cutting, 182
trigger sequence steps, deleting, 182
trigger sequence steps, replacing or 

inserting trigger functions, 158
trigger sequence, clearing, 185
trigger sequences, save and 

document, 378
trigger setup file, 194
trigger setups, saving/recalling, 46
trigger specification file, 453
trigger specification too complex, 337
trigger step status, 469
trigger, go to, 249
trigger, go to in Listing window, 236
trigger, go to on run, 196, 447
trigger, recalling, 194, 453
trigger, send e-mail, and fill memory 

action, 166
trigger, system, 446
trigger, system, setting, 312
trigger, time trigger occurred, 474
triggering, 146, 152, 194
triggering after external data 

analysis, 206
triggering capabilities, summary 

of, 370
triggering the state analyzer, 359
triggering the timing analyzer, 357
triggering, understanding logic 

analyzer, 369
triggers, dynamic, 206
triggers, quick, 143
triggers, recalling, 194
triggers, storing, 194
triggers, strategies for setting up, 376
troubleshooting, 331
tSample accuracy, manual 

adjustment, 600
tSample adjustment resolution, 600
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tSample range, 600
tSetup, 600
turbo state mode, 98, 553
turbo state mode, flag actions, 157
turn off/on default storage action, 181
tutorial, 40
tutorial configuration file, 44
tWidth, 600
two's complement, 232, 241
two’s complement, 159
type, symbol, 458
types, probe, 474
TZ (timing zoom), 129

U
U4154A, 522, 523
U4154A Characteristics, 592, 596
U4154A clock channels, 562
U4154A data channels, 561
U4154A eyescans, 567
U4154A logic analyzer notes, 544, 549
U4154A pod, 561
U4154A Specifications, 592, 596
U4154A state clock qualifiers, 548, 552
U4154A state sampling clock, 548, 552
U4164A Logic Analyzer Product 

Overview, 520
unassigned channels, data on, 

transitional timing, 365
understanding logic analyzer 

triggering, 369
undo, 387, 398
undo trigger sequence step shown as 

if/then, 182
unique bus/signal names, 447
unsplit analyzer, 389
update software, 327
upgrade, module, 397, 425
upgrades, E5876A, for 

16801A/16821A logic 
analyzer, 553

upgrades, E5877A, for 
16802A/16822A logic 
analyzer, 553

upgrades, E5878A, for 
16803A/16823A logic 
analyzer, 553

upgrades, E5879A, for 16804A logic 
analyzer, 553

upgrades, E5880A, for 16806A logic 
analyzer, 553

upgrades, licensed hardware, 139
user interface, 527, 531
user threshold value, 334
USER, General-Purpose ASCII symbol 

file format, 516
user-defined symbols, 132, 471
user-defined threshold voltage 

level, 77

V
value at marker measurement, 253, 

391, 400, 403
value at measurement, 620
value, position marker by, 246, 247
value, symbol, 458
variable names, 132
variable size, 513
VARIABLES, General-Purpose ASCII 

symbol file format, 518
version information, 397
version information, configuration 

file, 208
vibration, 595, 600
View As dialog, 224
View menu, 388
view operation keyboard 

commands, 532
view packet event as bits, 165
viewers/tools, loading, 208
viewing bus data as chart, 224
viewing captured data, 207
viewing tabbed windows, 313
virtual analyzer, 431
Visual Basic Editor, 401
Visual Basic toolbar, 401
voltage marker properties, 

changing, 262
voltage markers for analog 

signals, 257
voltage markers, placing, 259
Voltage number base for analog signal 

in Listing, 241
voltage threshold, 595

W
wait for arm from another module, 186
wait for arm from another module 

trigger function, state mode, 499
wait for arm from another module 

trigger function, timing mode, 487
wait for external arm, 192
wait for external arm trigger function, 

state mode, 498
wait for external arm trigger function, 

timing mode, 486
wait N external clock states trigger 

function, 499
wait T seconds trigger function, 485
waiting in trigger step, 340
warning dialogs, showing/hiding, 447
warning messages, 339
warning messages in the status 

log, 469
waveform color, 231
waveform display scale, changing, 221
waveform display, changing the 

delay, 222
waveform font size, 229
waveform height, 232

Waveform menu, 394
waveform numeric data values, 

showing/hiding, 232
waveform operation keyboard 

commands, 532
waveform tool tip display, 230
Waveform window, 404
Waveform window background 

color, 228
Waveform window, analyzing 

data, 220
Waveform window, bus/signal row 

properties, 230
Waveform window, filtered data 

color, 229
Waveform window, finding a 

bus/signal row, 224
Waveform window, go to locations 

in, 222
Waveform window, group signals into 

bus, 227
Waveform window, inserting/deleting 

buses/signals, 227
Waveform window, lock scrolling, 229
Waveform window, new, 396
Waveform window, overlaid waveform 

color, 228
Waveform window, properties, 227
Waveform window, Quick Trigger 

in, 143
Waveform window, showing/hiding 

parts of, 226
Waveform window, timing zoom 

background color, 229
Waveform window, viewing bus data as 

chart, 224
Waveform windows, Fast Zoom In 

option, 230
waveforms, accumulate, 229
waveforms, overlaying, 223
waveforms, re-arranging, 223
web sites, 351
what's new, 25
why are pods missing?, 362
width (bus/signal), 83
width of buses/signals, 426
width violation on pattern or pulse 

trigger function, 485
width, packet decode column, 305
width, tabs in Source window, 282
window details, 469
window menu, 396
window operation keyboard 

commands, 532
window properties, 387
window properties, editing, 310
window tabs, turning on/off, 313
window, cancel processing, 469
window, Overview, 307, 418
window, resume canceled 

processing, 469
windows, 404
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windows, adding/deleting, 313
windows, 

adding/deleting/duplicating, 307
windows, display, using, 313
windows, help on, 397
windows, renaming, 311
writing to target control port 

signals, 475

X
XML format configuration file, 198, 208, 

210
XML format configuration files, 

automatic module mapping, 445
XML format files, offline analysis, 218
XML vs. ALA format, when to use, 380

Y
Y-Axis interval measurements, 260
Y-Axis markers, creating new, 258
Y-Axis markers, deleting, 260
Y-Axis markers, renaming, 261
Y-Axis markers, sending to back, 261

Z
zoom in on data, 45, 221
zoom out/in, 388, 398
zooming, 621
zooming fast in Waveform 

windows, 230
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